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Welcome
MAXQDA 2020 is a high-performance program for professional, social science-
oriented data analysis – ideal not only for researchers but also for students and
teachers at universities and secondary schools. MAXQDA is used in a variety of
disciplines: the social sciences, education, health sciences, the humanities, economics,
marketing, and many others. In short, MAXQDA is the ideal software package for the
effective management and systematic evaluation of texts, documents and all kinds of
media data. Get to know the software package in the MAXQDA manual.

MAXQDA is the result of more than 30 years of continuous development that began
with MAX for DOS in 1989. MAXQDA 12 was groundbreaking as the world's first
QDA software that provided the same functionality for both Windows and Mac,
allowing you to switch effortlessly between the two platforms. We have continued on
this path of one combined software solution for Windows and Mac with MAXQDA
2020. The menu, icons, shortcuts and functions are nearly identical, eliminating the
need for two different user manuals.

This guide provides a detailed overview of the features of MAXQDA. The “Getting
Started Guide” offers a brief introduction. The manual explains each of MAXQDA's
functions rather than following the logic of learning to use the program. Further help
can be found on the website www.maxqda.com, which features online tutorials,
textbook references and information on the annual user conference in Berlin, the
“MAXQDA International Conference MQIC”.

In our continuous effort to improve and troubleshoot MAXQDA, we are always
interested in your feedback and suggestions. To send us your ideas simply email our
Customer Support or use the feedback function in MAXQDA.

Research is a journey. Travel it well!

Your MAXQDA team

https://m22.maxqda.com/download/GettingStarted-MAXQDA2020-en.pdf
https://m22.maxqda.com/download/GettingStarted-MAXQDA2020-en.pdf
https://m22.maxqda.com
http://conference.maxqda.com
http://m22.maxqda.com/emailto:cs@maxqda.com
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Getting Started Guide: Go for it!

Introduction
Welcome to the MAXQDA Getting Started Guide! As no one likes to read long
introductions and manuals, we tried to make this one as short as possible to help you
get started as quickly as possible. The guide will enable you to start your analysis and
make your own experiences with MAXQDA. We will focus on the actual usage of the
program, and not on the presentation of different analysis and research methods. If
you want to find out more about those, we have provided a list of useful publi-cations
in the chapter “Further literature”. As you may know, there is an endless number of
different qualitative methods. But most of them can be conducted with the help of
MAXQDA as they all follow the same basic structure as pictured in this illustration.

The vast majority of qualitative analysis methods work with categories. These can
either be created from within the data or based on prior knowledge of the data,
existing theories, or recent research results. Categories are often also named codes or
keywords, but whatever the name, they all have the function to organize and
systematize the data, often even working as analytical codes. Analytical codes are the
result of an analytical process that exceeds simply determining a topic, and this is what
we refer to as Codes in this guide. Coding data can take a long time, but don’t worry:
there are many different ways to make use of QDA (qualitative data analysis) software.
It’s not always necessary to code your data in order to analyze it with MAXQDA; you
can also use it simply for organizing your da-ta, or searching for words and word
combinations.
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The MAXQDA Interface
Starting MAXQDA

When opening MAXQDA, you will see a window on the top left that lets you type in a
user name or a user abbreviation (which can be more practical in your later work).

To create your first MAXQDA project, click New Project, name your project and save it
to a place of your choice. The best location for a MAXQDA project is inside a local
folder on your computer, not on a network drive or on a USB flash drive. You should
also avoid folders that are synchronized by a cloud service like iCloud, Dropbox or
Google Drive. These services may compete for access to the project database while it is
open in MAXQDA.
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MAXQDA 2020 project files have the file ending MX20. You can also recognize these
files in Windows Explorer or Mac Finder by the description “MAXQDA 2020 Project”.

MAXQDA uses Projects, like Excel uses workbooks (.xlsx), and Word uses text
documents (.docx). Nearly everything you import to or create with MAXQDA (like your
Codes and Memos) will be saved in Projects.

The right side of the start screen provides you with several links, for example the
option to open up the MAXQDA online manual, watch MAXQDA video tutorials or
send feedback to the MAXQDA team.

The user interface

Once you successfully created and saved your first MAXQDA project, the following
screen will appear – with all of the main windows still mostly empty.
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The division into four windows makes working with MAXQDA very easy: as you can
see, the first window (1) in the upper left corner contains the Document System, the
window below (2) contains the Code System, the window in the upper right corner (3)
is the Document Browser, and the fourth window (4) is called Retrieved Segments.
(Don’t worry, if you only see three windows. The fourth window is hidden when you
start MAXQDA for the first time, because you don't need it at the beginning of your
analysis.)

These four windows make up MAXQDA’s basic structure. You can rearrange them by
swapping the windows’ sides, or by displaying the windows in three instead of two
columns. You can change those settings in the main menu with the four symbols on
the “Home” tab.

These tabs (some programs may call them “ribbons”) are located at the top of the
MAXQDA window and offer access to many of MAXQDA’s features. On the “Home”
tab you can open or close individual windows and arrange the screen according to the
work you intend to do. On top of that, you can “undock” individual windows from
the four-window structure and drag them to a different position or even a second
computer screen. To open and close the windows, you can click on the button for the
respective window(s), or simply close a window by clicking the “x” symbol in its upper
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right corner.

Now, let’s return to the four main windows! All the files you wish to work with will be
imported into the Document System window. In case you use codes and subcodes,
you can manage them in the Code System window. You can view and edit your data
in the Document Browser. The Retrieved Segments window is where the results of
your retrievals will be displayed later on.

A few notes on data storage and saving

MAXQDA administers everything you import, comment, or define in one single file,
the Project file. So, once you create it: one project = one file. As we learned earlier,
those files end in MX20 (older versions’ projects end in MX18 or MX12). MAXQDA
Exchange files are special types of files used to make data exchanges between
different program versions.

In order to ensure that your project is always safe, please read the following box:

Please note: MAXQDA automatically saves everything that is imported or created by
the user(s). However, you should still make sure to regularly create back-ups via the
option Save Project as, which you can find in the “Home” tab and save them on a
secondary storage device.

To sum up, the Project file contains all the data material you need to work on your
research project, bachelor thesis or master thesis. But there’s an exception to every
rule: if you use a lot of audio or video files, the Project file may become too large, even
after importing only a few video files. The standard setting therefore automatically
embeds pictures and PDF documents only up to a certain file size (5 MB), whilst audio
and video files are saved separately. Of course, you can change these settings. But
when your Project file becomes too large, it may be difficult to exchange it with
others.

Important keywords

Here are some of the most important keywords you should know for your work with
MAXQDA:

Projects are the system files, or “work units” in MAXQDA. They contain all imported
data, like texts, PDFs, pictures, tables as well as the codes, memos, comments you
created.

Documents are those units that you want to analyze. They can be interviews, focus
group protocols, video or audio recordings, articles from scientific journals and many
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more.

Codes are your most important analysis tool. They can be assigned to anything you
consider worth marking, be it text segments, sections in a photo or parts of a video.

The Code system or Code tree describes the entirety of all codes and subcodes which
can be ordered hierarchically.

Coding is the act of assigning a code to a marked segment of your material.

Coded segments are those material segments that have been assigned a code.

Memos basically serve as your records. You can note your ideas, assumptions, and
questions for your next analysis steps, or formulate first hypotheses regarding possible
connections in the data.

Comments are shorter than memos. You can use them to assign comments like
“contradictory”, or “important part!” to coded segments.

Overviews are tabular presentations omnipresent in MAXQDA. There are overviews of
coded segments, memos, variables, links and so on. All MAXQDA overviews follow the
same principle and allow easy access to individual elements so that you don’t lose
track of your data.

Import and explore your data
Importing data

Before we learn about the different ways to import your data let’s have a closer look
at the Document System window.

When you right-click the word Documents or the symbol next to it, a large context
menu will open.
You can see a part of it here:
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Alternatively, you can go via the “Import” tab menu and click on the appropriate
symbol for your data, e.g. Transcripts, or – even easier – drag and drop the files from
Windows Explorer or Mac Finder into the Document System window. On the “Import”
tab you will see additional options to import special types of data, including importing
documents from spreadsheets, focus group transcripts or creating a text directly in
MAXQDA.

In the way that your computer lets you create folders to organize your files,
MAXQDA’s New document group function lets you create document groups to
organize your documents. Right-click a document group and choose Import
document(s) to import them, or drag and drop your documents from one group to the
other.

Exploring data

Analyzing qualitative data does not really work without you knowing the data. So
MAXQDA makes it easy for you to look through your files: simply double-click on a
document in the Document System window, and it will be opened in the Document
Browser, looking roughly like the interview transcript in the following example:

Paragraph numbers make it easier to discuss certain segments in a team (“Have a look
at the comment in paragraph 4!”) as well as coding whole paragraphs at once. You
can also use the paragraph numbers to quote your data sources. If you need a finer
numbering of your data, you can change the display to line numbering at any time by
right-clicking in the text and selecting “Convert to Line Numbering”.

In the example above you can see three colored vertical stripes, as well as a yellow
sticky note symbol next to the text. The latter shows that a memo has been attached
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to that paragraph. The vertical stripes are the so-called coding stripes symbolizing
which code the text was assigned to (in this case long codes ending on “..Interests”,
“..Career” and “..Parents”). To view the whole code name, simply enlarge the coding
column by dragging the line next to the coding stripes to the right.

What is a memo? Memos serve to create notes and records to attach them to texts,
text segments, document groups, images, audio or video files, and even codes – just
like you would do with “real” sticky notes.

When you open a text in the Document Browser for the first time, that sector will still
be empty as you have not coded nor created a memo yet. Just try to create one now:
double-click somewhere in the memo sector and a memo dialog window will
automatically open. As we will talk about memos in more detail later, this is all you
need to know for now.

The standard setting for the codes is to be displayed left of the data. If you prefer
them on the right, however, you can just place the whole sector there by clicking the
sector head and dragging it to the other side. There is no functional difference.

In the very top of the Document Browser, a toolbar shows you the most important
features.

If you import and open a PDF document in the Document Browser you can use a few
additional settings. You will see that you are provided with icons, which enable you,
for example, to zoom in or out or to jump to the next page of the PDF file.

At some point of your research, you may wish to print a text including the paragraph
numbers (or save this display to PDF with a PDF printer). To do so, chose the symbol
Print document or use the shortcut key Ctrl+P (on Windows) or cmd+P (on Mac). The
print menu will give you a variety of choices for the design of your print:
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Search your data

The exploration phase of your research may call for the necessity to search your
documents for certain words. In MAXQDA, word search can be done locally in each of
the four main windows, that means in one window at a time. You will find a
magnifying glass symbol in each window to enter the search word upon click.
MAXQDA will display the term’s frequency, and you will be able to navigate from each
hit to the next to view its context by using the arrow keys.

A more powerful tool than the local search is the Lexical search (to be found in the
“Analysis” tab or via the magnifying glass symbol in the Standard toolbar). The Lexical
search enables you to search several documents at a time; it is not restricted to opened
documents.

As soon as the window opens you can enter as many search items as you like at once.
Use the return key to end your entry or add a new search string. Each search item is
placed in a new line. The standard setting follows the “OR” logic, i.e. as soon as one
of the search items is found, it will be listed as a hit. Clicking an item will show you the
relevant paragraph in the Document Browser window.
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Color-coding and memos

Sometimes you may want to mark something in a text or note comments, hypotheses
and further ideas, before you have even started thinking about categories and the
general direction of your analysis. Just like you may then highlight passages in a book
or stick a sticky note to a page, you can use the Highlight coding function in MAXQDA
to mark texts with five colored, virtual pens (red, blue, green, yellow, and purple). You
can find the color-coding icons at the top of the Document Browser window.

You can select any text part with your mouse and then click one of the symbols to
highlight it with the color of your choice. The difference to highlighting in “real life” is
that it is much easier to find those passages again in MAXQDA than to skim through a
book. How to retrieve coded segments created with Highlight coding, will be
described further down in Data analysis. As we learned, color-coding is a useful tool to
mark important things even before the explicit coding process. Another useful tool is
the Memos function. With the help of In-Document-Memos you can attach memos to
any place in any document. Select any part of a document, right-click on the
highlighted selection and use the context menu to create a new memo for you to fill
with your thoughts and ideas:

Similar to color-coding, it is simple to retrieve Memos. You can find all types of memos
and a special memo search feature on the “Memos" menu tab. The search results are
displayed in MAXQDA’s Memo Manager, where you can easily manage, edit and filter
all your memos, e.g. by only displaying memos you have written in a certain time
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period.

Code your data
Coding data segments

As we learned earlier, the central work technique among most analysis methods is
Coding the data. But what does this mean? Coding describes the process of selecting
part of the data material, for example a paragraph or one part of an image, with the
mouse (just like in Word or other programs) and assigning a code to it. This is
principally the same as tagging contents, but coding in empirical social research
includes much more than that.

So, what is a code then? Your first associations may be of secret services and their
coding and decoding machines, or of codes as strictly regulated mappings as in Morse
codes. Both associations are misleading! In the context of qualitative research a code is
more of a label used to name phenomena in a text or an image. In technical terms, a
code is a character string that can consist of up to 63 characters in MAXQDA, be it
several words or more cryptical strings like “CR128”. In social research, codes can
possess different meanings and take on different functions in the research process:
there are factual codes, thematic codes, theoretical codes and many more (see
Kuckartz 2018, Richards 2014). From simply looking at the code itself, its role in the
research process is not always clear: it could be of minor importance or play a key role.
Only its context or framing will shed light on that.

So, how can codes be created? Simply right-click the root of the Code System in the
Code System window and choose the option New code from the context menu.
Alternatively, you can select the corresponding symbol in the toolbar in the upper right
corner or hover over a code and click on the green plus symbol that automatically
appears.

A dialog window to define your new code opens:
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How can I assign a code to a certain document section? First, you select a section with
your mouse (if you want to mark the whole paragraph, just click the paragraph
number). Then you either drag and drop the marked section onto a code, or the other
way around, i.e. you drag the code on the selected section. Once you did that for the
first time, you will see that the number next to that code in the Code System, showing
how many times a code has been used, changed from “0“ to “1“. If you look at the
Document System you will see that the number of coded segments in a document is
displayed next to each document as well.

MAXQDA offers you other coding possibilities; you can access them via right-clicking a
selected section in the document or via the icons in the toolbar Code, which is located
at the top of the Document Browser window. The toolbar looks like this:

The code that you used last is always displayed on the very left. If you click the red
coding symbol on the right, it will assign this code to a selected text section. Each of
the following icons refers to a different coding function; you can for example click the
Undo code symbol and then choose one or several codes from a drop-down list.

The context menu in the Document Browser contains even more coding options,
which you can see when you right-click into a marked text section:
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Analyze your data
Activating documents

Maybe you saw the option Only in activated documents earlier in the dialog window
for the Lexical search and asked yourself what that means. Activation is one of
MAXQDA’s key concepts: it means that you can select documents (and/or codes) for
your analysis and then work only with the selected items. How does the activation
work? This is very simple: in every document’s or document group’s context menu you
will see the option Activate right at the top. More experienced MAXQDA users will
simply click the document or folder symbol to activate a document or a document
group.

You can immediately see if a document or group is activated. Both name and symbol
are colored red and a red arrow appears in front of them. symbols in the Document
System window change to indicate if a document is activated or not. The grey circle
turns into a red arrow to show that a document is currently activated. Further below,
MAXQDA’s so-called Status bar displays the total number of documents currently
activated. Should you wish to limit your search to certain texts, activate them first and
then chose the option Only in activated documents in the dialog Lexical search.

How can I reset the activation? Simply go to the Document System window and click
the icon Reset activations on the toolbar. Alternatively, you can click on the document
or document group symbol again.
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Retrieving all segments coded with one code

Coding isn’t everything and your analysis is certainly more than just coding. At one
point you will want to stop coding and start looking at the results of that process. The
easiest way is to retrieve all segments assigned to one specific code. If you, for
example, do a research based on interviews, you may ask: “What was said about a
certain topic and who said what?” The magic word to get exactly those answers is
Retrieval. In MAXQDA such a Coding Query works – similar to the Lexical search – via
activations.

Activate all documents that you want to include in the Coding Query, as well as those
codes assigned to the segments you are interested in. Activation of codes works just
like the activation of documents (right-click the code and choose the option Activate
or click on the symbol in front of the code name). All coded segments found will
appear in MAXQDA’s fourth main window, the Retrieved Segments window. Below
every segment you will see the segment’s source information. In the example below
the segment can be found in paragraph 6 of document “Jamie“.

The source info does not only tell you which document a certain segment is from, it
also lets you go directly to that document: click on the document name, and the
document will be loaded to the Document Browser window with the coded segment
right at hand, so that you can easily view it in its context.

Using visualizations

Visualizing results is one of MAXQDA’s strengths which is why we want to include this
chapter in a Getting Started Guide. There are several ways to visualize data in
MAXQDA, starting with the possibility to assign individual colors to codes and
documents. This does not only help you with the visual organization of your data, but
colors can also be given certain meanings. MAXQDA is the first QDA software to allow
the use of emojis as a code symbol. This may be particularly useful to overcome
language barriers, for example when working in international projects.

The visualization tools also allow you to show data connections in a comprehensible
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way. The most used visual tool is the Code Matrix Browser, which you can open via
the “Visual Tools” tab.

So, what does the Code Matrix Browser show?

The columns list the different documents; in this case each document is one
respondent in a survey on life satisfaction. The respondents were for example asked
about issues they encounter on a daily basis. You can see here that all of them
mention emotions, but that only two of the respondents mention money-related
issues.

Conduct Mixed Methods analyses
Defining document variables

One of the most important MAXQDA features is its support of Mixed Methods
approaches. For every document in the Document System a whole set of attributes
(that is, variables as used by statistics programs) can be managed. You can, for
example, record personal data or background information for interviews as variables or
variable values, and use them for your Mixed Methods analysis. The option List of
document variables in the “Variables” tab will open the following dialog window:
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On opening, you will see that several variables have already been defined. These are
the so-called system variables whose values are automatically set by MAXQDA and
cannot be changed. The option New variable lets you define further variables. The
most common variable types are Text (like “teacher” or “student” for the variable
“occupation”) and Integer (like whole numbers for the variable “number of children”).
You can define new variables anytime.

Entering variable values

To enter values for the Document variables, use the toolbar in the List of document
variables and switch to the Data editor.

The document variables table can be exported to Excel or SPSS format, which means
that you can continue working on them with statistics programs like SPSS or Stata and
conduct a statistical analysis.

Transforming code frequencies into variables

The frequency of segments assigned to a certain code can be transformed into a
variable, which will receive the code’s name. Right-click on the preferred code and
choose Transform into a document variable in the context menu. In the following
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example, the code “Significantly Positive” has been transformed into a variable:

Using document variables in your analysis

Quantitative and qualitative data can be connected in a variety of ways. The easiest
way is to choose the document variables as selection criteria when you run a Coding
Query. This will enable you to compare sociodemographic characteristics like “What
did New Yorkers over 50 say about XY?” or “How did the suggestions by singles
compare to those of married couples?”. The relevant selection can be made with the
function Activate by document variables in the “Mixed Methods” tab.

First, choose a variable from the list on the left (in this case: Martial status), press the
arrow and then choose the variable value on the right (in this case: single). As soon as
you click Activate, all documents with matching variable values will be activated in the
Document System, in this example all interviews with male respondents.
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01 - The Workspace

How to Start the Program
When you open MAXQDA, the following start dialog will appear in which you can:

choose a user name,●

start a new project,●

open existing projects,●

open example projects, and●

view your license information.●

The window area to the right displays all the latest MAXQDA news.

MAXQDA Start Dialog

Entering your username

Enter your name in the "User" field and your signature will be added to everything
you do in MAXQDA, be it importing documents, coding segments or creating memos.
This becomes particularly useful when working in teams, as it’s easier to see who has
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done what.

Starting a new project

Before you can analyze your data with MAXQDA, you need to create a new MAXQDA
project into which you can import your data. Click on New Project, enter a project
name and choose a location to save your project. (Please see the note on file saving
locations below.) As soon as MAXQDA has created a new project you can start to
import your data.

Opening existing projects

MAXQDA lists the recently opened projects in the lower window area, which you can
open with a double-click. If you want to open a project that doesn’t appear in this list,
click on Open Project and choose a file from the dialog window that appears.

Important note about saving MAXQDA projects: As MAXQDA is a database program,
all changes are always saved directly in the project file. For this reason, it is very
important that the computer's connection to the project file is not interrupted,
otherwise there may be problems with the project file.

To avoid data loss, we recommend that you do not open the project file from the
following locations:

USB drives●

network drives●

external hard disks●

folders synchronized with the cloud (Dropbox, Google Drive, iCloud, etc.).●

It is best to copy your project to a local hard drive (e.g. to the desktop) and open it
from there. Of course you can save your MAXQDA projects on USB drives, network
drives etc., but you should not open the file directly from there.

Opening example projects

Click on the Open Examples button to list the featured example projects, with which
you can thoroughly explore all MAXQDA’s functions. Just click on a project in the list
to open it.

https://m22.maxqda.com/help-mx20/import/import-group-data
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Changes to projects are saved automatically

MAXQDA does not include a save function which you must click when you finish
working on a project.

MAXQDA operates as a database program, which means that all changes you make to
a project, including the import of texts or later coding of data, are automatically saved.
Exceptions are edits to texts, memos and MAXMaps. These are saved automatically
every few minutes, as well as automatically when you close the window and the
project.

Opening projects from earlier versions (MAXQDA 2018 or older)

To open a project that was created in an earlier version of MAXQDA, follow these
steps:

Start MAXQDA and select Open Project in the start window.1.
In the dialog window that appears select file type of the old project.2.

MAXQDA 2020 for Windows can open the following project file types:

MAXQDA 18 (extension: MX18)●

MAXQDA 12 (extension: MX12)●

MAXQDA 11 for Windows (MX5)●

MAXQDA 10 (MX4)●

MAXQDA 2007 (MX3)●

MAXQDA 2 (MX2)●

MAXQDA (M2K)●

MAXQDA Exchange files (MEX), that were created with MAXQDA for Mac versions●

11.2.2 or newer
MAXQDA Exchange files (MEX), that were created with MAXQDA for Windows.●

MAXQDA 2020 for Mac can open the following project file types:

MAXQDA 18 (extension: MX18)●

MAXQDA 12 (extension: MX12)●

MAXQDA 11 for Mac (MX11)●

MAXQDA Exchange Files (MEX), that were created with MAXQDA for Mac version●

11.2.2 or newer.
MAXQDA Exchange Files (MEX), that were created with MAXQDA for Windows●

version 11.1.0 or newer.

Please note: MAXQDA 2020 will create a copy of the project in the new MX20 format
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in the folder where the project is located. Please note that the conversion process may
take several minutes to complete. The progress of the conversion process will be
displayed on your screen at all times.

Opening MAXQDA 2020 projects in MAXQDA 18

To open a MAXQDA 2020 project in the previous version MAXQDA 2018, you can
save it from MAXQDA 2020 in the previous format:

Open the project in MAXQDA 2020. (If you do not have a license for MAXQDA1.
2020, you can also use the free MAXQDA Reader.)
Select Start > Save project as from the menu bar.2.
Set the file type to "MAXQDA 2018 Projects", select a file name and location, and3.
then click Save.

Select the file type of the old project

Select the appropriate file format in the file dialog box

MAXQDA then saves a copy of the opened project in 2018 format. When converting
to the old format, the following adjustments are made to the project file:

Codeset memos are converted into free memos.●

The memo type "RQ"  is converted into a normal memo  type.●

Internal links that refer to a memo or are saved within a memo as well as coded●

segments that are assigned to a memo are not saved in the project file.
Maps from MAXMaps are not saved in the project file.●

Project File Backups
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Project file backups

It is strongly recommended that you regularly create project backups and save them
on external hard drives or flash drives, in order to minimize losses in case of computer
problems. Backup files shouldn’t be stored in the same location as your computer.

MAXQDA 2020 project files have the extension MX2020 - if the file extensions are
hidden in your computer system, you can recognize the files by the MAXQDA icon and
the file type "MAXQDA 2018 Project File".

You can transfer your MAXQDA project files to an external storage drive using
Windows Explorer or Mac Finder. Alternatively, open the file in MAXQDA and choose
Home > Save Project As in the top menu. Then specify a location and file name and
click OK.

Automatic backups

MAXQDA allows you to backup projects automatically. If you open a project that has
not been backed up by MAXQDA for more than a day, MAXQDA will save a copy in a
selected folder. MAXQDA automatically provides the backup file with a date and time
stamp.

Both the time interval after which a project should be automatically saved and the
directory for backup copies can be specified in the MAXQDA preferences. Open these
preference by clicking on the gear symbol in the upper right corner of the MAXQDA
window . There, you can also disable the function entirely.
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Define the settings for the automatic backup of projects

Warning: The automatic backup represents a good safety net, but does not replace
the regular backup of your important project files on the Internet or on an external
data carrier, such as a hard disk!

The Main Menu
After opening or creating a new project, you will see the MAXQDA interface:

At the very top of the screen, you will see the project document name including the●

location where it is saved.
Underneath the file name, you will see the main menu with several tabs that offer●

quick access to MAXQDA functions.
MAXQDA’s four main windows occupy the main part of the screen.●

A status bar is found at the bottom of the screen.●

The MAXQDA interface
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Menu overview

Along the top edge of the MAXQDA interface, you will see the Main Menu, which
features several tabs.

The Main Menu

As soon as you hold the mouse pointer on one of the main functions, a brief
description will appear for most functions.

Home tab

In this tab you can choose to create a new project, open an existing project, or
complete other project management functions like printing, exporting, and importing.
The tab also features functions for managing externally saved project files.

The four main windows can also be hidden or revealed or changed in their
arrangement. For teamwork, there are functions for user management and for
merging two projects. You can also open the logbook from this menu.

Import tab

In this tab, you can import your data into your new MAXQDA project. You can also
transform text documents into tables, spreadsheets or focus group documents.

The Import Tab

Codes tab

In this tab you will find the functions relating to codes. Some of these can be opened
in the context menus within the “Code System” window.

These options allow you to create new codes, create code frequency analyses and
manage your code favorites, shortcuts, and code alias table.
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Further functions let you export and import a code system, for example in the general
exchange format "REFI-QDA Codebook".

The Codes Tab

Memos tab

This tab provides access to important functions for working with your memos, in
which you can record your own thoughts, hypotheses, notes and ideas about the data.

On the tab you can create new free memos as well as open the Memo Manager for
individual memo types or, for example, list and edit all your memos in documents. You
can also search within your memos on this tab.

Variables tab

This tab lets you check and edit document, code and focus group variables as well as
check, add and edit the values of individual variables in the data editor. Additionally,
you can import and export variables.

It also allows you to create frequency tables and charts for these variables.

The Variables Tab

Analysis tab

This tab features MAXQDA’s extensive analysis functions. In addition to simple and
advanced lexical search functions, it includes retrieval functions for coded segments
(called a “Coding Query”) and a function for both qualitative and quantitative group
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comparisons.

The Analysis tab also offers access to the intercoder agreement functions and working
with summaries. You can create summaries of encoded segments and present them in
summary tables. These summaries are an additional level of analysis over and above
the data.

The Analysis tab gives you access to text paraphrasing functions and the categorization
of survey data and the analysis and coding of twitter data.

Code configurations let you analyze the co-occurrence of codes, code frequencies look
at how often codes are used, and code coverage looks at the scope of coded
segments.

The Analysis Tab

Mixed Methods tab

This tab includes various functions for the combination of qualitative and quantitative
data using documents and variables.

The activation via variables allows you to select documents or document groups, based
on their assigned variable values, for further analysis. The Quote Matrix and Crosstabs
functions are different visualizations that show connections between coded segments
and selected variables or variable categories.

The Typology Table is similar and shows percentages and mean values and standard
deviations for qualitatively-designed typologies. The Similarity Analysis for Documents
makes it possible to compare documents with regard to their coded segments and
variable values. You can use the Quantitizing function to store the code frequencies of
the activated codes as document variables.

Additionally, you have access to a wide range of further joint displays that incorporate
qualitative and quantitative data into a visual representation, such as the Side-by-Side
Display or the "Statistics for QUAL groups" obtained using qualitative data analysis.
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The Mixed Methods Tab

Visual Tools tab

This tab allows you to choose between many different visualization options:
"MAXMaps", the tool for qualitative modeling, can be found here as well as the
"Code Matrix Browser", the "Code Relations Browser" and the "Document
Comparison Chart".

The "Document Portrait" and "Codeline" tools always refer to a single text, i.e. they
can only be selected if a suitable document is opened in the "Document Browser"
window. The "Word Cloud" displays the most common words of the currently opened
text, PDF or table and can be adjusted using stop lists.

The Visual Tools Tab

Reports tab

This tab lets you create various table overviews for important analysis data, such as the
Overview of Coded Segments with all your coded segments and the Overview of
Memos with all your project memos.

Additionally, you can print the data in your project via this menu or export it for
further processing. With the Smart Publisher you create ready-made reports of the
coded segments while the code book contains the category definitions from your code
memos. You can also export tables of your summaries as well as look at a project
information page that provides a roundup of your project.

The Reports Tab

Stats tab (optional)

This menu is only available if you are running a license for “MAXQDA Analytics Pro”.
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Stats is a module, which offers frequently used descriptives and inferential statistic
functions, like frequency tables, crosstabs, one-way analysis of variance, correlation
and creating scales.

The Stats tab

MAXDictio tab (optional)

This tab is only available if you are running a license for “MAXQDA Plus” or
“MAXQDA Analytics Pro”. MAXDictio is a module, which offers many functions for
word frequencies, word combinations, and other tools for text exploration as well as
quantitative content analysis based on a dictionary.

The MAXDictio Tab

Please note: For Mac, all the functions can be found in identical order in the menu at
the top of the screen.

Further functions in the main menu

There are several icons to the right of the menu that provide access to other MAXQDA
functions.

Undo options

Undo – undoes your last action, such as deleting a code or document.

Redo – redoes an “undone“ action.

When using the undo function in MAXQDA, please note the following:

Turning on Edit mode for a text or spreadsheet document disables MAXQDA's global●

undo function. While Edit mode is on, no actions can be undone in MAXQDA. Only
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the local undo function in the "Document Browser" is active, which means you can
undo text edits using the formatting bar or context menu. Once you switch off Edit
mode all changes within the document are saved and can no longer be undone.
The same applies to transcription mode, as MAXQDA's Edit mode is automatically●

turned on for this.
The "Merge Projects" and "Import Teamwork" actions cannot be undone. Since●

these functions can have complex effects on the project structure, a backup copy of
the project is automatically created in the designated folder before the function is
started. Actions taken before using these functions cannot be undone.
Text changes within a memo are also saved when the memo is closed. The undo●

function returns the memo to the state before it was opened.
The undo function of MAXQDA has no effect on MAXMaps - there is a local undo●

function, which applies to the opened map.

Reducing or expanding the main menu

Reduce Menu /  Expand Menu – click on this icon and you can reduce the main
menu so that more space is available to work in MAXQDA’s four main windows.
When the menu is reduced, click the tab heading to access a function on the tab.
Another click on the symbol will expand the menu again.

Opening preferences

Preferences – here you can open the MAXQDA preferences menu.

Feedback to the MAXQDA Team

Send Feedback to the MAXQDA Team – opens a window where you can send a
message, including screenshots, to the MAXQDA team.

Help menu

Help – the question mark opens a comprehensive help menu that provides access
to MAXQDA’s online help and tutorials as well as information about your license.

The Four Main Windows
MAXQDA's four main windows occupy the main part of the main interface:
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The four main MAXQDA windows

The four windows have the following functions:

The “Document System” provides an overview of all the texts, PDF files, tables,●

pictures and media files of your project. You also have the option of organizing these
documents in document groups, which act as folders.
The “Code System” displays all the codes, subcodes and code memos along with the●

number of associated coded segments.
The “Document Browser” displays one of the documents from the “Document●

System”, where it can then be worked on. You can highlight, edit, code, create links,
or attach memos in this window. Geo-Links are also displayed in the “Document
Browser”.
The “Retrieved Segments” window is a results window. Here you can display a●

selection of coded segments (Retrieval).

Small toolbars in the MAXQDA windows

Each window has a toolbar, which gives you quick access to frequently-used functions.
By hovering over each symbol, you can see what each symbol does. Symbols that are
found in more than one toolbar always have the same function, such as:

  prints out the content of the window
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  exports the content of the window

  allows for search in associated window

  undocks the window

  maximizes the window to the largest possible size

  closes the window:

Small toolbar within a window

Hiding or displaying the main windows

All four windows can be individually displayed or hidden so that you can control the
arrangement of windows on your screen and optimize your work space.

Click on one of the the four window symbols in the Home tab to hide or show one of
the main windows.

Symbols for hiding or showing the four main windows

You can close the windows by clicking on the appropriate icon  in the upper-right
hand corner of each window. Next to the close icon, you also have the option of
clicking to maximize the window to its largest possible size.

Note: At least one window must be open, which means it‘s not possible to switch off
all four windows at the same time.

Optimizing the interface
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Adjusting the window size

The size of each window in comparison to the others can be adjusted as you wish by
clicking with the left mouse button on a border and dragging it in the appropriate
direction.

Window height and width can be adjusted by clicking and dragging borders with the mouse

The two-column and three-column layouts

You can change the arrangement of the four main windows at any time from a three-
column view for wide screens to a two-column view better suited for narrow screens.
On the Home tab, there are four icons that you can use to customize the window
layout:

Adjusting the windows in the “Home” tab

Top left: The three column layout for wide screens. The “Document Browser” is found
in the middle and “Retrieved Segments” in the third column on the far right.

Top right: Alternative three-column layout with the “Document System” and the
“Code System” on the right side.

Bottom left: The two-column layout with the “Document System” and the “Code
System” on the left side.

Bottom right: Alternative two-column layout with the “Document System” and the
“Code System” on the left side.
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Small screens

When coding a document, it is sometimes helpful to close the “Document System”
and “Retrieved Segments” window, so the “Code System” and “Document Browser”
are larger. The “Document Browser” can then be made even bigger by dragging the
border in the direction of the “Code System”.

Optimal window setup when coding on small screens

The same is recommended for retrieving coded segments, the "Coding Query"
function. The "Document Browser" window is often not required and can be hidden.

Sometimes you want to see both the coded passage and its context. The easiest way
to do this is to open the "Retrieved Segments" and "Document Browser" windows
next to each other. If you then click on the source indication in front of the segment,
the surrounding context will be displayed the adjacent window.

There are several tasks for which specific window arrangements can be useful: for
example, in the case of selective searches for coded segments based on variable
values, it may be useful to display the "Document System" in the left window, to see
which documents are currently selected, and the "Retrieved Segments" in the right
window, so as to immediately check the results.

Maximize window

The four main windows can not only be hidden and displayed independently, they can
also be maximized to full screen mode by clicking on the corresponding symbol in the
upper right corner of the window. This is very useful, for example, if you want to
reorganize the category system and have the entire screen available for it.
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Context Menus and Toolbar in the
"Document System"
In addition to the various menus accessible from the menu, MAXQDA can be
controlled using the toolbars and context menus in their respective windows. The
functions that relate to the handling of documents are available in the “Document
System” window.

Toolbar

The toolbar at the top of the “Document System” window offers quick access to the
following frequently-used functions:

 Reset activations – resets current activations

 Activate by ... – enables the activation of documents depending on their variable
values and colors as well as random activation

Display only activated documents - reduces the display of documents to currently
activated ones

Import document(s) – allows you to insert text, PDF files, spreadsheets, images and
media files into the project

New text document - creates a new text document and opens it directly for editing
in edit mode

New document group – creates a new document group directly above the top
document group in your list

Display search toolbar – allows you to search for a specific document name

Settings - opens a dialog with locally relevant options (see below)

Undock window

Maximize window

Hide window
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Local settings

After clicking on the gear symbol in the "Document System", the following options
dialog box will appear with locally relevant settings:

Settings for the Document System

Open documents in tabs - If this option is enabled, each opened document is displayed
in a new tab in the "Document Browser". The previously opened document remains
open in a tab.

Show variable values at mouse-hover - Select which document variables should be
displayed at the mouse pointer when you hold the mouse over a document name.

Ignore images and objects when importing text documents - graphics, especially
photos, take up a lot of space in a text, and there are research situations where only
the plain text is of interest, not the potentially annoying graphics. Therefore, by
selecting this option you can ensure MAXQDA does not import graphics and other
objects and cleans up the text.

Insert new documents at the end of the list - By default, new documents are inserted
at the top of the tree or at the top of a document group. Select this option to insert
documents at the bottom of the hierarchy level instead.

Documents and document groups

In order to better organize your documents, it is possible to create document groups.
In MAXQDA, it is, however, not absolutely necessary that each document is put in a
document group. Documents can simply be left in the root folder of the “Document
System” window.

Documents can also be temporarily grouped together from various document groups
for certain aspects of your analysis. In MAXQDA, these groupings are called
"document sets."
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Example: In an interview-based study on kindergartens in which teachers,
administrators, and parents are interviewed it makes sense to make three folders,
named “Administrators,” “Teachers,” and “Parents.”

In the “Document System,” it is possible to differentiate between three levels, each
level offering a different context menu:

the project level●

the document group(s) level●

the document level●

Three levels in the “Document System” window

The top level

The top level in the “Document System” hierarchy is the project level. After creating a
new project, the “Document System” is empty except for the “Documents” entry.
When you right-click on the icon, the following context menu will open:
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Context menu for the upper level in the Document System

The menu contains the following functions:

Activate All Documents – activates all documents in the entire project.

Deactivate All Documents – deactivates all documents in the entire project.

Activate Documents by Variables – allows you to create logical conditions based on the
existing document variable values for selecting and activating documents.

More... > Activate by Color – this function enables you to activate documents by their
assigned color.

More... > Activate by Random – this function enables you to activate documents at
random.
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More... > Activate Focus Group Participants by Variables – with this function the focus
group participants can be activated via their variable values for the analysis. (The entry
is visible only if the project contains focus group transcripts.)

Invert Activation – activates all documents that are not currently activated and
deactivates all those documents that are currently activated. This is especially helpful
when doing logical activations; you can then very quickly compile segments from
documents with contrasting document variables.

Memo – creates a project memo, i.e. a memo that refers to the entire project. If a
memo already exists, it is opened.

New Document Group – creates a new document group.

Collapse All – collapses all document groups for a better overview. Thus, the individual
documents of the document groups will not be visible.

Sort Document Groups (Ascending) – sorts all document groups in ascending
alphabetical order.

Sort Document Groups (Descending) – sorts all document groups in descending
alphabetical order.

Import Documents – you can import one or more files. These are assigned to the top
level ( the "root" folder).

New Text Document – inserts a new text document at the top of your "Document
System" and opens it directly for editing.

Move Activated Documents Here – moves all activated documents to the top level of
the “Document System” window. This function is only visible if at least one document
is actually activated.

Coded Segments – lists all coded segments in the entire project in table form in the
Overview of Coded Segments.
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Variables – displays the Data Editor for Document Variables for all documents in the
project.

Codes – lists all codes in the entire project in table form in the Overview of Codes.

Memos – lists all memos in the entire project in table form in the Overview of Memos.

Summaries – lists all summaries in the entire project in table form in the Overview of
Summaries.

Links – lists all links in the entire project in table form in the Overview of Links.

Focus Group Speaker - opens the Overview of Focus Group Participants" with all focus
group participants contained in the project and their variable values. (This entry is only
visible if the project contains focus group transcripts.)

Teamwork > Export Teamwork: Export Data to Exchange File – exports the coded
segments, memos, summaries, paraphrases and variables of your project.

Teamwork > Import Teamwork: Import Data from Exchange File – imports the coded
segments, memos, summaries, paraphrases and variables of an external project.

Word Cloud – creates a word cloud with the most frequent words that appear in the
documents within your project.

Code Cloud – creates a code cloud with the most frequent codes that appear in the
documents within your project.

MAXDictio: Quantiative Content Analysis – creates a count of the dictionary categories
in all your text, PDF, and table documents. (This function is only available for
"MAXQDA Plus" or "MAXQDA Analytics Pro".)

The middle level: document groups

A project can contain as many different document groups as you wish to create. A
context menu is also available at the document group(s) level, which offers functions
that only affect that specific chosen document group.
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Context menu for the middle (document group) level in the Document System

The following options are available in the context menu of a document group:

Activate All Documents – activates all documents in the document group.

Deactivate All Documents – deactivates all documents in the document group.

Memo – creates a memo that refers to the selected document group. If a memo
already exists, it is opened.

Delete – deletes the selected document group, including all documents, coded
segments, memos, summaries and variables that are associated with it.
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Rename – lets you give a new name to the document group.

Import Document(s) – one or more new documents can be imported. These are
assigned to the selected document group.

New Text Document – inserts a new text document at the top of your "Document
System" and opens it directly for editing.

Export documents - exports all documents of the clicked document group.

Sort documents > ... - sorts the documents within this document group according to
various criteria. Text documents can be sorted by the date of their last modification in
Edit Mode.

Move Activated Documents Here – moves all activated documents to this document
group, thus resorting the “Document System” accordingly. This function is only
displayed if at least one document is actually activated.

Coded Segments - Opens the Overview of Coded Segments with the codings of all
documents of the selected document group.

Variables - Opens the Data Editor for Document Variables with the variable values of
all documents of the selected document group.

Codes - Opens the Overview of Codes with the codes assigned in at least one
document of the selected document group.

Memos - Opens the Overview of Memos with the memos of all documents of the
selected document group.

Summaries - Opens the Overview of Summaries with the summaries of all documents
of the selected document group.

Paraphrases - Opens the Overview of Paraphrases with the paraphrases of all
documents of the selected document group.

Links - Opens the Overview of Links with the links of all documents of the selected
document group (document links and external links, geo-links and web links).
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Focus Group Participants - Opens the Overview of Focus Group Participants with the
focus group participants contained in the selected document group and their variable
values. (The entry is only visible if the document group contains focus group
transcripts.)

Word Cloud – creates a word cloud with the most frequent words that appear in the
documents within this document group.

Code Cloud – creates a code cloud with the most frequent codes that appear in the
documents within this document group.

Single-Case Model > Single-Case Model (Coded
Segments)/(Summaries)/(Paraphrases)/(Code Hierarchy) - Creates a new single-case
model in MAXMaps with the selected document group at the center.

Teamwork > Export Teamwork: Export Data to Exchange File – exports the coded
segments, memos, summaries, paraphrases and variables of all documents this
document group.

Teamwork > Import Teamwork: Import Data from Exchange File – imports the coded
segments, memos, summaries, paraphrases and variables from another project into
this document group.

MAXDictio: Quantiative Content Analysis – creates a count of the dictionary categories
in all your text, PDF, and table documents in the document group. (This function is
only available for "MAXQDA Plus" or "MAXQDA Analytics Pro".)

Please note: Document sets are handled similarly to document groups. They are a
temporary grouping of documents, but only contain links to the documents instead of
the documents themselves. The context menu that appears when you right-click on a
document set is similar to the document group context menu, but it does not contain
the options to import documents.

The lower level: the document

A context menu is also available at the individual document level and contains a variety
of functions connected to the chosen document.
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Context menu for the lowest (document) level

The menu contains the following functions:

Activate/Deactivate – activates the document; if the document is already activated, the
option will be to deactivate it.

Open Document – opens the document in the “Document Browser”. The document
which is currently opened in the “Document Browser” is indicated in the “Document
System” with a special symbol (document with a pen).

Open Document in a New Tab – opens the document in a new tab in the “Document
Browser”. The document which is currently displayed is indicated in the “Document
System” with a special symbol (document with a pen).
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Open Document in Second Document Browser – opens the document in an undocked
“Document Browser”. The document which has last been focused is indicated in the
“Document System” with a special symbol (document with a pen).”

Delete Document – The document and all its associated data (memos, coded
segments, variable values) are deleted.

Rename Document – The name of the document can be edited.

Export Document – The selected document is exported and saved to a location of your
choice.

Memo – creates a memo for the document.

Assign Audio / Video File – Opens a dialog window where you can select an audio or
video file to assign to the text. (The entry is visible only if you click a text document
that has not yet been assigned a media file.)

Transcribe Audio / Video File – Activates transcription mode for an audio or video files.
(The entry is only visible if an audio or video file is assigned to the selected document.)

Coded Segments - Opens the Overview of Coded Segments with the coded segments
in the selected document.

Variables - Opens the Data Editor for Document Variables with the variable values of
the selected document.

Codes - Opens the tabular Overview of Codes with the codes assigned in the selected
document.

Memos - Opens the Overview of Memos with the memos of the selected document.

Summaries - Opens the Overview of Summaries with the summaries of the selected
document.

Paraphrases - Opens the Overview of Paraphrases with the paraphrases of the selected
document.
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Links - Opens the Overview of Links with the links of the selected document
(documentation links and external links, geo-links and web links).

Focus Group Participant - Opens the Overview of Focus Group Participants with the
participants of the selected focus group and their variable values. (The entry is only
visible if a focus group transcript has been selected.)

Document Portrait – opens a visualization of the document that uses the code colors
of the coded segments in the document to create a picture of the document. The size
of the coded segment acts as the weighting factor, meaning that the longer the coded
segment, the more space that color takes up in the visualization.

Codeline – opens a visualization of the coded segments of the document. A matrix is
created with the codes on the y-axis and the paragraph numbers on the x-axis. It is
then possible to see which codes were used in each paragraph of the document.

Word Cloud – creates a visualization of the most frequently-used words in the
document (only for text, pdf and table documents).

Code Cloud – creates a code cloud with the most frequent codes that appear in the
document.

Single-Case Model > Single-Case Model (Coded
Segments)/(Summaries)/(Paraphrases)/(Code Hierarchy) - Creates a new single case
model in MAXMaps with the selected document at the center.

(Color Selection) - A color can be assigned to the document.

Teamwork > Teamwork Export: Export Data to Exchange File - Exports the encoded
segments, memos, summaries, paraphrases and variables of the selected document.

Teamwork > Teamwork Import: Import data from Exchange File - Imports the coded
segments, memos, summaries, paraphrases and variables of another project into the
selected document.
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Teamwork > Export Teamwork – allows for the export of all coded segments, memos,
summaries, and variables for the document. The exported file can be imported in a
project on a different computer. This function enables you to work in a team and
divide the work on a single document among team members.

Teamwork > Import Teamwork – allows for the import of coded segments, memos,
summaries, and variables for the document of an earlier exported file.

MAXDictio: Quantitative Content Analysis – creates a count of the dictionary
categories in the selected document. (This function is only available for "MAXQDA
Plus" or "MAXQDA Analytics Pro".)

Properties – opens a window with all the properties of the document, which can then
be edited (e.g. whether or not the document should be opened in read-only mode).
You can also link a media file to the corresponding document (e.g. an audio file with
the corresponding transcribed interview) to either code the transcript or the media file
itself.

Context Menus and Toolbar in the
"Document Browser"
Toolbar

The “Document Browser” is MAXQDA's main work window: This is where you can
code texts and images, write memos, link text and/or images together, add external
links and more. The majority of the functions you will carry out in the “Document
Browser” are available in the context menu, which you can access by simply right-
clicking in the window. The most commonly-used functions are also available in the
toolbar at the top of the “Document Browser.” It contains the following functions:

Show sidebar - displays the sidebar to the right of the document. Memos,
comments and paraphrases can be displayed in the sidebar.

  Print document – allows you to print the document displayed in the window,
optionally along with memo symbols and coding stripes.

  Export displayed document – saves the open document in a location of your
choice.
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  Display search toolbar – allows you to search within the open document.

Settings - opens a dialog with locally relevant options (see below)

  Undock window

  Maximize window

  Hide window

Local settings

When you click on the gear symbol in the "Document Browser" window, the
following options dialog box will appear with local settings:

Settings for the “Document Browser“ window

Copy text segments with source information to clipboard - If this option is enabled,
the indication of origin (document group, document name and document position) is
appended to all text segments that you copy to the clipboard.

Display coding stripes on the right - By default, the coding stripes are displayed to the
left of the document. Select this option to place the encoding strips to the right of the
document.

Maximum number of codes in 'Quicklist' - The setting determines how many codes
were last used in the encoding bar above the document.

Context menu

If you highlight a segment of text or select a section of a picture opened in the
“Document Browser,” a context menu will appear with a large selection of various
functions, if you right click on the selected segment.
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Context menu in the Document Browser

Most of the available functions are self-explanatory, but they will still be explained
quickly in the following section.

Note: For PDF and image documents some functions such as cut and paste are not
available because these file formats do not permit modification. Some functions are
also unavailable for table documents.

Code with New Code – codes the highlighted text or section of an image with a new
code.

Code In-Vivo – codes the highlighted text with a new code created and named with
the highlighted text.

Code with “xyz” – codes highlighted text or section of a picture with the most
recently used code.

Code with Activated Codes – codes highlighted text or section of a picture with all



01 - The Workspace   53

activated codes in the “Code System.”

Insert Memo for Selection – creates a memo for the highlighted segment.

Search for Highlighted Text – opens the lexical search, with which you can search for
the selected text in all or part of the project.

List Assigned Codes – displays the codes assigned anywhere in the selected segment.

Insert as New Document – adds the selected text or image excerpt as a new document
at the top of the "Document System".

Convert to Line Numbered Text/Convert to Paragraph Numbered Text – Switches
between the numbering of each line and the numbering of each paragraph in text
documents. The numbers are used for quotations from the data.

Insert Document Link – sets an anchor for a link, which is a connection between two
sections in your data or memos.

Insert external Link – opens a file dialog to allow you to choose a file to be linked to
the highlighted section of the text or image.

Insert Web Link – allows the insertion of a link to a website.

Insert Geolink – allows to insert a geolink; a file dialog will appear to open and import
a KML file, which links to a geographic location.

Remove link – deletes a link from the selected segment.

Cut – cuts the highlighted text from the document as in Microsoft Word.

Copy – copies the highlighted text as in Microsoft Word.
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Paste – pastes the contents of the clipboard as in Microsoft Word (only works when in
Edit Mode)

Paste without formatting - Same functionality as e.g. in Word: The text from the
clipboard is pasted and the formatting of the existing text is assigned. (This entry is
only visible when Edit Mode is switched on.)

Undo Text Changes – undoes the most recent change to the text (only works when in
Edit mode).

Undo All Text Changes – undoes all changes to the text that have been done since Edit
mode was turned on (only works when in Edit Mode).

Display Geolink Column – displays the geolink column next to the memo and code
visualization column on the margin of the “Document Browser.” All geolinks are
visualized with a symbol in this column.

Display timestamp column - By default, the timestamps for connecting to an
audio/video file are displayed to the left of a transcript. Here you can hide this column.

Seitenleiste > Seitenleiste anzeigen – Rechts neben dem Dokument wird eine Spalte
eingeblendet, in der die Memos, Kommentare und Paraphrasen Dokuments dargestellt
werden.

Context Menus and Toolbar in the "Code
System"
Toolbar

The toolbar at the top of the “Code System” window offers quick access to the most
commonly-used functions in this window. These functions are:

  Reset activations – resets current code activations.

Display codes from activated documents only - reduces the code system to codes
assigned in at least one of the activated documents.
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  New code – adds new code into the code system.

  Display search toolbar – allows you to search for a specific code.

Settings - opens a dialog box with local settings options (see below)

  Undock window

  Maximize window

  Hide window

Local Settings

Click on the gear symbol in the "Code System" and the following options dialog will
appear with local settings options:

Settings for the Code System window

Display frequency of - here you define what the numbers behind the codes should
indicate. The setting does not refer to the entries "Paraphrased segments" and "Focus
group speaker" in the code system. Is reset to the setting Coded segments of all
documents when changing projects.

Sum up frequencies of subcodes - if you collapse a code, the frequencies of the code
and all its subcodes will be added if this option is selected.

Table view - Switches from tree view to tabular view of all entries in the code system.
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Will be turned off when changing projects.

Display only emoticodes - if this option is enabled, only emoticodes are displayed in
the code system and all other entries are hidden. Will be switched off when changing
projects.

Display 'Paraphrased Segments' at the top - by default the entry 'Paraphrased
Segments' is displayed below the codes. Enable this option to fix the entry at the top
of the code system.

Display 'Focus Group Speaker' at the top - by default, the 'Focus Group Speaker' entry
is displayed below the codes. Enable this option to fix the entry at the top of the code
system.

Insert new subcodes below - by default, new subcodes are inserted directly below the
clicked upper code. Activate the option to add new subcodes below the existing
subcodes.

"Coding with new code", "Coding in vivo", "Open coding".

Insert new codes at the top - new codes added by the listed coding functions are
inserted at the top of the code system.

Insert new codes at current position - Newly added codes are inserted at the current
position, i.e. the blue mark, as subcodes.

No duplicate code names on same level - this option prevents codes with the same
name from being generated at the same hierarchy level.

The top level in the “Code System”

When you create a new project, the “Code System” is empty except for the “Code
System” icon and label. This represents the root directory or folder, the upper level of
the “Code System” hierarchy. If you right-click on the symbol or the label next to it,
you will see a context menu. Since most selectable functions only apply to a non-
empty Code System, some codes have already been inserted into the following
illustration.
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Context menu for the upper level of the Code System

This menu offers access to the following functions:

Activate All Codes – activates all codes in the entire “Code System”.

Deactivate All Codes – deactivates all codes in the entire “Code System” (except focus
group participant codes).

More … > Activate Codes by Variables – allows activation based on code variable
values.

More … > Activate Codes by Color – allows activation based on code colors.

More … > Invert Activation – activates all currently deactivated codes and deactivates
all currently activated codes in the entire “Code System.”

More … > Load Activation – code activation status will be imported from a file
previously created in MAXQDA.

More … > Save Activation – the current activation status of the code system is stored
in a file that can be called up at a later time in order to establish this specific activation
status.
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New Code – creates a new top level code in the code system.

Code Favorites – opens window with your code favorites.

Code Alias Table  – Displays a table with all codes that can be assigned an alias with
up to 255 characters for each code.

Sort – sorts all subcodes of the current code by alphabetical order or by code
frequency.

Reduce All Subcodes – for a better overview all subcodes are reduced so that only the
codes at the top level are visible.

Move Activated Codes Here – moves all activated codes to the top level of the “Code
System” window. Subcodes of activated codes will keep their position as subcodes as
long as they are not activated. This function is only visible if at least one code is
actually activated.

Coded Segments – lists all coded segments in the entire project in table form in the
Overview of Coded Segments.

Variables – the complete data matrix for code variables is displayed.

Linked Memos – lists all memos that are linked to any code in the “Code System.”

The lower level: individual codes and subcodes

There is also a context menu for the single code/subcode level, which offers functions
that affect the code you right-clicked on.
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Context menu on the code/subcode level

The following functions are shown in the context menu:

Activate Incl. Subcodes / Deactivate Incl. subcodes – the code including all its subcodes
are activated or if it is activated, it is deactivated together with the subcodes.

Activate/Deactivate – only the code itself, without its subcodes, is activated.

New Code – creates a new subcode for the selected code.

Delete Code (and Subcodes) – the selected code is deleted. In the alternative view of
the “Code System” as Table, several codes can be deleted simultaneously. When a
code is deleted, every association to coded segments will be deleted. Subcodes will
also be deleted. The removal of codes from a code system can be visualized as the
cutting of branches from a tree: when a branch (code) is cut, all attached subcodes
and subcodes of subcodes are also cut off.
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Rename Code – allows you to create a new name for the code.

(Color Selection) – allows to set a color for the code.

Memo – creates a memo for the clicked code. If a memo already exists, it is opened.

Add Code to … > Code Favorites – the selected code is included in the "Code
Favorites" window, which enables a fast coding process for a few selected codes.

Add Code to … > Code set – the selected code is included in a new or existing code
set..

Subcodes > Sort – sorts all subcodes of the current code by alphabetical order or by
code frequency.

Subcodes > Copy/Paste – copies all subcodes so that they can be pasted into another
code.

Move Activated Codes Here – inserts all activated codes as subcodes of the chosen
code. Subcodes of activated codes will keep their position as subcodes as long as they
are not activated. This function is only visible if at least one code is actually activated.

Duplicate Code with Coded Segments - Creates a copy of the code below the clicked
code, including the associated encoded segments.

Copy Coded Segments – copies all coded segments for the selected code, so that they
can be copied into a different code. After choosing this option, right-click on the code
that you would like to paste these coded segments into and select Paste Coded
Segments (from Code 'xyz')

Move Coded Segments – cuts the coded segments from the current code, so you can
insert them in a different code. After selecting this option, right-click on the code
where you want to move the coded segments to and select Paste Coded Segments
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(from Code 'xyz').

Coded Segments – opens the Overview of Coded Segments with all coded segments
coded with the current code, offering an overview of the text and image segments
assigned with the code.

Documents – opens the Overview of Documents with all of the selected documents in
which the code was used.

Variables – opens the Data Editor with all code variables of the code and its subcodes.

Summaries – lists all summaries in the entire project in table form in the Overview of
Summaries.

Linked Memos - all memos that have links with this code are displayed.

Crosstab - opens the mixed methods Crosstab function to compare the frequencies of
the clicked code for groupings of documents.

Subcode Statistics - opens the Subcode Statistics dialog box to create a frequency table
or chart of the subcode frequencies of the clicked code.

Code Model > ... - creates a new code model in MAXMaps with the selected code at
the center.

Intersections – All codes that overlap with this code are displayed in a pop-up list, with
the most common overlapping codes topping the list. Clicking on an entry in the list
displays the corresponding segments that contain overlaps in the "Retrieved
Segments" window.

Transform into a Document Variable – creates a numerical document variable with the
name of the current code in the variable list. The number of times the code appears in
each document is entered as the variable value for each document.

Transform into a Categorical Document Variable – creates a new string variable whose
value for each document is the subcode that appears most often in that document
(only works for codes that have subcodes).
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Subcode Statistics – opens a "statistics for subcodes" dialog window for creating a
frequency table or a chart of the subcode frequencies of the selected code.

Crosstab – opens the mixed methods "Crosstabs" function, which can be used to
compare the code frequencies for groups of documents.

Properties – opens the properties menu, where a color, alias name, and keyboard
shortcut can be assigned or changed for a selected code.

Context Menus and Toolbar in the
"Retrieved Segments" Window
Toolbar

The following commonly-used functions are available in the toolbar at the top of the
“Retrieved Segments” window:

Display origin - displays the document from which the segment originates for each
segment, supplemented by the position within the document.

Display favorite variables - shows the variables belonging to the document and
their values that are marked as favorites in the list of document variables for each
document or coded segment, depending on the sort order.

Display comments of coded segments - displays the column with comments on the
coded segments.

  Overview of retrieved segments – shows overview of all retrieved segments in
table form. Overview will be displayed in a new window.

  Smart Coding Tool – opens the displayed retrieved segments in the Smart Coding
Tool, where the assignments of codes can be customized.

  Code Relations Browser – opens the Code Relations Browser for the displayed
retrieved segments, which visualizes overlapping codes.
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  Word cloud – creates a word cloud of the words most often used in the displayed
retrieved segments.

  Code retrieved segments – all coded segments that are currently in the
“Retrieved Segments” can be coded additionally with an existing code.

  Code retrieved segments with a new code – all coded segments that are currently
in the “Retrieved Segments” can be coded additionally with a new code.

  Print retrieved segments – prints segments along with indications of their origins.

Open as Word document - creates a text document in Word DOCX format and
opens the document with the program associated with that format.

  Open as Excel table – opens the retrieved segments in an Excel document.

  Open as HTML table – opens the retrieved segments in your standard browser.

  Export retrieved segments – the segments can be exported in text format RTF
(text format), or as tables in XLS or HTML format. Memos attached to coded
segments, other codes assigned to the segment, as well as tooltip variables, can be
included in the exported material.

  Display search toolbar – allowing for searches within the retrieved segments.

Settings - opens a dialog with locally settings options (see below).

  Undock window

  Maximize window

  Hide window

Local Settings

When you click on the gear symbol in the "Retrieved Segments" window, the
following menu will appear with local settings:
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Settings for the Retrieved Segments window

Ordered by Document System – the segments in the “Retrieved Segments” window
will be sorted in order of the “Document System.”

Ordered by Code System – the segments in the “Retrieved Segments” window will be
sorted in order of the “Code System.”

Ordered by Weight Score (ascending/descending) – sorts retrieved segments according
to the weight assigned to them.

Include Subcodes – automatically includes all subcodes in the retrieval for each code
activated in the “Code System.”

Use Weight Filter – displays only those retrieved segments that are within a certain
weight range.

Edit Weight Filter – opens a window where you can change the range of weight scores
included in the “Retrieved Segments” window.
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Dislpay weight - displays the weight of the coded segments in the code name. The
weight is only displayed when the origin information is displayed.

List View - This is the default view for the "List of Coded Segments".

Classic View - Switches to the view of previous versions of MAXQDA.

Table View - Switches to a tabular list of coded segments.

The Status Bar
At the bottom of the MAXQDA screen, you will see a status bar that includes
information about various aspects of your current workspace (e.g. the number of
activated documents and codes, the number of retrieved segments, the current
retrieval option, etc.)

Status bar at the bottom of the MAXQDA screen

Activated Documents – number of currently activated documents

Active Codes – number of currently activated codes

Coded Segments – number of coded segments, which are displayed in the
“Retrieved Segments” window

Default Weight – displays the current standard weight, with which each new
coded segment is provided. The icon is interactive! Click the icon to customize the
standard weight.

Use Weight Filter – displays the current status of the weight filter for the retrieval:
If there is no checkmark displayed on the icon, the weight filter is switched off and all
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segments will appear in the “Retrieved Segments” window, regardless of their weight.
If a checkmark appears on the icon, the weight filter is active and only the segments
which satisfy the conditions of the filter will appear. The icon is interactive! Click the
icon to turn the weight filter on and off.

Include Subcodes – displays the current status of the retrieval: If there is a
checkmark on the icon, the subcodes are included in the retrieval; if no checkmark is
displayed, the subcodes are not included. The icon is interactive! Click the icon in
order to determine whether subcodes will be included or not.

Sort Sequence – shows the sequence of the coded segments in the “Retrieved
Segments” window, which can be sorted by Document System, Code System, or
weight. The icon is interactive! Click the icon to toggle between the various sorting
options.

Coding Query – displays the selected mode of retrieval, such as “Simple Coding
Query” or “Overlapping.” The icon is interactive! Click the icon to call up the Complex
Coding Query.

Managing Table Overviews
MAXQDA lets you open several table overviews that list project data such as coded
segments, memos or variables. In the Reports tab you can find many of these, the
contents of which always refer to the whole project:

Overview in the 'Reports' tab

Overviews in MAXQDA can be customized as in Excel or other similar spreadsheet
programs. For the following example, we’ll use the table view of the document
variables in MAXQDA:
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Table view of an example project’s document variables

The heading of each column has the name of each variable, although the standard
MAXQDA system fields are written in a different font color:

Document group – the name of the Document group in which the document is●

found
Document name – the name of the document●

Creation date – the date on which the document was imported●

Number of coded segments – the number of coded segments in the document●

Number of memos – the number of memos in the document●

Author – the user that was logged in when the document was imported●

Adjusting column width and position

The width of each column can be changed by clicking and dragging the border
between the columns. Double-clicking on the column header border to the right of
the column resizes the column to its optimal size, so that the contents of each row can
be fully seen.

Adjust column width and position
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It is also very easy to change the order of the columns. You just need to click on a
column header and drag it to the place you wish to have it.

By right-clicking on a column header, the context menu appears for that particular
column. This includes various options, including the option to hide the column or
search within the column. The Select field option opens a window where you can
select which of the columns should be viewed in the standard view.

Sorting tables

Tip: Tables can be sorted very easily. Just click on the column header of the column
that you want to sort the rows by.

Sorting tables

Tables can be sorted alphabetically or in reverse alphabetical order. Clicking once on
the column header sorts it alphabetically; clicking a second time sorts it in reverse. A
small triangle appears inside the column header of the column that is currently being
used to sort the table and whether it is sorted alphabetically or in reverse alphabetical
order.

Please note: Tables in MAXQDA contain both editable (blue) and un-editable (black)
columns. The system variables, for example, cannot be edited. You would therefore
need to change the document name in the “Document System” and change the
document group of a document by dragging it to a different document group in the
“Document System.”

In the editable cells of the table, you can enter or change a value by double-clicking on
the cell and then typing the value.

Selecting rows in a table

The table contents can also be selected and copied into the Windows clipboard. The
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selection of one or multiple rows, or a section of the table, is done as follows: A single
cell can be selected by simply clicking on it, and additional cells can be added to the
selection by holding the Ctrl key (Windows) or Command key (Mac) and a section of
the table can be selected by clicking the first and last rows to be included while
holding down the Shift key. In MAXQDA, the selected sections of a table are
highlighted in green.

You can also search for certain values within each column of tables in MAXQDA. You
only need to right-click on the column in which you want to search and select Search.
In string fields, the search will start with the initial character. If you wish to search for a
certain word or phrase that does not have to appear at the beginning of the value,
you can use the asterisk (*) at the beginning of your search.

Context menus for tables

All overviews in MAXQDA have context menus that can be called up by using the right
mouse button. The number of options that appear in the context menu depends on
the overview. It is usually possible to delete a selection (e.g. a coded segment or
memo). In the Overview of Coded Segments, you also have the option to change the
weight score of each segment. The most options are available in the document
variables table.
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Context menu in the document variables table

Table overviews with a detailed display

The Overview of Coded Segments differs from, for example, from the Overview of
Variables in that it is divided into two parts. The lower section is used just as in other
tables. The upper section serves as a detailed view. Here, the coded segment, or text
or image segment itself that is selected in the bottom section appears. The same
applies to the “Overview of Memos”: Here the detailed view of the memo will appear.
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Detailed view of the “Overview of Coded Segments”

The toolbar in table overviews

There are many situations in MAXQDA where table overviews are used to display
information, and they are similar in how they can be worked with, which is similar to
the handling of tables in Excel. All table overviews have a toolbar offering quick access
to frequently-used functions.

The overviews include various icons in the toolbar depending on their function and
purpose. The following icons are found in nearly all of these toolbars:

Only activated documents – Displays only the rows in which activated documents
appear. The icon can only be clicked when at least one document is activated.

Only activated codes – Displays only the rows in which activated codes appear. The
icon can only be clicked when at least one code is activated.

Switch on Filter – Turns the filter for the columns on and off. The icon can only be
clicked when a filter has been set for at least one column. Set the filter by right-
clicking on the column header.

Reset all filters – Deletes the defined filter for all columns of the table.

Search – Turns the search toolbar for the table on and off.

Excel table – shows the current table in an Excel document. This does not happen
within MAXQDA, but can be printed out or saved as a separate file.

HTML table – shows the current table in an HTML document. This can also be
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saved or printed out, but is no longer connected to your MAXQDA project.

Export – saves the content of the table in diverse formats including Excel (XLS/X) or
Website (HTML) and opens the file. Unlike the two functions above, you can choose
the file name and location. This exported file is also no longer connected to your
project file.

Searching in table overviews

To search through a table, click the icon

in the header of the overview. Another toolbar will then appear where you can enter a
search term.

Searching in a table overview

Highlight rows with hits – Highlights the rows in which the search term appears.

Choose search columns – Allows you to select the columns in which to search.

Find & replace – Allows you to enter a term to replace hits. Only hits that the user
has permission to change will be replaced. In the Data Editor for Document Variables
shown above, the values of the user variables with blue headers can be adjusted, for
example, but not the document names or the number of coded segments.

Tip:If you want to restrict the search to a single column, right-click the column header
and select the option Search. MAXQDA automatically selects only the clicked column
for the search.



01 - The Workspace   73

Restrict search to one column

Filtering table overviews

Table overviews can easily be filtered. For example, in the Data Editor you can display
only the rows with documents containing more than 20 codes or whose names begin
with “B”:

Right-click on the heading of the column you wish to filter, and select the Set Filter●

option. (If a filter is already set for the column, this option is called Edit Filter.)

Set filter by column

Set the desired filter options in the window that appears.●
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Filter window

In all four input fields, you can define criteria to filter. The following criteria are
available:

Contains●

Doesn’t contain●

Starts with●

Greater than or Lesser than (applies to both numbers and the alphabet)●

Earlier than and Later than (available only in columns containing a date)●

OR/AND: Here you can select the manner in which the four input fields are combined.
With OR, the rows in which at least one of the criteria applies are listed. With AND,
the rows in which all of the criteria apply are listed.

Case sensitive – When this option is selected, you can differentiate based on whether
the text in the text column appears in upper or lowercase. In this case, if “interview”
in lowercase appears in the filtered column, “Interview” beginning with an uppercase
letter would not be taken into account.

After clicking OK, MAXQDA filters the table overview according to the defined criteria.
At the top right MAXQDA indicates how many of the originally existing rows are
currently displayed.
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Filtered table overview

If you set a filter for multiple columns, they are combined with the AND function.

You can switch a filter for a table overview on or off at any time using the  Switch on
Filter

icon, to toggle the view between all rows and filtered rows.

If you wish to delete all defined filters in an overview, click on the Reset all filters

icon.
Please note: Each time an overview is reopened, filters in table overviews will
automatically be set to “off”. The filter settings are saved individually for each
overview in the project, so if you have defined a filter and reopen the project at a later
time, you can turn on the filter by simply clicking the Filter  icon.

General Preferences
Click on the gear symbol in the upper right-hand side of the MAXQDA window to
open a window in which you can adjust several MAXQDA settings.

Open preferences
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Preferences Window

The following settings can be changed:

“General” settings

Folder for externally stored files

Here you can set the location for all of your externally-linked files to be stored. These
include audio and video files, for example, that are too big to be included in the
project file. Image and PDF files might also be stored here, depending on their size and
your settings (see below).

Default weight

Every code assignment receives a weight. The default weight score for newly-coded
segments is 0, but can be changed here.

Autosave documents in Edit Mode and memos

Here you can specify the amount of time after which the project is saved automatically
during editing of documents and memos.

Confirm delete

If you deactivate this option, MAXQDA no longer asks for confirmation when deleting
code assignments, codes, documents, memos etc., but deletes this data directly. You
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can then only restore them using the Undo function.

”User interface” settings

Interface language

Here you can set the language of the menus, dialogs, and windows of MAXQDA.

Large font

The size of the text in the “Document Browser” can be adjusted as you wish, but you
can’t control the exact text size in MAXQDA menus and toolbars. With this option,
though, you can switch all of these user interface texts to a larger size. MAXQDA will
need to restart.

Reset user settings

This is an emergency option of sorts that you can use if you have somehow altered
your settings in a way that makes MAXQDA unusable and can’t figure out how to
undo these settings. If you check this box, MAXQDA will need to restart, and all of
your settings will then be reset.

”PDF and image documents” settings

Do not embed if larger than [MB]

This value determines the size at which an imported PDF or image file will be saved not
in the MAXQDA project file, but instead in the folder for externally stored files, with
only a reference to the document created in the project. The default size is 5 MB. If
necessary, you can adjust this value to be higher or lower.

”Automatic project backups” settings

Backup projects automatically

If the option is activated, MAXQDA checks each time a project is opened, when it was
last saved by MAXQDA and creates a backup of the project upon request.

Time interval [days]

Sets the number of days after which MAXQDA will start the next backup of the
project.
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Folder for backup copies

Here you can specify the folder in which you would like MAXQDA to save backup
copies of your project.
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02 - Importing Data

Supported Data Types
The following table provides an overview of what data types you can import into
MAXQDA:

Data Format Examples and Notes

Texts, transcripts,
Transcripts with time
stamps and associated
media files,
Focus group transcripts.

Word (DOC/X)
OpenOffice (ODT)
Rich Text (RTF)
Text (TXT)

Interview transcripts, field notes,
observation logs.
Time stamps allow the
synchronization of transcript and
sound.
Speakers in group discussions are
automatically coded

Documents PDF Academic journals, literature,
news articles

Tables Excel (XLS/X) Spreadsheet with survey result

Images PNG, TIF, JPG, GIF, SVG,
BMP

Photo diaries, advertisement
images

Audio files MP3, WAV etc. Recorded interviews (these can be
transcribed and synchronized with
the transcript)

Video files MP4, AVI, MPG, MOV
etc.

Recordings of group interactions,
YouTube videos
Data can be transcribed and
synchronized with the transcript.
Video and audio can be coded
directly.

Surveys, questionnaires Excel (XLX/S)
SPSS (SAV)
Direct import from
SurveyMonkey

Exported data matrices from the
open-source software LimeSurvey

Pre-structured texts and
tables

Same as for texts and
tables

Exports from the online data
collection tool kernwert.de can be
coded automatically during the
import
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Websites Downloads from the
MAXQDA Web
Collector (free
extension for Chrome
browser)

Company presentations, news
articles

Tweets Direct import of Tweets Social media analysis of trending
topics

YouTube comments Direct import from
YouTube

Social media analysis of trending
topics

Video file subtitles SRT Film analysis

Bibliographic Data RIS, TXT For literature reviews

MAXApp-Projects XML, ZIP Fieldwork

Important: In Windows, ODT documents can only be imported in MAXQDA if
Microsoft Office (2003 or later) is installed on your computer. Otherwise, the
documents can be saved in RTF format and then be imported into MAXQDA.

All text and table documents imported into MAXQDA can be edited in the “Document
Browser.” This means you have the option of fixing typos, deleting or adding text, etc.
This is also possible once you have done some coding and/or creation of memos. This
means you don’t have to have a completed document to start your coding. PDFs,
images, and audio/video files cannot be edited in MAXQDA.

You can also create new texts or spreadsheets in an opened project at any time, into
which you can paste content from the clipboard.

Analyzing texts in any language (Unicode supported)

The fact that MAXQDA supports Unicode makes it possible not only to import and
analyze documents in any script, from Japanese to Cyrillic to Arabic, but also to create
codes and variables in these languages. The support for Unicode text is available in
every MAXQDA function.

Unicode is an international standard with the goal of standardizing all known
languages and characters. This makes it possible to work with various languages in the
same document. One sentence can be in English, the next in Mandarin, and the next
in Arabic. In MAXQDA, even codes and variable names can be created with “foreign”
characters, and searches and in-vivo coding are possible with any language.

http://unicode.org
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Import and Group your Data
Importing data via the Import tab

The Import tab provides numerous functions for importing different data types. When
you create a new project, the tab is automatically opened so that you can start
importing data directly:

Importing data via the Import Tab

How to import standard data such as texts, PDF documents, tables, images or audio /
video files:

Go to the Import tab and click on the appropriate icon for your data type on the1.
left, e.g. Transcripts to import interview transcripts and Texts, PDFs, Tables to
import Word files, PDF documents or Excel files.
A dialog window will appear, in which you can select the files to be imported. Press2.
Ctrl (Windows) or cmd (Mac) to select multiple files at the same time.

After making your selection, the files are inserted into the open MAXQDA project and
displayed in the "Document System" window. The following image shows that seven
texts ("Kim", "George", etc.) have been added.

Display of documents in your Document System after import

By default, all inserted texts, PDF documents, tables and images are saved in the
project file. This means that you can modify or delete the source file with no effect on
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the file in the project. Conversely, if you make changes to a file in MAXQDA, e.g.
improving typing errors, without changing the source file. Exceptions are audio and
video files, they are not stored in the project because of their size but in a special
folder for external files. The same applies to PDF documents and images that exceed
an adjustable file size. For more information, see "External Files".

When inserted, MAXQDA takes the filename as a document name, it can be modified
later, avoiding duplication. Depending on the type of document, the documents are
given different symbols.

Note: Using the other icons on the tab, special data types, such as focus group
transcripts, survey data, or data from Twitter can be imported. The specifics of these
imports are described in detail in their own sections.

Ordering the documents in document groups

Once you’ve imported your documents you’re ready to start your analysis. Most people
don’t start with the analysis immediately, though, and prefer to organize the
documents in folders, as they might do on their computer’s hard drive. Rather than
using folders, MAXQDA uses document groups. They work just like folders do on your
computer – you can name them and drag documents into them.

Document groups keep your Document System organized

There are two ways to create a new document group:

Click the New Document Group icon  in the "Document System" toolbar.●

Right-click on the root folder in the “Document System“ and select New Document●

Group from the context menu.

https://m22.maxqda.com/help-mx20/import/external-files
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MAXQDA then creates a new document group at the top of the "Document System"
and automatically assigns a name and number. To give the document group a
meaningful name, click on it with the right mouse button and select Rename.
Alternatively, click the name once with the mouse button to select the line, and then
click the name again.

Suitable names for document groups are e.g. the data types (individual interviews,
group discussions, document analyses, etc.) or differentiation criteria resulting from
the sampling (first survey wave, second survey wave, ecclesiastical organizations,
public-law organizations, etc.).

Please note: Document groups can only be created at the top level. You can’t create a
document group within a document group.

The assignment of documents to document groups can be changed at any time by
clicking on the document symbol in the "Document System" with the mouse and,
holding down the left mouse button, moving it to where you want to assign the
document. You do not have to specify the document group to which it is to be
assigned when importing the document.

Moving and sorting documents

Moving individual documents

You can arrange the order of the documents in the "Document System". Just click
and drag the document to the desired position.

Moving multiple documents

You can select multiple separate documents by holding down the Alt key (Windows)
or option key ⌥ (Mac) and then move this selection while holding down the mouse
button. To select a range of documents, first click on one document and then click on
a second document while holding down the Shift key ⇧. This then selects all the
documents between these clicked documents.

Moving multiple documents by activating them

To move multiple documents at once, first activate these documents by, for example,
holding down the Ctrl key (Windows) or the cmd key (Mac) and then clicking on them.
Now click on a document group with the right mouse button and select Move
Activated Documents Here.
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Move all activated documents to a document group at once

Sorting documents

To sort the documents in a document group, choose Sort Documents from the context
menu of the document group and then the required sorting order in the drop-down
menu. Sort criteria include Document Name, Last Edit, and Text Length (only text,
table, and PDF documents are taken into account).

To sort document groups by their names, right-click on the root folder of the
documents, and choose Sort in Ascending Order to sort them from A - Z or Sort in
Descending Order for the reverse order.

Please note: You will often be working with documents or document groups whose
names consist of numbers or whose names contain numbers, e.g. Interview 1,
Interview 2, Interview 3. In the case of more than ten documents or document groups,
it is recommended to use double-digit numbers for their description, so that the
documents are sorted according to the order of numbers, e.g. Interview01,
Interview02, ..., Interview48. In the case of more than 100 documents or document
groups, corresponding three-digit designations should be used, e.g. Interview001,
Interview002 etc.

More data import options

You can import documents not only from Import tab but also through several other
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functions:

Click the Import Documents  icon on the toolbar of the "Document System".●

Or use the keyboard shortcut Ctrl+D (Windows) or cmd+D (Mac).●

Or click on the root folder in the "Document System" with the right mouse button●

and select Import Documents.
Or, right-click the document group to which the document is to be assigned. From●

the context menu, choose Import Documents.

Import documents via the context menu in the document group

As described above, a dialog window opens in which you can select which file to
import.

Please note: The imported documents are imported into the selected document group,
i.e. marked in blue. If no document group or root folder is selected in the "Document
System", MAXQDA inserts the new documents at the top of the document "tree".

Importing documents via drag and drop

Files can be imported via drag and drop: Select one or several documents in the
Windows Explorer or Mac Finder and simply drag the documents into the "Document
System" with the mouse. Then drop the documents in the desired position.
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Tip: To import the documents of a whole folder into MAXQDA, drag the folder from
the Windows Explorer or Mac Finder to the "Documents System". MAXQDA then
creates a new document group with the same name of the file folder at the top of the
document “tree” and imports all documents that MAXQDA can import. If the folder
contains subfolders, these are also created as separate document groups.

Document sets

MAXQDA makes it possible for you to create and save a temporary grouping of
documents. While each document can only be in one document group, it can be in as
many document sets as you wish, because document sets are only made up of
shortcuts to the documents. In other words, a document set can be deleted without it
having any effect on the document. If that same document were deleted from a
document group, however, it would be deleted from the project along with all of its
memos, coded segments, links, etc.

Document sets can be created via activation. You can activate a document by right-
clicking on it and selecting Activate from the context menu. You can see that a
document has been activated, because it turns red and a red arrow appears just to the
left of the document symbol.

Tip: For quick, easy activation, left-click on the document symbol. You can also
activate all documents in a document group at once by clicking on the folder icon.

After activating all the documents that you want to create a set out of, you can create
that set as follows:

Right-click on the word Sets at the bottom of the “Document System”.1.
Select New set.2.

MAXQDA then creates a new set with the name “Set 1” and adds all activated
documents to this set. You can click on the name with the right mouse button and
choose another that is more appropriate. Document sets are manipulated like
document groups; you can activate all the documents in a document set at the same
time and use all the options for working with document groups (Codes, Memos,
Variables, Links, etc.).

Modifying document sets at a later stage

Individual documents can be deleted from a document set: Right-click on a set and
select Remove document from set. Or drag and drop documents to move them from
set to set.
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Tip: You can drag a document (or a number of documents) into a set at any time.
Drop the document(s) into the desired set and MAXQDA will insert it/them directly at
the top of the set.

Document sets are very practical when you want to analyze a certain selection of
documents. Forming a document set is also an easy way to save the result of a
complex variable activation process.

Document variables generated automatically during the import process

Each document contains a data record of variables (“document variables”). When you
import a document, a record is simultaneously generated – much like during your first
visit to a new doctor. If at the time of import a data record containing variables is
generated, firstly only certain internal MAXQDA variables will be saved.

You would like to know which variables? Then click on Variables ("System Fields") in
the context menu of the document to see these internal variables. MAXQDA will
display the number of coded segments and memos available for this document in the
columns Coded Segments and Memos.

Overview of Variables for a newly imported document

Some information will appear at the cursor if you hover the mouse over a document
name in the "Document System" window and wait a moment.

Create New Text or Table Documents
MAXQDA lets you not only import and export texts and tables, but also create them,
for example for ethnographic descriptions of researched items.

Create new text documents

There are several ways to create a new text document:

Click the New Text Document  icon in the toolbar of the "Document System", or●
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go to the Import tab and click the Create Document icon, or●

press the key combination Ctrl+T (Windows) or cmd+T (Mac), or●

right-click on the root folder of your documents in the "Document System" and●

select New Text Document to insert a text at the top of the document list, or
click on a document group with the right mouse button and select New Text●

Document to create a text at the top of the selected document group.

Creating a new document via the context menu of a document group

MAXQDA will automatically assign the document a name in the form of “Document
nn,” where nn is a consecutive number. Of course, you can always change the name
later. After creating a new document, it is automatically opened in the “Document
Browser” and put in Edit Mode, so you can start to type or paste text from another
program into it.

Create new tables

To create a new table, go to the Import tab and click on the text (not the icon) Create
Document. Then click New Table Document in the menu that appears. You can freely
select the number of rows and columns.
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Select the number of columns and rows when you create a new table

Please note: When creating a new table, no new columns can be added later.

Convert text document into a table

You can convert a text document automatically into a table document, i.e. to
paraphrase the text in another column:

Open a text document by double-clicking on it in the “Document System“.1.
Then go to the Import tab and click on Convert Text > Insert Displayed Text as a2.
Table Document
A dialog box will appear, in which you can specify the number of columns.3.

Choose the number of columns

Please note: The original text will be preserved in the conversion to a table.

A new table document appears in the "Document System", which you can recognize
by the symbol  and which will bear the same name as the source document. Each
paragraph of the source text appears in a separate line of the new table. If you have
selected more than one column for the table, the text appears only in the first column.
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The original text will appear only in the first column

As this picture shows, this conversion function makes it easy to paraphrase and
summarize texts in MAXQDA. When you activate Edit mode, you can paraphrase the
texts in the empty columns of the newly created table.

External Files
In general, all documents will be imported into the MAXQDA project file, meaning the
original file remains in place. You can modify or delete the original file without
affecting the imported document in MAXQDA. This concept holds a great advantage
over other QDA software, in which the primary files are constantly at risk of being
modified “from the outside.”

With MAXQDA you can connect audio or video files to their transcriptions and import
PDF and image files, which means that the “one project = one file” concept is not
always optimal. If you were working with many audio/video, image, or PDF files, for
example, your project file would quickly become very large, which would slow down
processes in MAXQDA and make it almost impossible to move the file.

For this reason, MAXQDA does not save audio and video files in the project file and
imported PDF and image files only up to a certain size (default setting 5 Megabytes).
Instead they are saved in an external folder. You won’t notice any difference in the
way you work with the documents in MAXQDA; the icons in the “Document Browser”
look just like they would if the documents were saved in the project file.
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The threshold for the file size can be set in the overall MAXQDA preferences.
Preferences can be opened by clicking on the gear wheel on the upper right corner of
the MAXQDA Main Menu.

Open settings

Edit settings for saved files

You can also set the location where external files are to be saved. If you do not change
it, the default location for all external files will be as follows:

for portable license installations: [MAXQDA 2020 Files]MAXQDA_Externals●

for Windows normal license installations: [My documents]MAXQDA_Externals●

for Mac normal license installations: [My documents]/MAXQDA_Externals●

Please note: All your external documents will be saved in a global external folder. If
you wish to save externals in a project-specific folder, you should create a folder for
the designated project. However, it can be useful to work with a global external folder
from which external files can be accessed by multiple MAXQDA project files. For this
reason, when you delete a document, the associated media file will not be deleted
without confirmation, as the file could still be linked to other documents.
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What actually happens when a PDF or image file larger than the set
maximum size is imported into the “Document System”?

You are informed that the file is saved externally and is not embedded in the project.●

The document is added to the list in the “Document System” just as it would be if it●

were a smaller file.
The document is visualized with the PDF or image icon as is the case with smaller●

files.
The document is copied into the “MAXQDA_Externals” folder unless you have●

chosen to have external files saved elsewhere. The original document remains in its
original location.

What happens to a document in the “Document System” when it is
linked to a media (audio/video) file?

The location of the original file is saved in the Properties menu of the document.●

The original media file is never saved as part of MAXQDA project file, even if it is●

smaller than the maximum file size.
The media file is copied into the folder for external files. The original document●

remains in its original location.
When importing a text file with timestamps, MAXQDA also looks through the file for●

timestamps, creates a List of timestamps synchronizes the text with the audio/video
file.

Which file is actually used – the original or the copy?

MAXQDA always looks for the original first – it looks for the file based on the path
that is saved in the properties menu of the document. If the original is not found, the
copy of the file in the external files folder is used. This file is then loaded. In other
words, the original file can be moved or deleted without it affecting the proper
functioning of MAXQDA.

Be careful when using the same file name for different files!

It is possible to import several documents with the same name into the “Document
System” (e.g. three files named “Interview 1”). This is only a problem if the file is
larger than the set maximum and must be saved in the external files folder. When the
most recently imported file is saved, it automatically replaces the older file with the
same exact name.
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What happens when you change the external files folder for a project that
already has external files saved in the default external files folder?

In this case, MAXQDA will ask you if you would like to move the documents from the
previous location to the new external files folder. The documents are only moved once
you confirm this. Since this action changes the global setting for all projects, all files
are moved from the former external files folder to the new.

Can you import an externally saved document into the project file at a later time?

Yes, you can. To do this, right-click a document in the "Document System" and select
Properties. Then click Embed document.

Can you store a document outside the project file at a later stage, that is, save it in the
folder for external files?

Yes, you can do this, too. To do this, right-click a document in the "Document
System" and select Properties. Then click Store documents externally.

To store several documents outside the project file, go to Home > External Files > Store
Documents in Folder for External Files. A dialog box will appear listing all documents
stored in the MAXQDA project file. Here you select all the documents that you want to
store externally.
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Function for storing files externally

How do you transfer external files from one computer to another?

To share the project with team members and colleagues, including the external files,
follow these steps:

Send the MAXQDA (MX20) project file.1.
Bundle all external files by clicking on External Files > Bundle External Data Files in2.
the Home tab. MAXQDA then compresses all external files associated with the
current project into a Zip archive, which is named after your project (e.g.
“Projectname.mx20.zip”) and saved in the same place as your project file.
Transfer this newly created Zip file.3.

Procedure on the receiving end:

Open the MX20 project file.1.
Click External Files > Unpack Bundled Data Files in the Home tab and select the Zip2.
archive in the Windows dialog box that appears. MAXQDA then unpacks the
archive and moves the linked files to your external files folder. If you saved the zip
archive in the same folder as the project file, MAXQDA automatically accesses the
archive and unzips the files on request.

If a document is linked to an audio or video file, the original location of the
audio/video file will be listed in the document properties. If a document with this name
isn’t found in the appropriate folder, the file in the external files folder will be opened.

Text Documents
Importing texts

You can import texts into MAXQDA, as described here:

by clicking the Import Documents icon  in the "Document System", or●

by clicking the Texts, PDFs, Tables icon in the Import tab.●

https://m22.maxqda.com/help-mx20/import/import-group-data
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Importing data via the Import Tab

If you want to import text documents into MAXQDA you should briefly think about
how to prepare them for the import. If you want to analyze certain sections of text as
a single unit, for example, it makes sense to put them together in the same paragraph.
MAXQDA enters a new paragraph number after each hard return. This makes it easier
to then automatically code these paragraphs in MAXQDA.

Here are the things to remember when importing a text document:

All formatting aspects – like bold, italics, etc. – are carried over to MAXQDA.●

All fonts and text sizes are carried over.●

Paragraph formatting (e.g. right-justified, line height) is also carried over.●

The text can contain tables, pictures, graphics, etc.●

If objects like graphics are imported or not can be determined in the local●

preferences of the "Document System", which you can open by clicking on the gear
symbol at the top right of the window.

In-text tables

As listed above, MAXQDA can import tables included in text documents, and you can
code parts or whole cells of these tables in MAXQDA. The only limitation here is that
the size of the table can no longer be changed once it has been imported.

Please note:As a rule, we recommend that you use tables in text documents only
sparingly. This not only increases your analysis options (e.g. automatic coding at
paragraph level), but also increases the performance of the display. We particularly
advise against importing interviews in a table structure in which each response is
contained in a separate row.

Links to websites embedded in texts

Documents imported into MAXQDA can also have links to websites (hyperlinks) in
them. Clicking on the link in MAXQDA brings up the webpage or HTML file in the
default browser.

Hyperlinks are always made up of two parts: the visualization (whether it be a button,
picture, or text) and the URL, which is the information about the location of the file,
which may be a WWW address. By hovering over the link, you can see the
location/URL in the tooltip that appears. Usually, this is not otherwise visible.
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Hyperlink in a text

Please note: When you enter an Internet address in a text in MAXQDA, it will
automatically transform into a clickable hyperlink when you close Edit Mode.

You can find more notes and advice in Links in MAXQDA.

PDF Documents
Importing PDF documents

You can import PDF documents into MAXQDA, as described here:

by clicking the Import Documents icon  in the "Document System", or●

by clicking on the Texts, PDFs, Tables icon on the Import●

Importing data via the Import Tab

Text from a PDF document as a separate text document

After a PDF document has been imported into a MAXQDA project, you can extract the
text from the PDF document. Images and formatting are ignored, only the plain text is
inserted as a new text document in the "Document System".

Click on a PDF document in the "Document System" and select the function Insert
PDF Text as New Document. The new text appears directly below the clicked
document.

https://m22.maxqda.com/help-mx20/links/links-in-maxqda
https://m22.maxqda.com/help-mx20/import/import-group-data
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Tip: With many PDF texts, the conversion makes it possible to search within
paragraphs when conducting a lexical search.

Working with PDF documents

There are some special considerations when working with PDF documents, as the PDF
format was not conceived for text editing but rather as a layout format for printing,
and hence are much bigger files than simple text documents.

Tip: PDF documents may contain pages in both portrait and landscape orientation.
MAXQDA displays all of the pages in a PDF document in the same page orientation as
the first page. If your document contains mixed page orientations, it might be
necessary to rotate them into the same orientation before importing the document in
MAXQDA.

Saving PDF files outside the MAXQDA project file

By default, all PDF files smaller than 5 MB will be saved in the project file upon
insertion. PDF files larger than 5 MB are not saved in the MAXQDA project itself, but
rather in the folder for externally saved files, and generate only a reference to the
externally saved data. You can customize the maximum file size as well as the location
for externally saved files through MAXQDA’s preferences, which you can access via the
gear symbol in the top right corner of MAXQDA.

Tip: If you are working with many large PDF files (e.g. with a total size of more than 1
GB), it makes sense to store them externally so that the MAXQDA file remains small
and can be easily secured. For optimal performance it is recommended that externally
saved files be located on the local hard disk and if possible not on a network, although
the acceleration of network speeds mean that this poses less and less of a problem.
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Coding text and image segments

Text and image segments in PDF documents can be coded with the mouse. Select and
create a frame around the desired segments to subsequently code them. MAXQDA
does not distinguish between text and image encodings in regard to code frequency;
however in the Coding Query when searching for overlap, the query will search
independently for overlap/intersection in text and image documents. Overlap between
text segments and image segments will be ignored. The “Near” function for image
segments always returns a result of 0, both in the Complex Coding Query and the
Code Relations Browser.

If a text is in the format of a scanned PDF file, Optical Character Recognition or OCR, a
text recognition process, must carried out with a suitable program before the import
into MAXQDA. This process makes it possible to mark and code the text in MAXQDA
later, otherwise it would only be possible to mark images.

Absence of paragraphs in PDF files

PDF documents, unlike text documents, have no paragraph structure per se. MAXQDA
functions that rely on the paragraph structure can therefore not be used in PDF
documents. These functions include, among others, automatic coding with the
parameters “Sentence” or “Paragraph”, as well as the “Near” function for segments
in the Complex Coding Query and Code Matrix Browser.

Navigating through the "Document Browser"

As soon as a PDF document is displayed in the Document Browser, several clickable
icons will appear in the toolbar. You can flip forward and backward, adjust the zoom
and use the bookmarks for navigation (many PDF files have several bookmarks, e.g.
one per chapter).

Tip: MAXQDA does not support editable PDF form fields. To display content from PDF
forms, save your PDF document via a PDF printer as a new PDF file that contains the
contents of the form fields as pure text.

Image Documents
Importing images

You can import Images into MAXQDA, as described here:

by clicking the Import Documents icon  in the "Documents System", or●

https://m22.maxqda.com/help-mx20/import/import-group-data
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by clicking on the Images icon on the Import tab. ●

Importing data via the Import Tab

Working with images

When working with images, there are a few special aspects to consider that are
described in this section.

Saving image documents outside MAXQDA projects

Normally all image documents of less than 5 MB are saved directly in the MAXQDA
project. Image documents larger than 5 MB are not saved directly in the project, but
rather in the folder for external files, and only a reference referring to the externally
saved file is generated. You can customize the maximum file size as well as the
location for externally saved files via the MAXQDA preferences, which you can access
by clicking on the gear symbol in the top right of your window.

Tip: If you are working with many large image files (e.g. with a total size of more than
1 GB), it makes sense to store them externally so that the MAXQDA file remains small
and can be easily secured. For optimal performance it is recommended that externally
saved files be located on the local hard disk and if possible not on a network, although
the acceleration of network speeds mean that this poses less and less of a problem.

Coding image segments

In image documents, borders can be drawn around the selected area with the mouse
which can be subsequently coded like text segments, meaning they can be dragged
and dropped into a code. With the Complex Coding Query and Code Relations
Browser, the “Near” function for image segments always returns a result of 0.

Rotating and zooming into images

As soon as an image document is displayed in the “Document Browser“, several icons
for viewing the image will appear in the toolbar. You can zoom in or out of the image
as well as rotate it clockwise (images imported from digital cameras and mobile
phones should automatically be correctly rotated by MAXQDA provided the correct
information has been saved in the image).
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Audio and Video
You can import audio and video files into MAXQDA, as described here:

by clicking the Import Documents icon  in the "Documents System", or●

by clicking on the Audios or Videos icon on the Import tab.●

Importing data via the Import Tab

There are some special considerations regarding audio and video files.

MAXQDA supports the the following formats as standard:

Audio Windows: MP3, WAV, WMA, AAC, M4A
Mac: MP3, WAV, AAC, CAF, M4A

Video MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP
Windows: additionally WMV
For video, a MP4 file with the video codec H.264 / AVC is recommended.

Audio and video files are generally not imported directly into a MAXQDA. Instead,
they are stored in the MAXQDA Externals folder and linked to a text document in
which you can, if necessary, save a transcript.

When importing an audio or video file, MAXQDA creates a new text document with
the name of the media file and assigns the newly added document the inserted media
file. The media file itself is stored in the MAXQDA external folder. If a file with the
same name already exists in the Externals folder, MAXQDA asks if the existing file
should be overwritten. You can adjust the location of the external address in the
MAXQDA settings. The settings are called up via the gear wheel at the upper right
edge of the window.

In the "Document System", you will recognize a text document with the associated
media file by the additional symbol displayed in addition to the document symbol: a
musical note  for audio files and a video camera  for video files.

https://m22.maxqda.com/help-mx20/import/import-group-data
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Audio and video files in the „Document System“

Assigning audio/video files to a text document

You can also assign a media file to an existing text document. To do this, right-click on
the document in the "Documents System" and select Properties. Here a link to a
media file can be assigned or changed at any time.

To do this more quickly you can right-click on the document and choose Link
Audio/Video file.

Assigning an audio/video file to a document.

Play and edit audio and video files

Audio and video files can be played and edited in MAXQDA's "Multimedia Browser".
For detailed information, see Analyzing Videos.

Table Documents
Importing table documents

You can import Excel documents into MAXQDA, as described here:

https://m22.maxqda.com/help-mx20/19-analyzing-videos/the-multimedia-browser
https://m22.maxqda.com/help-mx20/19-analyzing-videos/video-analysis-with-maxqda
https://m22.maxqda.com/help-mx20/import/import-group-data
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by clicking the Import Documents icon  in the "Documents System", or●

by clicking on the Texts, PDFs, Tables icon in the Import tab. ●

Importing data via the Import Tab

What happens when a Excel spreadsheet document is imported into a MAXQDA
project?

The first worksheet in the Excel workbook will be imported.●

Hidden columns in Excel will also be imported.●

The columns are numbered according to their order, whereby the contents of the●

first row will be used as the column header.
The entries in the first line of the table are used as headings.●

The row order will remain the same when imported.●

The font will be standardized.●

Importing table documents into the “Document System“

Please note: Excel spreadsheets that use Object Linking and Embedding (OLE) to
integrate embedded objects such as Word documents, PowerPoint slides, etc., can
have a significant impact on performance, so we advise against using them. Instead,
external links are much better suited for linking tables with objects outside the
MAXQDA project..

The table view in the “Document Browser”

Table documents in MAXQDA will be automatically formatted. It is not possible to
modify the text format.
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You can zoom into the table using the zoom icon in the “Document Browser” toolbar.
The font will appear accordingly larger or smaller. The height of the rows will be
automatically set to the height of the largest cell.

Please note: When importing, the columns are numbered according to their order in
the Excel document. The number is at the beginning of each column heading and
cannot be changed post-import.

During the import, the first line of the imported document is copied as the column
header. You can adjust this heading by right-clicking on a column and selecting Edit
Entry:

Modify column header

When you import a table each column will be assigned a type automatically:

Text●

Numeric●

Date/Time●

To change a column type, open the drop-down menu “Type.”

Please note: It is not possible to modify the column type if the column contains coded
segments.

The column widths and column positions can be modified using Drag & Drop. Like
overview tables, table documents in MAXQDA can be sorted by clicking the column
header. The original order can always be restored by right-clicking on the column
header and selecting Reset sorting. Alternatively, you can click on the empty column
header just above the row number.
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Modify table view

You can access the following options by right-clicking on the column header:

Context menu of a column header

Hide – hides the column.

Edit – allows the modification of column name and column type.

Select fields – opens a window in which the columns to be displayed can be selected.

Reset Sorting – restores original order after import.

Notes on table rows

The row numbers are fixed when the table is imported into MAXQDA, and cannot be
modified.

A row in the table corresponds to exactly one paragraph. Within a cell, there is no
differentiation between paragraphs.
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Editing table documents

The contents of individual cells can be modified. In order to do so, click on the Edit
mode on/off  button in the top right corner of the “Document Browser”.

Tip: To insert a paragraph within a cell, hold down the Alt key (Windows) / option key
(Mac) and press Return.

Coding table documents

Any text segment of any cell can be coded. First, double-click on the cell in order to
select the contents. The cell will then be outlined in yellow, and you can mark a text
segment. All of the usual MAXQDA coding options, including color-coding and coding
with emoticons, are now available. It is not possible to code across multiple cells.

Coded text in a cell

Please note: When you hide a column, the corresponding coding stripe in the
“Document Browser” will also be hidden.

Notes on retrieval functions in table documents

The retrieval options for coded segments in table documents are identical to those for
text documents. For example, overlap will be handled in the same way as it is with
normal text. The retrieval functions also include hidden columns and are based on the
current configuration of the table. Retrieval functions for a single row correspond to
those for a single paragraph.

The Near function in the Code Relations Browser and Complex Coding Query applies
to columns in table documents. This means that only the vertical proximity of two
codes, and not the horizontal or diagonal proximity, will be taken into account, and
that coded segments in different columns will never be found, when using the Near
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function.

Click on the source data in the “Retrieved Segments” to indicate the coded text in the
“Document Browser” and display the corresponding column.

Memos in table documents

As with all documents in MAXQDA, you can assign memos to table documents. You
can assign a memo to a table document like this:

Right-click a selected text section in a cell and select Insert Memo for Selection to●

compose a memo for the text section.
Right-click on a cell and select Insert Memo.●

Double-click in the memo column to the left of the table to create a memo to the●

first character of the first cell at the click position height.

Adding memos to a table document

When you click on a memo symbol, MAXQDA will indicate to which text or cell this
memo is assigned.

Please note: When a column is hidden, the memos assigned to the cells in this column
will also be hidden.

Table documents and visual tools

In principle, hidden columns in table documents will be taken into account when using
Visual Tools.

Code Matrix Browser functions as with any other type of document, as only the
number of coded segments for a particular code will be analyzed.
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Code Relations Browser functions as with overlapping in normal text. Overlap can only
occur within a particular cell. The “Near” function will search only for coded segments
in the same column.

Codeline Each row represents a paragraph in the Codeline – the column structure is
ignored in this case. Hidden columns will be taken into account. Paragraphs will be
sorted in their original order.

Document Comparison Chart As with the Codeline, each row in the table represents a
paragraph – the column structure is ignored. Hidden columns will be taken into
account. Paragraphs will be sorted in their original order.

Document Portrait This tool operates differently than with regular documents.
Columns will be more or less ignored; cells will be processed from left to right, then
top to bottom. A one-dimensional structure is then created, which is displayed as
usual in the Document Portrait.

Exporting table documents

Table documents cannot be printed directly from MAXQDA; they can, however, be
exported in Excel format. Click the Export Displayed Document  button in the
Document Browser or select Project > Print > Displayed Document from the main
menu. Alternatively, you can right-click on the document in the “Document System”
and select Export Document.

Transcripts
Transcribing recordings is easy with MAXQDA, because MAXQDA provides all the
standard transcription functions, such as automatic speaker exchange, autocompletes
with defined shortcuts and timestamps for synchronizing transcriptions with audio or
video files. All the functions for transcribing in MAXQDA are described here.

MAXQDA also lets you import transcripts created with specialized transcription
software, including f4/5 transcript, Inqscribe or Transcriber Pro. This is usually the case
when a professional service provider has transcribed your recordings. The transcripts
created with such software usually contain timestamps corresponding to certain audio
or video files. MAXQDA automatically includes these timestamps. Most transcription
programs create their transcripts in Rich Text Format (RTF), a format for text
documents that can be imported directly into MAXQDA without conversion.

When creating transcripts, it’s a good idea to insert a timestamp at the end of

https://m22.maxqda.com/help-mx20/transcription-audio-video/transcription-mode


02 - Importing Data   108

paragraphs least as well as at easily misunderstood points within a paragraph. A
transcript then looks like this:

I: So, Robert. Could you please describe your current living situation for me?
#00:00:10.5#
B: Sure. Uhm, at the moment I am living with my parents. In my old room in the
basement. I did have a room in the dorms at college but I am taking a semester off
and wasn't sure where I'd end up going. I am looking for an internship at the coast,
so I'll probably find a place with a roommate there soon. #00:00:30.1#

Example transcript with timestamps at the end of paragraphs

Importing transcripts without timestamps

If your transcripts do not contain time stamps, you can import them via Import >
Transcripts > Transcripts without Timestamps. Alternatively, you can simply drag the
transcript from Windows Explorer or Mac Finder to the "Document System".

Importing transcripts with timestamps

Importing transcripts combined with their corresponding audio or video files:

Ensure that you have the appropriate audio or video recordings for all transcripts1.
that you want to import. You can use the transcripts and the media files in the
same folder and under the same name.
In MAXQDA, go to the Import tab and select the function Transcripts2.

Select Import of Transcripts with Timestamps

In the drop-down menu, select the entry of the transcription software that was3.
used to create the transcript. Select Transcript with Timestamps if you do not know
the software used.
A dialog window will appear in which you can select a transcript for the import. If4.
you press Ctrl (Windows) or Cmd (Mac), you can also select several transcripts.
Click Open and MAXQDA will search the file for timestamps and ask for the5.
associated media files. Select them in the dialog window that opens, and click
Open. If you don’t want to link any media files to the transcript, click Cancel.
MAXQDA will ask if you want to import the transcript without a media file and if
you want to keep the timestamps in the text.
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Importing transcripts from AmberScript

AmberScript is an online transcription app with automatic speech recognition. To
import a transcript from AmberScript:

Edit the transcript online1.
Export the transcript in JSON format. Make sure to activate the options to include2.
time stamps and speakers.
In MAXQDA go to the Import tab and choose Transcripts > From Amberscript3.
(.json)

Importing transcripts from f4x Spracherkennung

f4x Spracherkennung is an online transcription app with automatic speech recognition.
To import a transcript from f4x Spracherkennung:

Edit the transcript with f47f5 transcript1.
Export the transcript in RTF format.2.
In MAXQDA go to the Import tab and choose Transcripts > From f4/f5 transcript3.

Importing transcripts from Temi

Temi is an online transcription app with automatic speech recognition. To import a
transcript from Temi:

Edit the transcript online1.
Export the transcript in DOCX format.2.
In MAXQDA go to the Import tab and choose Transcripts > From Temi (.docx)3.

Importing transcripts from Trint

Trint is an online transcription app with automatic speech recognition. To import a
transcript from Trint:

Edit the transcript online1.
Export the transcript in XML format.2.
In MAXQDA go to the Import tab and choose Transcripts > From Trint (.xml)3.

What happens when you import a transcript?

MAXQDA creates a new text document with the transcript.●

The audio or video file is copied into the folder for external files and assigned to the●

transcript.

https://www.amberscript.com/en
https://www.audiotranskription.de/Spracherkennung
https://www.temi.com/
https://trint.com
https://m22.maxqda.com/help-mx20/import/external-files
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Text documents with the associated media file can be recognized by their special●

symbols in the "Document System": a musical note  for audio files and a
video camera  for video files.

MAXQDA converts the timestamps in the transcript to internal MAXQDA timestamps
and entries in the timestamp table and simultaneously removes them from the text for
better readability. The chronology of the timestamps is checked in the text:
Timestamps that refer to an earlier time than those previous to them are removed.

Tip: If you do not assign an audio or video file during import, you can do this later by
right-clicking on the document name and selecting the Properties option. However,
this is only possible if you do not leave the time stamps in the text during import,
because only then will they be converted into MAXQDA-internal time stamps.

Timestamp display in MAXQDA

Texts that already contain timestamps when imported can, if necessary, be subdivided
more precisely with further timestamps. For more information, see the Transcription
section.

Supported timestamp formats

MAXQDA automatically recognizes the following timestamp formats in a transcript:

Software Timestamp format

easytranscript, f4 & f5transcript #hh:mm:ss-x#

HyperTRANSCRIBE [hh:mm:ss.xxx]

Inqscribe, Transcriva [hh:mm:ss.xx]

Transana (h:mm:ss.xx)

Transcribe [hh:mm:ss]

Transcriber Pro hh:mm:ss

If you are using a different transcription software, you may be able to customize the
timestamps by finding and replacing digits in the program with one of formats that

https://m22.maxqda.com/help-mx20/transcription-audio-video/transcription-mode
https://m22.maxqda.com/help-mx20/transcription-audio-video/transcription-mode
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can be imported:

Note: If you import any text document that contains timestamps in one of the formats
listed above, MAXQDA will automatically detect the timestamps and ask you for the
associated media file.

Focus Group Transcripts
MAXQDA offers a variety of functions for the analysis of focus groups. To use these
analytical tools, it is necessary to import focus group transcripts using the focus group
import function. If you are transcribing a focus group interview in MAXQDA or if you
have already imported a transcript, you can also convert the text into a focus group
transcript later. When importing a focus group transcript or converting a text into a
focus group transcript, all speech contributions are coded with the respective speaker
name, which makes it easy to differentiate between individual speakers in the analysis.

To import a focus group transcript to MAXQDA, select Focus Group Transcripts in the
Import tab and choose your transcript format from the drop down menu. Linking the
focus group transcript to an audio or video file and working with time stamps works
just like importing a regular transcript.

Import focus group transcripts

Each contribution begins in a new paragraph. At the beginning of each contribution●

the name of the participant appears, followed by a colon. Using bold type or special
fonts for the names will not affect the import process, however upper and lowercase
will be taken into account. Names like “Lisa B.” or “Gábor” with spaces and special
characters are not a problem when importing. The subsequent text will be coded
with the names of the speakers, up to the point where the next speaker is indicated.
MAXQDA will tolerate a space that is accidentally set before a name or in front of a●

colon, and treats the associated names to be identical.
The names of the speakers that appear before the colon can be a maximum of 63●

characters in length.
Sections of text at the beginning of the transcript (in which no colon occurs within●

63 characters) will not be coded. This provides the opportunity for you to include a
title and general information about the focus group for easy recognition.
Timestamps originating from the transcription software F4 or F5 will be treated as●

https://m22.maxqda.com/help-mx20/import/transcripts-with-timestamps
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usual: MAXQDA will ask if you wish to associate the corresponding audio/video file
with the transcript. The timestamps will be integrated into the MAXQDA project and
removed from the text.

Let’s take the following interview with multiple speakers as an example:

Moderator: Well good morning to everyone – thank everyone for being here. We’ve
been chatting and I’ve already outlined what we were hoping for this discussion in
your packs. We know you come from a variety of employment backgrounds and we
are hoping to guide the discussion and get your opinions about along various topics
connected to the various current financial crises and general economic downturn. To
start with though we just want to find out what things are prominent – most
occupying your minds.

We need to ensure that we’ve covered the important things during discussion. So
perhaps if we could go round the room – you say what matters – roughly in the
context of what this discussion is all about. Just to assist the transcriber eventually, if
you could just say your name when you start talking after a while … it won’t go in the
transcript itself.

Moderator: How do you feel now about your job and how secure do you feel? What
changes have you experienced in this regard? Please do talk about relationships at
work and morale if it’s relevant to you.

Lucas: It has changed now where I work. It’s an international firm. Hope you don’t
mind me not saying what type of work it is. You are really gagged and your jobs on
the line if it gets out. We’re under the cosh basically. In the last couple of years two
other big parts of the company have shut up shop or move to the Far East.

Moderator: So do these other closures affect morale?

Lucas: Well … it’s more like it’s a great weapon to use when they want you to work
extra time for no money. The stress – there’s just no morale at all. You get the
impression that HR are lining you up for the sack. It’s because of employment laws
now – they’ve got more leeway to discipline you if you are off sick for instance. Half
the time people are off sick because of stress

Following a successful import, MAXQDA opens the transcript immediately in the
“Document Browser”, and from the coding stripes in the margin you can see that the
speech contributions have already been coded. During the import MAXQDA creates a
new document in the “Document System” with the filename of the transcript. This
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document has its own symbol, which allows you to immediately recognize that it
relates to a focus group. Below the document, the speakers of are listed individually,
with the number at the end of the line indicating the number of contributions. The
speakers are attached to their transcripts. If you move the document, the speakers will
move with it. Only the order of speakers can be adjusted with the mouse. Like other
documents, focus groups documents can be assigned to a document group or set.

MAXQDA view after importing a focus group transcript

In the “Code System” you will see a very similar listing: At the bottom of the Code
System a code with the name of the imported data will appear, with the speakers
listed as subcodes, and the same  symbol as in the “Document System”. Speaker
codes and the speakers in the document are attached: If you change the order of the
speakers or their names in the Code System, their order will also change in the
Document System, and vice versa. This also applies when a focus group transcript is
deleted: If you remove a transcript from the “Document System”, the corresponding
code and its subcodes will be deleted from the “Code System”.

Tip: You can choose to place focus group speaker codes at the top of the Code
System, in the "Code System" window settings.

The fact that the speakers are available both in the "Document System" and in the
"Code System” opens up extensive possibilities for the analysis, as the speakers can be
activated as independent codes and as document subsets. More information:
Analyzing Focus Groups Data.

Tip: After importing the transcript you should check the names of the speakers for
typographical errors. This will avoid frustration later, in the case that the same person
appears twice under different names because the name was written or spelled
differently. Since the speaker code cannot be deleted, you would have to make the
appropriate modifications in a word processing program and then import the

https://m22.maxqda.com/help-mx20/focus-group-analysis/can-maxqda-support-focus-group-analysis
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transcript again.

When you import multiple transcripts, a unique code will be assigned to each focus
group along with subcodes for the respective speakers. The top-level codes can be
moved within the same Code System, but the speaker codes are firmly attached to
their top-level code, and their order can be modified only under this top-level code.

Tip: The automatic coding function for speakers may be useful for other types of
documents in which multiple individuals interact, for example forum discussions or
comments on YouTube videos.

Converting an already imported text into a focus group transcript

Sometimes you realize that it would have been better to import a text as a focus group
transcript into MAXQDA after you have already imported and coded it as a normal text
document. Or you have transcribed an interview with several participants in MAXQDA
and would like to code all of the speakers and their contributions automatically. In
both cases you can use the function Convert Text>Insert Displayed Text as a Focus
Group Transcript, which is available in the Import Tab. First, open the relevant
document and then start the function. MAXQDA will insert a copy of the text as a
focus group document:

The speakers contributions will be coded automatically and corresponding codes for●

each speaker will be created in the „Code System“ window.
MAXQDA will copy all existing coding information and memos into the newly●

created document, also the variable values and the summaries.
A linked media file will be linked to the new document, too.●

The links in or on the document will not be transferred.●

Survey Data from Excel
Importing survey data and other structured data from Excel spreadsheets

With MAXQDA you can import structured documents from an Excel spreadsheet in
XLS/S format, during which individual table cells will be automatically coded. In
addition, variable values can be assigned to the individual texts. This is particularly
useful when importing (online) surveys with standardized and open answers.

How should the Excel table be structured?

When imported into MAXQDA, each row of the table becomes a new document,
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wherein the contents of the cells form the document content and are coded with the
respective column header. The structure of the Excel table corresponds to the principle
of a data matrix of a standardized survey. This logic is illustrated in the table below:

Document
Group

ID
[Document
Name]

Positive Feedback
[Open Question 1]

Negative
Feedback
[Open
Question 2]

Age
[Variable
1]

Pre-knowledge
[Variable 2]

Group A Person 1 Great conference!
The catering
was a bit tight

22 high

Group A Person 2
Best keynote I have
heard in a long time

25 medium

Group B Person 3
I especially enjoyed
the pre-conference
workshop

none 21 medium

Group B Person 4
Great job - keep
going!

Please make
workshops
longer in the
future

31 low

Each row of the table contains a case, and the columns "Open Question 1" and
"Open Question 2" contain the respondent’s responses to the respective questions.
The "Variable" columns contains standardized information for each case in the form
of variables. Of particular importance are the first two columns "Document group"
and "Document Name", which assign the individual rows of the table to documents in
MAXQDA’s “Document System”.

Please note: It is not absolutely necessary to have a column for the “Document
Group” as MAXQDA can also create a new document group, into which all
documents are imported, during the import process. However, at least one column is
required, which contains the document name.

Starting the import process

To import Survey data from an Excel file, go to the Import tab and select the Survey
data> Import data from Excel spreadsheet function. You can also import documents
from an Excel spreadsheet on the Import tab from Excel spreadsheets. In principle,
however, both calls lead to the same result.
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Import Excel files

Selecting import settings

After calling up the function, the desired Excel file must be selected from the file
dialog box. This opens a window where you can enter the settings for the import.

Settings for importing documents from an Excel spreadsheet

The two top settings determine which columns contain the Document Group and the
Document Name. If the names "Document group" and "Document Name" are used
in your table as column headings, MAXQDA will automatically select them, but this
choice can be changed at any time.

If you select [Create new document group] for the entry "Document group",
MAXQDA will automatically import all documents into a new document group.
MAXQDA automatically selects this option, if your table doesn’t contain a column with
the heading “Document Group”.
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Tip: When importing survey data, it is recommended that you select the ID’s of the
respondents as a column for the document names. In this way, you can avoid any
ambiguity in the association of responses to cases, even during the subsequent export
of data into statistical software.

In the middle section, you can select the columns to be imported as coded text or as
variables.

If both “Code” and “Variable” are selected, MAXQDA will import the contents of this
column as both as coded text and as a variable. This may be useful, for example, you
do not wish to view the variable information of a document each time as a tooltip over
a document name or in the Data Editor for document variables, but rather view, for
example, how old a respondent is and whether he has children, directly in the text.

Please note: When the dialog box opens, MAXQDA will have marked all the columns
in the Excel table which vary a lot as coded text, since these are most likely to be
responses to open questions.

If neither “Code” nor “Variable” are selected, MAXQDA will ignore the column during
the import process.

In the lower section, further options are available:

Code empty cells: When this option is selected, MAXQDA will import and code cells
without content as empty paragraphs; these cells would otherwise not be coded.

You can also decide how MAXQDA should handle documents that were already
included in the project before the import. MAXQDA considers that a document
already exists in the project if the document name and document group are identical.

Import: When this option is selected, existing documents will be included in the
import, and therefore may appear twice in the respective document group.

Ignore for import: Select this option if documents that already exist in the project
should not be taken into account during the import.

Add text to existing documents: It is also possible to add text to existing documents.
For example, data from different points in time in a longitudinal study can be added to
the original document. Existing variable entries in existing documents will be updated.
Empty variable values in the Excel table are ignored when importing.

Please note: For documents whose name appears repeatedly in a document group, the
text will be added to the first document of the same name.
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Selecting other settings for importing variables

If you choose to import variables, a second window will open after you click OK.

Source: By selecting this option, you can again decide which variables will be
imported.

Target: If there is already a document variable with the same name in the project,
MAXQDA assigns the variable to it automatically and no other choice is available. If
there is no variable with the same name in the project, you can specify the type of
variable. Options include: Boolean (true/false), date/time, decimal, integer, and text.

Preview data type: This column displays a preview of how an entry will appear in the
appropriate column in the data editor.

A final report window confirms the import of documents from the table and lists how
many texts, codes, and variables were imported, as well as how many documents may
have been ignored during the import.

Imported texts in MAXQDA

After importing the table from the example into an empty MAXQDA project, it will
appear as follows:

Imported texts in MAXQDA

When importing, MAXQDA proceeds as follows:

Document groups that do not yet exist will be created.●

The headings of the code columns will run from left to right and will be inserted●

from top to bottom in the code system as new code names, as long as they do not
yet exist. All text segments from the code columns will be coded with the respective
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column headings.
If a variable does not yet exist, it will be created. Each document will be assigned the●

variable value from the variable column.

In the section "Categorize Survey Data" you will find information on how to analyze
the imported survey data in MAXQDA.

Survey Data from
SurveyMonkey
Which import options does MAXQDA offer for
SurveyMonkey data?

With MAXQDA you can import survey data directly from
SurveyMonkey into an open MAXQDA project in order to
analyze the data with all MAXQDA tools. The use of
another software such as Excel for export and import is
no longer required. While importing the data every case
of the online survey becomes a MAXQDA document.
You can code the answers of the open-ended questions
automatically with the question text. Additionally, you
can transform the standardized information into
document variables.

Please note: In order to use this MAXQDA tool access to
your own SurveyMonkey account is required. Not all
SurveyMonkey plans allow access to the data by third-
party applications like MAXQDA. Please check the
website of SurveyMonkey, if your plan allows to export
data (at present at least an EXTRA- or PREMIUM plan is
necessary).

Starting the import process

To start the data import, proceed as described below:

1. Select Documents > Import data from SurveyMonkey●

in the main menu.
2. You will be redirected to the login page from●

SurveyMonkey in your Internet browser. Fill in your

https://m22.maxqda.com/help-mx20/20-analyze-tweets-surveys/categorise-survey-data
https://www.surveymonkey.com/pricing/details/
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login data and click Login.

Login page for SurveyMonkey in the Internet browser

Please note: If it is the first time you connect with
SurveyMonkey a window might appear asking for free
access through your firewall. Please confirm that
MAXQDA is allowed to contact the Internet. Otherwise
the import is not possible.

3. Another SurveyMonkey window opens and you are●

asked to authorize MAXQDA to get data from
SurveyMonkey.

Authorization of SurveyMonkey in your browser window

Please note: MAXQDA uses the connection to
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SurveyMonkey only for importing the survey data. When
you close MAXQDA the authorization from
SurveyMonkey for MAXQDA is cancelled meaning you
must reauthorize the import of further data from
SurveyMonkey each time you restart MAXQDA.

Importing data

After a successful authorization of SurveyMonkey●

MAXQDA loads an overview of your surveys and
displays the dialog below. In this window you can select
the survey you want to import

This dialog window allows you to select a survey you want to import

Via the selection at the bottom you can choose●

whether you want to import every case or a random
sample of the cases. After doing that click Continue.
A new dialog window appears. Here you can choose on●

the top which question shall be applied as document
name. In order to guarantee a unified definition of the
documents the case-ID is selected by default. In general
it is advised to keep this selection.
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Tweaking the settings for the import

In the center of the window you can choose the columns
to import as coded text or as a variable. If you tick both
marks MAXQDA imports the content of this column as
both, a coded text and a variable. This can be useful if
you want to read the information of the variable directly
in the text (e.g. how old a person is or whether she has
kids). By doing that you can avoid receiving this
information only via the tooltip or the data editor of the
document variables.

If you don’t place a tick mark on a column MAXQDA
ignores this column for the import.

The selection at the bottom allows you to set the option
Code empty answers. If you mark this option, MAXQDA
imports and codes cells without content as empty
paragraphs. Otherwise empty cells would not be coded.

After clicking OK the data will be imported:
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A new document group labelled with the name of the●

survey will be created.
Every imported case in this document group will be●

imported into an own document.
For each question that had been ticked in the column●

to import as a “code” a new code will be created in the
“Code System” window
The imported documents contain answers to those●

questions that are selected automatically in the column
“Code”. The answers are coded automatically with the
particular question code. This gives you the opportunity
to get an overview of every answer of a question just
by using the Coding Query functions in MAXQDA.

Data from SurveyMonkey after the MAXQDA import

Information about the single question survey types

The question types from SurveyMonkey are imported into
the MAXQDA project as described in the following table.
You can determine whether an answer will be imported
as an automatically coded answer to an open-ended
question or/and as a document variable in the dialog that
is shown before starting the import (see above).

Question type Standard import in MAXQDA

Multiple Choice
1 variable
‘Other’ answer: automatically
coded text

Dropdown
1 variable
‘Other’ answer: automatically
coded text

Star Rating 1 variable
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Matrix/
Rating Scale

1 variable per item
‘Other’ answer: automatically
coded text

Matrix of Dropdown
Menus

1 variable per answer cell
‘Other’ answer: automatically
coded text

Ranking 1 variable per rank
Net Promoter® Score 1 variable
Slider 1 variable
Single Textbox Automatically coded text

Multiple Textboxes
Automatically coded text per
textbox

Comment Box Automatically coded text
Contact information 1 variable per box
Date/time 1 variable

Twitter Data
MAXQDA’s Twitter analysis features

MAXQDA allows you to import data directly from Twitter
into an open project and to analyze it using MAXQDA’s
usual functions as well as the specific analysis tool.

With a complex search, you can search for tweets on
Twitter according to specific hashtags, usernames or
terms, and then import them into a MAXQDA project.
The function’s special feature is that it can code your
Twitter data automatically with up to 100 author names
and up to 100 hashtags during import (and, if necessary,
later). This automatic preparation can save a lot of time,
which you can then use for your actual analysis.

Researchers who analyze social media data can use
MAXQDA to answer the following questions, among
others:

What did a user, user group or company post at a●

certain time? What were other users reaction to its
content?
Which are the most common words used in the●

tweets?
How many followers do the people tweeting about●

https://m22.maxqda.com/help-mx20/20-analyze-tweets-surveys/autocoding-and-analyzing-twitter-data
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particular topics have and what is the reach of
individual tweets?
On which weekdays and at what times were tweets on●

certain topics written?

Please note: To use this function, you need your own
Twitter account.

Import Twitter data

To import twitter data, go to Import > Twitter Data.

Importing Twitter data

The following dialog window will appear:

Dialog window for importing data from Twitter

Twitter login

In order for MAXQDA to import data directly from
Twitter, you must first link your Twitter account to
MAXQDA. To do so, click Connect to Twitter at the top
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of the dialog window:

Connect to Twitter

A new browser window will open where you can enter
the login data of your Twitter account. Then, click
Authorize App to allow MAXQDA to receive Twitter data
from your account.

Authorize MAXQDA for Twitter

After registration, you can close the browser window and
return to MAXQDA to start importing data.

Please note: MAXQDA uses the connection to Twitter
only for importing tweets. When you close MAXQDA,
the connection will be cancelled, meaning you must
reconnect to Twitter each time you restart MAXQDA.

Searching for Twitter data

The original dialog window that you opened in MAXQDA
will remain open, indicating whose account is connected
to MAXQDA. You can now check the box below the
login button, which was previously greyed out. Only once
you have agreed to the terms of using Twitter data
neither for advertising purposes nor for personal
identification can you start your search on Twitter. Once
you agree to the terms, the search fields will be-come
available.
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Search window for importing Twitter data

The complex search follows the same principle as the
advanced Twitter search. In the top fields, you can enter
words or strings that must appear or not appear in the
tweets. In the middle and lower sections, you can set
define specific conditions for the search and the accounts
to be searched:

From these accounts – searches for tweets from specific
users. Multiple usernames can be entered, separated by
commas.

To these Accounts – searches for tweets in which the
entered username appears at the beginning of the tweet.
Multiple usernames can be entered, separated by
commas.

Mentioning these Accounts – searches for tweets in
which the entered user name appears somewhere in the
tweet. Multiple usernames can be entered, separated by
commas.
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Further parameters can be set in the lower section:

Language: Limits the search to the selected language (the
assignment of tweets to a language is done by Twitter
itself and is not verified by MAXQDA). If you wish for
tweets in all languages to be taken into account, allow
the default parameter “Any language” to remain.

From/to: The default search period is set at seven days,
becuase this is the maximum period allowed by Twitter’s
search function. You can reduce the search period, for
example to one day, by adjusting the dates accordingly.

Include retweets: By default, this option is not selected. If
you wish to include retweets in your analysis, simply
place a check mark in the appropriate checkbox at the
bottom of the dialog window. (The inclusion and
exclusion of retweets is managed by Twitter.)

Please note: All search criteria are linked with the search
operator AND. This means that only tweets that meet all
of the conditions entered will be retrieved.

After clicking the Run Search button, a preview window
with the first 100 search results will appear. The number
of tweets found is displayed on the lower left. When
more than 100 search hits are found, the display is
updated approximately every 10 seconds.

Preview of search results

When you click Import data, MAXQDA will begin the
importing the tweets.

Please note: Imports are limited to 10,000 tweets.
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Immediately after import, a dialog window will appear
with the functions for autocoding tweets.

Twitter data in MAXQDA

During the import process MAXQDA creates a new
document group in the Document System, in which a
table document is generated for every 1,000 tweets.

Table document with Twitter data in the Document System

To ensure transparency of the research process, the
name of the document group contains the import date.
A memo will also be created for the document group in
which the search query is stored:

Memo of a Twitter import with the exact search query

When you double-click on the document in the
Document System, the Twitter data will be displayed in
the Document Browser:

https://m22.maxqda.com/help-max18/20-analyze-tweets-surveys/autocoding-and-analyzing-twitter-data
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Table document with Twitter data in the Document Browser

Each imported Twitter document contains several
columns, each named in the top line:

Date/Time
The time when the tweet was
sent

Tweet Text of the tweets

Hashtags
All hashtags that occur in the
tweet

Type
Marks whether a tweet is a
retweet or a reply

Reply
Lists the Twittername to which
tweet was replied

Author und real name
Twittername and real name of
the author

Author location

Location entered by the Twitter
user himself - not necessarily the
location from which the tweet
was sent (may be empty)

Author timezone
Time zone according to user
(may be empty)

Author URL
Author's website (may be
empty)

Author description Self-description of the author

Followers
Number of followers of the
author (the higher the range of
a tweet)

Follows
Number of people who follow
the author

Tweets Number of tweets
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Profile verified by
twitter

Specifies whether the author's
profile has been verified by
Twitter

Profile created
Specifies how long the author
has been registered on Twitter
with their profile

Retweets
Number of times the tweet has
been retweeted

Likes Number of likes for the tweet

Language
Language in which the tweet
was written (automatically
recognized by Twitter)

Device
Device or software from which
the tweet was sent

Tweet-Coordinates
Geoposition from which the
tweet was sent (often empty)

YouTube Data
What YouTube data analysis options does
MAXQDA offer?

YouTube videos are often commented on by viewers,
and sometimes their comments sections even turn into
forums for extensive debates, for instance in the case of
videos on political topics. These comments can be very
interesting to researchers working in diverse disciplines in
the social sciences, as well as in market or opinion
research.

MAXQDA allows you to import comments posted on a
YouTube video into an open MAXQDA project and have
them coded automatically. Additionally, you can import
any transcripts or subtitles provided with the videos,
which means you don't have to transcribe them
manually.

You can analyze the imported data using MAXQDA's
wide range of tools, including thematic coding, word
frequency analysis, and visualization tools. These tools
allow you to answer questions including, but not limited
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to, the following:

What is the content of the comments posted on the●

selected videos?
Which words are used most frequently in these●

comments?
How have viewers rated the selected video?●

Which comments are replied to most frequently and●

which not at all?
How do users communicate with each other?●

What is said in a video or in certain scenes?●

Importing YouTube data

To import YouTube data into your MAXQDA project, first
open the YouTube video in your browser (e.g. in
Chrome, Firefox or Safari) and copy the complete link
from the URL bar to the clipboard.

Copy the complete YoutTube link

Go to Import > YouTube Data in MAXQDA.

Start import from YouTube

You will then see the following dialog box. If you have
saved a link for a YouTube video to the clipboard,
MAXQDA automatically enters it in the first field and
retrieves the corresponding video information. If you
already have the dialog box open, you can paste a link
from the clipboard into the field at any time and then
click the button Retrieve video information.
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Dialog box for importing YoutTube data

In the upper area of the dialog box, MAXQDA will display
how many comments and how many transcripts or
subtitles assigned to the video are available to download.

Please note: YouTube does not allow you to download
transcripts/subtitles for all videos, even if subtitles are
displayed on the YouTube page of the video.

In the lower area of the dialog box, select whether you
want to import the comments and transcript or just one
of the two. The following options are available for
importing comments:

Import only top level comments – If you choose this
option, the replies to comments are ignored.

Autocode comments – If you select this option, each
comment is automatically coded with a code. The code
indicates how many replies were made to the comment.
You should leave this option activated to give you easy
access to the texts of comments later.

To import the transcripts, you can select or deselect all
the available languages listed in the dialog box. The
following options are also available:
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Include times in transcript – If you select this option, the
corresponding times in the video times are added at the
beginning of each line of the transcript. This is useful if
you don't need to match the video to the transcript (in
that case the times are displayed as MAXQDA
timestamps at the beginning of each line).

Link existing video file to transcript – If you have
downloaded the YouTube video, you can link it directly
to the transcript. To do this, simply tick this option and
select the video file by clicking on the three dots.

Please note: You can link video files to their transcript at
any time later: MAXQDA saves the corresponding times
during import and displays them later as timestamps.

Imported comments in MAXQDA

The following displays an example of the view in
MAXQDA after you have imported YouTube comments:

Imported YouTube comments in MAXQDA

What happens when you import comments from
YouTube?

Comments are compiled in table documents, 1,000●

comments at a time, in the "Document System". These
table documents are labeled with a YouTube icon.
These table documents are stored in a document group●

whose name contains the video title and the import
time. The corresponding document group memo
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contains more information about the video, such as the
publication date and the number of likes.
A new code named "Autocode <Video Name and●

Import Time>" is added to the "Code System".
This code contains the subcode "Comment at top level●

with...", where as many subcodes are added to the
code as there are different frequencies of replies to a
comment. All comments are coded with the code
according to their number of replies.
The second subcode is the code "Reply to comment".●

All replies are coded with this code.

To later display all the comments at the top level in the
"Code System" to aid your analysis, you can do the
following:

Activate all the documents containing the comments1.
of one (or more) videos.
Activate the code "Comment at top level with..."2.
including all subcodes.

The table document with the imported YouTube
comments contains the following columns:

Nr. – Consecutive numbering, where the answers to a●

comment are numbered starting at 1 for easy
identification:

0001 = oldest comment
0001-01 = first reply to oldest comment
0002 = second-oldest comment
0002-35 = 35th reply to second-oldest comment

Comment – The comment text●

Author – Name of the comment author●

Author URL – Link to the author's profile●

Top level – Indicates whether the comment is a top●

level comment (i.e. not a reply). The cell will either
contain the word "yes" or <empty>.
Replies – Number of responses to a top-level comment.●

Always 0, if it is not a top-level comment, that is, a
reply.
Likes – Number of likes given to the comment●

Published – Date the comment was posted●
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Updated – Date the comment was updated, if●

applicable

Please note: The YouTube comments import function is
limited to the 10,000 most recent comments per video.

Imported YouTube transcripts

Here you can see a YouTube transcript once it has been
imported into MAXQDA:

Imported YouTube transcript in MAXQDA

The transcript text is displayed in the "Document
Browser". In the example, a video file has been assigned
to it such that timestamps can be seen in the column
next to the paragraphs. Clicking on a timestamp plays
the video at the corresponding position.

Subtitle Data (SRT)
Videos often come accompanied by text files that contain
the spoken words of a video combined with the
corresponding playback times such that the texts can be
displayed as subtitles to the video. Very often the SRT
format is used for these text files, which can be
generated for YouTube videos, for example, using
various software tools.

You can import these text files in SRT format into
MAXQDA. Start the import as usual via Import > Texts,
PDFs, Tables or right-click on a folder in the "Document
System" and select Import Document(s). Then select an
SRT file in the file dialog box.
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MAXQDA imports the file and asks you for the
corresponding video file.

Imported SRT data in MAXQDA's Document Browser

The timestamps in the SRT file are converted into
MAXQDA timestamps. Clicking on a timestamp plays the
video file at the corresponding playback position.

If you have downloaded an SRT file assigned to a
YouTube video, this file may have been created
automatically. YouTube identifies places in these files
that were not easily recognized by the automatic system
in a light gray and gray font. This color coding is adopted
by MAXQDA during the import. Please note that such
automatically generated transcripts have no punctuation
either, that is, without commas, full stops, or other
punctuation.

Web Pages
With the MAXQDA Web Collector, you can save web
pages in your browser and then import them into
MAXQDA as a PDF, image or text. Additionally, you can
also directly import websites that are available in HTML
format as MAXQDA texts.

Please note: If you use the direct import of web pages in
HTML format, web pages are imported as text
documents (and not as web pages). The layout can
change a lot during the import, which is why the version
of the import with the Web Collector from MAXQDA is
clearly preferable. The direct HTML import is particularly
suitable for simply structured and laid out data.
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Saving web pages with the MAXQDA Web
Collector

The MAXQDA Web Collector is an add-on for the
Internet browser „Google Chrome“. It allows you to save
entire websites and import the files as pdf, picture, or
text documents into MAXQDA. Among other things, this
tool is useful to compare websites from various
organizations, or to collect and edit content from
websites for analysis with MAXQDA.

Installing the MAXQDA Web Collector

In order to work with the MAXQDA Web Collector the
installation of the Internet browser “Google Chrome” is
required. As soon as  “Chrome” is installed on your
computer you can start the installation of the “MAXQDA
Web Collector”:

Open „Google Chrome“.1.
Search the Chrome Web Store for „Web Collector for2.
MAXQDA“.
In order to add the add-on to your browser click „+3.
Add“.
After a successful installation you can see a tiny4.
MAXQDA icon top-right in your browser window:

MAXQDA icon to open the MAXQDA Web Collector in „Google Chrome“

If you want to open the Web Collector just click on the
MAXQDA icon:
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MAXQDA Web Collector

The Web Collector offers three modes:

Entire web pages can be saved. The layout remains●

optimally maintained.
Web pages can be saved in a simplified version. The●

website will be reduced to text and pivotal pictures.
Selected segments can be saved in order to transfer●

only a chosen section of a website.

Saving entire web pages

If your research is based on the analysis of every visible
item of the website it is recommended to safe the entire
website in order to import it to your MAXQDA project as
true to the original as possible. For doing that proceed as
described below:

Open the website you want to safe in Google1.
Chrome.
When the website is fully loaded open the Web2.
Collector by clicking the tiny MAXQDA icon.
Make sure the tab „Web Page“ is open.3.

Note: In case the pictures are not displayed after you
switched to the tab “Simplified Web Page” and back,
please reload the website in the browser.

Assign a name to the document. This name will later1.
be inherited into the MAXQDA project.
If required, you can fill in a text in the “Document2.
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Memo” box. This text will later be connected to the
imported document as a document memo.
Click Collect.3.

The MAXQDA Web Collector informs you about the
progress and saves the website in the selected download
folder of your browser. By default, it is the download
folder of the logged in user. The web page is saved in a
format that was specially developed for a further
processing in MAXQDA.

Please note: Time for saving can vary depending on the
scope and complexity of the website.

Websites that are saved this way can be imported into
MAXQDA as a pdf or picture document.

Saving simplified web pages

In case the focus of your website analysis lies on text you
can safe it as “simplified” website. The website will be
reduced to text and pivotal pictures which can be
compared to the read mode of your smartphone. This is
particularly useful for big newspapers and magazines. In
order to import a “simplified” website proceed as
described below:

Open the website you want to safe in Google1.
Chrome.
When the website is fully loaded open the Web2.
Collector by clicking the tiny MAXQDA icon.
Click on the “Simplified Web Page“ Tab. The web3.
page will then be displayed in a reduced window.

Please note: Some websites cannot be simplified for
technical reasons. You will be informed if this is the case
via a message in the Web Collector window.

If required adjust further options such as font type,4.
font size, and margin. This is particularly important if
you want to import the website as a pdf document
later.
Assign a name to the document. This name will later5.
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be inherited in the MAXQDA project.
If required, you can fill in a text in the “Document6.
Memo” box. This text will later be connected to the
imported document as a document memo.
Click7.

The MAXQDA Web Collector informs you about the
progress und saves the website in the selected download
folder of your browser. By default, it is download folder
of the logged in user. Websites that has been saved this
way can be imported into MAXQDA as a pdf or text
document.

Saving segments of a web page

In case you are only interested in a certain segment of a
website there is a possibility to save single units of a
website.

Highlight the segment you are interested in with your●

mouse.
Right-click the highlighted segment and choose Collect●

selection.

The highlighted segment will be downloaded
immediately. It will be saved in your selected download
folder.

Segments that have been saved this way can be imported
into MAXQDA as a pdf or text document.

Copyright notice: the MAXQDA Web Collector uses
“Single File”, a Chrome extension created by Gildas
Lormeau.

Importing web pages into MAXQDA with the
Web Collector

You can import a saved web page into your MAXQDA
project by following these steps:

Open the MAXQDA project you want to import the1.
saved websites in.
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Mark a document group in the “list of documents” in2.
order to import the website in a selected document
group.
Select Import > Web Collector Data in the main menu.3.

Import Web Collector data from the Import tab

The following dialog window will appear:

Dialog window for the import of documents that have been saved with the Web Collector

If you open the dialog for the first time MAXQDA1.
selects the standard folder for downloads and displays
it at the top of the box. Every single website located in
this folder will be listed in the center of the dialog. By
clicking the three dots … you can choose any other
folder to import saved websites from the MAXQDA
Web Collector.
Select every website you want to import with the2.
mouse. It will be highlighted green.

Tip: Double click a row to open the downloaded file in
the Internet browser. This allows you to check single
websites for their content.

Two options are provided at the bottom of the dialog:3.
first, you can select whether websites should be
imported as pdf or picture documents. Second, you
can select whether simplified websites or segments
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should be imported as pdf or text documents.

In order to start the import, click Import selected files.
The time for import can vary depending on the scope
and format of the selected document. A progress bar
informs you about the import progress of each
document.

In case you selected pdf or picture format and you want
to import big files, MAXQDA asks you whether you want
to import them as externally saved files or in the project
(see External Files).

Please note: The main layout will be adopted in the
import process. The website’s changed print layout won’t
be intentionally not imported. Deviations from the
website’s original layout might occur especially as far as
complex websites are concerned.

Direct imports from wep pages in HTML-Format

You can also import an HTML file directly into1.
MAXQDA. To do this, go to the Import tab and select
In the dialog box that appears, select the HTML file.
MAXQDA imports the file as a text document and2.
includes images, if they were linked correctly in the
HTML file.

Please note: If you use the direct import of web pages in
HTML format, web pages are imported as text
documents (and not as web pages). The layout can
change a lot during the import, which is why the version
of the import with the Web Collector from MAXQDA is
clearly preferable. The direct HTML import is particularly
suitable for simply structured and laid out data.

Bibliographic Data (Endnote,
Zotero etc.)
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What type of literature can be imported into
MAXQDA?

MAXQDA offers the possibility to import bibliographic
data from literature management programs such as
Endnote, Mendeley, Citavi and Zotero in order to
conduct literature reviews or to review the state of
research in literature. Such programs are mainly used in
the scientific field for literature work, which means that
they primarily serve the administration of literature
references and the creation of literature lists and support
the creation of scientific texts. Similar to MAXQDA, the
literature management programs work with projects,
which are containers containing all collected
bibliographic information. The units of the projects
consist of literature references (author, title, etc.), for
which digital versions of the full texts in PDF format are
often stored as attachments.

MAXQDA is compatible with all literature management
programs that are able to export their literature
databases in RIS format, which is a standard format for
bibliographic information. With the following programs it
is possible to import the assigned full texts into MAXQDA
in addition to the literature references:

Endnote●

Mendeley●

Zotero●

When importing into MAXQDA, each literature entry
becomes its own text document. If full texts are
imported, MAXQDA automatically connects them to the
literature entries using the document link. The individual
information in the literature entries is automatically
coded for later analysis so that, for example, all titles or
abstracts can be compiled and searched. The
attachements can be automatically coded during the
import with the keywords assigned to them and the
notes for a literature entry can be saved as a document
memo with the corresponding appendix.
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Literature import in MAXQDA

Remarks on the RIS format

RIS is the short form for "Research Information System
Format". RIS files are simple text files in which all
exported literature entries are listed one after the other.
The RIS files contain so called " tags ", which consist of
two letters and are followed by the corresponding
information. Important tags are for example:

TY – Type of reference, always marks the beginning of a
new entry

ID – Unique identification number for each entry

AU – Author

TI – Title

PY – Publication date

ER – Closes entry, always located at end of entry

A detailed description of all RIS format tags can be found
on Wikipedia under
http://en.wikipedia.org/wiki/RIS_(file_format). An
example of RIS source data is listed below:

TY - BOOK
AU - McLuhan, Marshall

http://en.wikipedia.org/wiki/RIS_(file_format)
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AU - Fiore, Quentin
TI - The medium is the message
PY - 1967
CY - New York
PB - Bantam Books
ER -

Importing literature data from Endnote,
Mendeley or Zotero

Before importing literature data into MAXQDA, you must
export the desired data from your literature management
program in the RIS format.

Export from Endnote

Export options Endnote

Select the literature entries you want to export.1.
Select File > Export... from the main menu.2.
Enter a file name and select a directory.3.
Set the file type to "Text Only" and the output style to4.
"RefMan (RIS) Export" as shown in the following
picture. If this output style is not available, open the
selection list and select "Select Another Style..." at the
top, where you can search for the output style.
Click Save5.

Export from Zotero
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Export options Zotero

Right-click on a collection and choose Export1.
Collection... Alternatively, choose File > Export
Library... from the main menu to export the entire
library.
In the appearing dialog select "RIS" as format.2.
If you want to export the notes and the associated3.
files (especially the full texts), make sure to check the
corresponding boxes for Export Notes and Export Files.
After clicking OK, assign a file name and select a4.
directory.
Click Save5.

Starting the Import in MAXQDA

After you have exported the desired data, select Import >
Reference Manager Data > Import from
Endnote/Mendeley/Zotero in MAXQDA. The following
dialog appears:

Import literature from Endnote
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Click Select File... to select the exported file in RIS format.
This file has either the extension RIS (Mendeley / Zotero)
or TXT (Endnote).

MAXQDA analyzes the file and shows you various
options for importing it. First you can choose if you want
to import the references as well as the attachments (full
texts) or only one of them.

Tip: MAXQDA checks by author, year, title and
publication type which bibliographical references and
which attachments already exist in the project file and
indicates in brackets how much new data is added by the
import. MAXQDA only imports new entries so that no
duplicates are created.

For the import of attachements the following options are
available:

Only PDF files - Select this option to ignore all other file
formats such as Word documents when importing
appendices.

Autocode keywords - By setting this option, a small area
with all keywords contained in the literature reference is
coded at the beginning of each attachment. This makes
it easy to select full texts based on the keywords assigned
to them. Please note that the keywords contained in a
literature reference do not necessarily have to match the
keywords actually assigned in the text by the authors.

Add notes as document memos - If this option is
enabled, all notes for a literature reference are added as
document memos in the "Document System". The tag
N1 of the RIS format is evaluated for the notes.

Store attachments in folder for external files - If this
option is disabled, all PDF and image files will be copied
to the MAXQDA project file. This is usually recommended
if there are only a few or small attachments. If this option
is enabled, PDF and image files will be saved in the
External Files folder, so the project file itself will remain
very small. Here you can find more information about
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externally stored files.

If you want to import attachments from Endnote, you
have to click on Select file... at the bottom of the dialog
to tell MAXQDA where the Endnote library from which
you exported the data is located in your file system. This
is necessary for MAXQDA to know where the
attachements are located. The Endnote library has the file
extension ENL.

By clicking OK the import process is started.

Import bibliographic data from other programs

If you neither use Endnote, Mendeley nor Zotero, you
can still import a RIS file with bibliographic information.
Export all desired references from your program in RIS
format.

Tip: You can also export search results in RIS format from
an online journal or catalogue, for example to analyse
how the thematic focus of a journal's titles has changed
over the years.

Switch to the tab Import in MAXQDA and select the
entry Reference Manager Data > Import Bibliographic
Data from RIS File. A short explanation window will
appear and then a selection dialog which lists only files
with the endings RIS or TXT. Select the exported file and
confirm your selection with OK.

Please note: When using this import option, no
attachments (full texts) are imported.

What happens during the import?

A document group "REFERENCES" is created in the●

"Document System".
All literature entries are added to the newly created●

document group as individual text documents. The
entries are sorted alphabetically and marked with their

https://m22.maxqda.com/help-mx20/import/external-files
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own symbols.
The document name consists of the surnames and first●

names of the authors as well as the year. In the case of
two authors these are linked with "&", in the case of
three or more authors only the first author is
mentioned and "et al." is added.
In the "Code System" a code "REFERENCES" with the●

two subcodes "RIS" and "KEYWORDS" is generated.
The code "RIS" contains all RIS tags used in the import
file as subcodes, e.g. "Type of reference" or
"Abstract". The code "KEYWORDS" contains all
keywords assigned in the literature references as
subcodes.
When importing, all references are automatically coded●

by coding each text section with the corresponding RIS
code.
Each keyword in the literature reference is coded with●

the corresponding keyword in the code system.
DOI links are inserted into the text as hyperlinks, so that●

you can access the online version of a publication
directly if required.

If attachements are imported, the following will also
happen:

A document group "REFERENCES > ATTACHMENTS" is●

created in the "Document System".
All attachments are imported into this document group●

as separate documents.
The documents retain their file names and are sorted in●

alphabetical ascending order of their references. The
sorting of the document names is therefore not
necessarily alphabetical and the same document names
may occur, e.g. if there are several documents with
"Table of Contents".

And in case references and attachments are imported:

In addition, document links are created, which link the●

literature reference with the corresponding
attachments, so that you can jump back and forth
between literature reference and full text with a single
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click. In the literature reference, the document link can
be found in the "Link to PDF (L1)" section (the name
comes from the RIS format and also applies if it is a file
format other than PDF). In the appendix, the document
link is placed at the beginning of the document.

Adopting selected information as variables

The following variables are automatically assigned to
each newly created document when importing literature
data, including attachments if imported.

RIS_Type (Type of reference) – Text variable●

RIS_Author (First author) – Text variable●

RIS_Title (Title) – Text variable●

RIS_Reference-ID (Identification number of the entry in●

the literature database, is only exported by a few
programs, e.g. Endnote) – Integer
RIS_Year (Year of publication) – Integer●

The variables are created as system variables and cannot
be changed by the user.

Analyzing literature data in MAXQDA

After the import and the automatic pre-coding, the
bibliographic data and the corresponding full texts are
available in MAXQDA like normal documents. This means
that they can be searched, coded, linked and assigned
memos and are available for further analysis. Of course,
the Visual Tools and all other functions such as the
graphics and statistics functions can also be used. By
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importing the variable values, for example, only
documents of a certain type can be selected for analyses,
such as journal articles or anthology articles, or only
publications from a certain year.

Some initial ideas for the analysis:

Right-click on a keyword in the code system and select●

the function Activate Documents Containing this Code.
MAXQDA will then activate all literature entries and
attachments to which this keyword has been assigned.
Double click on "RIS > Abstract" to open all abstracts●

in the "Coded segments" overview. Start the Smart
Coding Tool by clicking on the symbol bearing the
same name in the toolbar to encode and systematize
the abstracts.
Activate the document group "REFERENCES" and●

activate the code "RIS > Title" to list all titles in the
"Retrieved Segments" window. Click on the Word
Cloud icon to start an analysis of the (most common)
words in the title.

Exporting bibliographic data in RIS format

Bibliographic data from a MAXQDA project can be
exported in RIS format for import into a reference
management program, for example. The export function
can be found in the Reports tab. Click on the Export icon
and select the Bibliographic Data as RIS File entry from
the menu.

After you have specified a saving directory, all documents
of the project that contain literature references (indicated
with a book symbol) are exported to a RIS file with UTF-8
encoding.
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Structured Documents
(Preprocessor)
What are structured texts?

Often you may wish to import documents that are
structured and pre-coded. Examples for this kind of
document include:

Forms: Here you would like to code each section with●

its respective heading for the field in the form.
Questionnaires filled in by the respondents in a●

structured text file: Here you may wish to code the
answers with their respective questions or instructions.
Asynchronous online discussions: that you have●

retrieved with online tools and already tagged.

The problem is similar in each case: before the actual
analysis has begun certain text sections have already
been allotted to specific form fields or similar. And you
would like to save yourself the effort of manually coding
each. To solve this problem, MAXQDA has the
preprocessor that allows you to split a text file into
several text documents during its import and to code
labeled text areas with one or more codes.

Import structured data with the preprocessor

The preprocessor lets you enter a large number of
documents into a single file and have them separated out
into different documents when imported into MAXQDA.
The syntax rules are as follows:

#TEXT textname this is the content of the 1st text...
#TEXTtextname this is the content of the 2nd text...
#TEXT textname...

Every document must start with the “#TEXT” and
“TEXT” must be written in capital letters.
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The name that you want to give to the document should
come immediately after the “#TEXT” without a space in
between. If you do not enter a name, MAXQDA will
automatically assign one when the document is
imported. The first imported document will be called
“Document nn,” and the following documents will be
named in sequential order in the “Document System.”
This automatic numbering is useful when, for example,
you enter the answers to open questions in a partly
standardized survey. The answers must then simply be
entered in the order of the standardized data in the SPSS
file. It is not necessary to enter a name for each text.
Both texts will have the same name.

Document names are handled by MAXQDA as follows.
You can enter any kind of string (up to 63 characters) as
a document name – spaces are also allowed. If you enter
a document name with more than 63 characters,
MAXQDA will truncate it automatically. Once the
document has been imported into MAXQDA, you can
change the name to include up to 64 characters.

Example

In the example project, various interviewees were asked
about their level of satisfaction with various aspects of
their life. Their answers were transcribed and imported as
Word documents.

The resulting Word file appears as follows:

#TEXT 4(26,f,0k,sin)
I've gained too much weight over the last several years and I
don't seem to be doing anything to get rid of it. I have high
cholesterol levels, but I don't attempt to change my eating
habits. I'd like to jolt myself into becoming more physically
active, so I can lose the weight and feel more energetic. I keep
saying I'm going to do something about it, soon.
#TEXT 3(34,f,2k,mar)
Overall I am pretty happy with my mental, social and physical
health. I would like to improve my dedication to working out.
I am the type of person who will work out 5 times a week for
a month straight and then is slowly turns into less days a week
until it is none. I get distracted by school work, my job or just
being tired.
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After each #TEXT entry is the name being given to the
document. For the purposes of this project, it made sense
to assign a number for each of the interviewees in
addition to some basic information about that person,
including age, gender, number of kids, and marriage
status.

The Word file was then saved with the name
“HealthSatisfaction” in RTF or DOC/X format. It could
then be imported by going to the Import tab and
selecting Structured Text.

Tip: MAXQDA automatically creates a new document
group in the „Document System“ during import and
inserts all texts into this document group.

All texts will appear in the “Document System” after
being successfully imported. The documents are named
as previously specified followed by #TEXT as an
identifying agent. In the above example, the document
name consists only of a text number and the personal
data indicated in parentheses.

Documents after being imported with the Preprocessor

Pre-coding text segments during import

The document is then imported, separating out each
individual document and assigning the given name for
each in the “Document System” from the original RTF
document.

In this way, it is possible to very quickly import and
separate out many different documents formerly
contained in a single file. The Preprocessor is able to do
significantly more than this simple action, however. In
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many cases, you will already be able to code aspects of
the document, and the Preprocessor can do that
automatically during the import. To do so, you simply
need to use additional syntax words.

For each section of the document that is to be coded,
you simply need to type “#CODE” before and
“#ENDCODE” after. In the case of a standardized survey
or questionnaire, you could, for example, code each
answer with the question number that it connects to.
The answer to the first question, then, could be coded
with the code “Question1” as is shown below.

#TEXTinterviewee1
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
 
#TEXTinterviewee 2
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
…
Important: It is important to remember that “CODE” is
written in capital letters.

To avoid typos when entering “CODEquestion1,” it is
possible to simply use a place holder, such as “§1” for
the first question, “§2” for the second, etc. You can then
later do an automatic search and replace, finding all
instances of “§” and automatically replacing it with
“CODEquestion.” This can save you a lot of time in
addition to helping you avoid typos.

It is also possible to define and code with a subcode in a
document prepared for the Preprocessor. To do so, use
the following syntax:
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#CODE CodenameSubcodename

You are giving the complete information about the
subcode, including its name and the code it is a subcode
of. The code and subcode are separated by a “” symbol,
but no spaces. As with any codes used in a document
imported with the Preprocessor, MAXQDA will first check
whether the code already exists, and if it does not, it will
be created.

Important: As soon as “#CODE” appears in the text, the
new code will be used, automatically ending the coded
segment of the previous code.

Text excerpts, as well as full paragraphs, can be pre-
coded with the help of the preprocessor during import,
as shown by the following example:

#TEXTtextname
Here is a text. Encoding begins here with #CODECode
1Subcode#. In the next sentence it ends with
#ENDCODE# in the middle
#CODECode 2
Here is another text. The encoding ends here
#ENDCODE# in the middle of the text.…

For a preliminary encoding of keywords from various text
excerpts, the following rules apply:

When the keywords #CODE or #ENDCODE appear●

alone in a row, it is not necessary to insert # at the end.
If these keywords appear within a text, or at the end of
a line of text, they must be enclosed with #.
It is not possible to “layer” encodings. When a new●

#CODE# command comes before an #ENDCODE#
command, the previous code is automatically closed.

Tip: To assign several codes to a text part you can
combine the codes with two “&&” characters, e.g.
#CODEFirst code && Second code && Third code

Mark participants of a focus group

If you use the tag #SPEAKER inside a text section,
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MAXQDA will import the text as a focus group transcript
and will code the text after the tag with a speaker code.
The tag #ENDSPEAKER closes the speaker coding. The
tag may be inserted within a sentence, but then a # has
to be added after the name of the speaker.

#TEXTFocus group 1
 
#SPEAKERModerator
A warmly welcome to our session …
#ENDSPEAKER
 
#SPEAKERParticipant 1
#CODETheme 1
I have the following opinion
#ENDCODE
#ENDSPEAKER

This function is very interesting for exporting data that
have been collected online with the tool
http://www.kernwert.com.

MAXApp Projects
MAXApp is a free app for iOS and Android that allows
you to collect data from fieldwork (photos, sound
recordings, videos, texts). The data can then be exported
later via Dropbox or by a connection to a computer and
then imported into an open MAXQDA project. The
documents are imported into a new document group,
including their respective memos, codings, emoticodes
and geographic data, if available.

Exporting projects from MAXApp

Open the project you want to export in MAXApp.

Android

Export the project via Dropbox or via the memory of the
device. For the last option you need to connect your

http://www.kernwert.com
https://m22.maxqda.com/products/maxqda-app
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device with a USB cable to your computer.

For detailed information about exporting projects from
MAXApp for Android, please refer to this link.

iOS

Export the project via Dropbox or via iTunes. For iTunes
export you need to connect your device with your
computer first.].

For detailed information about exporting projects from
MAXApp for iOS, please refer to this link.

Importing projects into MAXQDA

To import data from a MAXApp project into an open
MAXQDA project, follow these steps:

Go to the Import tab and click the MAXApp Project1.

A dialog window will appear in which you can select2.
either a ZIP file or an XML file. Open the folder where
the exported MAXApp project is saved. For a Dropbox
exports, a folder for MAXApp projects will have been
saved in your dropbox.
Open the ZIP or XML file inside the folder that is3.
labeled with the project name and choose Open.
Import the MAXApp project4.

The documents will be imported into your project and
placed in a new document group that is named exactly
like your MAXApp project.

https://m22.maxqda.com/help-mx20/24-maxapp/maxapp-for-android
https://m22.maxqda.com/help-mx20/24-maxapp/maxapp-for-ios
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03 - Viewing and Editing Data

View Documents
To view and edit a document, it must be open. MAXQDA will automatically open the
most recently imported document. To open a specific document in MAXQDA, you can:

double-click on the document in the “Document System,” or●

right-click on the document in the “Document System” and choose Open document.●

The document is then opened in the “Document Browser”, and the icon next to the
name of the document in the “Document System” changes from a sheet of paper to a
sheet of paper with a pencil on it.

You can now begin to work with the document in the “Document Browser”. You can
code document or picture segments, attach memos, link segments, insert external
links, edit text, or add new text.

"Document Browser" setup

The "Document Browser" window has the following setup:
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“Document Browser“ window setup

The window title displays the name of the open project and on the right there are
some icons for controlling the display, for printing, for exporting and for searching.
The coding bar is located directly underneath it, with which you can code the
document. Coded segments in the document are visualized in the gray side area with
so-called "coding strips". In the memo column, you can attach yellow memos with
notes on the data.

For texts, as shown in the example, there is a column with paragraph numbers
immediately to the left of the text, and each paragraph that is not empty receives a
consecutive number in MAXQDA. You can use these numbers as sources for citations
from the material.

Opening and viewing two documents windows

In MAXQDA's Document Browser you can only open and edit one document. But you
can still open two documents simultaneously, each in in a separate document browser.
This is helpful notably for conducting literature reviews: Open a publication as a PDF in
one window and code thematically, directly from the document. You can
simultaneously open and code a text document in which you have made your notes in
the second window.

To open a document in its own document browser, right-click on the document in the
“Document System” and select and select the option Open document in second
Document Browser. The second document browser will open and display the selected
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document.

Open document in second Document Browser

What are the rules for working with the second document browser? The following
functionalities will make your work easier:

Document links

When you click on a document link within a document, it will open in a second●

document browser, while the original document or section remains displayed. This
allows you to view both linked document sections at the same time. You can find
further information on document links here. 

Coding and coding stripes

The drop-down “Code” toolbar is always displayed in the first document browser.●

The second document browser will display its own Code toolbar.

If the same document is displayed in both the document browsers, newly added●

codes are displayed immediately in both browsers after they are created; the display
is thus synchronized.
The filter settings for the displayed coding stripes are saved separately for each●

document browser. In this way, you can display, for example, only red coding stripes
in one document browser, and only coding stripes by a specific author in the other
document browser. Once you close the second document browser, the selection of
the coding stripes is reset: that is, the next time you open the second document
browser, all coding stripes will be turned on and visible (of course, only if they were
created while coding the document.)

https://m22.maxqda.com/help-mx20/links/document-links
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Jump from segments to the “Retrieved Segments” window and Overview
of Coded Segments

Clicking on the source data in the "Retrieved Segments" window always brings up●

the selected segment in the standard document browser, not in the new second
document browser. The same is true for browsing the segments in the "Overview of
Coded Segments".

Editing documents

In the second document browser, you can switch to edit mode at any time by●

clicking the Edit button, to make changes to the document. Please note that
only one of the two open documents can be in Edit mode at a time.

Please note: If the same document is open in both MAXQDA document browsers, it is
not possible to edit the document.

Opening documents in tabs

MAXQDA includes the option of opening more than one document in the “Document
Browser” at once, each opened in a separate tab. This allows you to switch quickly
back and forth between documents. Once you have opened documents in tabs, you
can switch to any of them by clicking on the appropriate tab at the top of the
“Document Browser”. Documents can be opened in tabs by holding the Shift key and
double-clicking on the document or by right-clicking on the document and selecting
Open in a new tab.

Once a document has been opened in this way, tabs will appear at the top of the
“Document Browser” with the names of each of the documents open. You can switch
between the documents by clicking once on the appropriate tab. The tabs can be
closed individually.

If tabs are already open, a document opened in the normal fashion from the
“Document System” will appear in the currently selected tab in the “Document
Browser”.

Tip: To open all documents in a document group in tabs, drag the document group
into the Document Browser with the left mouse button, then release.

In the local preferences of the "Document System" window, you can set that
documents are opened in a new tab by default. To do this, click on the gear in the
upper right corner of the toolbar and select the option Open documents in tabs.
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Open documents in tabs

Edit Text Documents and Tables
Text documents and tables can’t be modified after you open them in the "Document
Browser”, to prevent unintentional changes to the document during your analysis.
However, you can open a document in Edit Mode at any time, which allows you to
adapt the text, for example, to correct a typo or error. You also need to activate Edit
Mode to create a new text in MAXQDA.

To turn on Edit Mode:

Click on the Edit Mode icon in the Document Browser toolbar as in the image below.●

Alternatively, you can also use the shortcuts Strg+E (Windows) or cmd+option/alt+E●

(Mac).

Turn Edit Mode on/off

For text documents, the usual text formatting functions such as font size and size are
available in Edit Mode. A separate formatting toolbar will appear below the coding
toolbar.

Formatting toolbar for text documents

You can edit both the content and presentation of texts in table documents.
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Note: It is not possible to edit contents of a PDF, an image, an audio file or a video file
within MAXQDA.

Saving text edits

The changes made in Edit Mode are transferred to the MAXQDA project file when the
Edit mode is closed. The modified text is saved every 5 minutes as you go. You can set
this backup interval in the global settings of MAXQDA, which can be opened via the
gear symbol  on the top right of your MAXQDA window.

Set the interval for Autosave in Edit Mode

Undoing text changes

You can undo changes made in Edit Mode- this works in the same way as in Word.
For example, if you delete or reinsert a text passage, you can undo all these steps. You
can do this either by right-clicking the context menu in the "Document Browser" and
selecting the Undo Text Changes option.

Alternatively, you click on the symbol in the toolbar: 

With the 'Undo All Text Changes' option, you can undo all the changes made since
you last opened Edit Mode with one click.

Line Numbers in Text Documents
By default, when importing a text into MAXQDA, all paragraphs are sequentially
numbered so that you can use them to cite the data material. This is sufficient in most
cases for the accuracy of the citation. However, sometimes it is desirable to use line
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numbering instead of paragraph numbering for the citation.

Therefore, MAXQDA allows you to switch back and forth between paragraph and line
numbering: Right-click in the text and select Convert to Line Numbered Text.

Option for converting paragraph numbered text to line numbered text

In the following dialog box, the desired width of the text can be set in characters, e.g.
60 characters, 80 characters, etc.

Set max. line length

The result is a line-numbered text with a fixed number of characters per line and a
paragraph mark at the end of the line.
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Text with line numbers

You can switch back to a paragraph numbered text at all times. To do this, right-click
in the text and select Convert to Paragraph Numbered Text.

Please note: MAXQDA uses soft returns (Shift+Return) for line numbering. When
switching back to paragraph numbering, these are replaced by regular paragraphs
(Returns). If a text contains soft returns before the conversion to line numbering, the
paragraph numbering can be different than before the line numbering. MAXQDA
informs you before converting to line numbering if a text contains soft line breaks.

Rename and Delete Documents
Document groups, document sets, and individual documents can be renamed at any
point. Simply right-click on any of these objects and select the appropriate entry from
the context menu. It is not recommended that you have more than one document
with the same name. It is possible, but it can be very confusing.

Right-clicking on documents opens the context menu, giving you the option Delete
document, which also deletes the coded segments, memos, and links associated with
it. In the context menu for a document group, you also have the Delete document
group option, which deletes all the documents in a group in one single action.
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Context menu for a document

The Document Properties Window
If you right-click on a document in the “Document System” or "Data Editor for
Document Variables" and select  Properties, the following window will appear,
which lets you view and change certain settings for that document:

Document properties window

Read-only – if this box is checked, the document will no longer be editable, even in
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Edit Mode. This is the default setting for PDFs and Image files.

External Document – If this box is checked, it means that the document is not actually
part of the MAXQDA project file. Instead it has been copied into the folder for
externally-linked files. In this case, the file name is also indicated under Original
Path. To import an externally stored document into the MAXQDA project file, click on
the Embed external document button.

Media file – If you want to link a document to an audio or video file, you can insert the
path to that document in this field. To do so, click on the line, then the button with
the three dots at the end of the line…

External link 1/2/3 – To create a link to a file that is accessible from your computer and
contains, for example, additional information about the interviewee or image, click in
the line for the external links and then click the three points at the end of the line.

Assign a Color to a Document
You have the option of assigning a color to each of your documents. This color is then
used in all tables and visualizations, including in MAXMaps. For example, you can use
color attributes to indicate the processing status of a document or to make other
features, such as the interviewer or the location, visible.

To assign a color, right-click on the document and select Color from the context menu
that appears.
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Choose a color in the context menu

Click on one of the standard colors it will be displayed on the document symbol. Click
the icons to the right of the color squares to select your own colors.

Note: If you select MAXQDA's default color blue, no colored square will appear on the
document icon.

The color attributes of the documents are listed by default in the first column of the
"Data editor for document variables" and the "Document overview". Since each
column can be used as a sorting criterion, overviews can also be sorted according to
color. Documents with the same color will then be listed one after the other regardless
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of the document group to which they are assigned.

MAXMaps, MAXQDA's tool for concept maps and modelling, also includes the color
attributes of the documents: The document symbol is displayed in its color.
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04 - Codes

The "Code System"
Codes have a hierarchical structure, meaning you can create multiple subcodes,
followed by subcodes of subcodes. All of the codes are shown in the “Code System”
window.

At the beginning of a project, this window is empty except for the “Code System” and
“Sets” icons and their associated icons.

MAXQDA’s “Code System” has the following characteristics:

A code is a text with a maximum of 63 characters consisting of one or more words.●

A code can contain empty spaces and special characters.
The number of codes in unlimited.●

The hierarchical structure can contain up to ten levels.●

Codes can be assigned a color.●

The so-called color codes play a special role. They are like text markers and change●

the background color of the marked text.
emoticodes also play a specific role. An emoticon symbol appears in the “Code●

System” in the place of the code symbol, with pre-defined names that can be
changed.
Beginning with MAXQDA 12, there are also special codes for the participants of a●

focus group. These codes can be identified by this icon . These codes can perform
special functions.

Working with coded segments (of text, images and videos) and the “Code System” is
a central aspect of computer-supported analysis. This work is usually not done
automatically by the software, but rather is controlled by the researcher, although this
often requires a significant amount of time. The “Code System” is shown as a tree
structure on the screen. It looks like the file/folder system in Windows Explorer or Mac
Finder with which you are likely familiar. A plus or minus sign before the code name
indicates whether or not a code contains subcodes. You can expand or close the sub-
categories by clicking this button.
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Hide subcodes

You can click on the triangle symbol before the code to reveal or hide its subcodes.

Tip: With the function Collapse all subcodes, which is accessible from the context
menu of the top level of the “Code System”, you can conveniently collapse all codes
so only the top level codes will be visible.

Using MAXMaps you can build a network structure of codes to be used during the
coding process, meaning you can code selected segments within a document and
code them by dragging them onto a code in the network map.

The “Code System” toolbar

The following frequently-used functions for codes can be selected in the toolbar at the
top of the "Code System" window:

  Reset activations – resets current code activations.

Display codes in activated documents only- reduces the display in the “Code
System” window to codes that have been assigned to at least one of the activated
documents.

https://m22.maxqda.com/help-mx20/maxmaps
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  New code – adds new code into the code system.

  Display search toolbar – allows you to search for a specific code.

Settings - opens a dialog with locally relevant options (see below).

  Undock window

  Maximize window

  Hide window

In addition to using the toolbar to access functions in the “Code System,” you can
also use the context menus that appear when you right-click on various icons in the
window (e.g. on a code or the “Code System” icon, etc.).

Codes and Coding in MAXQDA
Coding parts (or "segments") of a document is one of the core functions of
MAXQDA. Coding is the process of assigning one or more codes to a segment that
you have selected with your mouse in the "Document Browser". This process allows
you to, for example, conduct a systematic qualitative content analysis.

So, what is a "code", exactly? Libraries have always used keyword catalogs, and
researchers in the social sciences should also be familiar with the use of “categories”,
for example from the grounded theory approach or from content analyses. Other
synonyms are "keyword" or "label". What the code represents depends on the task
and the given situation. Broadly speaking, however, a code is a tool for identifying the
content of a document, perhaps classifying it, and making it easier to find it again.
Codes create order – this can be illustrated by the example of the keyword catalog.
These catalogs help you find the right book and at the same time provide an overview
of the topics on which the library has many or just a few books. Of course, how useful
such a catalog is will depend on the complexity and usability of the index system and
on the accuracy of the keywords used.

In technical terms, a code in MAXQDA is a text of up to 63 characters. Codes are like
card index boxes that contain index cards to which text passages, parts of images, or
video segments are attached and on which a category name is written at the top. The
name of a code is like a label that acts as a tab in the index box. This label can be
easily changed without affecting the structure of the index box or the index cards
themselves.
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Create a New Code
The word “Code System” at the top of the list represents the root of your system of
codes (or hierarchical "Code Tree"). You can gradually build up a system of categories
from this point.

Adding codes at the top level of your "Code System"

In order to insert a code at the top level, click on the green plus sign that appears
when you move the mouse over the first line of the code system:

Creating a new code using the green plus sign

Alternatively, you can use the following options to create a new code at the top level:

If no code exists in the "Code System! or if the first line is marked with the word1.
"Code System", you can click on the New code  icon in the toolbar of the "Code
System". The Alt+N (Windows) or cmd+option+N keyboard shortcut (Mac) will also
generate a new code at the top level.
Right-click the word "Code System" in the top line and select New Code from the2.
context menu.

No matter which way you choose, the following dialog box for code definition will
always appear:
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Dialog box to enter a new code

Type the name of the new code into the text field in the upper part of the window
(MAXQDA allows a length of 63 characters for a code name). You can select a color
attribute for the new code below.

If you select the option Use as the default color for new codes, all newly created codes
in the project will use this chosen Color. Of course, you can change this default color
each time you create a new code using this dialog.

Click OK to create the new code and close the window. If on the other hand, you click
on Add Code, the window remains open and you can define further codes at the top
level.

Adding subcodes

If you want to define subcodes, click on the green plus sign that appears when you
move the mouse over the desired parent code:
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Creating a new subcode using the green plus sign at the parent code

Alternatively, you can right-click a code and select New Code from the context menu.
You can also create a new code using the Alt+N (Windows) or cmd+option+N
keyboard shortcut (Mac) or the New code icon in the toolbar. Note, however, that
the blue focus must be on the code for which you want to create a subcode.

If a check mark is placed in the option Use color of parent code when defining
subcodes, the color of the upper code is assigned to this newly defined subcode. In
the text field "Code memo" you can enter a comment to this code, e.g. the definition
of the code. After closing the dialog box, you can - if you have entered something in
the field "Code memo" - recognize the symbol for a code memo next to the newly
defined code.

Newly added subcodes with memo symbol

Please note: Newly defined codes are always inserted at the top of the category system
in the "Code System" window. This applies to all levels of the hierarchy. If you prefer
to insert subcodes at the end of existing subcodes instead, the option Insert new
subcodes at the bottom can be selected in the local settings for the "Code System".
The local settings can be accessed by clicking on the Gear icon in the "Code System"
toolbar.
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Settings for the “Code System” window

Import Codes and Code Memos from Excel
MAXQDA can create a code system from the rows in an Excel spreadsheet. The
reading of a code system from a table is useful when you want to define multiple
codes in advance.

The first row of the table must include the keywords “Code” and “Memo”. Each
additional row corresponds to a new code and associated Memo. In the “Code”
column, you can define subcodes using a backslash "\".

Tip: To insert a backslash "\" on a Mac, press option+⇧+7.

To start the import, select the function Import Codes and Memos from Excel
Spreadsheet from the Codes tab.

Example

Code Memo
Codename 1 Here is a text, e.g. with the code definition
Codename 1Subcode 1.1 Here is a text with the code definition
Codename 2Subcode 2.1Subcode 2.1.1 Here is a text with the code definition

When importing a table, MAXQDA proceeds as follows:
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Unless they already exist in the MAXQDA project, five codes are created:1.
"Codename 1" and "Codename 2" are created at the top level. "Codename 1" is
assigned the subcode "Subcode 1.1" and "Codename 2" is assigned the subcode
"Subcode 2.1", which in turn is assigned the subcode "Subcode 2.1.1".
In addition, each newly inserted code is assigned the corresponding text from the2.
second column as a code memo.
Code names and subcode names are each shortened to 63 characters.3.

Edit Code Properties
You can right click on the name of any code and choose Properties in the drop-down
menu in order to open the Properties window:

Properties window for a code

In this Properties window, you can…

Change the name of the code (max. 63 characters available),●

Assign or adjust a Code Alias (max. 255 characters),●

Modify the code color,●

Assign a keyboard shortcut.●

Since the number of characters for a code is limited to 63, longer code designations
can be assigned as code aliases. For example, they may be exported instead of the
code names when using the Smart Publisher.

Assigning a color to a code

A color attribute can be assigned to each code or subcode. To do this, right-click on a

https://m22.maxqda.com/help-mx20/reports/smart-publisher
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code and click on one of the default colors in the context menu. The icons on the
right-hand side of the context menu allow you to define your own colors and list the
colors already used in the project.

Select a color for a code in this context menu

Tip: If you change the color of a parent code, MAXQDA asks if you want to apply the
Color to all the subcodes as well.

The color is visualized in the "Document Browser" and in visualizations created with
the Visual Tools. In the "Document Browser" the coding stripes are displayed in the
corresponding code color. This makes it easy to identify which segments are assigned
to a code.

Codes of various colors in the Code System

The color is also seen in the bottom right of the icon next to each code in the “Code
System”.
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Differently colored Codes

The color attribute is also displayed in all MAXQDA tables that contain codes, e.g. in
the “Overview of coded segments” table that is available for each document group
and each document. There, the color attribute may be used as a criterion for sorting
the table. This is done by clicking on the column header of the column containing the
colored icons. Unless you have changed the order of the table’s columns, this column
will be the first one in the table.

Color attribute in the first column of the “Overview of coded segments”

The color attribute plays an important role in all visual tools of MAXQDA. For instance,
the Document Portrait is based completely on the colors of the codes that are assigned
to a particular document. Thus, the selection of colors is an important step: colors
should be assigned according to the kind of analysis that you plan to conduct. For
instance, a psychologist could assign red colors to aggressive statements and green
colors to friendly statements. When analyzing documents in regard to the topics
mentioned a meaningful association of topics and codes is recommended. Thus, you
are able to identify topics and combinations of topics with one glance. When working
with focus groups, you should associate the speakers with the different colors, in order
to quickly find out when a person is speaking.
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Adding a code alias

Code names in MAXQDA can be 63 characters in length. However, it is sometimes
desirable to note a shorter or longer description in addition to the code name. This
allows you to employ an automatically generated report with selected coded
segments, for example in Smart Publisher.

To create a code alias for a code, right-click on the code in the Code System and select
“Properties”. This will open a window where you can enter a code alias, among other
options.

Creating a Code Alias in the “Code Properties” Window

Alternatively, you can click Code Alias Table in the Codes tab, which will generate a
table in which you can conveniently enter multiple code aliases, and view for which
codes an alias has already been assigned.

Code Alias Table

Edit the "Code System"
Moving codes

Changing the structure of the category system is not difficult. All codes can be moved

https://m22.maxqda.com/help-mx20/reports/smart-publisher
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with the mouse and the drag-and-drop function.

In the following example, the “Code System” contains four codes (A, B, C and D).

Moving codes with the mouse

To move Code D to the top of the list, you would need to do the following: Click on
Code D and drag it in front of Code A while holding down the left mouse button,
then, when a line appears, drop the code.

It is also easy to make a code a subcode of another code. If you want Code B to
become a subcode of Code A, for example, you would carry out the following actions:
Click on Code B, drag it to Code A, and release as soon as Code A has a green
background. Code B is then added as a subcode of Code A.

Move multiple codes

You can select multiple separate codes while holding down the Alt (Windows) or
option ⌥  (Mac) key and then move your selection while holding down the mouse
button. To select a range of codes, first click on a code and then click on a second
code while holding down the Shift key ⇧. This will then also select all codes between
the clicked codes.

Sorting subcodes

Subcode can be sorted in ascending and descending order by name and by frequency,
by right-clicking the parent code and selecting Subcodes... > Sort from the context
menu.

Adding a new top-level code

A common procedure when working with codes is to group previously defined codes
under a new, more abstract category, as shown in the next diagram:
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MAXQDA’s hierarchical “Code System” makes it easy to group existing codes under
new top-level codes. Reorganizing the “Code System” can be done at any time during
the analysis process:

Create a new code at the top level of the hierarchy ("new" in the example above).1.
Drag Code B to "new" and release it; it will be inserted as a subcode.2.
Do the same with Code D.3.

Creating a new code to hold to former codes as subcodes

Dividing a code into subcodes

Often when working with a code system, it is desirable to differentiate between
elements grouped under one code. In MAXQDA this corresponds to dividing a code
into two or more subcodes. For example, imagine you have created a code named
“Family” and have assigned document segments, in which an interviewee talks about
his family, to this code. Then imagine that it becomes necessary to differentiate
between “Mother”, “Father”, and “Siblings”.
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This differentiation of a category does not work automatically, but requires that each
segment previously coded under "Family" is re-read by the researchers and assigned
to one of the three new subcategories. This can be done particularly conveniently in
the Smart Coding Tool, which was specifically designed for this purpose.

Codes can be divided as follows:

Activate all documents and the code “Family.”1.
Create three subcodes for “Family”: “Mother,” “Father,” and “Siblings.” Only the2.
code to be differentiated, in this case "Family", should still be activated, but not the
three new subcategories, in order to be able to carry out the reassignment
conveniently.

Splitting up a code

Start with the first segment in the "Retrieved Segments" window and decide to3.
which of the three subcodes this segment is to be assigned.
Click on the coding strip to the left of the segment and move it to the selected4.
subcode while holding down the left mouse button. During this process, the
segment is moved to the selected subcode, i.e. the coding with the parent code is
deleted immediately.

Tip: If you hold down the Ctrl key (Windows) or the command ⌘ key (Mac) during this
operation, the encoding is copied from the source code to the target code and
remains in the parent code.

This is how you can work with all segments, so you continue in the same manner for

https://m22.maxqda.com/help-mx20/05-coding/smart-coding-tool
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the second. When you get to the end of the list, all segments will have been re-
classified - they have been assigned to one of the three codes in question.

Alternatively, you can click on the document name below a segment in the "Retrieved
Segments" window in step 4 to display the segment in the "Document Browser".
There you can code as usual, i.e. by clicking and dragging with the mouse and
assigning the desired subcode. With this procedure, however, the old codings in the
upper code are still retained, i.e. all segments still have the assignments to the code
"Family".

However, this is normally not the intention - the old encodings of the parent code
must be removed. You can double-click on the parent code to list its encodings in the
"Overview of Coded Segments", select all encodings and then remove them by
clicking on the delete symbol in the toolbar.

Merging Codes

It is often necessary to combine two or more codes that capture something similar in
the data material into a single code.

Merging two codes with the mouse

For two codes, this can be done very easily via drag & drop: Click on the code you
want to merge with another code and drag it to the highlighted word "Merge" that
appears to the right of the target code and release the mouse cursor on that word.
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Merging codes using the mouse

As soon as you release the mouse button on the word " Merge ", MAXQDA moves all
encodings of the source code into the target code and deletes the source code. In the
example, the coded segments of Code C are added to the segments already existing in
Code D. The code C is then deleted.

To indicate that the segments of another code were inserted into a code by fusion, a
plus sign in brackets "(+)" is added after the target code.

Please note: If you merge a code that has subcodes with another code, the subcodes
are attached to the target code. It is not possible to merge a parent code with one of
its subcodes.

Merging multiple codes using the context menu

You can also merge several codes at once at any time:

To select all codes you want to merge, hold down the Alt (Windows) or the option1.
⌥ (Mac) key and click on each code with the mouse button.
After that, right-click on the code into which all other codes are to be merged.2.
Select Merge Codes from the context menu that appears.3.

Code Memo behavior during mergers

In MAXQDA each code can have only one code memo, so the question arises what
happens with the code memos of the codes that are being merged:

If only one of the merged codes has a memo, it is attached to the remaining target●

code.
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If several codes have a memo, MAXQDA asks whether the memo texts should be●

combined at the target code or whether the memos should be converted into free
memos. Free memos are not directly assigned to any element in MAXQDA and can
be displayed e.g. via the Memos tab.

Copying subcodes

In some cases, you will be setting up the same subcodes for various codes. You might,
for example, have the codes “Childhood,” “Teenage Years,” and “Adult Life,” which
should each have the subcodes “Education,” “Family,” “Friends,” and “Memorable
Experiences.” So that you don’t have to create these four subcodes three times, you
have the option of setting them up for one of the main codes, copying its subcodes,
and pasting them into the other main codes. To do so, you would follow these steps:

Right-click on the code and select Subcodes... > Copy from the context menu.1.
Click on any other code and select Subcodes... > Paste from the context menu.2.

MAXQDA then adds the copied sub-codes in the same order as the original code. The
newly inserted sub-codes keep the Color previously assigned to them.

Delete Codes
Deleting a code from the “Code System” is somewhat like cutting off a branch from a
tree. By deleting that code, you are also deleting any subcodes, which are like smaller
branches attached to the bigger one you cut off. At the same time, all coded
segments that had been created with those codes are deleted.

The easiest way to delete codes is to go directly to the "Code System": Click on the
red X that appears as soon as you move the mouse over the line of the code to be
deleted.
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Delete code using the delete icon in the Code System

You can also right-click on the code to be deleted and select Delete Code or Delete
Code Incl. Subcodes from the context menu. Alternatively, you can also select a code
with the left mouse button and then press the Del key (Windows) or the Delete key
(Mac).

Deleting several codes at once

If you want to delete more than one code at a time, it is necessary to switch to the1.
table view of the “Code System.” To do so, click on the Change to table view icon
in the “Code System” toolbar.
You can now select as many codes as you wish by clicking on them while holding2.
the Ctrl key (Windows) or cmd key (Mac) and then right-clicking and selecting
Delete code(s) from the context menu. Codes can also be deleted in this manner in
the “Overview of Codes,” accessible via the Code menu or the content menu in the
“Document System”.
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Create Code Sets
With MAXQDA it is possible to store temporary combinations of codes as code sets.
This allows you to group the same codes in different ways or to make frequently used
codes available for coding. The code sets only contain references to existing codes, so
removing a code from a set has no further consequences.

To create a new code set, right-click on the word “Set” in the Code System, then
select New set.

Create a new code set in the “Code System”

After you enter a name for the set, you can drag and drop the desired codes into the
new set with the mouse. The codes can also be moved within the set or to another set
using the mouse.

Tip: If you activate codes before you creating a new code set, MAXQDA places the
activated codes directly into the new code set.
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Overview of Codes
It might be of interest to take a look at how many times each code was assigned to
individual, multiple, or all documents. Next to the visual display of the Code Matrix
Browser you can also open the Overview of Codes, which you can found in several
places in the program:

In the Reports tab,●

In the context menu at the root of the “Document System”,●

In the context menu of a Document Group or Document Set, or●

In the context menu of an individual document.●

https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
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Open the Overview of Codes in the context menu of a Document Group

A table view of all of the codes that occur in the relevant documents will appear. The
table may contain more or fewer lines depending on the place in the program from
which it was called up. In the title of the overview you can see which documents the
overview applies to and to how many (different) codes in the document a segment is
assigned.

Please note: When the “Overview of Codes” is opened in the Reports tabit contains
also codes to which no coded segment is assigned. Otherwise, only codes to which at
least one coded segment is assigned in the relevant document will be displayed.
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Overview of codes for all documents (see top left) with 21 codes (see top right)

The other columns consist of:

Code – the name of the code that appears in the “Code System”●

Parent code – Here the parent code is displayed for the easier assignment of codes. If●

the “Parent code” column is empty, the code in this row belongs to the top level of
the code system.
Coded segments of all documents – The number of segments in the analyzed●

documents that have been coded with a particular code or subcode.
Coded segments of activated documents – Takes only activated documents into●

account. If this column displays all zeros, then presumably because no documents
are selected. Once you can activate documents, you can directly observe how the
values in this column change.
% Coded segments of all documents – The share of segments that have been coded●

with the particular code or subcode, in relation to the total number of coded
segments in column "All coded segments". The sum of the column is 100%.
% Coded segments of activated documents – As in the “All coded segments %”●

column, but takes only activated documents into account.
Documents – Number of documents in which the code or subcode appears●

Code alias – Alternative name for a code with up to 255 characters, that e.g. may be●

exported in the Smart Publisher report instead of the code name itself.

Right-clicking a row opens a context menu with various options, you can open the
Overview of coded segments or Overview of linked memos, for example. You can also
change the color attribute of a code from this menu.

A toolbar is displayed above the “Overview of codes” from which the following special
functions can be accessed:
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 Aggregate on 1st level – Only the codes at the top level of the code system will be
displayed. Here, the code frequencies of the subcodes are added, as well as the
number of documents in which the code occurs.

 Statistics – Displays the values of the columns “All coded segments” and
“Activated coded segments” as a frequency table or chart. For more Information
regarding frequency tables and Charts see Frequency Tables and Charts for Subcodes

Transfer the "Code System" to Other
Project
It is possible to export an entire "Code System", and import it into another MAXQDA
project file. This function is especially useful as it allows you to build a “Code System”
in one project, then apply it to another. In this case, importing and exporting the
“Code System” eliminates the need to enter new codes.

To export your "Code System", go to the Codes tab and select Export Code System.

The “Code System” will be converted into a specific file format with the extension
MTR. You can then import the “Code System” into a new MAXQDA project with the
corresponding procedure Import Code System.

Please note: MAXQDA can also export and import the cross-software QDC format
(REFI QDA Codebook). You can select this format in the file dialog box when exporting
or importing.

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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05 - Coding

How to code
Assigning codes to segments of texts, images or video footage in MAXQDA is known
as “coding”.

You can code a document or document segment with as many codes as you want.
The technical limit for the number of coded segments per document is so high that it
usually has no practical significance. Moreover, coded segments can overlap, intersect,
or be completely contained within other coded segments.

Selecting the segment you want to code

The process of coding can be done in many different ways, but you always start by
selecting part of a text or an image in the "Document Browser” with your mouse. You
can see an example of a selected text passage in the “Document Browser” below:

A highlighted segment of text

Please note: The smallest part of a text that can be coded is a single character. In most
cases, you would want to code at least an entire word.

Coding texts and image segments in a PDF

You can select a text in a PDF as you would in a text document.

If you want to select an image in a PDF, e.g. because you want to analyze a scanned
PDF whose text cannot be converted into a “selectable” text using OCR (character
recognition), you can use the mouse to draw a frame. To do this, you only have to
start the welection process in an area that does not contain any selectable characters.
You can adjust the selected area later by clicking the corners and dragging them to a
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suitable size.

Highlighted text (above) and highlighted image segment (below) in a PDF

Selecting segments of images

In image files, you can drag a frame with the pressed mouse button in the same way
as in PDF documents. The edges of the frame can be adjusted later by clicking and
dragging the corners.

Selecting texts in tables

To select a text in a table, double-click the cell. As soon as the cell shows an orange
frame, you can select text in this cell with the mouse. You cannot select multiple cells
at the same time.

Selecting segments of videos

Videos are analyzed and coded in a separate window, the "Multimedia Browser". In
the Coding Videos section, you'll find detailed explanations for how to code videos.

Code the selected text with your mouse

The simplest way to code in MAXQDA is to drag and drop a selected text or image

https://m22.maxqda.com/help-max18/05-coding/coding-video
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segment onto a code with your mouse.

Move the mouse to the area of the selected segment, press the left mouse button,
and move the mouse to the desired code in the "Code System". Here, release the
mouse button and “drop” the selected segment onto the code.

Coding via drag and drop

Tip: The same segment can also be assigned consecutively to several codes.

Alternatively, you can also do the reverse, that is, drag your desired code to the
selected segment and then release the mouse button.

Please note: MAXQDA makes sure that the same code is not assigned to the same
segment multiple times. Segments assigned with the same code will therefore never
overlap; they will turn into a single, larger coded segment.

Display Coded Segments in the "Code
System"
Information on if and how many coded segments are assigned to a specific code can
be found in the “Code System”. This information is displayed in the frequency column
to the right of the code name.

In the following figure, the number 14 appears after the code “Health”. This indicates
that up until this point, a total of 14 segments have been coded in this category.
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Information on the number of coded segments

When you "collapse" the subcodes of a code by clicking on the triangle symbol before
the code, the code frequencies of the subcodes are added to the frequencies of the
parent code. MAXQDA shows how many segments have been encoded with a
collapsed code including all its subcodes.

Options for displaying the frequencies in the "Code System".

For the "Code System" window, you can call up the local settings by clicking on the
gear next to the magnifying glass.
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Code System Preferences

At the top in the settings you can define the frequencies MAXQDA should output
after each code. You can choose between the following variants, each of which has a
different analytical information gain:

Selected option Analytical relevance

Coded segments in all
documents

How often was a code assigned in all documents?
This is the default option as described above, which is
always used automatically when opening a project.

Coded segments in all
activated documents

How often has a code been assigned in the currently
activated documents?
The numbers are automatically updated when you
activate or deactivate documents.

Coded segments in opened
document

How often has a code been assigned in the document
currently opened in the "Document Browser"?
Encodings in audio and video files are not taken into
account here.

Document groups
In how many document groups does a code occur?
It does not matter whether a code was assigned once or
several times in a document group.

Document sets
In how many document sets does a code occur?
It does not matter whether a code was assigned once or
several times in a document set.
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Documents
In how many documents does a code occur?
It does not matter whether a code was assigned once or
several times in a document.

If you deactivate the option Sum up frequencies of subcodes, MAXQDA always
outputs only the frequencies of the upper codes, regardless of whether the code is
collapsed or not.

Display Coded Segments in the Document
Browser
As soon as you have coded a document or image segment, a coding stripe appears in
the gray area next to the document in the “Document Browser”. Those visualizations
are called "coding stripes". Those "coding stripes" indicate where the document has
been coded. The standard is, that this visualization appears to the left of the
document. To place the "coding stripe" to the right of the document, you can select
"display coding stripes on the right" in the local settings. To view the local settings,
click on the gear next to the magnifying glass. The column for the coding stripes can
be made bigger or smaller by clicking on the separator between the column headers
and dragging to the right or left.

Visualization of coding stripes on the left side of the Document Browser

You can also choose whether code names should be permanently shown in the coding
stripe column or not. By right-clicking in the gray area of the column in the document
browser, you will call up a window with various setting options. One of those options
is to Display code names.

You will always be able to see the code name in the tooltip that appears if you hover
your mouse over the "coding stripe". The tooltip also shows you the assigned weight,
the author of the coded segment, the date that the segment was coded, and the last
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time it was edited.

Tooltip appearing from the coding stripe

This tooltip always displays the complete code name, with all its possibly existing
"parent codes". The permanent display next to the "coding stripe" is limited to the
lowest code level. In other words, the coding "Interests\Day-to-Day Issues" only "Day-
to-Day Issues" is displayed. The subcode can be idientified by the two preceeding dots.

If there are many coded segments, that overlap each other, it can also be difficult to
figure out exactly which codename belongs to which "coding stripe". This can be
immediately identified when you move the mouse over a "coding stripe", at which
moment the code name will appear brighter and the code assignment will be
displayed.

Coding stripe column visualization options

By right-clicking on an empty grey space in the "coding stripe" column, you can call
up a window with various settings for the visualization of coded segments in the
coding stripe column:
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Option menu for the visualization of coding stripes

Here you can adjust the following settings:

You can choose to only visualize activated codes.●

You can choose to visualize coded segments created by certain users.●

You can choose to only visualize coded segments of a certain color.●

You can choose whether to change the text color of the text in the document to●

match the color of the code it was coded with.
As mentioned before, you can choose whether the code name should be shown or●

not.
Finally, you can choose whether the tooltips should include the information about●

the author and date of creation.
Display or hide emoticodes.●

Permanently display coded Areas in images●
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The option to switch off codes with selected colors is particularly useful when you are
working in a team with independent coders. In this case, the coders should be defined
as codes on the highest level of the code hierarchy and the different coders should use
the same code tree organized as subcodes of the coders. Now, while the training the
coders, you can hide the visualization of other coders’ work. Later on, they can
compare their coding with the coding done by the others.

The option to color the text according to code colors only makes sense if you do not
have many overlapping codes. Overlapping codes cause the color of the text to be a
mix of those overlapping codes, which can make it very difficult to interpret.

Listing codes assigned to a segment

Often it's useful to determine which codes are assigned to a specific text or image
excerpt. To do this, select a text segment or image section and select List assigned
codes in the context menu.

Display assigned Codes

This will display a menu in which all assigned codes are listed. Click on an entry in the
list to highlight the code in the “Code System.”
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List of assigned codes for a segment

Further Ways of Coding
Beyond the classic coding technique of the drag and drop, MAXQDA offers several
other ways to code a selected segment:

Coding with newly defined (free) codes: As in Grounded Theory, a segment can be●

assigned a new (free) code.
In vivo coding: In-Vivo coding: Select and highlight meaningful terms in the texts and●

automatically add them as codes in your code system while coding the text segment
with the code.
Coding with selected codes from the Quick List: Documents are targeted based on●

the occurrence of one or more pre-selected codes, and coded where applicable.
Simultaneous coding with multiple codes: A segment is coded with the activated●

codes.
Coding with code favorites: Selected codes are displayed in a separate window, from●

which they can be easily applied to segments to be coded.
Coding with self-defined keyboard shortcuts: Up to nine codes can be assigned their●

own keyboard shortcut, which can be used to quickly code a marked-segment.
Coding with MAXMaps: Marked segments are dragged onto selected codes, which●

are arranged on a “map” or diagram.
Coding with the "Open Coding Mode": After selecting a segment, a window for●

creating and assigning a new (open) code appears automatically.
Highlight coding: This works like highlighting a text passage in a book with a colored●

text marker. In MAXQDA, five different colors can be used for color coding: red,
green, yellow, blue or magenta.
Coding with symbols and emoticons: Selected segments are coded with emoticodes,●

i.e. an emoticon or a symbol.
Coding in the "Retrieved Segments" window and "Overview of Coded Segments":●

Coded text passages can be compiled in a list. In these compiled segments you can
then select and code further text passages. For more information, see the section
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Coding in the "Retrieved Segments" window and the "Overview of Coded
Segments".

The following section describes in detail how these techniques are used. The different
options can be chosen from the context menu that pops up when you select a
document segment and click the right mouse button.

Context menu with coding functions for a selected segment.

1. Coding with newly defined codes

An easy way to create a new code, i.e. a code that is not yet listed in the “Code
System,” is to use the shortcut Ctrl+W (Windows) or cmd+option+W (Mac).
Alternatively, click on the selected segment with the right mouse button and choose
With new code or click the Code retrieved segments with a new code icon in the
"Document Browser" toolbar.

Coding toolbar in the Document Browser

A dialog window will open, and you can type in the name of the new code. The code
will be added to the “Code System” at the highest level of the hierarchy. If necessary,
you can later move the code to another level in the “Code System” with your mouse.

Tip: You can also define several new codes and assign them to the selected segment.
To do this, click the Additional code button in the dialog box.

2. Coding In vivo

Another way of coding is with the so-called in-vivo coding. If you, for example, select
the word “global village” and then click on the Code in-vivo symbol in the toolbar on

https://m22.maxqda.com/help-mx20/segment-retrieval/code-in-the-retrieved-segments-window-and-the-overview-coded-segments
https://m22.maxqda.com/help-mx20/segment-retrieval/code-in-the-retrieved-segments-window-and-the-overview-coded-segments
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the “Document Browser”, the word “global village” is added to the “Code System”
as the code for this short text segment. The shortcut Ctrl+I (Windows) or
cmd+option+I (Mac) has the same effect.

When you want to code a whole segment of text with the in-vivo coding function, and
not only one or two words, code the one or two words with this function first. Next,
select the entire text segment (including the word) and click Code highlighted
segment symbol (not the in-vivo coding button!). MAXQDA expands the coded
segment automatically.

3. Code with selected code in the Quick List

The “Code” toolbar provides quick access to frequently used coding functions. The
“Quick List” is located on the toolbar to the right of the Edit button. Whenever you
click on a code in the Code System, or when coding is in progress, the corresponding
code appears at the top of the Quick List. Click on the Code highlighted segment 
immediately to the right of the Quick List to assign the code in the window to the
selected segment. In this way, multiple areas of a document can be coded without
having to select the code each time.

You can also use the keyboard shortcut Ctrl+L (Windows) or cmd+option+L (Mac) –
this way you code with the last code you used.

4. Coding with Multiple Codes simultaneously

First, activate the codes in the “Code System” that you want to use to code the
selected segment in the “Document Browser.” To activate a code, you can right-click
the “Code System” and select Activate. Then right-click on the segment and choose
the option Code with activated codes.

5. Coding with the Code Favorites

If you are working with an extensive “Code System,” it can be difficult to work
efficiently, since it is hard to find each code quickly in the large list. The coding Quick
List offers on way of working around this, but there is another option that can be
helpful in certain circumstances. It allows you to also code with more than one code at
once. The function is called the code favorites.

And how does it work? Simply right-click on a code and select Add code to...> Code
Favorites. After you have added the first code, the code favorites window will appear.
You can then continue to add more codes to the list in the same fashion: right-click on
the code and select Add code to code favorites.
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Tip: You can also drag and drop codes from the “Code System” into the open “Code
favorites” window.

The list of code favorites

You can now begin to code. Simply highlight the segment as usual and click on the
code in your list of Code favorites. You can now see in the coding column on the left
side of the “Document Browser” that the segments have been coded.

Tip: You can also drag and drop a highlighted segment on a code in the code favorites
window or vice versa drag and drop a code onto a highlighted segment.

When you are finished using the code favorite window, simply close it by clicking on
the x in the top-right corner. To re-open the window, you can either add another code
(via the context menu) or select Code favorites from the Codes drop-down menu.

Rearranging the sequence of codes or deleting codes

If you want to rearrange the sequence of the codes within the code favorites, click on
the icon Edit code favorites. Now, highlight codes with the mouse and use the arrow
up and down icons to move codes up and down. To delete a highlighted code, click
on the red X labeled Remove selected codes from code favorites at the top of the
window.

Click again on the Edit code favorites icon to continue with your coding work. If you
drag a high-lighted segment onto a code in the code favorites window the Edit Mode
will be switched off automatically.

Tip: You can remove a code from the code favorites at any time by clicking the right
mouse button in the window and selecting Remove selected codes from code
favorites. You can also remove several codes by highlighting them first.
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6. Coding with keyboard shortcuts

For quick coding using your keyboard, you can assign keyboard shortcuts for up to
nine codes. To do so, select the menu option Keyboard Shortcuts for Codes in the
Codes tab:

The Keyboard shortcuts for codes window

In the left column you will see the available keyboard shortcuts Ctrl + 1 to Ctrl + 9
(Windows) or cmd + 1 to cmd + 9 (Mac). You can drag and drop a code from the list
of codes into one of the nine rows, thus assigning a keyboard shortcut to the code. If
a shortcut already been assigned, it will be overwritten by this action. For clarity, the
name of the code appears in the right column, along with the parent code if necessary
– not the entire code hierarchy.

To cancel the assignment of a shortcut to a code, click on the appropriate row and
click the Remove Shortcut button.

For coding, it may be helpful to leave the keyboard shortcuts window open until you
have memorized the shortcuts. It does not matter if the window is open or not when
coding: Simply highlight a segment in the Document Browser and hit the selected
shortcut keys. MAXQDA will then encode the selected segment with the associated
code.

Tip: When you right-click on a code and select Properties, a window will open in which
you can assign the code directly to one of the nine available keyboard shortcuts.
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Creating shortcuts via the Properties menu

7. Coding with MAXMaps

The “Code System” is organized in a hierarchical tree structure, which does not allow
for multiple cross-relationships between subcodes. In some cases, it may be necessary
to create a non-hierarchical structure to form network relationships and organize
codes in a different structure.

This is possible with MAXMaps, the mapping tool that is part of MAXQDA. Open
MAXMaps in the Visual Tools tab to start the tool and create a new map. Use Drag &
Drop or Alt+double-click (Windows) or option+double-click (Mac) to copy codes from
your code system to the map. Codes can be freely arranged on the map, linked to
each other with arrows or lines, and free symbols or images can be added to the map.

Coding is simple: Drag a selected segment from the “Document Browser” to a code in
the map.
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Coding with codes in a map

Open Coding Mode
Particularly in research projects that are based on Grounded Theory, many so-called
open codes are created: In a first step, a text is reviewed line by line and identified
aspects are recorded in numerous new codes. For this case of application the mode
"Open Coding" is particularly suitable, which allows to immediately create a new code
for a marked segment, to assign it and if necessary to write a code memo as well as a
comment for the created coded segment.

Activating the Open Coding mode

Click the Open Coding Mode icon in the “Document Browser” toolbar.

Activating the open coding mode

Using the Open Coding mode

Using the open coding mode is easy - as soon as the mouse key is released after
selecting a text segment, the following dialog window appears:
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The dialog is, in principle, very similiar to the dialog for creating new codes:

Type the name of the new code in the upper dialog field of the window (max 63●

characters)
You can select a color attribute for the new code below●

The text written in the dialog field "Code memo" is used as a memo for the newly●

created code (which can be assessed by clicking on the memo icon in the "Code
System")
The comment on the coded segment can contain up to 255 characters (about 2-3●

sentences) and is directly assigned to the coded segment.

Tip: You can fold in and out the areas for the code memo and the comment on the
coded segment by clicking on the arrows. You can enlarge the input fields by clicking
on one of the window's corner and dragging the entire dialog larger while holding
down the mouse button.

Color Coding (Highlighting)
Color coding text is a technique that is especially useful at the beginning of the
analysis process. It is similar to the marking of text in a book with a highlighter. It
allows you to color code the passages you find particularly interesting when reading
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through the text for the first time. Before you decide which codes to use and before
you start analyzing your text in categories, this technique lets you keep track of what
seems important.

MAXQDA also offers this functionality- The Code toolbar in the Document Browser
contains five color coding highlighters.

The Document Browser toolbar with five color options

To color code a segment of text, follow a similar process as with standard coding:
select the text segment with your mouse and click on one of the five colors in the
toolbar. The text segment will now be highlighted in that color and color coded
accordingly. A new coding stripe will be visible in the coding column next to the
document.

A section of text coded with “BLUE”

In practice, then, color coding does much more than just change the color of the text
– it is also a coding action. This means that you can later compile of the green-coded
segments and work with those that are most important. This lets you code more
specifically once this initial general coding run is complete. Retrieving all codes with a
specific color coding can be done by activating all documents in the “Document
System” and activating the appropriate color code in the “Code System.”

If at a later point, you delete the color code in the “Code System”, you are not only
deleting the color code. All coded segments for that code will also be deleted. In other
words, all the highlights of that color will be deleted from your documents (not the
texts themselves, just the colors assigned to them).

Color codes are identified with a specific symbol in the "Code System":
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Symbol for a color code in the “Code System“

Tip: You can change the name of a color code in the "Code System" at any time.

Emoticode: Coding with Emoticons and
Symbols
The “Emoticode” function allows you to assign symbols and emoticons to text and
image segments, as well as audio and video clips. It can generally be employed with
the same functionality as “normal coding:” All the functions of conventional coding
are supported, meaning emoticons and icons will be displayed in the overview tables
of coded segments and in visualizations such as the Document Portrait.

Emoticons and symbols

MAXQDA includes over 300 emoticons and symbols, which are organized into
different thematic groups. Emoji icons are widely known due to smartphone use. They
include different types of smileys as well as many other symbols. Each emoticon
symbol has a name, which serves as code's name.

Opening the Emoticode window

In order to code using emoticodes, you must first open the emoticode window. You
can do so by clicking the corresponding symbol in the coding toolbar in the
"Document Browser".

Activate emoticode function

After being called up, the window containing the collection of emoticons appears and
can be moved anywhere on the screen.
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The emoticode window

Please note: Each emoticon or symbol is assigned a name. This is visible when the
mouse moves over an emoticon or symbol in the emoticode selection window. After
coding, it will be listed as a code name in the code system.

If more symbols are included in a thematic section than can be displayed in the
window, you can scroll through all symbols in the section using the blue arrows at the
bottom of the window.

When you click on the clock icon, MAXQDA displays the most recently used symbols
and emoticons. In addition, you can add frequently used symbols to favorites. To do
so, right-click the symbol and select Add to favorites. The symbol is then shown
additionally in the 2nd tab from the left, marked with a star. Symbols can be removed
from the favorites list using the same method.
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Add and remove symbols from favorites

Emoticode window options

Window and symbol size can be customized. Click on the Properties  button at the
top of the window.
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emoticode properties window

Coding with emoticons

Coding segments with emoticons is just like color coding or coding with the toolbar.
The segment is selected in the “Document Browser” or “Multimedia Browser,” then
you can subsequently click on the desired symbol or emoticon in the emoticode
window. If the emoticon has already been used in the existing “Code System,” the
reverse is also possible – meaning the selected segment can be dragged into the code,
or the code into the segment.

Emoticode display in the “Document Browser”

In the "Document Browser" the selected emoticon appears in the middle of the
coding stripe in place of the normal code icon. By default all new emoticodes get the
color blue, the color can be changed as usual in the "Code System" and is then also
used for the coding stripe in the "Document Browser".

Coding stripe with emoticode in the “Document Browser”

In the selection window for the displayed coding stripe (which can be called up with a
right-click on the mouse in the visualization area), you can hide or show coding stripes
with emoticodes in the “Document Browser.”
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Select “Display emoticodes” to emoticodes on the coding stripe

Emoticodes in the “Code System”

When the “Code System” is displayed in the normal tree structure, the emoticodes
appear in the place of the usual code symbols. The display of codes in the code system
can, if desired, be restricted to emoticodes. To do so click on the settings icon in the
"Code System" window and select Display emoticodes only. This setting is
automatically reset when you open another project.
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emoticode display in the “Code System”

Emoticodes in the “Retrieved Segments” and “Overview of coded
segments”

Emoticons, in most cases, replace code symbols, and are therefore found in the source
list in the “Retrieved Segments.” In the table view, as in the “Overview of coded
segments,” emoticons are displayed instead of the circle containing the code colors,
allowing the entire table to be sorted by emoticons.
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emoticons in the retrieved segments and coded segments overview

Emoticodes in MAXMaps and other MAXQDA visual tools

In MAXMaps, the appropriate emoticon will appear in the place of the code symbol. In
the Code Matrix Browser, Code Relations Browser, and Codeline, the emoticon will
also be displayed in the place of the code symbol.

In the Document Comparison Chart each code that is present in the paragraph is
represented by a colored section of the bar. Code colors, not emoticons, are used.

The Document Portrait is displayed with emoticodes rather than code colors if the
“Mix” feature is turned off. When the “Mix” feature is turned on, it mixes the code
colors where codes overlap. In this case, the code color of the emoticon is used.

Coding Videos
The Multimedia Browser

Using the Multimedia Browser you can easily play and code audio and video files. To
open the Multimedia Browser (formerly known as "Media Player" in older MAXQDA
versions), click the Open video file   or Open audio file  symbol in the "Document
Browser" toolbar.
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Open the Multimedia Browser in the Document Browser

The Symbol is only displayed when there is a media file attached to the opened
document.

The Multimedia Browser looks like this:

The Multimedia Browser window

Detailed instructions on coding videos in the "Multimedia Browser" can be found in
the chapter "Code Videos Directly".

https://m22.maxqda.com/help-mx20/19-analyzing-videos/code-videos
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Delete Coded Segments
MAXQDA offers the option of deleting single or multiple codes simultaneously, from
several locations.

Please note: If you delete a code from the Code System, the code is removed from all
coded segments in all documents.

Delete coded segments from “Document Browser”

Move the mouse over the coding stripe or over the code name.1.
Right-click and select Delete.2.

Right click on Coding Strip or Codename to delete a coding in the “Document Browser” windows

Delete coded segments from “Retrieved Segments” window

Right-click anywhere on a coded segment or on the coding strip.1.
Select Delete.2.

Deleting a coded segment in the “Retrieved Segments” window
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Delete coded segments from “Overview of coded segments” or
“Retrieved Segments” in table view

Right-click on a row or select multiple rows while holding down the Ctrl key1.
(Windows) or cmd key (Mac) to simultaneously delete multiple coded segments.
Select Delete.2.

Delete most recent coded segments with "Undo Code" icon

Clicking on the code symbol with the right mouse button causes a context menu to
appear, with which the coding of the text segment can be removed. Choose Delete to
remove the coding.

If you need to first find the location of a coded segment in a document, deleting the
code in this way may not be very convenient. A better way is to use MAXQDA’s Undo
function. In the “Code” toolbar on top of the “Document Browser” window, there is
an Undo button. Clicking on it opens a list containing the last codes assigned. This
can especially helpful to remove codes created with one of MAXQDAs automatic
coding functions.
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Undo function in the “Code” toolbar

The most recent coded segments are shown at the top of the list. By clicking on the
third coding, only this one will be removed again, the two codings listed above will be
retained.

Please note: If only the size of a coded segment is changed, this action does not
appear as a new entry at the top of the list.

Modify Coded Segments
There are various ways to modify coded segments:

By assigning a new code.●

By assigning another code in the place of an existing code.●

By modifying the segment boundaries, meaning enlarging or reducing the coded●

segment while the code remains in place.

All three of these modifications can be easily carried out in MAXQDA.

Coding a segment with more than one code

After having coded a segment, the segment remains selected (with the exception of
highlight-coded segments). It is possible to attach more codes to the same segment,
for example using drag & drop.

If you want to assign one or more codes later, the segment must be selected again.
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This is easiest if you click on the coding stripe of this segment with the left mouse
button. The segment will be highlighted again and you can assign a code in the usual
way.

Replacing a coded segment

When reviewing your text analysis, you may decide that the wrong code was assigned
to a text segment. Or you may decide that the “Code System” is not precise enough,
so it is necessary to expand the “Code System” and distinguish between different
codes. In both cases, you will need to replace one code assigned to a text with
another.

This can be done in several ways:

Assign the correct new code as additional code, e.g. by first clicking on the coding●

strip to mark the segment and then dragging the segment onto the new code with
the mouse. Then delete the previous coding by right-clicking on the coding strip and
selecting Delete.
A faster way is to drag the coding stripe directly onto the new code while holding●

down the Ctrl key (Windows) or cmd key (Mac).
If the coded segment is shown in the "Retrieved Segments" window, this procedure●

can also be abbreviated: drag the coding stripe next to the relevant segment to
another code (without holding down a key).
The new code will automatically be assigned to the coded segment. If the other code●

is not activated, it may be that the coded segment was removed from the “Retrieved
Segments” window.
A coded segment can be moved from the table view or the “Overview of Coded●

Segments” to a different code in the same manner. Simply drag the line to another
code.

Click and drag to move the coded segment to the desired code

Editing the size of a coded segment

Sometimes a segment may be coded outside of its logical boundaries, meaning it is
too short or too long. The coded segment will, therefore, be difficult to understand
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because it is out of context. Segment boundaries can be adjusted in the following
way:

Select the segment by clicking on the corresponding coding stripe or code name in1.
the “Document Browser”. The segment is now highlighted in the original
document.
The segment boundaries can now be redefined as usual using the mouse. Then2.
encode the segment again with the same code. Alternatively, you can right-click the
coding stripe and select Recode with highlighted segment.

MAXQDA automatically adjusts to the newly defined segment boundaries.

Changing the size of the coded segment

Please note: Existing coded image segments in image or PDF documents will only be
adjusted when the newly selected area either completely includes the existing segment
or when the newly selected area is completely inside the area of the existing coded
segment.

While the "Recode" function always adjusts the segment borders to the current
highlighted area, you can also expand the segment boundaries with the new
highlights:

Highlight a passage that overlaps with the beginning or the end of an existing1.
segment.
Right-click on the coding stripe and choose the entry Extend with highlighted2.
segment.

Move or Copy all Coded Segments of a
Code
The Modify Coded Segments section has already described how you can move or copy
individual coded segments.

https://m22.maxqda.com/help-mx20/05-coding/modifying-coded-segments
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Moving all the coded segments of a code

If you move a code from one position in the “Code System” to another, the code
references move automatically together with the code. This is like moving a drawer
from one place to another in a cabinet; the drawer’s contents move together.

To move a complete drawer is something other than to move only its contents. The
same is true with code references. If you only want to move the code references to
another code, you cannot use the procedure described above. There is another
procedure that leaves the drawer in its place and merely shifts its contents.

In MAXQDA, it is the Move coded segments option that does this job. This option is
available in the context menu of the particular code from which code references are to
be moved.

To move coded segments from one code to another, follow these steps:

Right-click on a code in the “Code System.”1.
Select Move coded segments. This transfers the code references to an internal2.
clipboard. (Up to this point, nothing has really changed in the “Code System”. The
number of coded segments for this code remain the same.)
Right-click the target code and choose Move coded segments from ‘first code.’3.
MAXQDA asks you to confirm the command before executing it.
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Moving coded segments

The first code remains in the “Code System” until you delete it, but the number of its
coded segments is now zero. The contents of the clipboard have been moved to the
target code.

Possible subcodes’ references, however, will not have been moved. Be careful when
deleting Code B now, since all subcodes – if there are any – will be deleted too, along
with their code references.

Handling code conflics

It may happen that some of the segments which you have moved to the target code
have already been coded with this code. Suppose that you move the codings from
"Code B" to "Code A", MAXQDA proceeds as follows in the case of an overlapping
code:

The outer segment boundaries of both encodings are retained. Thus, if a segment●

with "Code B" is from word 1 to 5 and the words 4 to 10 have already been coded
with the target code "A", the new segment ranges from word 1 to 10.
If both coded segments have a comment, the comment on the target code is●

retained. The comment on the moved code is deleted.
If only one of the two coded segments has a comment, this comment is preserved.●

The coding weights of the target code "A" are retained, regardless of the coding●

weight of the shifted code.
If several existing segments of the target code "A" are combined into one large●

coded segments because they all lie in the segment boundaries of a "B" coded
segment, then this large segment receives the weight of the oldest "A" coded
segment. Only the comment of the oldest coded segment of "Code A" will be
taken, all other comments of code will be deleted, even if the oldest coding has no
comment. If none of the existing coded segments has a comment, the comment is
taken from "B".

Because of overlapping coded segments, the number of coded segments of the target
code after you shifted codes can, of course, be smaller. If you move 10 coded
segments from "Code B" to "Code A" with 20 coded segments and several segments
overlap, you will not see 30 but fewer segments under "Code A".

Copying all the coded segments of a code

The function “Copy coded segments” is similar to the “Moving all coded segments of
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a code” function. The important difference is that the original code assignment will be
retained; that is to say, the coded segment will be duplicated and assigned to a new
code in addition to the original code.

This action is performed as follows:

Right-click on the selected code in the “Code System”.1.
Select Copy coded segments from the context menu that appears.2.
Move the cursor to the target code to which you want to copy the coding added3.
and click on it with the right mouse button.
Select Insert coded segments from xx from the context menu that appears4.

Tip: If you want to delete all code assignments but want to keep the code in the
“Code System,” it is best to create a code named “trash” and then copy the code
references to the “trash.”

Code Weight Scores
When coding a document segment, you are attaching a segment of a text or image to
a code in the “Document System.” MAXQDA also allows you to assign a weight score
to each of these coded segments to indicate how important that particular coded
segment is. It may be that certain coded segments represent a typical argument or
theoretical concept that you want to be sure and hold on to. In this case, these
segments are a sort of signpost.

MAXQDA allows you to indicate how important or appropriate a segment is for the
code it is coded with by giving it a weight score between 0 and 100. This weight score
could be described as a “fuzzy variable,” because it is not meant to give an exact
numerical worth for the segment. Rather, it is intended to be a guide, so you can later
sort your retrievals based on the weight assigned.

Code weight scores weights can later be used as a sorting criterion for the codings
and in numerous analysis functions as a selection criterion, that is, the analysis then
only refers to the coded segments with a specific weight.

Every newly coded segment automatically receives the default weight score, which is
somewhere between 0 and 100.

When you use MAXQDA for the first time, the default weight will be set to 0. This can
be changed in two places in the program:

In the Preferences menu which you can access via the gear symbol in the top right●
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corner of you window
In the status bar at the bottom of the screen, by clicking on the Default weight icon.●

A dialog window will appear where you can set a new default weight value. The
current value is always visible in the status bar.

Changing the default weight in the status bar

Code weight score display

The weight of a coded segment is shown in the source information below each
retrieved segment in the “Retrieved Segments” window. It is displayed behind the
code name in brackets.

Weight score

The display of weight scores in your "Retrieved Segments" can be managed in the
window settings of the "Retrieved Segments" window, which you can accessed via
the gear symbol at the top right of the window. Uncheck the option Show Weight to
hide the weight score.

The “Overview of coded segments”, available for document groups, each individual
document, and the whole project, also includes the weight scores for each coded
segment.

Adjusting the code weight

When coding, the default weight score is always set automatically. A different weight
score can either be assigned in the window "Document Browser" in the "Retireved
Segments" window or in the "Overview of Coded Segements".

Please note: How you choose to use different scales of weights is up to you. You could
make a ranking list with a highest score of 1, or a highest score of 100 for particularly
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important segments.

Assigning weight scores in the “Document Browser”

Right-click on the coding stripe for the coded segment that you would like to alter1.
the weight score for.
Select Modify weight.2.
You can then enter a number between 0 and 100.3.

Changing the weight score in the “Document Browser”

Assigning weight scores in the “Retrieved Segments” window

A weight score can also be assigned and modified in the “Retrieved Segments”
window. Right-clicking anywhere on the coded segment or on the coding stripe
displayed next to it to open a context menu, where you can select Modify weight and
enter a number between 0 and 100.

Changing the weight score in the “Retrieved Segments” window

Assigning weight scores in the “Overview of Coded Segments”

In the “Overview of Coded Segments” table, you will find a column for the weight
score of each coded segment. By double-clicking on a cell in the column, you will be
able to enter a new weight between 0 and 100.
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Tip: You can also adjust the weight for several coded segments in the "Overview of
COded Segments". To do this, select all the coded lines whose weight you watn to
change, and by right-clicking on the segement to open the context menu, select the
change weight entry.

Code Comments
You have the option of creating a short comment for each of your coded segments.
This might be an overview of the coded segment or a comment about its significance
for your analysis. Comments are particularly useful for the category development.

To create a comment for a coded segment, follow these steps:

In the “Document Browser”: Double-click on a coding stripe or on a code name - or●

right click on the coding stripe and select Edit comment.
In the “Retrieved Segments” window: Double-click or right click on the coded●

segment or the coding stripe displayed next to it.

A window will appear in which you can enter the comment. The comment can contain
up to 255 characters, which corresponds to approximately 2 to 3 sentences, that is,
the length of this paragraph. Use Shift + Enter (⇧ + ↵) to create a line break.
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Window for entering comments

You can easily see if a comment has been written for a coded segment when you look
at the code symbol. Normally the inner part of the little circle is white in color,
independent of the color of the code symbol. When a comment is attached, the inner
circle appears in the same color as the outer line of the symbol. If you hold the mouse
on the coding strip, the comment appears in the tooltip.

A coded segment with a comment (the circle in the middle of the coding stripe is filled)

Displaying Comments in the Sidebar of the "Document Browser"

You can display comments on coded segments right next to the data it is attached to:
right-click on the document displayed in the "Document Browser" and select Sidebar
> Comments.
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Displaying comments in Sidebar

You can adjust the width of the sidebar by dragging the border between the Sidebar
and the document to the right or to the left. Right click into the sidebar to see further
display option and to optionally also display memos at the same time.

Note: It is not possible to display comments and paraphrases at the same time. If you
select to display paraphrases, comments are automatically switched off - and vice
versa.

Hover over a comment to see coded segment and delete option

If you move the mouse over a comment in the sidebar, the corresponding segment is
highlighted in the document as shown in the figure above. Click on the red X at the
top of the comment to delete it.
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Finding your coded segment comments

As long as you haven’t changed the standard view, you can find all of your code
comments in the “Overview of coded segments” table in the second column. You can
also insert new comments and delete/change old ones from this view. By right-clicking
on the column header, the overview is sorted according to this header. You an also
sarch for comments: right-click on the "Comment" column header and select Search.

Create, edit and search for comments in the “Overview of Coded Segments“

The Overview of Documents for a Code
To answer the question in which documents or document groups a certain code was
used, MAXQDA gives you the option to use the Overview of Documents. To show this
overview, right-click on a code and choose Overview of Documents from the context
menu. It makes no difference whether the code has collapsed subcodes or not – the
Overview of Documents takes into account only the code in question.
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The Overview of Documents in the context menu

A tabular list of all documents that have segments coded with the chosen code will
open. In the following example, the code “Day-to-Day Issues Emotions” was used in
ten documents and two different document groups. The column “Number of coded
segments” shows how many coded segments were found in each document.

“Overview of documents” for a code

In addition to the usual symbols above the overview, which include the functions for
filtering rows and for export, the Aggregate to document groups  function is
available. This function restricts the display to include only the document in which the
selected code appears.
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Taking the example above, after clicking the button, the table will consist of two rows
with the document groups “New York” and “Indiana”. The number of coded
segments will be added up:

Aggregating to document groups

Smart Coding Tool: Working with Coded
Text Segments
The Smart Coding Tool is designed for working with coded text segments and is very
well suited to performing the following tasks:

Getting an overview of the contents of a category,●

Reviewing and, if necessary, changing relevant categories,●

Customizing your categorization system(s), particularly differentiating (i.e. breaking●

down) parent-codes or aggregating codes.

The Smart Coding Tool is always used to compile coded segments and can therefore
be opened in two places. By clicking on the Smart Coding Tool icon: 

in the “Retrieved Segments” window or●

the Overview of Coded Segments.●
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Opening the Smart Coding Tool from the 'Overview of retrieved segments'

The Smart Coding Tool will open immediately after you click on the icon.

The Smart Coding Tool table window

The table window is divided into two display areas. A reduced code system is displayed
in the left area. When you open the Smart Coding Tool, only the codes assigned to the
compiled coded segments will be displayed in the code system. So that the hierarchical
structure can be retained, sometimes non-activated parent codes are also displayed.
The number at the end of a code row in the system indicates how often the code
appeared in the selected documents.
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In the right area, the coded segments are listed in a table. The segments whose code is
selected in the hierarchical list on the left and highlighted in blue will always be shown
here. The code that is currently selected is displayed in the upper left corner. At the
top right, you can see how many coded segments (from how many documents) are
displayed in the table, that is, how many rows the table contains. When the Smart
Coding Tool is opened, only the documents from which the compiled coded segments
originated will be activated. Only their coded segments are displayed.

The individual columns in the table contain the following information:

Document – The source document in which the coded segment is found

Coded segments – The coded segments of text

Codes – The list of codes assigned in the area of the displayed coded segment. It
doesn't matter whether the code has only been assigned to one character of the
segment, the entire segment, or even beyond the boundaries of the segment. Only the
codes that are visible on the left in the code system are listed. So that the code name
is not listed repeatedly in the column when a code is broken down into its subcodes,
the parent code of the displayed coded segment is not displayed.

Comments – A text field that can be freely edited (max. 255 characters) to add
comments to coded segments.

Like all MAXQDA table widows, the individual areas can be adjusted: the columns can
be adjusted in width and position with the mouse, or hidden with a right-click on a
column heading. A click on the heading sorts the column in ascending order, another
click in descending order.

Please note: All other MAXQDA functions are locked while the Smart Coding Tool is
open.

Symbol toolbar

Along the top edge of the window you will see a toolbar containing the following
options:

Quit – closes the Smart Coding Tool. Alternatively, you can click the X to
close the window.

Only activated codes – restricts the display of the code system to the activated
codes only. This option is selected automatically when you open the Smart Coding
Tool. When turned off, all your codes and subcodes are displayed.
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New code – creates a new subcode in your code system. The new codes are always
displayed at the bottom as the last subcode.

 Only activated documents – restricts the display of coded segments to those in
currently activated documents. The display of frequencies in the code tree is adjusted
accordingly.

Filter – applies the filters you can define by right-clicking on the column heading
and selecting Set filter.

Reset all filters – removes all filters from all columns.

Display search toolbar – lets you to enter a search term to search for text in all or
specific columns.

Display parent code – in addition to the code, the "Codes" column also displays its
parent code.

 Display comments – displays the “Comments“ column.

Undo – undoes the last action in the Smart Coding Tool.

Redo – redoes the last action in the Smart Coding Tool.

Create new code

You can always add new codes to use to code selected segments:

Click on the New code1.
In the dialog window that appears, enter your new code name and, if necessary,2.
assign a code color. You can also enter a description of the new code in the "Code
Memo" text box.
Click on Add code if you want to add further codes. Click on OK to finish creating3.
new codes.

Tip: To create a new code at the top level, right-click on the root of the code hierarchy
and select New code.

Newly created codes are automatically activated so that these are displayed in the
code system.

Note: All changes to the code system using the Smart Coding Tool, including the
creation of new codes, are added directly to your overall “Code System”.
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Assign a code

To assign a code to a coded segment, click and drag the line of the code to one of the
displayed codes in the code system. The newly assigned code is then immediately
displayed in "Codes" column. To code only part of a coded segment, first double-click
on the whole coded segment text, then select the portion of text you want to code,
and drag it to one of the codes in the code system. Even if you assign the same code
to several sections of a coded segment's text, the code name will only be listed once in
the "Codes" column.

If you hold down the Ctrl key (Windows) or cmd key (Mac) while dragging-and-
dropping a whole line onto a code, the complete coded segment is moved to the
selected code. It will thus no longer be displayed.

Assigning a code to a coded segment text.

Tip: By right-clicking on a row and selecting New code, you can add a code and assign
it to the entire coded segment.

Remove assigned codes

To remove an assigned code, click the cross that appears when you move the mouse
over a code in the "Codes" column. All assigned codes are then removed from the
coded segment.

Removing an assigned code from a coded segment.
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Customize your code system

Your code system can be customized throughout the entire analysis process. You can
change the order of codes with the mouse and even insert them as sub-subcodes. By
right-clicking on a code, all the functions from the overall "Code System" are available
to customize your code system in this window:

Delete code●

Sort subcodes (alphabetically or by category frequency)●

Change code color●

Create or edit code memo●

Click a code in the code system to list all the segments coded with this code. This way
you always have an overview of the contents of your individual categories. The
selected code in the code system is highlighted blue. The name of the selected code is
also displayed at the top of the window.

Display all codes of a coded segment

Please note: The "Codes" column always shows which codes have been assigned to
the segment in addition to the currently selected code. This column will never show
the parent code of the selected code.

Moving or copying individual coded segments

By default, if you drag a coded segment onto a code, that code will be assigned to the
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segment in addition to other previous codes assigned to it. The segment will still be
coded with the code whose other segments are displayed in the right window.

If you hold down the Ctrl key (Windows) or cmd key (Mac), however, while dragging a
coded segment to a code, the code will be replaced. That is, the code whose segments
are currently listed in the right window is removed and the segment you dragged to a
different code disappears from that list.

This function is e.g. especially useful if you want to transfer a code from one subcode
to another subcode, because it suits it better in terms of content.

Moving or copying several coded segments

To move or copy all segments of a code to another code, right-click on a code and
select the function Move Coded Segments or Copy Coded Segments in the context
menu.

Then right-click on the target code and select the corresponding function: Move
Codded Segments from 'Code xy' or Copy Coded Segments from 'Code xy'. For more
information on this function, refer to the section Move or copy all coded segments of
a code.

Working with comments on coded segment

In the comments column you can write a comment regarding each coded segment.
The comments are stored as  Coded Segment Comment  for the code selected in the
code system and highlighted in blue.

In comments field, you can add comments about the coded segment texts, ideas for
new categories, and more. They are also suitable for keeping track of your analytical
procedure (i.e. "still unclear“ – "come back to this again later") or for other team
members ("please cross-check this!").

Double-click on a cell in the "Comments" column to enter a new comment or edit an
existing one.

https://m22.maxqda.com/help-mx20/05-coding/moving-all-coded-segments-of-a-code
https://m22.maxqda.com/help-mx20/05-coding/moving-all-coded-segments-of-a-code
https://m22.maxqda.com/help-mx20/05-coding/creating-comments-for-coded-segments
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Entering a comment on a coded segment.

Export your display

Your current display can be exported via the usual icons at the top right of the
window. All the rows (coded segments) in the right field are always exported.

Open as Word document – Creates a temporary Word document which is opened
with the program associated with this format on your computer. To permanently save
this file, you must save it in another location on your computer.

Open as Excel spreadsheet – Creates a temporary Excel spreadsheet which is
opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

Export – MAXQDA creates a table (XLSX), a text document (DOCX) or a website
(HTML) after you have entered a filename and location. The exported file is opened
immediately.

Code Cloud
Code clouds are used to visualize the most frequently assigned codes as word clouds.
They are particularly suitable for exploring and illustrating the use of codes in a project.
The code cloud can represent the codes used across all the documents in a project or
only a selection of documents.
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Code Cloud

Opening the code cloud

You can generate a word cloud for a single document, for a document group, for a
document set, or for all documents in a project. Right-click on the appropriate level in
the "Document System" and select the entry Code Cloud.

Alternatively, you can also access this function via Codes > Code Cloud in the main
ribbon menu. A dialog box will appear in which you can select the required documents
and codes.

Code cloud settings

The settings for code clouds are very similar to those of word clouds and are described
in detail there. The differences are minimal:

The entire code name is always displayed and can therefore consist of several words,●

as in the example in "income down".
The Minimum Frequency option in the Start tab refers to the number of codes●

https://m22.maxqda.com/help-mx20/visual-tools/word-clouds
https://m22.maxqda.com/help-mx20/visual-tools/word-clouds


05 - Coding   245

assigned in the selected documents.
Some functions of the word cloud, such as "word frequencies", the "stop list" and●

"ignore numbers" are not available, since these do not make logical sense in the
case of a code cloud.
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06 - Creative Coding

The Idea behind Creative Coding
During an open coding stage of their analysis process, researchers may create many
codes which in hindsight vary greatly in their scope and level of abstraction. Creative
Coding effectively supports the creative process in which these codes are generated,
sorted, and organized, and in which a hierarchical code structure is created based on
the relationships between codes. The function provides a large workspace on which
you can move codes and form meaningful groups. You can place codes that belong
together next to one another, insert parent codes, rename codes, change their color,
and create a logical structure. Usually, however, this logical structure is the result of a
long period of open coding and working with the codes.

The functionality of Creative Coding is fully integrated in MAXMaps and is carried out
in three steps:

First, drag the codes you want to work with from the "Code System" into the●

MAXMaps workspace.
Next, group and organize the codes, create parent and subcodes, define new codes●

if necessary, and change the color of the codes as desired.
Finally, transfer the changes to your existing "Code System".●

Start Creative Coding and Select Codes
To start the Creative Coding process click Creative Coding in the Codes menu tab.
MAXMaps will then activate Creative Coding Mode and the following workspace will
appear:
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Selecting Codes for Creative Coding

Please note: When Creative Coding Mode is activated only those top level codes will
be displayed, that have a maximum of two subcode levels. All top level codes with
more than two subcode levels are not available.

Now, single codes can be dragged from the "Code System" onto the blank workspace
on the right with the mouse. If you select a code with subcodes, MAXQDA will insert
the subcodes automatically onto the workspace.

You can select multiple separate codes by holding down the Alt key (Windows) or
option key ⌥ (Mac) and then drag the selection onto the Creative Coding workspace
while holding down the mouse button. To select a range of codes, first click on a code
and then click on a second code while holding down the Shift key ⇧. This will also
select all codes between the clicked codes.

To search for a code in a potentially very long code system, you can click on the
magnifying glass above the codes. There is also a sort icon to sort the codes within
each hierarchy level by alphabet.



06 - Creative Coding   248

Selected Codes for Creative Coding

To remove a code from the workspace, right-click the code and select Remove from
map.

After completing your selection, click the Start organizing codes symbol at the top
left of the screen.

Please note: While MAXQDA's Creative Coding Mode is activated, the MAXQDA
application is blocked and no further changes can be made to the open project until
Creative Coding is finished.

Organize Codes
Once you have clicked on Start Organizing Codes on the Start menu tab, you can
start structuring and organization your codes. The display will change at this point; the
"Code System" on the left will close and a color panel appears that displays all of the
colors currently in use.
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Organizing Codes on the MAXMaps workspace

All codes can be freely arranged on the workspace with the mouse. You can move
multiple codes at once by drawing a border around them with the mouse and then
positioning them as desired.

The following options are available in Creative Coding Mode:

Creating relationships between codes●

Creating new codes●

Merging codes●

Modifying code colors●

Undoing changes●

Displaying coded segments and code frequency of a code●

Please note: All changes made in Creative Coding Mode are not directly added to the
"Code System". These are added when Creative Coding is closed.

Creating connections between codes

As displayed in the image above, connections between codes are shown with an
arrow: When an arrow is pointing at a code, it means that this code is a subcode of
the other. In the above image, for example, the code "Sports" is a subcode of the
code "Interests".
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To make Code A a subcode of Code B, proceed as follows:

Go into Link Mode by clicking the Link (Define as Subcode)  symbol on the Start1.
menu tab.
Click on the desired top-level code and draw an arrow to the desired subcode.2.

To avoid the occurrence of circular references, existing assignments of the subcode to
other codes are removed.

To delete an arrow, right-click on it and select Remove from map.

Adding new codes

Users often wish to group multiple codes under an abstract concept. For this purpose,
you can always create new codes by clicking the Insert new code  symbol on the
Start menu tab. MAXQDA will subsequently insert the new code in the top left of the
workspace.

As per usual, you can rename the code by double-clicking on its label.

Merging codes

To merge two codes, proceed as follows:

Drag a code with the mouse button pressed down onto another code until the1.
message "Merge codes" appears at the mouse cursor.
When you release the mouse button, the following confirmation message will2.

appear: Confirmation
message for merging of codes
After clicking on Yes the shifted code disappears from the map and its code3.
assignments are assigned to the target code.

If you have activated the display of the code frequencies, you can directly see that the
number of coded segments under the target code has increased. Since some segments
may already be coded with the target code, the frequency displayed may be less than
the sum of the code frequencies of the merged codes. The merge is provisional until
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you quit Creative Coding, thereby updating the code system. Then the coded
segments are assigned to the target code and the source code is deleted in the code
system.

If you choose Don’t ask again, the inquiry for the merging of codes will no longer
appear in the current Creative Coding session.

Dealing with memos when merging codes

Of course, both codes may include a code memo. In this case MAXQDA will ask you
how to deal with the memo content of the moved code:

Changing the color and appearance of codes

The color and appearance of codes can be modified as follows:

First, make sure that the Link Mode is off. If necessary, click the Link (Define as1.
subcode) icon to turn off Link Mode.
Click the code whose color you wish to change. To select multiple codes at once,2.
draw a border around the codes with the mouse or click on each code while
holding the Ctrl key (Windows) or cmd key (Mac).
Click on a color in the color panel on the left to select a color already in use.3.
Alternatively, you can assign a new color from the color panel.

If you change the color of a parent code, the color of the subcodes will also be
changed following confirmation. If you create a new color, MAXQDA will apply this
new color to selected codes automatically.

As soon as you select one or more codes, the Format menu tab appears at the top of
the window. You can use this tab to adjust the way the codes are displayed, for
example, to enlarge the caption and make it bold.

To modify the appearance of an individual code, double-click on the code. A dialog
window will appear in which you can define the font size, symbol size, etc.
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Undoing changes

Recent actions can be undone step-by-step by clicking the Undo changes  symbol in
the top right corner of the user interface.

Displaying the code frequency and coded segments of a code

In order to organize codes, it can be helpful to visualize the number of each of their
associated coded segments. By clicking the Display code frequency  symbol on the
Start menu tab, the code frequency will be automatically displayed in brackets after
the code name.

When you right-click on a code, a context menu will appear from which you can
access the following options:

Memo – Opens the associated code memo.●

Overview of coded segments – Opens the tabular overview with identical name, in●

which you can inspect the coded segments of the code.
Overview of linked memos – Opens the “Overview of memos” where you can●

browse all memos of the selected code.

Saving the current state of the process as a MAXMap

Working on the code structure with Creative Coding may take some time and may
include different stages of development. While you start with arranging codes in
groups first, you possibly are merging codes and creating new higher level codes later
on. To track these different stages MAXQDA allows you to save the current status of
your work as a regular MAXMap: just click on  Save as Maps in MAXMap icon on
the Start menu tab. The map will be available after quitting Creative Coding when you
start Visual Tools > MAXMaps from the main menu.

Quit Creative Coding and Transfer
Changes to Code System
Changes made in Creative Coding Mode will be applied only once you quit Creative
Coding. Once you have finished organizing your codes, you must quit Creative Coding
in order for the changes to be applied to your "Code System". To do this, click the 
Quit Creative Coding symbol on the Start menu tab in the top left of the window. The
following message will appear:
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Quit Creative Coding

The following options are available:

Yes – the code structure will be transferred to the existing Code System

All codes from the Creative Coding workspace that do not have a parent code will●

be sorted alphabetically and inserted at the top of the Code System. This applies also
to newly created codes.
Subcodes will be inserted according to their hierarchical position.●

Any color changes to codes will be applied.●

Merged codes will be merged, i.e. the origin code will be deleted and its coded●

segments will be moved to the target code. If the deleted code contained a memo it
will be converted to a free memo, that can be accessed in the Memos menu tab
anytime.
The Creative Coding map will be converted into a normal MAXMap.●

No – Creative Coding will be closed without transferring the changes to the "Code●

System". This means all changes will be lost!
Cancel – returns to Creative Coding.●
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07 - Transcription

Transcription Mode
MAXQDA enables you to transcribe audio and video files in the Multimedia Browser
(called the "Media Player" in older MAXQDA versions). To get started with your first
transcription in MAXQDA, you must first import the audio or video file by clicking
Audios or Videos icon in the Import tab. (How this works exactly and where MAXQDA
stores the recordings, is explained in further detail here.)

When importing a recording, an empty text document is created in the "Document
System", to which the audio or video file is assigned and in which you can write the
transcript. These text documents with their associated media file can be recognized by
special symbols in the "Document System": Transcripts of audio files feature a musical
"note" and transcripts of video files a video camera:

Special symbols for audio and video files in the

Turning Transcription Mode on

Right-click on the document and select the option Transcribe Audio File or Transcribe
Video File.

This allows you to switch on MAXQDA's Transcription Mode, in which the windows
you need for transcription are arranged optimally:

The Multimedia Browser is displayed and placed at the top of the screen.●

The "Document Browser" with the transcript is displayed directly below - where you●

can write your transcript.
A dialog window is displayed to the left of the Multimedia Browser where you can●

adjust all your settings for the transcription.

https://m22.maxqda.com/help-mx20/import/inserting-audio-and-video-files-in-a-maxqda-project
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Transcription Mode

Starting the transcription process

Now you can play the recording and start writing. To play and pause,

Press F4 or F5,●

or press Ctrl (Windows) or Shift ⇧ (Mac) twice in succession, then you don't have to●

move your fingers very far,
or use the play and pause icon in the Multimedia Browser".●

To quickly navigate to a certain spot in your audio file, use the slide control in the
Multimedia Browser window or use the keyboard combination F12 and ⇧+F12 to
rewind or forward 5 seconds.

Tip: How to use the function keys for transcription on a Mac is described in our
Frequently Asked Questions.

The transcript and the recording are linked to each other using time stamps. For
detailed information on using time stamps, see this section.

The transcription text is stored automatically in the project file every 5 minutes. You
can change this time interval in the Transcription settings. To access the settings, click
the gear icon at the top right of your MAXQDA window.

https://m22.maxqda.com/faq/b-9-can-use-f4-transcription-maxqda-mac-os-x
https://m22.maxqda.com/help-mx20/transcription-audio-video/timestamps-to-link-transcripts-with-sound
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Adjusting the rewind interval, volume and playback speed

A rewind interval of 2 seconds is set by default so you continue your flow when you
resume playback. You can adjust this interval at any time, to a time between 0 and 10
seconds, in the transcription settings.

Adjust rewind interval

Tip: You can close the Transcription Settings window if you don't need it. You can
open it at any time by clicking on the Transcription Settings icon on the left side of the
Multimedia Browser.

Open Transcription Settings and the control panel

To adjust the volume and playback speed, click the Control Panel icon in the
Multimedia Browser. The following dialog window will appear, which allows you to
adjust the volume and speed of playback.

Adjust the volume and speed of playback in the Control Panel
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Coding while transcribing

You can code the typed text with new or existing codes during transcription. To do
this, highlight a text segment, for example, and drag it to a code in the "Code
System".

The whole functionality of the Multimedia Browser is also available. This makes it
possible to highlight and code sections and to set memos and document links. For
detailed explanations on how to use the Multimedia Browser, please refer to the
section for coding videos.

Starting and stopping the transcription

You can start and stop Transcription Mode at any time - just close the Multimedia
Browser.

To resume working on a transcript, right click on the document and select Transcribe
audio file or Transcribe video file.

Transcribing with a foot pedal

For faster and easier transcription, MAXQDA supports the following foot pedals from
Audiotranskription:

The yellow “Science” switch has the same functionality as the F4 or F5 key●

(depending on the software setting inside the foot pedal): press once to play, and a
second time to stop.
The black “Science II” switch must be held down to play media data and will stop●

playing when released.
The "Office" footswitch has three buttons: Press the left button to rewind 5●

seconds, the right button to fast forward 5 seconds. Press and hold the middle
button to playback the media file and release to pause playback

Tip: The "Office" footswitch is the same as Infinity's popular 3-button footswitch.

Automatic Speaker Change and Autotext
You can simplify your transcription work with the help of two functions:

In an interview with 2 participants, speakers' contributions can be labelled
automatically as such at the beginning of a paragraph and individual letters can be
replaced by any text.

https://m22.maxqda.com/help-mx20/19-analyzing-videos/code-videos
https://www.google.com/search?q=infinity+usb+foot+pedal
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Automatic speaker change

When transcribing a recording with two speakers, you can switch on the automatic
speaker change in the transcription settings. As a result, each new paragraph begins
automatically with a freely definable name, pseudonym or abbreviation.

Follow these steps:

If you have not already done so, start transcription mode by right-clicking on a text1.
document with an associated audio or video file and selecting Transcribe Audio
File/Video File
Select the option Automatic speaker change in the "Transcription Settings" dialog2.
window.
Enter names for each speaker. It's a good idea to add a space on the end too.3.
Select the Bold option if you want to want to pu the emphasis on one name.4.

Transcription Settings

If you can't see the transcription settings, you can open it by clicking the Transcription
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Settings icon on the left side of the "Multimedia-Browser".

If the names of the two speakers are marked "I:" and "B:", the next name will be
entered automatically for each paragraph change in the transcript and save you a lot
of typing.

Automatically entered “I:” and “J:”

Autotext

In the "Transcription Settings" you can also define abbreviations, which are
automatically replaced by text when two spaces are entered. This is particularly useful
when you transcribe a group discussion with several speakers, because then the names
of the participants can be filled with shortcuts and you can save yourself a lot of
typing. Likewise, you can also use frequently recurring and difficult to type
transcription elements with brackets, e.g. "(Incomprehensible)" or "(2)" for 2 seconds
as autotexts.

The autotexts shown in the following picture are defined for all new MAXQDA
projects by default. The abbreviations can be up to one letter long.

Autotexts make transcribing easier
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You use the "Bold" setting to control whether the text is inserted in bold script.

The autotext is stored in your project so that you can also use different computers with
MAXQDA installed for transcription without having to reenter your required autotexts.

A total of 15 autotexts can be stored. The entire autotext function can be switched off
by deactivating this option in the "Transcription settings".

Link Transcript to Recording with
Timestamps
With timestamps you can link your transcript to the original recording so that you can
always access the original sound and listen back to difficult to understand sections.

By default, MAXQDA automatically enters a timestamp at each end of a transcribed
paragraph, which is usually at the end of a speaker's contribution. The timestamps
appear in a separate column in the "Document Browser".

Timestamps in the document browser

Clicking on a timestamp (or the range between two timestamps) opens the associated
media file and starts playback at the stored position. Playback automatically ends at
the next timestamp.

Automatic timestamp addition can be adjusted in the "Transcription settings"
window. If the window sis hidden, you can open it by clicking on the Transcription
settings icon on the left side of the "Multimedia Browser".

Please note: You can hide the display of the timestamps in the transciption text
documents by right clicking the text and de-selecting Display Timestamp Column.
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Add timestamps manually

You can also manually insert timelines into a transcript, such as to mark a difficult to
understand section:

To do this, click on the New timestamp icon in the "Document Browser",●

or press F6.●

Add timestamps in current position

MAXQDA then inserts a timestamp where your cursor is in the text and visualizes it in
the time stamp column at the left margin. You can also create multiple timestamps in
a row, but only one timestamp is displayed in the timestamp column.

Timestamps can't be inserted at will, however, MAXQDA instead checks whether the
chronology of timestamps is retained by inserting a time stamp. If, for example, the
current playback position of an audio file is at 3 minutes, but a timestamp already
exists at 4 minutes, no further time mark can be added.

Please note: New timestamps can be inserted in the Edit mode as well as in the
transcription mode.

Delete timestamps

To delete an unnecessary timestamp, click on it with the mouse button and select
Delete timestamp in the context menu.

There is also a "Overview of Timestamps", which lists all timestamps of the currently
opened transcript. You can open the overview by clicking on the icon with the same
name at the top of the "Document Browser". In the overview, you can delete
timestamps by marking one or more rows and clicking the delete icon.

https://m22.maxqda.com/help-mx20/transcription-audio-video/the-overview-of-timestamps
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The Overview of Timestamps lists all the timestamps in a transcript

Insert Timestamps into a Transcript
MAXQDA lets you insert timestamps into a transcript retroactively in order to link
places in the text with the corresponding locations in the audio or video file. This can
be helpful if you have already transcribed a recording with a different software - or
have access to an existing transcript, for example from the Internet.

Let’s say we want to have a synchronized connection link the text and the audio for
the song “I Want You” by Bob Dylan. To save us the time of doing the transcription,
we can get the text from Dylan’s website. We can then either copy and paste it into a
document in MAXQDA, or we could paste the text into an RTF or DOC/X file and
import that file into MAXQDA. For this example, we’ll name the document “Dylan: I
want you.” Once the text is in MAXQDA, we need to create the link to the audio file.

Right-click on the document in the Document System and select Link audio/video1.
file.
In the dialog window that appears, select the audio/video file you wish to assign to2.
the document. This assignment can later be modified by selecting Properties in the
context menu of the document. In the dialog window that appears, you can click
on the three dots in the “Media file” row to reopen the file.

The MAXQDA document with the Dylan text is now linked to the audio file, but the
audio file wasn’t actually imported as part of the MAXQDA project. You will now see
that the symbol next to the “Dylan: I want you” document has changed. This is the
symbol for a document linked to an audio file:
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Inserting timestamps into a transcript

Double-clicking on this document opens it in the “Document Browser” (see below). A
new column has been inserted between the text and the paragraph numbers, which
will show your timestamps. The document only has one timestamp at this point,
representing the very beginning of the song, since we haven’t added any yet.

Imported transcript with media file connection

In order to play the song and to insert the timestamps, two things need to be done
first:

Turn on Edit Mode by clicking on the edit toggle switch in the "Document1.
Browser" at the top right.
Open the "Multimedia Browser" by clicking on the Open audio file icon, which can2.
also be found in the "Document Browser" toolbar.

Next, we would want to put the cursor at the beginning of the actual song text, right
before “The guilty undertaker …” and start playback of the song. We can do by
pressing the F4 or F5 keys on the keyboard or by double-tapping the Ctrl (Windows) or
⇧ (Mac) key. We would then let the song go until right before the singing begins and
insert a timestamp by clicking on the New timestamp icon in the "Document Browser"
or by pressing the F6 key. We want to do this same thing for the beginning of each
verse. We would then see a timestamp symbol next to the first line of each verse.
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Timestamp in front of the verses

We can now use the synchronized text and audio together. By clicking on any of the
timestamps, we will hear the song played from that point. If you do this with an
interview transcript, you can in a similar way get back to various sections that you may
want to hear again for tone or emphasis.

If you turn on the Sync Mode in the toolbar and click on the timestamp next to the
first verse, the text follows the song, meaning the section of text being sung will be
highlighted, similar to the way karaoke works. You can then follow along with the
song text as you hear it.

Listen and View Transcript and Sound at
Same Time
MAXQDA allows you to play an audio or video file at the same time as the transcript.
You can view media files synchronized to their transcribed texts, like a teleprompter
for a television presenter, or karaoke, in which you can read the text along to the
sound playback.

To start a synchronized playback, click on the Sync Mode button in the “Document
Browser" toolbar.



07 - Transcription   265

Open Sync Mode in the Document Browser

Begin by clicking the Play symbol or the F4 key.

Sync Mode works in both directions: If you change the playback position with the
slider, the transcript jumps to the corresponding text point. This also works when you
click anywhere in the media file, which in turn changes the playback position.

The "Overview of Timestamps"
The Overview of Timestamps lists all timestamps in the currently opened transcript. To
open this overview, click on the icon of the same name in the "Document Browser"
toolbar.

Open the Overview of Timestamps

The Overview of Timestamps has as many rows as there are timestamps in the
document, and every row has several columns. The first two columns contain the start
and end points of that segment. In the third column, you have the option of writing in
a short comment about that particular segment. The “Duration” column provides the
length of the respective segment.
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The Overview of Timestamps

This Overview of Timestamps table and the “Comment” column both function just like
any other MAXQDA table. You sort the order of comments or search for a comment.

Tip: To search for a comment, right-click on the “Comment” column header and
select Search.

If you are importing a document with timestamps, you still have the option to add
new ones once it has been imported into MAXQDA. The option to write your
comments in the list of timestamps also gives you a new way to find sections of your
media file. You can use comments to organize and quickly access certain sections.
Double-clicking on a row takes you to that section of the text in the “Document
Browser” and starts playback of the media file from that point.

Please note: Each transcript to which a media file is assigned contains at least one
timestamp at position 0, the beginning of the document.



08 - Memos   267

08 - Memos

About Memos
MAXQDA makes it possible to create your own notes and remarks and to attach them
like post-it notes to text passages, texts, document groups, images, audio/video clips
and of course codes. In MAXQDA these remarks are called "Memos". Such a memo
can be very different things: While one memo contains a short summary of an
interview or hints for its course, another memo contains first ideas for theory
development or hints for the use of a developed category.

Especially in social science evaluation methodology it is common to work with memos
and there it is above all the research style of Grounded Theory developed by Glaser
and Strauss in which memos play a special role. But regardless of the research method
chosen, it is important to clarify the difference between the memos and the qualitative
data: The qualitative data are processed and analyzed, but are usually not significantly
changed once the evaluation and coding has begun - at best, typos are eliminated.
Memos, on the other hand, are a dynamic type of text, they are products of the users
and can be changed, supplemented, modified and integrated at any time.

In MAXQDA you can assign memos in numerous places:

„Document System“

• Documents
• Documentgroups
• Documentsets
• Root of the Document System

„Document Browser“ • Segments in texts, spreadsheets and images

„Multimedia Browser“ • Positions in audio and video files

„Code System“
• Codes
• Codesets
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Memos in the MAXQDA User Interface

There is also a memo type, the "free memo", which is not directly assigned to a
position in the data material, nor to a document or code. Such memos also exist in the
research style of Grounded Theory, they do not belong to a certain original text, but
exist freely floating without concrete assignment.

Opening and Editing Memos
To view and edit an existing memo, double-click the yellow memo icon with the left
mouse button and the following memo window will appear.
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The Memo Window

In the upper area of the memo you can assign a meaningful memo title - just click on
the bold title with the mouse. In the upper right corner MAXQDA shows when and by
whom the memo was last edited. Hold the mouse cursor over this information to see
who originally created the memo.

The actual memo is written into the large text window:

At the top, there is a toolbar for formatting the text, so you can create enumerations●

and numbers, for example.
By clicking on the icon, you can prepend the creation date to a new entry.●

A table can be inserted by right-clicking in the text window and selecting the●

function with the same name.

Tip: If you want to use parts of an open text in a memo as a quote, you can select a
text passage and drag it into the memo by holding down the mouse button. MAXQDA
automatically adds the document name and the position of the inserted text as source
at the end of the text by default.

Saving memo content

MAXQDA is saving all entered information and changes to a memo when closing the
window. In addition, the memo window will be saved regularly and you can adjust the
time interval in MAXQDA's settings. The default setting is 5 minutes.
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Memo symbols

You can assign either the yellow standard Post-it symbol or one of eleven other
symbols to each memo. This makes it possible to indicate what kind of memo it is. In
detail the following possibilities are available:

Memo visualization options

Each user can assign the symbols to specific memotypes as desired. For those who
work according to the Grounded Theory method, it is recommended, for example, to
use the symbol T for theory memos, M for method memos and the question mark for
memos that refer to the further collection of data (theoretical sampling).

Since the meanings of the memo visualizations are assigned individually, you can
indicate the function or significance of each memo type in the current research project
in the Type Label text box. Please note that it is possible to edit this field in any open
memo; any memos of the same type will be amended accordingly.

Tip: By moving the mouse over a yellow memo symbol in MAXQDA, a small
information window appears with the title of the memo, the last modification date, if
applicable the assigned label for the memo type as well as the beginning of the memo
text.

Deleting memos

To delete an open memo, click on the red "X" at the top right of the window.

Tip: You can also delete a memo on the spot by right-clicking the memo icon and
selecting Delete Memo.

Copying memos

You can duplicate a memo by right-clicking the memo icon and selecting Copy Memo.
Click again with the right mouse button on a place in MAXQDA where you can place
a memo - e.g. in the memo column in the "Document System" - and select the option
Paste Memo here.

Print and export individual memos

Individual memos can be printed and exported. To do so, you will find the Print  and
Export  icons in the toolbar at the top of the memo window.



08 - Memos   271

By selecting Print, the print preview window opens, in which you can define the page
margin, header, etc. When printing a memo, its "title" is inserted as a heading, author
and creation date are also listed.

By selecting Export, the complete memo can be exported in a format similar to a
Word, PDF or HTML file. Of course, you have to enter a file name under which the
memo will be saved.

Exported memo

Opening Multiple Memos at Once
You can double-click several memo symbols one after the other to open each memo in
its own tab. The tab display makes it possible to quickly switch back and forth
between different memos. A click on the symbol "x" in the tab line closes the
currently displayed memo.
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Multiple open Memos in Tab display

Tip: You can pull individual tabs out of the memo window with the mouse, so you can
view multiple memos at the same time, each in their own Memo window.
Alternatively, you can click Undock window

symbol, which will also bring up a new Memo window.

Memos in Documents
Memos can be attached to any text or image position similar to sticky notes in a book
or article.

You can create memos in documents like this:

In the document, select an area to which you want to assign a memo, e.g. a text1.
passage that is interesting for theory or a contradictory text passage.
Right-click the selected segment and choose Insert Memo for Selection from the2.
context menu.
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Insert memo for selected text segment

The memo window in which you can write your memo will appear right away.
MAXQDA automatically assigns the memo title "Memo x" to new in-document
memos, where x stands for a consecutive number. You can change this title at any
time, e.g. select a more content-oriented title by clicking on the title with the mouse.

In-document memo

After closing the memo, the selected memo symbol appears to the left of the
document in the so-called "Memo column". If the sidebar is switched on, the memo
text is also displayed to the right of the document, as it is known from text processing
programs, for example.
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Memo icon in the memo column (left) and display of the memo in the sidebar (right)

To reopen the memo later, double-click on the memo icon in the left memo column or
on the memo display in the right sidebar.

Please note: If you delete a text passage in Edit mode to which a memo is assigned,
the memo is retained and automatically assigned to the previous text. This feature is
designed to prevent valuable notes from being deleted unintentionally.

Creating memos by double-clicking in the memo column

You can also create a memo directly in the memo column to the left of the text at any
time: Double-click at desired document position to attach the memo.

Creating a memo by double-clicking in the memo column

When creating a memo by double-clicking in the memo column, the memo is
automatically attached to the document position at the click position on the left
margin.
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The number of memos per document and per document location is not technically
restricted, i.e. you can create several memos at the same level in the "Document
Browser". MAXQDA then automatically displays them next to each other, the memo
column is automatically displayed wider.

Changing memo assignments to document segments

You can adjust the assignment of a memo to a text or image section any time:

Select the area to which you wish to assign the memo.1.
Right-click the memo icon in the memo column in the Document Browser and2.
select Attach Memo to Current Selection.

Displaying memos in the sidebar

In the sidebar to the right of the document, you can display memos, paraphrases, and
comments on coded segments. To display the sidebar, you can either

right-click in a document and select Sidebar > Memos or●

click on the small icon Show Sidebar in the upper right corner of the "Document●

Browser".

Display memo in sidebar

The contents of the memos are displayed in the sidebar at the height of the
corresponding text or image segment. Since memos can be very long, only one memo
at a time is displayed in the sidebar; the blue arrow icons within the yellow memo
indicator jump back and forth to the next or previous memo. The memo content
displayed is limited to 2,000 characters, corresponding to about three quarters of a
page of text.

Displaying memos in the "Document Browser" is interactive:
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Click a memo icon in the left memo column once to highlight the corresponding text●

or image segment and display the memo content in the sidebar.
Double-click the memo icon in the left memo column or the right sidebar to open it●

for editing.
When you hover the mouse over a memo in the right sidebar, the corresponding text●

or image segment will be highlighted.

In the sidebar, in addition to the memos, the paraphrases of the document or the
comments of coded segments can be displayed, but not at the same time. If you right-
click on the sidebar (not on a memo, but on the grey background area), a context
menu will appear in which you can specify which content should be displayed in the
sidebar.

Select contents of sidebar

Document Memos
Memos can be assigned at all levels in the "Document System" window, i.e. the
individual documents, the document groups, the document sets and also the topmost
entry, the root of the document tree. Unlike positions within a document, only one
memo can be assigned to each object.

There are several options for creating a new memo in the “Document System”:

Right-click on a level of the Document system and select the Memo option from the●

context menu.
Alternatively, you can create a memo for the currently selected document or level●

using the keyboard shortcut Alt+Shift+M (Windows) or option+shift+M (Mac).
The fastest way to create a new memo is to double-click in the memo column to the●

left of the code frequencies.



08 - Memos   277

Creating a memo for a document from the context menu

The appearing memo window is exactly the same as for the memos in the "Document
Browser". As title the new memo automatically takes over the document name, this
can be changed at any time by clicking on the title.

Whether a document or a document group has a memo is visualized in the
"Document System" by the selected memo symbol.

Visualization of a memo in the “Document System”

The project memo at the top level can be used to retain a description of the whole
project. The memos of individual documents can be used, for example, to save a
summary of the text that is always immediately accessible. One should also consider
that when moving the mouse over a memo symbol, an information window appears
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containing the first lines of the memo text. It is therefore a good idea to start the
memo with some important information.

Code Memos
You can write a memo for each code. Code memos can be used, for example, to
retain the definition of a category, including anchor examples that illustrate the
meaning of the category using original quotations. If you work according to the
research style of Grounded Theory, you can record all thoughts about the concept or
category in a code memo.

There are several options for creating a new memo in the "Code System":

Right-click on a code and select Memo from the context menu.●

Alternatively, you can create a memo for the currently selected code using the●

keyboard shortcut Alt+Shift+M (Windows) or option+shift+M (Mac).
The fastest way to create a new memo is to double-click in the memo column to the●

left of the code frequencies.

Creating a code memo

The appearing memo window is exactly the same as for memos in the "Document
Browser". As title the new memo automatically takes over the code name, this can be
changed at any time by clicking on the title.

Please note: If you change the code name afterwards, MAXQDA will automatically
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adjust the memo title if you have not already done so.

After closing the memo, you will see a yellow memo symbol next to the code in the
“Code System”, making it easy to recognize that this code has a memo attached to it.

Tip: For code memos, you will often want to insert an anchor example or explanation
of when the code should be used. To insert parts of an open text in a memo, simply
highlight the desired text, then drag and drop it into the memo with the left mouse
button.

As with other memo types, you can choose another one of the visualization options in
the place of the default yellow memo icon. The selected icon will appear next to the
code in the “Code System”.

Free Memos
Free memos are neither directly assigned to a position in the data material nor to a
document or code. They are, so to speak, free-floating and are suitable, for example,
for recording general notes on the research project, thoughts on the development of
an object-related theory or ideas for analysis.

It is possible to create a new free memo in different places:

Main window of MAXQDA: Click on New free memo in the Memos tab.●

Memo Manager: Click on New free memo in the Start tab.●

"Overview of Memos: Click on the New free memo icon in the toolbar.●

The memo window for free memos is identical to all other memos in MAXQDA.

To access your free memos later, you also have various options at your disposal:

By clicking on the Free Memos icon in the Memos tab, all free memos of the project●

are opened in the Memo Manager, where you can conveniently view, manage, edit,
merge or differentiate between the free memos.
Alternatively, you can use the Memos tab to call up the "Overview of Memos" table●

with all memos of the project, which then also contains all free memos already
created.

https://m22.maxqda.com/help-mx20/memos/the-memo-manager
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The Memo Manager
The Memo Manager provides a clearly structured working space for the memos of a
project, in which you can manage numerous tasks around your memos:

The remarks for a selected case (in the form of In Document Memos) or all category●

definitions (in the form of Code Memos) can be reviewed, edited, adjusted and
integrated.
The Memo Manager is the ideal place to work with free memos that are neither●

directly assigned to a location in the data material nor to a document or code.
Various sorting and filtering functions provide easy access to memos, for example●

memos written by a specific person or at a specific time.
Memos can be organized into a group, a so-called set.●

The Memo Manager is opened via the Memos tab. After clicking on one of the memo
types, the following view appears:

The Memo Manager

The Memo Manager is divided into two parts: On the left the memos are listed in a
tree structure, on the right the memo currently selected in the tree is opened. In the
picture above the selection in the tree is on "In-Document Memos", therefore all In-
Document Memos of the project including a preview are listed on the right side.
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Opening Memos

To open a memo in the Memo Manager, click on it in the tree view on the left with
the mouse. On the right side, the memo content will appear; as soon as you click into
the memo content with the mouse, MAXQDA automatically switches to the Format
tab, where you have numerous options for structuring the memo.

Memo opened in the Memo Manager

By checking the Open in Tabs option (in the toolbar on the left side of the window),
each additional memo you click on on the left side will be opened in another tab,
while the memos already opened will remain open in their own tab.

Tip: You can detach individual memos from the window and display them in a
separate one.

To open all memos of a document in tabs simultaneously, right-click the document on
the left side of the window and select Open Memos. The option Open Memos in New
Window is also available here, which will open all memos of a document in a separate
memo window outside the Memo Manager.

Display and hide different types of Memos

On the Start tab all memo types of MAXQDA are listed, with the number of memos of
this type currently available in the project displayed in brackets. Click on one of these
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icons to display or hide the respective memos in the Memo Manager.

Only In-document memos are displayed in the Memo Manager

You will usually only want to work with one memo type at a time, but in principle it is
possible to display all memo types at the same time. The different memo types are
self-explanatory in themselves, it should only be noted that In-Media Memos refer to
the memos assigned to an audio or video file in the "Multimedia Browser".

Sorting and filtering Memos

In the left window you can set how the memos are to be sorted in the tree view at any
time in the toolbar at the top:

Options for sorting memos

You can use the first two icons on the toolbar to reduce the selection to the currently
activated documents and the currently activated codes.

The third icon will open the following filter dialog:
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Set filters for memos

Last edited by allows filtering by users who last worked on the displayed memos.

Last edited allows filtering by the date of the last edit, with MAXQDA automatically
setting the most distant and most recent edit dates.

Memos linked to an activated code reduces the display to all memos linked to an
activated code. The view in the Memo Manager is responsive to changes in activations
in the "Code System".

<Memo Icon> allows the selection of memos with a specific memo icon.
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The filter becomes active as soon as you close the filter window by clicking outside of
it. If filters are set, the filter icon is grayed out and a filter bar appears indicating the
effects of the filter:

Filter bar indicates that a filter has been set

The filter always refers to the left side of the memo manager and hides memos there.
Open memos on the right side are not affected by this, but you can only open them
after closing if they are displayed on the left side despite filtering.

To turn off the filter, click the "X" icon in the filter bar. All filters are automatically
reset when closing the Memo Manager.

Please note: The numbers of the icon labels in the Start tab are not affected by the
filtering.

Search Memos

Search the list of memos

You can search within the entries of the tree view using the magnifying glass in the
toolbar on the left side of the Memo Manager. Here, for example, a code memo is
searched for:

Search within the entries of the tree view
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Search Memo Contents

To search all memos of a project, click on Search in Memos in the Start tab of the
Memo Manager. The memo search is explained in detail here. It can also be accessed
via the Memos tab in MAXQDA's main window when the Memo Manager is closed.

Assembling Memos in sets

You can create sets that can contain as many memos as you like at any time. This
means that it is possible, for example, to group thematically related Free Memos with
Code Memos and In-Document Memos.

You can create memo sets like this:

Right-click the word Sets in the left window of the Memo Manager and select New1.
Set.
MAXQDA automatically assigns a name to the set, which you can change at any2.
time by right-clicking on the name and selecting Rename Set from the context
menu.
Use the mouse to consecutively drag memos into the set.3.

Set containing three memos

You can add more memos to a set later at any time. To remove a memo from a set,
right-click the memo and select Remove Memo from Set.

Export and Print Memos

You can export and print all memos of a project or a selection of memos at any time
using the Memo Manager. At the top right you will find two icons to access the export
and print functions:

https://m22.maxqda.com/help-mx20/memos/searching-for-text-in-memos
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Export and print memos

By clicking on both the Print icon and the Export icon, a context menu with three
entries will appear, allowing you to decide which memos to print or export:

Print/Export Memos in Left Window - all memos listed in the left window of the Memo
Manager, including memos in sets.

Print/Export Memos in Right Window- all currently displayed memos on the right
(depending on the view a memo, all memos opened in tabs, all memos listed under
each other)

Print/Export All Memos in Project
You can export in Word format (DOCX) or PDF format.

The Overview of Memos
Memos aren’t only accessible from their location next to documents, codes, document
segments, etc. They are also available as an Overview of Memos. You can access these
overviews in various ways.

An overview of all memos in the entire project can be displayed by going to Memos●

> Overview of Memos
The "Document System" allows you to compile all the memos in a document, in a●

document group or document set. To do this, select the entry Overview Memos in a
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context menu accessed by right-clicking the document, group or set.

Open the Overview of memos in the Reports tab

No matter from where you access the "Overview Memos", a tabular list of the
corresponding memos appears. Each memo represents one line in this table. A click on
a line shows the memo in the upper window of the overview.

The Overview of Memos

The columns in the table contain all important information about the memo,
including:

The name of the document and document group in which the memo is found (or●

the name of the code in the case of a code memo).
For memos attached to document segments, the paragraph number of that segment●

is listed.
The author of the memo.●

Last edited date.●

A preview of the memo text made up of the first 63 characters●

The origin of the memo (e.g. the document, document group, document segment,●
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or code the memo is attached to).

The upper section of the window displays the memo text, so that various memos can
be scrolled though without opening individual memo windows for each. Memos
cannot be modified or deleted in the “Overview of memos”. Instead, right-click on the
line where the memo is listed and select Delete Memo.

Please note: To modify a memo, double-click on the line where it is located. The usual
memo window will open, and from here you can modify or add to the memo text.

The overview can be adapted like all MAXQDA tables: The columns can be changed
with the mouse in their width and position, and by right-clicking on a column header.
A click on the header sorts the column in ascending order, another click in descending
order.

Filtering the Overview of Memos

As with all overviews in MAXQDA, the tabular Overview of Memos can be sorted
according to diverse criteria. This is especially handy if you want to compile only the
code memos of a project or user, or only the memos that were created after a certain
date. Click on a column header with the right mouse button and select Set filter to set
a filter for the selected column.

For more information on filtering overviews, see Filtering Table Overviews.

Predefined filters

In the Overview of Memos toolbar you will find, besides the usual filter possibilities for
table overviews, a pop-up menu with numerous predefined filters:

All Memos - Filtering is switched off, all memos in the table are displayed.●

Memos of selected users - Allows you to choose users or select only memos of●

certain users.
Code Memos - Reduces the display of the current table to the memos assigned in●

the "Code System".
In-document Memos - Reduces the display in the current table to memos that have●

been assigned to a document.
Document Memos - Reduces the display of the current table to the memos assigned●

to the "Document System".
Free Memos - Reduces the display of the current table to free memos.●

Memos associated with an enabled code - Reduces the current table's display to the●

memos associated with a currently enabled code.
Memos in audio and video files - Reduces the display of the current table to the●

https://m22.maxqda.com/help-mx20/screens-and-menus/managing-table-overview
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memos assigned to an audio or video file in the "Multimedia browser".

The predefined filters work independently of the filter options described for the table
view above.

Browsing through the Overview of Memos

It is also possible to search in the various columns. To search in a specific column,
right-click on the column header and select Search. The instances where the search
term appears are immediately highlighted, and the up and down arrows allow you to
navigate between memos. To search multiple columns simultaneously, select the
Choose search columns symbol. When you use the magnifying glass symbol  in the
Overview of Memos toolbar, the search will automatically be carried out in all
columns.

Please note: When you search the “Preview” column, only the only the first 63
characters of the memo will be included in the search. If you want to search the entire
memo text, select the option Memos > Search in Memos.

Creating a new free memo

In the Overview of Memos toolbar you will find the New free memo  icon. You can
create a new free memo, which is not assigned to any particular document, code, or
text by clicking on this icon. Alternatively, you can create a new free memo by
selecting New free memo in the Memos tab.>

Please note: Free memos are only visible in the "Memos overview" if the overview was
opened via Memos > Memos overview, in the Memo manager or by right-clicking on
the top entry in the "Document System".

Jumping from the Overview of Memos to a memo

The Overview of Memos is interactively linked to the positions where your memos
were created. Clicking on a line in the table makes MAXQDA "navigate" to the
respective memo:

From each memo displayed in MAXQDA’s Overview of Memos, the source document●

immediately appears in the “Document Browser” positioned exactly at the place
where the memo is found.
For In-Media memos placed at an audio or video position, the media file is positioned●

at the appropriate position, but only if the "Multimedia Browser" is visible.
For code memos, the code in question is selected in the "Code System" (highlighted●

in blue).
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For document memos, the document in question is highlighted blue in the●

"Document System".
When using memos from an audio or video file, the playback is positioned at the●

corresponding location of the memo, but only if the Multimedia Browser is visible.

Export Memo Texts from the Overview

All memos in your Overview of Memos can be exported as a sequential listing of the
memo texts in a text file for Word or other writing programs (DOCX and RTF format)
or as a table in Excel, HTML or TXT format.

This sequential listing of the memos as a text file will look, for example as follows:

Export memos as pure text

Here you see all the information contained in the memo, such as memo title, creation
date, and linked codes as well as the memo text itself. The exported RTF file can be
opened in your word processing program to add layout features like headers and
footers.

If you choose HTML or XLS/X as the export format, MAXQDA creates a table that is
immediately opened in your default web browser (such as Internet Explorer) or Excel.
The complete memo text is also exported here, but the font is formatted in contrast to
an export as pure text.

The "Overview of memos" can be exported via the icons at the top right of your
window:

Open As Excel Table - A temporary table in XLS/X format is created and displayed
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in the program associated with this format. To permanently save the created file, you
have to save it to a different location from Excel.

 Open as HTML table - A temporary HTML table is created and displayed with the
standard browser set. To permanently save the created file, you must save it under a
different location from the default browser.

 Export – MAXQDA creates a table as an Excel file (XLS/X format), as a web page
(HTML format) or as a text document (RTF format) after you have assigned a file name
and location. The exported file is opened immediately.

The entire table is exported unless individual rows are selected, which you can see by a
green highlight. A single memo is selected by clicking the left mouse button. Several
memos can be selected by holding down the Ctrl key (Windows) or the cmd key (Mac)
and clicking the desired memos with the left mouse button. A range of consecutively
listed memos can by selecting the first memo and then clicking the last desired memo
while holding down the Shift key.

Tip: To export code memos as a codebook with category definitions, MAXQDA
provides a separate report function, which can be accessed under Reports > Codebook
and the here describes this in detail.

Search within Memos
To search the contents of memos, select Memos > Search in Memos and enter the
word(s) you are looking for on the left side of the appearing window.

https://m22.maxqda.com/help-mx20/reports/creating-a-codebook-with-category-definitions


08 - Memos   292

Searching for “career” in the project memos

After clicking on Run Search, the Memo Manager opens and lists the memos for
which one or more words were found in the memo texts.

Search results

https://m22.maxqda.com/help-mx20/memos/the-memo-manager
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A click on a line in the left window or a click on a memo in the right list opens the
respective memo, whereby the search hits in the memo are highlighted.

Please note: The search also considers the memo titles.

Linking Memo Content with Content in
Documents
In MAXQDA you can link two text, image or memo segments to each other with
internal links. A click on the link at one position then jumps to the other position. The
two linked segments can be in the same document/memo or in two different
documents/memos.

To insert a link into a memo:

Select the text passage in the memo that you want to link.1.
Right-click on the marking and select Insert Internal Link (Anchor/Target) from the2.
context menu. If the memo is open in the Memo Manager, you can alternatively
click on the icon of the same name in the Format tab.
Select the target segment in a document or memo and repeat the process.3.

Inserting an internal link in a memo

Existing links in a memo are displayed in blue and underlined text. A click on the link
will take you to the linked destination - and vice versa. If you hover the mouse pointer
over the link, a preview of the target is displayed.

https://m22.maxqda.com/help-mx20/links/document-links
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Preview of an internal link in a memo

Link Memos to Code(s) or Coded
Segments
A memo can be assigned codes similar to a text segment. To do this, drag a code
directly from the code system into the open memo window and drop it there.

The bottom part of the memo shows how many and which codes are currently
assigned to the memo. The bottom section can be folded in and out at any time and
its height can be changed so that you can optimally adapt the view to your needs.

Linking a memo to a code
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Click the  symbol to activate all the codes currently associated with the memo.

If you want to remove the link to a specific code later, move the mouse over a code in
the memo window and click on the "X" symbol at the end of the line.

Compile memos linked to a code

How do you find memos that are linked to a certain code? In the "Code System"
window, right-click the code of interest and select the option Linked Memos from the
context menu. The result is a list of memos with the same structure as when calling up
the "Overview of Memos". The header line of the table indicates the code to which
the compilation refers.

The table contains all the memos associated with the code. As usual, each line
represents a memo. A single click jumps to the position of the memo in MAXQDA, a
double click opens the memo.

The table can be sorted according to the various data fields presented and the
compilation can be exported.

Compile memos linked to activated codes

It is also possible to compile memos linked to the currently activated codes:

In the "Code System", activate all codes for which you want to compile memos.1.
Open the "Overview of Memos" via the Memos tab.2.
Select Memos linked to an activated code from the drop-down menu in the toolbar3.
to filter the memos accordingly.
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Activated memos in the Overview of memos

If the filter is switched on, you can also activate and deactivate codes later, the "
Overview of Memos " then displays the appropriate memos.

Tip: There is also a filter in the Memo Manager with which the currently displayed
memos can be reduced to memos that are linked to an activated code.

Linking memos and coded segments

You can also link coded segments to a memo. To do this, drag a coded segment from
the "Document Browser", the "Retrieved Segments", or a table of coded segments
into the open memo window using the mouse.

The bottom part of the memo shows how many and which segments are currently
assigned to the memo.
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Link coded segments to a memo

Convert Memos into Documents
Since memos are used to assist in the development of ideas and hypotheses, it could
happen that they quickly become very important to your analysis. In some cases, these
memos may be important enough that you wish to convert them into documents, so
they can be analyzed and coded. It is only possible to associate an entire memo with
codes, while every single character of a document can theoretically be coded as many
times as needed.

To convert a memo into a document, follow these steps:

Open the Overview of Memos by selecting Overview of Memos in the Reports tab1.
Right-click on the memo to be transformed2.
Select Convert to a document3.

The newly-created document will now be listed as the first document in the
“Document System”. The first lines of the document are the former memo’s title,
author, and creation date.

Tip: The function is also available in the context menu of any memo symbol. Right-click
on a memo icon in MAXQDA and choose Convert to a document to transform the
memo into a document in the "Document System".
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The Logbook
The logbook is a MAXQDA feature that lets you write a journal of sorts to keep track
of your analysis work. The term “logbook” is usually a nautical term, used to record
significant events and observations, and it can be used in a similar way for your
project. The logbook is set up to have the newest entries at the top.

You can open the Logbook from the Home tab or with the keyboard shortcut
Ctrl+Alt+B (Windows) or cmd+option+B (Mac).

Opening the logbook

The logbook window is a simple RTF window with a toolbar, which is fairly self-
explanatory, and lets you format the text as you want. You can, for example, edit the
font style and size; use bold, underline, and italics; and change the text color. The
icons on the far left let you create a new entry and print or export the logbook.

Logbook

To create a new entry, click on the New Logbook Entry  button on the far left of the
toolbar. This automatically inserts a date and time stamp at the top of the page, and
you can enter your text directly below it.
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09 - Links

Links in MAXQDA
MAXQDA distinguishes between four types of links:

Internal links represent a connection between two text, video or image segments●

(e.g. to show the contrast between two interviewees’ responses to the same
question, you could link them with each other). By using internal links, it is also
possible to link a text passage in a memo to a passage in another memo or any
document.
External links create a connection between a text or image segment and an external●

document (e.g. a picture, document, audio/video file, etc.) that is not part of the
MAXQDA project.
Web links are connections between a text or image segment and a webpage. By●

clicking on this link, you can open the website in your standard browser.
Geolinks create a connection between a text or image segment and a place on the●

globe. This place is based on GPS coordinates and is shown in Google Earth or other
similar programs.

Links can be set (and if necessary deleted) within the "Document Browser", within a
memo, within the "Multimedia Browser" or in MAXMaps, the modeler of MAXQDA,
which can be used to create interactive visual representations of data, concepts and
context models.

The four types of links are listed in a table view and visualized with various symbols in
the Overview of Links.

Internal Links
Internal links are a tool to connect two locations within a MAXDQA project. These
locations can be within documents, video files, audio files as well as memos. Internal
links always connect two points with each other, an anchor point and a target point.
As soon as you click on an anchor point of an existing link, the corresponding target
point is opened up. In MAXQDA, these links work as two-way links. If you click on the
target point, you get back to the starting point of the internal link.

You can link two text or image passages like this:
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Select a text or image segment in the "Document Browser" with the mouse.●

Right-click on the marker and select the Insert Internal Link option. Alternatively, you●

can use the Ctrl+L (Windows) or cmd+L (Mac) keyboard shortcut, or click the Set
internal link icon  in the coding bar of the Document Browser. The display of the
marked position changes now: In texts it appears blue underlined in PDF and image
files a blue frame is drawn.

Toolbar button for creating an internal link

You can now select the target point of the link, either in the same document or in●

another, and repeat step 2.

If, after the first step, the user decides against creating the link or wants to change the
text that had been selected, clicking the Remove last link icon removes it.

Toolbar button for removing a internal link

You can recognize links within a text in the "Document Browser" by their blue color
and underlined text. As soon as you move the mouse over the link, a small pop-up
window appears with information about target document and a preview of the linked
location.

Blue underlined internal link with tooltip

These pop-up windows of the text linked to a text passage sometimes suggest
anchoring the link not only to a single word, but to an entire sentence or section. To
jump from a link in the "Document Browser" to the associated location, simply click
on the blue link. The document containing the destination point is loaded immediately
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and positioned exactly at the point of the link.

Tip: If the second "Document Browser" is open, MAXQDA automatically jumps to a
link in the other "Document Browser" window. This allows you to view both of the
two linked document locations at the same time.

Deleting internal links

To delete an internal link, right-click on the link and choose Delete Link from the
context menu.

Internal links in videos

You can also link a video clip to another video clip or document, e.g. a transcript.

Open the video file in the Multimedia Browser1.
Select a part of the video and click the Insert internal link icon from the toolbar.2.
You can now choose the document or document segment that the anchor should3.
be linked to, as is described above.

Internal links in memos

You can also insert internal links in memos to link a location in a memo to a location in
another memo, document, or video:

Open the memo.1.
Mark the desired text in the memo that is to be linked.2.
Right-click on the selection and select Set link anchor/target. Alternatively, you can3.
click the Set link anchor/target icon  on the Format tab in the Memo Manager.
In the same way, set the link target in another memo or as described above in the4.
"Document Browser" or in the "Multimedia Browser".

External Links
External links are links between a segment of a text or image in MAXQDA and a
document outside of the project (e.g. to link part of an interview transcript in
MAXQDA with a picture of the person saved elsewhere on your computer).

Insert external links in an open document

To insert an external link, simply highlight a section of text or image, right-click on it,
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and select Insert External Link. A window will then appear where you can select the
appropriate external document to be linked. This can be on your internal hard drive,
an external medium like a flash drive, or a network location.

External links, for text documents, are blue and underlined like the document links, or
in a blue frame for PDF and image documents. When you hover the mouse over the
link, a tooltip appears with the name and location of the linked document. Clicking on
the link opens the document in the appropriate program. For example, clicking on a
link to an image file in JPG format will open the file in an image viewer program.

Defining external links for documents

You can not only insert external links for a position in a document, but also define an
external link for the entire document. Such an external link is not created in the
"Document Browser", where the content of the document is displayed, but in the
"List of Documents", where all data of a project is listed.

To add an external link to a whole document:

Right-click the document name and choose Properties from the context menu.1.
A window will open in which you can assign up to three links to external files in the2.
"External Links" section. Click on one of the three lines with the mouse to select it
and then click on the icon with the three dots to select a file.

The external links appear in the context menu of a document and can be opened from
there at any time:

Please note: This form of external links is not listed in the "Overview Links".

Web Links
Web links in MAXQDA are links between a text or image segment and a website. A
web link can be created as follows:

Highlight the text or image segment to be linked with the web address.1.
Right-click on the highlighted segment and select Insert Web Link.2.

A window will open in which you can then enter a web address.
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Window to insert Web link

Please note: If a link was saved to the Windows clipboard, it will be automatically
displayed in the input field.

As is the case with the external links, you can hover your cursor over the web link and
see the linked website in the tooltip. Double-clicking on the link brings up the website
in your standard Internet browser.

Geolinks
With the creation of programs like Google Earth and Google Maps, it has become
possible to view any point on the globe with the appropriate coordinates. Geolinks or
Georeferences are links between elements in MAXQDA and a selected place on the
globe. You could, for example, choose to link each interview transcript in MAXQDA
with the place the interviewee lives.

With the help of these geolinks you can also show geographic aspects of sociological
research data. The use of georeferencing tools, especially Google Earth™, in
combination with software for qualitative data analysis is fairly new. Cesar Cisneros,
professor of sociology at Universitaria Autonoma Metropolitan Iztapalapa in Mexico,
was one of the first to use this technique. In 2006, he used geolinks in MAXQDA for a
research project in South America. MAXQDA includes a column in the “Document
Browser” specifically for these geolinks. To create one, follow these steps:

Go to the location in Google Earth™ that you would like to link to. You can then1.
save the location by right-clicking on it and selecting Save Place As …
Highlight the text or image segment to be linked in MAXQDA, right-click on it, and2.
select Insert Geolink. Simply select the saved KML file in the window that appears,
and the geolink has been created.

The KML file contains the coordinates to the saved place and everything else that
Google Earth™ needs to take you directly to that location. When you click on the
geolink in MAXQDA, Google Maps will open in your Internet browser and the location
will be marked with a red dot.
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By hovering your mouse over the geolink visualization, you will see the coordinates
that are saved for that location. The screenshot below shows you this below. It is a
geolink in the interview transcript “Teresa,” linking to the place that she lives in “New
York, NY, USA” at the exact coordinates.

Geolinks are visualized similar to other links (blue and underlined), but they also have
their own visualization column next to the opened document. If the column is not
shown, right-click somewhere in the document in the “Document Browser” and select
Display Geolink Bar. This bar makes it easy to differentiate between regular document
links and the geolinks.

The orange location symbol to the left of the paragraph number visualizes a geolink

Please note: When you add a geolink, the KML file is imported into the MAXQDA
project itself. Storing it in the project file makes it easier to pass on the entire project
with all the associated KML files to the other members of the research team.

Segments that contain geolinks can be coded just as any other segment can.

Geolinks can be easily viewed in the “Overview of links” table, available in the
“Document System” at multiple levels (project, document group or document). In the
first column of the chart, geolinks are marked with an blue locator symbol. If you click
on the column header of this column, the entire column will be sorted by the symbols,
so it is possible to obtain a successive list of all geolinks.

Overview of links with geolinks indicated with the orange locator symbol

Inserting geolinks as objects in MAXMaps

Geolinks can also be inserted in MAXMaps by right-clicking in a map and selecting
Insert Geolink. You will then be able to select the appropriate KML file from the
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window that appears.

The MAXMaps screen then looks as follows:

A geolink inserted in MAXMaps

The name of the location in Google Earth is automatically inserted as the label for the
geolink in the map. This label is usually long and can be easily changed.

The inserted geolink can then be set up, visualized, linked to other objects, and moved
around just like any other object in MAXMaps. You can, for example, insert a picture
to replace the blue circle, change its size, etc.

Geolink along with other elements in a MAXMaps map

Geolinking for codes, documents, memos and coded segments in
MAXMaps

All MAXQDA objects inserted in MAXMaps can be connected to a geolink. As with the
free objects mentioned above, a blue ball appears in the top right of object’s frame
when it is clicked on. Double-clicking on the ball opens Google Earth™ and takes you
to the assigned location.
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Using a background image with geolinks in MAXMaps

Google Earth™ allows you to save any view as a JPG file, which can be inserted in
MAXMaps as the background.

Invisible hotspots as well as all aspects of your MAXQDA project can then be inserted
and placed on the newly-imported background.

The Overview of Links
Document links, the most common form of link, are easily seen in the "Document
Browser", but if you have created many links, it is difficult to get an overview of them.
For this reason, MAXQDA makes it possible to view all links in an overview table. This
overview table is similar to the one used for the Overview of Coded Segments.

To view the Overview of Links, right-click on a document, document group or the
Documents icon (representing the entire project) in the “Document System” and select
Overview of Links. When right-clicking on a document or document group, only those
links from that document or group will be shown. Alternatively you can open the
Overview of Links from the Reports tab in the main menu.

The overview contains the following information:

Anchor point (Document 1), paragraph, preview, second location (Document 2),
paragraph, preview.

In other words, you see the document name, paragraph number, and a preview of
each side of a link. Document links are not hierarchical, meaning they don’t have a
specific direction. A link from Point A to Point B is also a link from Point B to Point A. If
you view all links from the whole paragraph, you will therefore see each link listed
twice: once as Point A to Point B, and once as Point B to Point A.
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Overview of Links for a project

In the Overview of Links, each type of link can be distinguished by the symbol that
appears in the column on the far left:

 Document links

 External links and web links

 Geolinks

The Overview of Links table works like other MAXQDA tables. You can choose to sort
it alphabetically or reverse alphabetically by clicking on the column headers. Clicking
once on a link opens the linked document segment in the “Document Browser”,
showing you where the link is located.

Exporting the Overview of Link

You can also access the usual export functions in the toolbar of the overview window:

Open As Excel Table - A temporary table in XLS/X format is created and displayed
in the program associated with this format. To permanently save the created file, you
have to save it to a different location from Excel.

 Open as HTML table - A temporary HTML table is created and displayed with the
standard browser set. To permanently save the created file, you must save it under a
different location from the default browser.

 Export – MAXQDA creates a table as an Excel file (XLS/X format), as a web page
(HTML format) or as a text document (Word or RTF format) after you have assigned a
file name and location. The exported file is opened immediately.
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10 - Text Search

Search in the Four Main Windows
All four main windows in MAXQDA have a magnifying glass icon in their toolbars.
Clicking on the Search icon opens a search field. Below you can see the search field
in the “Document Browser”.

Search in the “Document Browser”

MAXQDA begins searching as soon as you type the first character into the field and
shows you how often that particular search string has been found in the currently
opened document. You can use the arrow icons next to the search field to skip
through the search results.

By default, all occurrences of the entered text are taken into account, even those that
occur in the middle of a word, such as, for example, "less" in "school lessons". The
search can be customized using the icons in the search bar:

Case-sensitive – The letters in the search term and the term found must be the
same, including whether they are upper or lower case.

Starting letters - The beginning of a word must match the search characters. The
search for "erica" finds the name "Erica", but not "America".

Whole word – The search is checked for word-to-word consistency: if the search
term is "teacher", "teachers" is not registered as a hit. This option always includes the
option "Starting letters".

Find and replace search terms in texts and tables (in the "Document
Browser")

In the very right of the search bar there is another icon that opens a field for replacing
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the found hits with a new term.

Find & replace – Allows you to enter a term with which you can replace the search
hits, for example to render the opened text anonymous.

Please note: As long as Edit Mode is active, the replacements can be undone by
clicking the Undo text changes icon in the Edit bar.

Find and replace

Find and replace document and code names

To search within the document and code names listed in the "Document System" and
"Code System" and replace them if necessary, proceed as follows:

Click on the magnifying glass  in the header of the respective window. The1.
search field will open, in which you can enter a search term. MAXQDA then
highlights the hits in the names of your documents and codes.
Click on the Find & Replace icon in the header. An additional input field will2.
appear in which you can enter a replacement term.
Clicking on Replace or Replace all will replace the selected terms.3.

Lexical Search
The lexical search function allows you to research your documents without first coding
them. You can do searches of either

documents,●

memos, or●

coded segments, which are currently shown in the “Retrieved Segments” window.●

The search can also be limited to activated documents. You can choose to search in●

a single document, a document group, or all documents that have certain variable
values. The lexical search function can be started by selecting Lexical search from the
Analysis drop-down menu or by clicking on the magnifying glass icon in the
“MAXQDA standard” toolbar.
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Lexical search icon in the Analysis menu tab

After selecting to do a lexical search, the following window will appear:

The dialog window for the lexical search

Entering a search string

When the dialog box first comes up, the left pane is empty and you can just start
typing to enter the word or string (called the “search string”) that you want to find.
Use the return key to enter multiple search strings.

To add additional search strings later, click "New entry". To edit an existing search
string, click on the word and change it.

Search strings may consist of one word, multiple words, or only of a part of a word.
For instance, you can search for “Tom Hanks,” “Hanks,” or only “anks.” Quotation
marks are not necessary if a search string consists of more than one word - it would
lead MAXQDA to only search for words that are placed in quotation marks.

Tip: If you highlight text in the „Document Browser“ then right-click on it and select
the option Search for highlighted text, the highlighted text will be displayed directly in
the Lexical Search window.

Search strings may contain so-called “wildcard” characters. You can use the following
wildcard characters:
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? single chracter
l?ve finds
"love" and "live"

* multiple chracters
h*ks finds
"hanks" and "hawks"

<(...) word beginning
<(inter) finds
"interests" and "internal", but not "winter"

(...)> word end (sh)> finds "slash" and "flash", but not "ashes".

To search for the asterisk * or the question mark ?, a backslash "\" must be placed in
front of them: \* and \?.

Please note: Hyphenation is not automatically recognized in PDF-documents. If in a
PDF document the word beginning, e.g. "climate" is at the end of a line, MAXQDA
will only find the whole word "climate change" if you work with placeholders, e.g.
"climate??change". The two question marks represent the line break and have to be
included in every possible seperation of charcters of the word. In the case of "climate
change" as the search string, the following strings need to be included for a complete
search: "cli-??mate change", "climate??change", "..."

Deleting a search string

To remove search strings from the list, click the x symbol next to the word or select the
whole line and click the delete symbol at the top of the dialog window. By holding
down the Ctrl key (Windows) or cmd key (Mac), you can delete multiple search strings
at once.

Text search options

You will find the options for the search procedure in the right pane of the Lexical
Search window.

First, you must specify where you wish to search:

If you select In documents, additional selection fields that were previously displayed●

in light grey will become available. These additional fields include “Only in activated
documents” and “Only in retrieved segments”. If no texts are activated, these
options will not be available.

Other options:

Find whole words – Search only for strings that are exactly the same as the search●

string. For example, if you search for “teach,” the string “teacher” will not be
included in the search results. If you turn this function off, “teach” would also give
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you the strings “teacher” or “teaching” as results.
Case sensitive – Search only for strings in which the same letters are capitalized as in●

the search string.
Interpret search items as regular expressions – the entered search terms are●

interpreted as "regular expressions". Regular expressions can be used to perform
complex searches (see below for more information).
Include word forms from lemma lists – searches are conducted not only for an●

entered search term but also for all its word forms. A search for "go" will also find
the word "went". The option affects only single words, not composite words. You
also have to set the appropriate language for the text.

Please note: You can view and edit the lemma lists used by MAXQDA. In the Help
from MAXDictio you can find detailed information about the location of these lists. If
you use the word-form function for your search and publish the results, you need to
include a license reference in your publication because the used lists are available
under an open license.

You can also choose how the search terms are linked with each other:

With the OR combination, a hit is always included in the results list when one of the●

search terms is found.
With the AND combination, all the search terms must occur within a defined●

distance of each other in an adjustable search range.
As soon as you have selected AND, another option is made available directly below●

it:
Within xx document/paragraph/sentence.●

With xx you define the maximum distance of the search terms.
The following options are available as a search range:

Document – the two search terms must occur somewhere within a document. In❍

this case, the maximum distance cannot be set.
Paragraph (Text, Tables) – the two search terms must occur within xx paragraphs.❍

The search only includes text and table documents.
Sentence (Text, Tables, PDFs) – the two search terms must occur within xx❍

sentences. In addition to text and table documents, the search also includes PDF
files.

Examples:

You search for the terms "public" and "citizen" within a document. MAXQDA will
then check that both of the two terms occur at least once. A row is displayed in the
results table for each document in which both terms occur at least once.

https://m22.maxqda.com/help-mx20-dictio/lemmatization
https://m22.maxqda.com/help-mx20-dictio/lemmatization
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You search for the terms "public" and "citizen" within 1 paragraph. The list of results
then contains as many rows as there are paragraphs in which both search terms occur.

You search for the terms "public" and "citizen" within 2 paragraphs. For example, if
paragraph 12 contains the term "public", then "citizen" must appear in paragraphs
11, 12 or 13. Only then will this count as a hit.

As soon as you click the Search button, the search will begin.

Depending on how many documents you search and how complex the search is, it
could take some time to find all of the results.

Searching with regular expressions

If you select the option Use regular expressions, MAXQDA interprets the entered
search terms as "regular expressions". These are widely used in information
technology and allow complex searches to be carried out. The following table contains
some examples of regular expression searches:

Search term Explanation Example

d Number from 0 to 9
200d
finds all years from 2000 to 2009

[…]
One of the
characters in
brackets

h[oôó]tel
finds hotel, hôtel, hótel
200[0-9]
finds all years from 2000 to 2009
Class [34][a-d]
finds class 3a, class 3b to class 4d

( | )
One of the character
combinations in
brackets

M(ay|ey|ai|ei)
er finds Mayer, Meyer, Maier and Meier

As an example, a helpful tutorial on the use of regular expressions can be found on
the following website:
https://medium.com/factory-mind/regex-tutorial-a-simple-cheatsheet-by-examples-
649dc1c3f285

Please note: There are several technical implementations of regular expressions. Perl-
compatible expressions (PCRE) are implemented in MAXQDA.

Saving search terms

Searches can be saved, i.e. you won't have to enter the search terms again. Click Save,

https://medium.com/factory-mind/regex-tutorial-a-simple-cheatsheet-by-examples-649dc1c3f285
https://medium.com/factory-mind/regex-tutorial-a-simple-cheatsheet-by-examples-649dc1c3f285
http://perldoc.perl.org/perlre.html
http://perldoc.perl.org/perlre.html
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enter the name of the saved scan, and then click Save again. Search files are saved
with the extension .SEA (an abbreviation for search). Saved searches can be reentered
at any time.

Search Results
Your results of a search within documents will be shown in a table that appears as
follows:

Example search results

Along with the usual filter functions, the toolbar at the top of the results window
provides access to the following functions:

  Autocode search results – codes search results with an existing code. All search
results that have not been excluded from the selection (and which display a Stop
 symbol in the first column) will be autocoded.

  Code search results with a new code – codes search results with a new code. All
search results that have not been excluded from the selection (and which display a
Stop  symbol in the first column) will be autocoded.

   Autocode/Export: ignore hit – exclude selected rows from autocoding and
exportation by clicking on this icon.

Activatedocuments with hits – Adjusts the activation of the documents in the
"Document System" so that only those documents are activated for which a search
term was found. This makes it possible to perform further analyses for these
documents, for example, to only consider the activated documents in a group
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comparison.

Detailed list of found locations - Shows a list containing all individual search hits.
This icon is only visible if several search terms were searched for within a specified
context (sentence, paragraph, document). For example, if you search for "learning
group" and "tutorial" within a given paragraph, the detailed list contains all the hits
found individually for "learning group" and "tutorial" where both search terms
appear in the same paragraph.

Refresh – Opens the search dialog box again, e.g. to adjust the search settings.

  Open as Excel table – the search table will be opened in XLS/X format in the
appropriate program (usually Excel). If you have selected a section of the results table
(marked green), only these will be included in the new table.

  Open as HTML table – the search table will be opened as an HTML table in your
standard internet browser. If you have selected a section of the results table (marked
green), only these will be included in the new table.

  Export – The table can be saved as a Word or Excel file, as well as in HTML, Rich
Text or TXT (Tab delimited) format. All rows that do not display a stop symbol will be
exported.

The table of search results can be handled in the same way as other tables in
MAXQDA: clicking on any column header will sort the table according to this criterion.
For instance, clicking on Document will arrange the document names included in the
table in alphabetical order. Clicking here again changes the sequence to descending
order. A little triangle indicates the sort attribute and order (ascending or descending).

The entire table or parts of it can be copied to the Windows clipboard (by selecting all
or part of it and pressing Ctrl+C (Windows) or cmd+C (Mac).

Below the title bar, you can see how many documents contain the search string and
how many times the search string appears in those documents.

Please note: Once you click on a hit, the corresponding document is opened and
positioned exactly where the reference is located. The search term found is
highlighted.

Search results when using the AND combination with search terms

If you search for more than one search item within the whole document, paragraph or
sentence, the search results table will not only list the hits for each search item
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separately. Instead, it will contain as many entries as combinations of the search items
have been found in the defined contexts, thus the number of documents, paragraphs
or sentences in which all the search items exist. The following screen shows this for
the search for „happiness“ AND „satisfaction“. In the column „Context“ MAXQDA
informs you, if these search strings exist within a document, paragraph, or sentence.

A click on a row highlights the first hit of an entered search item within the context.

To get a list of each individual hit of search items, click on the icon  Detailed list of
hits.

Search for “happiness“ and “satisfaction“ within one paragraph

Please note: When exporting the search hits or when autocoding them, MAXQDA uses
the detailed list of search items.

Opening your last search result

As long as your project is still open, you can always go back and review the last search
result, thus saving time in case you need to do the same search again. Go to the
Analysis menu tab, click at the bottom of the Lexical Search entry to open a short
drop-down menu and select Last Search Result.

Export Search Results
The results table of the lexical search tool offers the possibility to export search results
by clicking on the Export  icon in the toolbar of the results window. The following
options window will appear, where the range of the data to be exported in relation to
the search term can be defined:
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Options for search results output

The export window is divided into two parts. Options for the export of search results
from a PDF document can be selected in the upper section, with the corresponding
options for search results from text and table documents in the lower section. Exports
of pure search results as a simple list is generally not useful; therefore you can define
the range for the export of search results.

For PDF documents, you can define how many words or sentences before and after
the actual search term are exported. This option is also available for text and
spreadsheet documents, in addition to the Paragraph option. When you select one of
these two options, the name of the context options will change and you can choose
how many sentences or paragraphs before and after the search term you want to
include:
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Setting the data range for export

Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only
paragraphs in which the search term is found will be exported. If the term appears
several times in the same paragraph, the paragraph is still listed only once, whereas
the search term or terms will be listed more than once.

Setting 1 Paragraphs after means that the paragraph containing the search term, as
well as the following paragraph, will be exported.

Please note: Read the chapter on Extended Lexical Search to learn how MAXQDA
recognizes sentences.
The recognition of sentences in PDF documents is optimized for left-to-right languages
and may not work as expected with right-to-left languages.

When you click OK, a window will pop up in which you can select the file name,
format, and location to be saved. The following options are available:

texts in Word format (DOCX),●

tables in Word format (DOCX),●

Excel (XLS/X),●

Website (HTML),●

Maintext in Rich Text Format (RTF)●

Table in Rich Text Format (RTF)●

Tab Delimited Text (TXT)●

The result as Maintext in Word format will appear as follows:

Document:           New York/Riley (28 - 28)
Search string:     family
to go to college straight from high school in 1964 and become a teacher.  I was a
good student in high school graduating 19th in a class of 403.  I really wanted to go
to college, but my family couldn't afford it.  Unfortunately, my mother had the
attitude college was a waste for girls, because they got married and didn't put their
college education to use.  So, I never pursued the issue.  I know, I shouldn't blame my
mother for my not going to college.  I could have been more enterprising and tried to
find a way to pay for it on my own.  I think never having been a teacher will always
haunt me.  Now it's too late. I'd have to take a large salary cut if I were to change
professions at this stage in life.
 

Each search result consists of the source data, including the name of the document
group and document, and the position in which the search string was found (in

https://m22.maxqda.com/help-mx20/lexical-search/the-extended-lexical-search
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brackets), followed by the search string itself.

Autocode Search Results
Like the segments in the “Retrieved Segments” windows, lexical search results can be
automatically coded, meaning all text passages found in the search are assigned as
specific code. This automatic coding has the advantage of being easy and reliable. The
disadvantage, however, in comparison to manual coding, is of course that you can't
examine the relevance of each respective text passage during the coding process. The
occurrence of a specified string in the text automatically triggers the coding. For
example, if the word "Mother" is automatically coded with the code "Family",
references to "Mother Earth” would also be included.

To code the search results automatically, follow these steps:

The best way to code search results automatically is to click on the Autocode search●

results with a new code symbol.
In the dialog box that appears, you can define the new code as usual. MAXQDA●

automatically enters the search string as the code's name and the search settings as
a code memo. You can modify both, if required. Then click OK. The new code will be
inserted at the top of code system.
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Autocode search results: Define a new code

In the ensuing options window you can set the range before and after the search●

term as well as the weight, which is established during the coding process.

Setting options for automatic coding of search results

In the "Code" field, you establish with which code MAXQDA should assign to the
search results. The “Quick list of codes” – which lists the most recently used codes – is
displayed in this window. The code that you created earlier is automatically selected
here. Furthermore, a weight value can be set for all coded elements, that is to say, all
segments will be coded with the same weight.

In the “PDF documents” field, you can set whether only the respective search result
should be coded, or whether additional words or sentences before and after the
search results should be coded as well.

Please note: Read the chapter on Extended Lexical Search to learn how MAXQDA
recognizes sentences.

In the “Text and table documents” field, you can also determine if whole sentences or

https://m22.maxqda.com/help-mx20/lexical-search/the-extended-lexical-search
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paragraphs before or after the search result should be coded.

Setting the parameters for Autocoding

Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only
the paragraph in which the search term is found will be coded. If the term appears
several times in one paragraph, it will nevertheless be coded only once

The setting 1 Paragraph after means that the paragraph in which the search term is
found as well as the following paragraph will be coded. Again, if the term appears
several times in one paragraph, it will nevertheless be coded only once.

Please note: If you do not want to code with a new code, but with an existing code
from the "Code System”, you can use the Autocode search results  option. Before
you start the process, click on the desired code in the Code System, which will cause
the code to appear in the list of recently used codes in the Autocode options window.
Text segments that are already coded with the selected code will be ignored during
the autocoding process - even if a text segment contains the search string. This
ensures that you do not accidentally overwrite your manually coded segments during
the automatic coding process.

Exclude search results from autocoding

Fundamentally, all search terms that appear in the results list will be autocoded.
However, before executing the autocode function, you can review the list of search
terms in order to decide whether each term should be included or not. Once one or
more lines in the results table have been selected, click on the red icon
 Autocode/Export: ignore hit in order to exclude the entry.

The fastest way to exclude a term is to double-click in the first column.
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Exclude search terms from autocoding

Please note: The selected codes are incorporated into the undo coding list which can
be accessed from the Code toolbar in the Document-Browser window with the
 icon. This action can be reversed with a single command if necessary.

Extended Lexical Search
The Analysis > Extended lexical search function, as with the simple search option,
allows you to analyze your documents to a certain extent without having to have
already done any coding. In addition to the simple search, the extended search offers
to search for different combinations of search words. The searches can be carried out
in:

documents,●

memos, or●

the coded segments currently called up in the “Retrieved Segments” window.●

The search can also be limited to those documents that are currently activated in the
“Document Browser”.

To start an extended lexical search:

Go to the Analysis menu tab and click at the bottom of the Lexical Search entry.1.
From the drop down menu select Extended Lexical Search.2.
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Extended lexical search dialog box

The dialog is separated into several parts. At first you can enter search items in the text
fields

All these search strings (AND combination)●

Any of these search strings (OR combination)●

None of these search strings (search strings for exclusion)●

Please note, that you can separate different search strings with a space. If you want to
enter a combined search string you can use quotation marks like “Mahatma Gandhi”
around your search string. Question mark (“?”) and asterisk (“*”) work as
placeholders for a single character or for one or more charaters. Use <(word) for word
begin and (word)> for word end, <(inter) will find “interest” and “interesting”, but
not “winter”, and (ks)> will find “banks” and “thanks”, but not “bankside”.

Tip: Hyphenation is not automatically recognized in PDF-documents. If in a PDF
document the word beginning, e.g. "climate" is at the end of a line, MAXQDA will
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only find the whole word "climate change" if you work with placeholders, e.g.
"climate??change". The two question marks represent the line break and have to be
included in every possible seperation of charcters of the word. In the case of "climate
change" as the search string, the following strings need to be included for a complete
search: "cli-??mate change", "climate??change", "..."

In the upper right part of the dialog you can define, in which part of the project
MAXQDA will search an in the options on the right you can define in which context
the search items have to exist.

All three search entries will be combined with AND. In the screen above MAXQDA will
present all sentences in which “climate” and “energy” exist together, but not
“politics”.

Please note: Sentences are defined by MAXQDA according to the following rules: A
sentence always begins following a period, question mark, exclamation mark, or
colon. The following exceptions apply:
# A number that is not four digits appears before a period (e.g. 1. or 2.).
# A single character appears before a period (to exclude abbreviations).
# Two identical characters appear directly before a period (e.g. ff. or pp.).
# Literal speech in quotation marks belonging to the sentence itself.
# First letter after a sentence is in small letters.
# A number appears directly following the end of a sentence.
# Quotation marks appear immediately after the end of a sentence.
In text or table documents, a new sentence invariably begins after a paragraph.

The recognition of sentences in PDF documents is optimized for left-to-right languages
and may not work as expected with right-to-left languages.

Keyword in Context (KWIC)
Often, you wish to determine the context in which a given term is used. In this case,
you can create and print a so-called KWIC (KeyWord In Context) listing. In MAXDictio,
MAXQDA's additional module for quantitative content analysis and word-based
analysis, there is a seperate function for creating Keyword in Context listings. The add-
on module MAXDictio is available in MAXQDA Plus and MAXQDA Analytics Pro. You
can find more information about MAXQDA's product range here.
Basic Kexword in Context listings can be done using MAXQDA's lexical search
functions. The procedure is as follows:

Perform a lexical search by keyword.1.

https://m22.maxqda.com/products
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Double click on any search result in the result table to exclude this result (a stop2.
sign symbol indicates which lines are excluded).
You now have two option: Export all KWIC-listing to Word, Excel, HTML, or RTF by3.
clicking the Export icon. In a second step you can print this file. Or click the 
Autocode search results icon to code the search results with a new code, e.g.
"KWIC". You could then double-click the KWIC code to see the overview of coded
segments and continue your analysis from there.

In both cases, a dialog window will appear and let you decide how much context to
include, e.g. 1 sentence or 10 words or after the search string.

Keyword-in-Context from Search Results

The following image shows what the export of a keyword-in-context search looks like.
It has the following structure: each hit starts with the source data (document group,
document name, and the paragraph number containing the hit). The next line
indicates the search word or search string that has been found in that paragraph.
Finally the text segment itself is listed.

Keyword-in-Context export (context 1 sentence)
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11 - Segment Retrieval

Activation: The Principle of Segment
Retrieval
In MAXQDA, you can search for information in your documents in a variety of ways.
One method is to search for particular words or character strings with the lexical
search function. You may be familiar with this search method from text-processing
programs. The principle is basically the same in MAXQDA, with the advantage that
you can search many documents simultaneously for the words. A lexical text search
finds only those terms that actually appear in the text. Searching with theoretical
concepts and subject categories, such as “Helper Syndrome” in a study of volunteers
in social work, will naturally not provide any results.

By assigning codes to appropriate document segments, you be able to find segments
that relate to a certain theme. This finding of coded segments, also known as retrieval,
requires only that you have created codes and assigned them to those document
segments. After you have assigned codes to the document segments, you will be able
to call up all segments that were coded with the same code. MAXQDA offers various
ways to do this retrieval, but it is all based on activation of documents and codes.

The following explanation applies not only to texts, but also to coded segments in
images, PDF files, table documents, audio and video files.

The retrieval principle in MAXQDA is very simple:

All document segments from activated documents that were coded with any of the
activated codes will be called up and shown in the “Retrieved Segments” window.

Activating documents

First the documents: All documents and document groups are listed in the “Document
System”. The starting point, then, is an inactivated document. The current state of the
activation can be recognized by the color of the document name and the document
symbol: Activated documents are displayed in red and the grey circle in front of them
changes to a red arrow.

An inactivated document
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An activated document

As soon as at least one document is activated in a document group, a red arrow will
also appear in front of the document group symbol:

1. Activation with the mouse

The easiest way to activate a document is with the mouse: Click with the left mouse
button on the symbol of a document to activate it. Alternatively, documents can be
activated by clicking on the grey circle in front of the document symbol or on the
displayed number of coded segments at the end of the row.

All documents in a document group or document set can be activated in the same
way: To do this, click on the folder icon of the document group or document set. All
the documents in the project can also be activated with a single click by clicking on the
folder symbol of the "Documents" entry at the top of the "Document System".

Activate documents by clicking on the symbol with the mouse

2. Activation via the context menu

You can also activate a document via the context menu: Right-click the document
name or icon and choose Activate from the context menu.

In the same way, you can also activate all documents of a document group or
document set at the same time by right-clicking the group or set and selecting
Activate all documents. This menu entry is also available at the very top level,
"Documents", the root of the Document System.
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3. Activation with the Ctrl or cmd Key

Similar to selecting files in Windows Explorer or Mac Finder, you can also hold down
the Ctrl key (Windows) or cmd key (Mac) and click on the required document,
document group or document set with the left mouse key.

Activating codes

Activating codes works in the same way as for documents. Either right-click on a code
and click Activate in the context menu or click on the all symbols of the codes you
want to activate.

Activating a code via the context menu

The activation of the codes is also indicated by a red arrow and the red colour of the
code name.

Tip: If you hold down the keys Ctrl + Alt (Windows) or cmd + alt (Mac) when clicking a
parent code, only the parent code and not its subcodes are activated.

The status bar at the bottom of the MAXQDA window gives you information about
the number of activated documents, activated codes, and the number of document
segments that are being called up based on those activations.
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Activation information in the status bar

Compiling coded segments in the "Retrieved Segments" window

All of the document segments that were found based on your activations are called
retrieved segments or coded segments and are displayed in the “Retrieved Segments”
window - if it is currently open.

Called up document segments (coded segments) based on activated documents and codes

Example

Let’s say that you wanted to know what certain interviewees (e.g. Riley, Kim, and Sam)
said about other people in their lives. You would start by activating the appropriate
documents in the “Document System:”
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Hold the Ctrl key●

Left-click on the document “Riley”●

Left-click on the document “Kim”●

Left-click on the document “Sam”●

Next, you will need to activate the appropriate code along with its subcodes. In this●

case, the code is called “People”.
You can now see some basic information about your activations in the status bar. It●

shows that you have activated three documents and five codes (this includes the four
subcodes of “People”). You can also see that 27 document segments were retrieved
based on those activations:

Activation information found in the status bar

More activation methods

Activation via search in document and code names

Both in the "Document System" and in the "Code System" a local search for
document and code names can be performed. If you click on the magnifying glass in
the window title of the "Code System", the following search bar appears:

Activate code names with search hits

By clicking on the red symbol Activate codes with search hits (far right) all codes are
activated in the example where the searched word occurs. This process overwrites the
previous activation status.

Activating by variables

Activating documents and codes can done manually, but also automatically depending
on certain variable values. This type of activation is referred to in MAXQDA as Logical
Activation or Activation via Document and Code Variables, and is described in detail
here.

Activating by color

Documents and codes can be activated not only manually (by clicking them) and
automatically (by document and code variables), but also by color. In both the

https://m22.maxqda.com/help-max18/mixed-methods-functions/activation-by-document-variable-variables-as-selection-criteria-for-the-coding-query


11 - Segment Retrieval   331

"Document System" and "Code System" windows you will find the Activate by Color
entry in the context menu that appears when you click on the top entry of the
hierarchical "tree", More... > Activate Documents/Codes by Color.

After clicking on this button, a dialog field will appear with all the colors that have
been used for documents/codes so far. You can then check the box next to the colors
to be activated. The two radio buttons at the top also let you check or uncheck all of
the colors with a single click.

The colors representing codes or documents to be activated

Activate documents by random

In addition to activation with variables and colors, documents can also be randomly
selected. Right-click on the root of the documents and choose More... > Activate
Documents by Random.

In the dialog that appears, MAXQDA displays how many documents are available in
the project and allows you to enter a number of documents to be activated.

Activation of documents depending on code distribution

To activate all documents in which a selected code exists at least once, right-click the
code in the code system and choose Activate Documents with this Code from the
context menu. The current activation in the "Document System" will then be
overwritten.
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Resetting activations

Cancelling the activation of documents or codes operates on the same principle as
activation: either via the context menu or with the mouse (eventually using the Ctrl or
cmd key.) When you want to start a new Coding Query, but already have documents
and codes activated from a previous retrieval, the easiest way to proceed is to
automatically deactivate all of those documents and codes.

In the Analysis tab, you will find a Reset activations button, which fulfills this function.

Button to “Reset activations”

If you want to reset activations for only the documents or only the codes, you can do
so with the button available in the “Document System” or “Code System” toolbars.

Button to “Reset activations” for all documents in the “Document System”

Button to “Reset activations” for all codes in the “Code System”

It is also possible to deactivate all codes or documents by right-clicking on the
Documents icon in the “Document System” or the Codes icon in the “Code System”
and selecting Deactivate all documents or Deactivate all, respectively.

The "Retrieved Segments" Window
The “Retrieved Segments” window is a results window – it shows you all of the coded
segments that were coded with any of the activated codes in any of the activated
documents. The principle of the segment retrieval is as follows:

For all activated documents, the segments to which activated codes are assigned are
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compiled in the "Retrieved Segments" window.

Retrieved segments in the “Retrieved Segments” window

The top line shows you how many coded segments from how many different
documents and document groups are currently listed.

Below each segment there is an indication of origin, which informs you about the
document and the position of the segment in the document as well as about the
assigned code. The last segment in the image above is from the document "Joanna",
where the line 29 was coded with the blue code "Education". To the far left of the
segments, coding strips are displayed in the color of the assigned code, very similar to
the "Document Browser", but without the code name.

Tip: If you click with the left mouse button on the line with the source information or
on the coding stripe, the source text is loaded into the "Document Browser" and the
coded segment is highlighted. At the same time, the corresponding code is
highlighted in blue in the "Code System" window. If you click on the origin of an
audio or video segment, the "Multimedia Browser" opens and the clip is highlighted.

To the left of the segments there is a column for displaying memo symbols. If memos
are assigned in the area of the segment, you will see the same memo symbols here as
in the "Document Browser". As usual, the memo symbol is interactive:

A single click with the mouse marks the segment assigned to the memo in the●

"Document Browser" and displays it in its sidebar, provided that these are visible and
memos are enabled for display in the sidebar.
A double click on the symbol opens the memo for editing.●

Working with Comments for Coded Segments

As in the "Document Browser", you can switch on a sidebar to the right of the coded
segments in which the comments on coded segments are displayed. You can display
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or hide the column with the comments by clicking (ICON) Display comments on coded
segments in the toolbar of the window.

Comment column in the Retrieved Segments window

Double-click a comment in the sidebar to edit it. To create a new comment, right-click
the encoded segment and select Edit Comment from the context menu.

Tip: Alternatively, a double-click on the coding stripe opens the comment window at
any time to create new comments or edit existing ones.

Display Favorite Variables

It is often helpful to obtain further background information on the coded segments,
for example how old the person was who expressed a certain opinion in the interview
or in which industry a company operates, whose website texts are analysed. For this
purpose, you can display the so-called favorite variables of the documents in the
"Retrieved Segments" window at any time.

This is how you proceed:

Switch to the Variables tab and open the List of Document Variables.1.
Check the "Favorites" column for all variables that are interesting for your analysis2.
and close the window again.
Click the Display Favorite Variables icon at the top of the "Retrieved Segements"3.
window - if it was not already enabled.
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Selecting Favorite Variables in the List of Document Variables (selected variables are additionally highlighted in blue here)

Show variable information in the Retrieved Segments window

The selected variable information then appears directly below the document name:
Jan, for example, is 25 years old, lives alone and is not convinced that climate change
can be prevented.

Deleting coded segments and adjusting the weight

If you click with the right mouse button on a segment or its coding stripe, the
following context menu appears, which you may already know from the "Document
Browser":



11 - Segment Retrieval   336

Context menu for a coded segment

Here you can delete the coded segment, i.e. it is permanently removed from the
project and the coded segment is no longer displayed in the "Retrieved Segments"
window.

You can also change the weight of the clicked coded segment, which is displayed in
brackets at the end of the assigned code name. After selecting the menu option
Modify Weight, a dialog window appears in which the new value can be entered.

Modifying the weight score of a coded segment

Please note: You can turn off the display of weights in the "Retrieved Segments"
window if required. To do this, click on the gear for the local settings in the window
title and deactivate the Show weight option.

Sorting segments in the “Retrieved Segments” window

You can adjust the sorting of the coded segments at any time in the local settings of
the window. To do this, click on the gear in the upper right corner of the window title:

Local settings in the Retrieved Segments window

You can also carry out other functions by right-clicking on a gray area of the
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“Retrieved Segments” window in which the info boxes appear.

There are three possible variations:

Ordered by Document System – this means that the segments are listed in the same●

sequence as in the “Document System”. The list starts with the segments of the first
activated document in the “Document System”, then those of the second activated
document are given, and so on. Search results in this order would let you compare
what one respondent said to different selected topics. For example, given that the
first respondent’s answers were contained in one document or interview, followed
by a second respondent’s answers in a separate second interview, all of the retrieved
segments from the first interview would be listed before those from the second
interview.
Ordered by Code System – this means that the segments are listed in the same●

sequence as the codes in the “Code System”, starting with the uppermost activated
code.
Ordered by Weight Score (Ascending/Descending) – This sorts the segments●

according to the weight that has been assigned to them.

Tip: In the status bar at the bottom of the screen, the currently selected sort sequence
is represented by an icon. This symbol, for example, symbolizes sort by documents .
To customize the sort sequence, simply click the icon.

The table view in the "Retrieved Segments" window

The “Retrieved Segments” can be displayed in a table view. To do this, open the local
settings as shown in the figure above and select the entry Click the Change to table
view . MAXQDA will then display the coded segments in the same manner as the
Overview of Coded Segments in the preview window. This display is interactive: Click
on a row to show the corresponding segment in the “Document Browser".

The “Retrieved Segments” in a table view

Overview of Retrieved Segments
An easy way to get an overview of your retrieved segments is to open the Overview of
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Retrieved Segments by clicking on the appropriate icon in the toolbar at the top of the
“Retrieved Segments” window.

Opening the Overview of Retrieved Segments in the toolbar

Structure of the Overview of Retrieved Segments

The overview is divided into two parts: A list representation of the retrieved segments
is displayed in the bottom half of the window, while the upper half displays a detailed
view of the segment you have clicked in the bottom list. Simultaneously, the
"Document Browser" (or the Multimedia Browser for video coding) is positioned
accordingly, so that you can also see the surrounding context of the respective
segment. The larger the screen, the better this function is.

The two-section window in the Overview of Retrieved Segments

The option to display the retrieved segments in a table in XLS/X or HTML format is
particularly helpful. This gives a very good overview: not only the segment in plain text
but all the information around it is listed, for instance the date when the segment was
coded and the name of the person who did the coding.

Tip: The overview table is also the best place to write comments on your coded
segments. You read the segment in the upper window and write your comment
below. Just double-click the field for comments in the matrix and type in your
annotation.

Coding texts directly in the Overview of Retrieved Segments

You can code text segments, which are displayed in the upper window of the
Overview of Retrieved Segments. To do this, select any text area in the upper window
area and drag the selected text onto any code. In the "Document Browser", the new
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coded segements will be visible as a coding stripe - provided no filters are set for the
display of the coding stripes.

The toolbar in the Overview of Retrieved Segments

The following functions - alongside the usual icons for filtering, searching, and
deleting - can be accessed from the toolbar:

Code retrieved segments – the selected coded segments (marked in blue) from the
list will be assigned to an existing code. It is possible to select multiple rows by holding
down the Ctrl key (Windows) or cmd key (Mac). Existing coded segments with the
selected code are not changed..

Code retrieved segments with a new code – the selected coded segments (marked
in blue) from the list will be assigned to a new code. It is possible to select multiple
rows by holding down the Ctrl key. If no rows are selected, the entire table will be
coded.

Show as Excel table – opens a table in XLS/X format with the retrieved segments
and associated information.

Show as HTML table – A table in HTML format is created and displayed with the
default browser. If nothing is selected, the entire table will be displayed. If individual
rows are selected and highlighted in blue, only these rows will be exported.

Export retrieved segments – lets you export the overview as a text for Word or
other writing programs, as a table in Excel format or as an HTML-formatted web page.
The options are described in detail in Printing and Exporting Retrieved Segments.

What information can be found in the columns of the overview?

Regardless of the document type, the following columns of the coding overview have
the same signification:

Document group – document group from which the coded segment originates●

Document – document from which the coded segment originates●

Weight – weight of the coded segment (can be modified directly in the overview!)●

Comment – comment on the coded segment (can be modified directly in the●

overview!)
Code – the code with which the segment is coded●

Created/Last edited by – person who originally coded/last changed the segment.●

Created/Edited – the date on which the coded segment was originally coded/last●

edited

https://m22.maxqda.com/help-mx20/segment-retrieval/print-export-retrieved-segments
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Depending on the document type, the following columns have different significations:

Text Documents

Start – paragraph in which the coded segment begins●

End – paragraph in which the coded segment ends●

Preview – the first 63 characters of the encoded text (when exporting the output●

contains the entire coded segment)
Area – number of characters in the coded segment●

Coverage % – number of characters in the coded segment in relation to the number●

of characters of the text as a whole.

PDF Documents

Start – for text coding, the position of the character at which the coded segment●

begins. For image coding, the lower lefthand corner of the segment.
End – for text coding, the position of the character at which the coded segment●

ends. For image coding, the upper right corner of the segment.
Preview – the first 64 characters of the coded text. For images, <IMAGE> will be●

displayed (upon exportation the entire coded text and image segment will be
displayed)
Area – for coded text segment, the number of codes; for a coded image segment,●

the encoded area as measured in PDF units (line breaks are counted as two
characters)
Coverage % – for text, the number of coded characters in relation to the total●

number of characters in the text; for images, the area of the encoded image in
relation to the total area of the PDF

Image Documents

Start – the upper left corner, at which the coded segment begins●

End – the lower right corner, at which the coded segment ends●

Preview – always displayed as <IMAGE> (coded image segment will be displayed●

upon exportation)
Area – coded area, in pixel x pixel, where the side lengths are each reduced by 1●

pixel.
Coverage % – coded area in relation to the total area of the image●

Table Documents

Start – cell in which the coded segment is found●

End – identical to “Start,” as coded segments are always in the same cell●

Preview – displays the first 63 characters of coded text (when exported, will include●
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the entire coded segment)
Area – Number of characters in the coded segment●

Coverage % – for text coding, the position of the character at which the coded●

segment begins. For image coding, the lower lefthand corner of the segment.

Audio and Video Files

Start – the time at which the coded segment begins●

End – the time at which the coded segment ends●

Preview – always displayed as <AUDIO> or <VIDEO> (image of beginning of clip will●

be displayed upon exportation)
Area – length of coded media clips●

Coverage % – length of coded media clips in relation to total length of the file●

Sort, Hide and Reveal Columns

As with all tables, you can also organize the Overview of Retrieved Segments as you
wish:

Drag & Drop columns to change their order.●

Sort the table by a column by clicking on the column heading.●

Hide or reveal columns by right-clicking on the column heading.●

Opening the Overview of Retrieved Segments

Which retrieved segments are included in the overview depends on the context of the
overview:

All coded segments from the project:

Reports > Overview of Coded Segments●

Right-click on the stem of the “Document System” or “Code System” and select●

Overview of Coded Segments

Coded segments that currently appear in the “Retrieved Segments”
window:

Click on the  Overview of Retrieved Segments button in the “Retrieved Segments”●

toolbar

All coded segments of a code:

Double-click on the expanded code, or●

Right-click on the expanded code and select Overview of Coded Segments●
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All coded segments of a code and its subcodes

Double-click on the collapsed code, or●

Right-click on the collapsed code and select Overview of Coded Segments●

Print and Export Retrieved Segments
You may wish to continue to work with the segments in the "Retrieved Segments"
window. MAXQDA makes it possible for you to print out these segments, copy them
to the clipboard, or to export them as a file.

Printing retrieved segments

To print out the retrieved segments,

Click on the Print retrieved segments icon  in the “Retrieved Segments” window●

toolbar.
Click in the window to place it in focus (recognizable by the green marker in the●

window title), and use the keyboard shortcut Ctrl + P (Windows) or cmd + P (Mac)
or,
Switch to the Reports tab, click the Print icon and select the Retrieved Segments●

option.

You will then see the standard option for selecting your printer. In this window, you
can also select the print layout and choose to print out only certain pages.

Printout of the “Retrieved Segments” window

If you want to be able to edit aspects of the formatting, it is recommended that you
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first export the retrieved segments, open them for edit in a word processor, and then
print them out.

Exporting retrieved segments

To export your retrieved segments, click the Export icon  in the toolbar of the
window. Alternatively, open the function from the ribbon menu: Reports > Export >
Retrieved Segments.

The following option menu will appear:

Options for the export of retrieved segments

In the left window, specify which supplementary information should be exported in
addition to the coded segments, including:

Memos - If you select this option, all memos assigned to the coded area of the
segment, displayed in the "Retrieved Segments" window, will also be exported. When
exported as an Excel document or as a web page, all memos from one coded
segments will be included in a single cell.

Time range (for transcripts with timestamps) - For segments from a transcript, both the
time at which an coded text starts and the time span of the coded text are exported.
You can then check when exactly a statement in an interview was made. The specific
points in time and time spans are determined according to the timestamps in the
transcript and the number of characters of a coded segment and, if necessary,
extrapolated if the coded segment does not exactly match the time stamps.
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Print other codes assigned to the segment - For each codedsegment, the export file
writes which codes were assigned to it. Each overlap with another code is listed,
including its weight. With the option Only activated codes, only the activated codes
are taken into account.

Include favorite variables – When this option is selected, all variables that are selected
as "favorites" in the "List of document variables“ will be exported. For export in XLS/X
or HTML format, each favorite variable will be assigned to its own column.

Document Variables (x selected) - Click on the button with the three points to select at
which point variables should be exported. With each coded segment, the variable
values of the corresponding documents are then additionally exported. When
exporting as an Excel document or as a webpage in HTML format, each variable has its
own column.

In the section to the right, you can specify which source data should be exported with
each segment.

Choose between the three export formats: Word Document (DOCX), Excel Document
(XLS / X), and Web page in HTML format. After clicking on OK, you can enter the file
name and location, whereupon the export is started and the exported file is opened
with the preset program for the respective file type.

Export Retrieved Segments as text

Tip: You can also export the coded segments in the Overview of Retrieved Segments
this way.
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Copying retrieved segments to the clipboard - including source
information

In a research project, citations (e.g. interview passages) are often integrated into the
final report. It is important to note the source information of these citations - the
document and paragraph or line from which they were taken. MAXQDA simplifies this
process with the function Copy segment with source information to Clipboard. You
can access this function by right-clicking on the source information in the “Retrieved
Segments” window.

Getting a segment's source information from the context menu

Tip: The function can also be activated by right-clicking on
(1) a coding stripe in the "Retrieved Segments" window,
(2) a coding stripe in the "Document Browser", or
(3) a line in the "Overview of Retrieved Segments".

When you open the function from the context menu, MAXQDA copies the selected
segment into the clipboard. Now you can paste the citation into your word processing
program by pressing Ctrl+V (Windows) or cmd+V (Mac). At the end of the citation, the
document name from the “Document System,” as well as the paragraph or line
number, will automatically be inserted.

Citation with source information in word processing program

Code Retrieved Segments
MAXQDA makes it possible for you to code some or all of your retrieved segments in
the “Retrieved Segments” window. In this way, you can search and code quickly
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within specific segments that have been called up.

Let’s say you've carried out a retrieval of the intersections between the codes “Health”
and “Home life” for all the women in your interview sample. You can then choose to
code all of these segments with a code called “Health + Home life + women.” To do
this, click on the  Code retrieved segments with new code in the toolbar of the
"Retrieved Segments" window and enter the new code name. After clicking OK,
MAXQDA will code all segments in the "Retrieved Segments" window with the new
code.

Coding retrieved segments with a new code

Please note: If the listed coding segments overlap because the same location in the
data material was coded with different currently activated codes, then the outermost
segment boundaries of the overlapping segments are used. The number of newly
created coded segments may therefore be less than the number of listed coded
segments.

This action will be added to the list of coding actions in the Undo coding menu in the
“Code” toolbar. When you open this list (the  icon is in the coding toolbar in the
"Document Browser"), you will see the most recent coding actions at the top with the
number of segments coded in each action in parentheses after the code name. If you
have coded many segments at one time with the autocoding function, they can all be
removed at the same time by clicking once on the appropriate line in this list.

Undoing coding actions
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Coding segments in the Overview of Retrieved Segments

You can also add a code to the segments listed in the Overview of Retrieved
Segments. Two symbols are available in the toolbar of the window for this purpose:

Code retrieved segments - an existing code is assigned to the selected (blue
marked) retrieved segments of the list. Several rows can be selected by holding down
the Ctrl key (Windows) or the cmd key (Mac). If no rows are selected, the entire table
is coded. Existing encodings with the selected code are not changed.

Code retrieved segments with a new code - the selected (blue marked) retrieved
segments of the list are assigned a code, which can be created by clicking on the icon.
Several rows can be selected by holding down the Ctrl key (Windows) or the cmd key
(Mac). If no rows are selected, the entire table is coded.

If you code the segments with an existing code, a dialog appears in which you can
select the code from the "Quicklist of Codes". The quicklist contains all codes last
used or clicked, so you may need to click on the desired code before starting the
function.

Options for automatic coding of the segments in the Overview coded segments with an existing code
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Code in the "Retrieved Segments" window
and the Overview Coded Segments
You can select text passages in the "Retrieved Segments" window or the Overview of
Coded Segments and code these by dragging and dropping them onto codes with
your mouse.

Coding text passages in the "Retrieved Segments" window

As soon as text segments are displayed in the "Retrieved Segments" window, you can
select any part of these segments and drag and drop them onto a code in the "Code
System". MAXQDA then generates a coded segment of the selected text section and
assigns it the selected code.

Coding text passages direcly in the Retrieved Segments window

Please note: You can't code several selected text passages simultaneously.

Coding text passages in the Overview of Coded Segments

You can similarly code text passages in the Overview of Coded Segments:

Select a text section in the upper window area in the Overview of Coded Segments.1.
Use your mouse to drag your selection onto a code in the "Code System".2.

Coding text passages direcly in the Overview of Coded Segments section

Simple Coding Query
The Coding Query tool facilitates the retrieval process and the compilation of coded
segments. This tool allows you to control all essential settings from within a dialog
window. Before opening the Coding Query tool, you should activate the selected
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documents and codes. You can then open the "Coding Query" dialog window from
the Analysis tab: Click on the Coding Query option and select Simple Coding Query
from the drop-down menu.

The following window will then appear:

You can determine various settings for the query from the dialog window:

Only activated documents – Select whether all documents, or only activated
documents, should be considered in the query. The number in brackets indicates how
many documents are currently activated.

Only activated codes – Same options as for Documents.

Include subcodes – If selected, subcodes of codes will be included in the query.

Use weight filter – The output of coded segments can here be limited to segments of a
specific weight range.
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Only segments of user – The output of coded segments can here be limited to
segments that were created by a specific user.

Complex Coding Query
Different than with classic quantitative content analysis, the categorization of data in
qualitative analysis is not the end of the document analysis; instead it is simply a step
toward further interpretative analysis. The categories create a structure within the
documents, but they don’t replace them. MAXQDA’s analysis functions are tools to
help you navigate and further develop this structure.

MAXQDA allows you to analyze the combination of activated codes in different ways,
by taking into account the different groupings and positions of coded segments. In
this section, we will discuss the complex combinations modes, of which MAXQDA has
many to offer.

To perform a complex retrieval you can call up the Complex Coding Query:

Select Complex Coding Query from the Analysis menu,●

Click on the icon  in the status bar at the bottom of the MAXQDA screen, or●

Access to the Complex Coding Query in the Analysis tab

The following dialog window will open:
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Complex Coding query window

The dialog window has the following aspects:

The "Function" field allows you to choose the analysis function, ie, a combination●

mode of the codes, the operation of which is described in each case.
Below that, there are three windows, labeled A, B, and C.●

Window A is important for almost every retrieval option and holds the selection of●

codes to be included in the selection function. To add codes, activate them in the
“Code System” and then click the button to add All activated codes.

B is also for selecting codes, but you can do so from the quick list. Simply click on the●

symbol to the right of window B to view the list. To transfer a code to the quick list,
simply click on it in the "Code System".

C allows you to set certain parameters (e.g. the maximum distance between two●

coded segments).
The "Results" field underneath offer functions to select what should be listed as a●

result in the "Retrieved Segments".

Tip: You can also drag codes directly from the "Code System" to the A and B with
your mouse.

The "Options" field lets you apply the following settings:
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Only activated documents (number of currently activated documents) - the coding
search is limited to the currently activated documents. You can also adjust the
activation in the "Document System" when the dialog window is open.

Include subcodes - when this option is activated, not only the selected codes but also
their subcodes are taken into account. Think of this options like so: the codes in the
code system are collapsed and all coded segments of the subcodes are included in the
coding search. Details on this option can be found in the Include Subcodes in Retrieval
section. This option can also be activated in the status toolbar after you have
completed your search.

Apply weight filter - if the option is activated, only the coded segments whose weight
is within the entered range are retrieved. The weight filter can also be set in the status
bar after a successful search.

Only coded segments of users - if this option is activated, only the coded segments
created by the selected users are taken into account.

Above the buttons you can see how many segments have been found, i.e. for how
many segments the set conditions apply.

The retrieval begins when you click on the Start button.

The following table gives you an overview of the various functions:

Name Description
Intersection
(”small picture”)

Retrieve only the part segments that have all of the codes listed
in "A" assigned to them.

Intersection (Set)
Retrieve only the part segments that have at least X of the codes
listed in "A" assigned to them (the number X is specified in
"C").

Overlapping
(”big picture”)

Retrieve the full segments where at least one part has all the
codes listed in "A" assigned to it.

Only one code
Search for segments where only one of the codes listed in "A" is
assigned (and none of the other codes listed in "A").

Only this code
Search for segments where the code selected in "B" is assigned,
but none of the codes listed in "A" are assigned.

If inside
Search for segments assigned to any one of the codes listed in
"A" that are also completely surrounded by a segment assigned
to the code selected in "B".

If outside
Search for segments assigned to any one of the codes listed in
"A" that has no overlap or intersection with a segment assigned
to the code selected in "B".

https://m22.maxqda.com/help-mx20/segment-retrieval/include-subcodes-in-retrieval
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Followed by

Search for segments assigned to any one of the codes listed in
"A" that is followed by a segment assigned to the code selected
in "B" within no more than X paragraphs. The number X is
specified in "C". (Does not work in image or PDF documents.)

Near

Search for segments assigned to any one of the codes listed in
"A" that is preceded or followed by a segment assigned to the
code selected in "B" within no more than X paragraphs. The
number X is specified in "C". (Does not work in image or PDF
documents.)

You can see which retrieval function is currently active in the status bar at the bottom
of MAXQDA, in this case it is the “Near” function:

Retrieval function in the status bar

Please note: If there are no segments shown in the “Retrieved Segments” window, it
could be because a retrieval function was accidentally activated. You can quickly check
for this in the status bar.

Complex Retrieval Functions
Intersection (“small picture”)

Definition: Retrieve only the part segments that have all of the codes listed in "A"
assigned to them.

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.

Attention: All selected codes in Window A must be assigned to a segment in order for
them to be listed!

Changing the activations in the “Document System” immediately changes your
results.

It is often helpful for this function to include the subcodes, so that all combinations of
intersections between each code (and its subcodes) are automatically included. The
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easiest way to include the subcodes is to click on the  symbol at the bottom of the
screen.

Example:

Intersection (Set)

Definition: Retrieve only the part segments that have at least X of the codes listed in
"A" assigned to them (the number X is specified in "C").

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.
Set the minimum number of codes that must intersect in Window C.4.

You can see in the “Results” window how many retrieved segments would be found
based on intersections.

Example:

If Codes 1, 2, 3, and 4 are entered in Window A, and you have entered in Window C
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that at least three intersections are required, the first two examples to the right would
not be called up. The first doesn’t have any intersections, and the second only has two
intersecting codes. The third has the required three intersection codes, though, so it
would be listed in the “Retrieved Segments” window.

Only the section of the coded segments that is coded with all three codes is displayed.

Overlapping (“big picture”)

Definition: Retrieve the full segments where at least one part has all the codes listed in
"A" assigned to it.

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.

Attention: Segments will only be listed if they are coded with all codes listed in
Window A.

The “Overlapping” function works just like the “Intersection” function, except that
the results are displayed differently. The results of “Overlapping” include the entirety
of each coded segment that overlaps, rather than just showing the section that is
coded with both codes.
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As with the “Intersection” function, it is often helpful to include subcodes in the
retrievals. Then all combinations of subcodes are tested for overlap.

Example:

Only one code

Definition:Search for segments where only one of the codes listed in "A" is assigned
(and none of the other codes listed in "A").

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.

Example:        

If codes 1 and 2 are in Window A, the first two examples on the right would be
included in the retrieval, because they don’t overlap each other. The fact that codes 2
and 3 overlap makes no difference, because code 3 is not in Window A. The third
example would not be included in the retrieval because codes 1 and 2 intersect.
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Only this code

Definition: Search for segments where the code selected in "B" is assigned, but none
of the codes listed in "A" are assigned.

This function is very similar to the “Only One Code” function, but it targets only one
selected code. The target code is selected in Window B. The other codes are selected
as usual in Window A.

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with4.
the mouse from the "Code System" into Window B.

Example:

Code 1 is the selected code (Window B). Code 2 and 3 are the codes in Window A.
When either Code 2 or Code 3 intersects with Code 1, Code 1 is not listed. This is the
case in the second and third examples on the right. Only the first example shows an
instance of Code 1 that isn’t intersected by Code 2 or Code 3. It would be listed in the
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“Retrieved Segments” window.

If outside

Definition: Search for segments assigned to any one of the codes listed in "A" that has
no overlap or intersection with a segment assigned to the code selected in "B".

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with4.
the mouse from the "Code System" into Window B.

Example:

This function would be helpful if you were looking for text segments in which people
talk about what they consider possible, but don’t want to include those instances that
are in the context of these peoples’ wishes.

Code 1 is in Window A, and Code 2 is in Window B. This means you are looking for
instances of Code 1 that are completely outside of Code 2. In the example on the
right, only the third example would be called up. In the first example, Code 1 isn’t
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even there, and in the second, Code 1 is not completely outside of Code 2.

If inside

Definition: Lists segments where the code in Window A is completely surrounded by
the code in Window B. Results can be the segments of the inner code (Window A) or
the outer code (Window B).

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with4.
the mouse from the "Code System" into Window B.

Example:

Let’s say you are interested in the things people said about criteria for success, but
only in the context of what they consider feasible. You could use this function, putting
the “criteria for success” code in Window A and the “considered feasible” code in
Window B.

In the examples on the right, only the first shows a case where Code 1 (Window A) is



11 - Segment Retrieval   360

found completely inside Code 2 (Window B). That is not the case in the second or the
third examples.

Followed by

Definition: Search for segments assigned to any one of the codes listed in "A" that is
followed by a segment assigned to the code selected in "B" within no more than X
paragraphs. The number X is specified in "C". (Does not work in image or PDF
documents.)

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.
Select the relevant code in Window B. The fastest way to do this is to drag it with4.
the mouse from the "Code System" into Window B.
Enter a maximum allowed number of paragraphs between the codes in Window C.5.
If zero is entered as a number, B must begin in the same paragraph as A.

You can define what results should be generated as result of this function: The
segments of the code in Window A which are within distance X before Window B's
code, the coded segments of Window B's code, or both. The last option, however, will
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rarely be necessary.

Example:

In the example on the right, we are looking for Code 1 (Window B) following Code 2
(Window A) within two paragraphs.

Code 1 appears four times in the example, but only the third instance would be
included in the results, because it follows an instance of Code 2 within two
paragraphs.

Near

Definition: Search for segments assigned to any one of the codes listed in "A" that is
preceded or followed by a segment assigned to the code selected in "B" within no
more than X paragraphs. The number X is specified in "C". (Does not work in image
or PDF documents.)

How it works:

Activate the relevant documents in the "Document System".1.
Go to Analysis > Complex Coding Query and select this function.2.
Activate the required codes in the "Code System" and then click on All activated3.
codes in Window A.
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Select the relevant code in Window B. The fastest way to do this is to drag it with4.
the mouse from the "Code System" into Window B.
Enter a maximum allowed number of paragraphs between the codes in Window C.5.
If zero is entered as a number, B must begin in the same paragraph as A.

You can define what results should be generated as result of this function: The
segments of the code in Window A which are within distance X before Window B's
code, the coded segments of Window B's code, or both. The last option, however, will
rarely be necessary.

Example:

We are looking for places where Code 2 (Window A) and Code 1 (Window B) are
found within two paragraphs of each other (Window C).

Code 1 is found four times in the screenshot, but only the second and third instances
are within two paragraphs of Code 2.

We chose to view the Window B code in the Retrieved Segments, but we could have
theoretically chosen to list the Window A code or even both of them.
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Weight Scores
All segments that appear in the “Retrieved Segments” window have their weight
listed next to the source data (in brackets after the code).

Weight scores Retrieved Segments window

These weight scores can be used for the retrieval process. The user can define a range
for the weight scores in order to retrieve only those document segments with scores
inside of that range. To define this area, click on the gear symbol in the upper right
corner of the window of the "Retrieved Segments" window, and select Edit Weight
Filter.

The following window will then appear, in which you can enter any number between
0 and 100.

Setting the range for the Weight filter

To turn the filter on and turn it on, you must switch it on again: Click on the gear
symbol in the "Retrieved Segments" window again and select Use Weight Filter.

This will cause only those segments to be displayed in the “Retrieved Segments”
window that have a weight score within the defined range. The weight filter affects all
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retrieval functions, including “Intersection” and all functions of the Complex Coding
Query.

The status line at the bottom of the screen indicates whether the weighting option is
currently activated or not. When the function is switched on, the weight range applied
in the "Retrieved Segments" window is displayed.

Display of weight filter in the status bar

Tip: Click the weight filter icon in the status bar to turn the weight filter on and off.

To the left of the weight filter, the default value for the weight is also displayed in the
status bar. After clicking on this icon, you can change the value assigned by default
when assigning codes.

Include Subcodes in Retrieval
A hierarchical system of codes can be constructed with MAXQDA. The program offers
an easy way to make use of the hierarchical structure.

Example

Imagine you have defined the following codes:

Success criteria [parent code without coded segments]●

ecologically❍

economically❍

socially❍

Ideal projection [upper code without coding]●

ecologically❍

economically❍

socially❍

If you now want to assemble all the coded document locations that have been
assigned a subcode of "success criteria" as well as any subcode of "ideal projection",
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you could use the Complex Coding Query to search for overlaps between the two
subcodes. This approach would, however, be very cumbersome, especially if you are
dealing with still deeper code hierarchies or a large number of subcodes.

MAXQDA now offers the convenient option including subcodes in a code search. To
do this, select the Include subcodes option in the context menu. In the example, it
would be sufficient to only activate the two upper codes and choose the Include
subcodes option. Now all subcodes of the two activated codes are taken into account
in the search for overlaps.

Whether the subcodes are included in the code search or not can be recognized in the
context menu itself (by the marked or unmarked checkbox).

The “Include subcodes” option in the context menu of the “List of coded segments”

It is also shown in the status bar, whether or not the subcodes (or “code children”) are
included. If there is a checkmark on the symbol, the subcodes are included.

https://m22.maxqda.com/help-max18/finding-coded-segments/logical-combinations-codes
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Subcode inclusion shown in the status bar

Tip: You can also select the option directly in the status line by clicking on the icon -
this acts as a switch and changes the setting.

Include subcodes in the simple Coding Query

The option for subcodes also aplies to the simple search for codes: In this case it's
sufficient to activate an upper code in order to automatically display the coded
segments of the non-activated subcodes in the "Retrieved Segments" window.

But, as described, the search function's full potential can be seen in the Complex
Coding Query, in which several codes are combined with one another.
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12 - Visual Tools

Code Relations Browser: Visualize Code
Co-Occurrences
A tool similar to the CMB is the Code Relations Browser (CRB). The CRB is a
visualization of the relationships between codes. A table shows how many document
segments any two codes are attached to. The representation is similar to the Code
Matrix Browser, but in this case, the little squares/circles stand for the number of co-
occurrences of codes.

The CRB is constructed as follows: Codes form the columns and the rows. The symbols
at the individual nodes indicate how many segments were coded with both the row's
code and the column's code. The larger the symbol, the more segments there are.

An example of the Code Relations Browser visualization

You can open the CRB in different ways:

Click on Code Relations Browser in the Visual tools tab,●

User the keyboard shortcut Ctrl+Alt+R (Windows) or cmd+option+R (Mac)●

Click the Code Relations Browser icon  in the "Retrieved Segments" window●

Code Relations Browser options

After opening the Code Relations Browser an options window will appear, which
allows you to change display options. Often, only the activated documents might be of
interest, for example.
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Code Relations Browser options dialog

First, you have to decide which codes will be shown as rows:

All codes – All codes will be shown, the order being the same as it is in the “Code
System”

Activated codes – Only the activated codes will be shown as rows.

A similar decision has to be made for the columns in the Code Relations Browser, with
the added option of Choose top level code. Selecting this option will open another
dialog window after pressing OK, allowing you to select as many top level codes as
you want. The selected top level codes and their subcodes will be shown as columns in
the Code Relations Browser.

Under Type of analysis you can select which relations MAXQDA will show:

Intersection of codes in a segment  – Only “real” overlaps of codes will be used, which
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means that a segment has to be coded with both codes and the codes need to
overlap.

Proximity of codes in same document – Alternatively the Code Relations Browser can
analyze how often two codes are present at a defined distance from one another. The
distance can be set to a specific number of paragraphs (text), rows (tables), or second
(audio / video).

If you search with the "Proximity" function and chose distance "0" you may find more
hits than searching for intersecionts of codes. The function "Proximity" only evaluates
if two codes are assigned somewhere in the same paragraph – not at the same
segment.

Important: Please note that the "Proximity" function does not work for PDF
documents and images.

Occurrence of codes in the same document – In this analysis type the Code Relations
Browser shows in how many documents both codes occur at all. The codes do not
have to intersect or be in a specific proximity to each other.

In the lower area of the options window you can restrict the Code Relations Browser
display to certain documents or parts of documents coded with specific codes.

Only for activated documents - This setting is used to restrict the display in the Code
Relations Browser to the documents currently activated in the "Document System".

Only for segments of the following codes - This setting limits the search to segments
coded with specific codes. If you drag a code from the "Code System" into the field
with this mouse, MAXQDA only analyzes code co-occurrences within segments that
have been coded with these codes.

Code Relations Browser toolbar

At the top of the screen, you will find the toolbar with the following functions:

 Code map – Opens a "Code Map" visualization that display the relations of the
codes currently displayed on a map.

 Quote Matrix – Export all coded segments in an Excel table.

 Create hierarchical codes - If this option is activated, the codes are displayed in the
hierarchical structure of the code system, even if the option "Only activated codes" is
set, non-activated parent codes are also included to maintain the tree structure. If the

https://m22.maxqda.com/help-mx20/visual-tools/code-map-position-codes-according-to-similarity
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option is deactivated, all codes are displayed on one level. If the "Only activated
codes" option is activated, then only the activated codes can be displayed.

   Names, columns: none/short/full – Determines display of document
names in column headers.

Display nodes as squares.

Display nodes as circles.

Display nodes as values.

Count hits per document only once – The Code Relations Browser display will be
based not on the number of code relations but rather on the full document, meaning
it will display only whether a code relation occurs in a document or not. For collapsed
subcodes, the code relation frequency of the subcodes will be aggregated. When
using the feature "Occurrence of codes in the same document" this option is selected
automatically and hidden from the display window.

Binarize view – when selected the Code Relations Browser will show only whether
a code relation is present or not; all symbols are displayed in the same size. For
collapsed subcodes, the code relations frequency of the subcodes will not be
aggregated.

Sum – displays the sum of rows and columns.

Refresh – updates display via the Refresh function.

Open as Excel table – Displays the Code Relations Browser view in Excel.

Export – Exports the displayed matrix as values, meaning the number of code
relations, in Excel or HTML format, or as an image file.

What is actually shown in the Code Relations Browser?

Each symbol in the matrix represents the number of co-occurrences of the two codes.
The larger the symbol, the larger the number of co-occurrences. If you hover over a
node with your mouse, a small window appears informing you about the node codes
and the number of their relations.
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Node information window

The order of codes in the Code Relations Browser will be identical to the order in the
“Code System”. If you want to change the order in the graphic, you have to change
the order in the “Code System” first.

Tip: You can hide columns from the display by right-clicking on the column header
and choosing Remove.

How are symbol sizes determined?

How MAXQDA determines the symbol sizes is explained in detail in the Code Matrix
Browser section.

Jumping from the symbol to the coded segment

You can jump to the document segments with overlapping codes by double-clicking
on the node representing them. The “Overlapping” retrieval function will
automatically be activated, bringing up the segments in the “Retrieved Segments”
window. The CRB can remain open, so you can quickly go from one set of overlapping
codes to another.

Please note: If you are in mode "Proximity" and double-click on a node, that has
collapsed codes, the collapsed subcodes will be expanded automatically and only the
higher code will be evaluated, not the previously collapsed codes.
If you are in mode "Occurrence of codes in same document" and double-click on a
node, all of the documents where the relation occures are activated.

Exporting the CRB as an image file

The Export  symbol allows you to save the current CRB display as a file, which you
can then insert easily into a word processing file or Powerpoint slide.

Click on the camera icon  to copy the current view into the clipboard. Now you can
open Word, PowerPoint, or other programs and paste the image into it by choosing
Ctrl+V (Windows) or cmd+V (Mac).

https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
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Code Matrix Browser: Visualize Codes per
Document  
The Code Matrix Browser (CMB) offers you a new way of visualizing which codes have
been assigned to which documents. The matrix provides an overview of how many
document segments from each document have been assigned a specific code, and this
for each existing code.

The Code Matrix Browser is constructed as follows: Documents are listed in the
columns while codes are listed in the rows. The symbols at the conjunction points
represent the number of coded segments that are coded with a particular code. The
larger the symbol, the more coded segments are assigned to the code in question.
Document groups, document sets or focus group speakers can also be displayed in the
columns of the CMB, for example to compare individual cases or groups of cases.

The Code Matrix Browser

The Code Matrix Browser can be opened in the following ways:

Selecting Code Matrix Browser from the Visual tools drop-down menu, or●

using the keyboard shortcut Ctrl+Alt+M (Windows) or cmd+option+M (Mac)●

Code Matrix Browser options

After opening the Code Matrix Browser an options window will appear, which allows
you to change display options. Often, only the activated documents might be of
interest, for example.
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Code Matrix Browser options dialog window

First you have to decide whether the results should be grouped or not:

Documents – No grouping, every document has a column.

Document groups – The columns are made up of document groups. The coded
segments of the documents in each group will be summed up.

Document sets – The columns are made up of document sets. The coded segments of
the documents in each document set will be summed up.

Focus group speakers – Focus group participants are displayed in the columns.

Further options allow you to selected data material:

Only for activated documents – Only the activated documents will be displayed. (If
there are no activated documents in a document group or document set, the CMB will
be empty.)

Only for activated focus group speakers - Only the activated speakers are displayed in
the columns. This option is only visible if the focus group participants have been
selected for the columns above.

Only for activated codes – Only the activated codes will be displayed as rows.

Use weight filter – Only coded segments with a weight within the limits of the
currently defined weight filter will be used.
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Code Matrix Browser toolbar

The toolbar is the first thing you will see at the top of the Code Matrix Browser
window. Here you have access to the following functions:

 Interactive Quote Matrix – Displays the coded segments associated with the cells
in an interactive view.

 Create hierarchical codes - If the option is activated, the codes are displayed in the
tree structure of the code system. Even if the "Only activated codes" option is
selected, non-activated upper codes are also included to preserve the tree structure. If
the option is deactivated, all codes are displayed on one level. If the "Only activated
codes" option is activated, then only the activated codes can be displayed.

    Names, columns: none/short/full – Setting the column widths

  Calculation of symbol size refers to all coded segments.

 Calculation of symbol size refers to the column.

 Calculation of symbol size refers to the row.

 Display nodes as squares.

  Display nodes as circles.

  Display nodes as values.

 Count hits per document only once – Representation in the CMB does not refer to
the number of segments, but to the documents, i.e. it is only displayed whether the
relevant code is present in the document or not. With collapsed subcodes, the code
frequencies of the subcodes are aggregated.

  Binarize view – Regardless of how many coded segments are present in a cell, this
function displays only whether a coded segment is present or not; the symbol size is
therefore unified. Even when a collapsed subcode with multiple encodings is present,
only one will be counted.

  Sum – displays the sum of rows and columns.

  Refresh – updates display via the Refresh function.

 Copy current clipboard view - Copies the visible area to the clipboard so that you
can easily copy the code matrix browser's results into reports or publications by using
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Ctrl + V (Windows) or cmd + V (Mac).

  Open as Excel table – Displays the matrix with the code frequencies of the Code
Matrix Browser in Excel. The columns and rows are reversed to allow an easier import
into SPSS.

 Export – Exports the displayed matrix as values, meaning the number of coded
segments per code and per document, in Excel or HTML format. The columns and
rows are reversed to allow an easier import into SPSS and other statistics programs.
Exporting as a graphics file (Vector or Bitmap) is also possible.

What is actually shown in the Code Matrix Browser?

The size and color of the clusters in the matrix show you how many document
segments in each document have been assigned each particular code and subcode.
The larger the cluster, the greater the number of segments that were assigned this
code or category in this document.

When you move the mouse cursor on a cluster, a screen tip appears:

Tooltip in the Code Matrix Browser

The name of the document, the code or subcode, and the number of coded segments
assigned to the code are shown in the box.

The document names in the column headers can be displayed in three ways:

 without document names,●

 with short document names, or●

 with full document names.●

The number of documents that can be displayed as columns in the matrix depends on
this setting. In most cases, it is sufficient to use short document names, showing only
the first few letters, which nevertheless is enough for you to recognize it. If in doubt
about a document, you can take a look at the screen tip, where the full document
name is displayed. If necessary, the width of the columns can be adjusted by clicking
on a dragging the lines between column headers. For focus group speakers, the
names of the participants will be displayed in the columns in the place of the
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document names.

Tip: The order in which the columns are displayed is determined by the order of
documents in the Document System. If you wish to change the order of the
documents, you must change the order of the documents in the Document System.
You can also adjust the order of the columns by clicking and dragging the column
header with the mouse. In this way, you can easily compare the coded segments of
two different documents or focus group participants. The next time you call the Code
Matrix Browser, however, the sequence is taken from the document system again.

By default, the codes are displayed in the CMB in the same way as in the “Code
System,” that is, in a hierarchical "tree" structure. Subcodes can be collapsed in the
usual way, by clicking the – symbol.

When the subcodes are collapsed, the number of coded segments is aggregated on
the parent code level. If a parent code (that hasn’t been used in the document) has
three subcodes with 10 coded segments each, when you collapse the subcodes, the
parent code will show 30 coded segments.

Jumping from the symbol to the coded segment

The document segments that have been assigned a particular code can be called up
immediately by double-clicking on the symbol. The relevant document and code are
then activated and the coded segments appear in the “Retrieved Segments” window.
It is possible to keep the CMB open, allowing one to easily view the contents of
different symbols.

How is the symbol size determined?

MAXQDA determines the smallest and largest code frequency of all displayed nodes
and then divides the distance between these two values into seven equally-sized value
ranges. The smallest value range receives the smallest symbol and the largest the
largest symbol. In addition, the maximum distance between the displayed code
frequencies is taken into account. For example, if codes occur only once or twice in the
displayed documents, this distance is very small, and neither the smallest nor the
largest squares will be used, but two medium-sized ones, so as not to over-emphasize
the difference. The following graphic shows which square sizes are used at which
distance between the smallest and largest values (the range). If the smallest displayed
value is e.g. 5, and the highest is 8, then the range is 8-5 = 3. The cells with value 5
are then assigned the smallest square from row "3", the cells with value 8, the largest
from this row. If all the visualized numbers are identical, a medium-sized square will be
displayed for all values.
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Square sizes in the Code Matrix Browser

The zooming-out of codes can change the overall view because this may change the
smallest and/or the greatest value.

If the Calculation of symbol size refers to the column/row option is selected, this
mechanism is applied individually to the column or row.

Exporting the CMB as an image file

The Export  icon in the toolbar allows you to export the Code Matrix Browser as
currently displayed. This file can later be inserted into a word processing program or
Powerpoint slide.

Click on the camera icon  to copy the actual view into the clipboard. Now you can
open Word, PowerPoint, or other programs and paste the image into it by choosing
Ctrl+V (Windows) or cmd+V (Mac).

Code Map: Position Codes According to
Similarity
In the code map, selected codes are displayed as on a map. The more two codes
overlap, i.e. the more similar they are in terms of their use in the data, the closer they
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are placed together on the map.

A code map

Creating a code map

To create a code map, follow these steps:

Select Visual Tools > Code Map in the ribbon menu. The following dialog box will1.
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then appear: Options for
new code maps
Use your mouse to drag all the codes from the "Code System" that you want to2.
place on the code map into the upper area of the dialog box. You can also activate
codes and transfer them directly to the dialog box via the Insert activated codes
button.
Select one of the following three options, which determine what aspect should be
analyzed to determine the similarity between two codes:
Intersection of codes in a segment – Counts the number of times two codes have
been assigned to a segment together. Intersecting codes are sufficient; they do not
have to cover 100% of the same area.
Proximity of codes in same document – Counts the number of times two codes
were assigned at a definable distance in the same document or in the same media
file. You can also enter the maximum distance in relevant number dial.
Code occurrence in same document – Counts the number of documents in which
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two codes occur. The location of the two codes is irrelevant; they must both have
been assigned at least once in the document.
If necessary, restrict your analysis to currently activated documents only.3.

Click on OK and MAXQDA will open an accordingly generated code map:

Code map window

What does a code map display?

Each circle symbolizes a code, with the distances between two codes representing
how similarly the codes have been applied in the data material. As a further option,
the larger the circles the more code assignments have been made with that code.
Colors can be used to highlight groupings (clusters). In addition, connecting lines
between the codes can be activated, which indicate which codes overlap or co-occur.
Optionally, the connection lines are displayed thicker the more coincidences there are
between two codes.

Please note: If a code selected in the options dialog box does not occur together with
any other selected code, it will not be placed on the code map. (2) Several codes may
be placed at the same position on the map if their similarity to other codes is identical.

Toolbar options:

You can use the toolbar at the top to adjust various settings for your code map.
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The first three symbols allow you to set what aspect is analyzed to determine the
similarity between two codes. These are the three options mentioned above:

 Analyzed relation of codes – Intersection of codes in a segment.

 Analyzed relation of codes – Proximity of codes in same document.

 Analyzed relation of codes – Codes occur in same document.

Changing these similarity settings recalculates the display of your code map.
Futher options:

 Display code frequencies - Displays the code frequency in the analyzed documents
after the code name.

 Size of code symbols reflects code frequency – The more frequently a code is
used, the larger its symbol will be displayed.

 Font size reflects code frequency – The more frequently a code is used, the larger
its name will be displayed.

 Font – Select a font for the display, e.g. to adapt it to the font used in your
publication.

Increase and decrease font size – Adjusts the font size of the code names.

 – Determines the color of the code symbols.
Select cluster to assign a color to the codes according to their group affiliation. You
can determine the number of clusters in the number field.
Select uniform to assign the same color to all codes.
Select Code System to adopt the color already assigned to the code in your "Code
System".

 Zoom out, Zoom in – Zooms in and out of the displayed section of your map.

 Refresh – Reopens the options dialog box to select other codes or documents.

Export code map

Symbols for export and further processing are available at the top right-hand corner:

 Copy current view to clipboard – Inserts a high-resolution image into the clipboard
so you can paste it directly into a report or presentation.
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 Save as map in MAXMaps - Creates a new map in MAXMaps, the tool for concept
maps in MAXQDA, and inserts the content of your code map here. You can edit the
map later in MAXMaps.

 Export – Saves the display as an image file in PNG or SVG format. If you select
Excel (XLSX) as the export format, all the calculated values are entered in the export
file: (similarity matrix, distance matrix and coordinates).

Code map interactivity

Code maps are interactive:

Click on a code to select it in the "Code System”.●

Right-click a code and select Remove to delete it from the map. The map will then●

re-generate itself with the remaining codes.

Opening a code map from the Code Relations Browser

If you use the Code Relations Browser, MAXQDA creates a matrix which displays the
common occurrence of two codes. Since exactly such an evaluation forms the basis for
the code map, it can also be opened directly from the Code Relations Browser.

To do this click on the first icon on the far left:

Open a code map from the Code Relations Browser

MAXQDA will then create a code map with all codes that are displayed both in the
columns and in the rows of the Code Relations Browser and that occur together with
at least one other of these codes.

Please note: In the code map that appears, you can't switch to other analysis models
of the relationships between codes. The model will have already been defined in the
Code Relations Browser.
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Notes on the analysis process and presentation

The classic multidimensional scaling method is used to position the codes on the map.

For this purpose, a similarity matrix is first calculated according to the display in the
Code Relations Browser and then converted into a distance matrix. For the conversion,
the column sums are calculated first, so each code is checked to see how often it
occurs together with any other code. The maximum of these column sums is
determined and defined as the maximum possible similarity. In each cell, the similarity
of two codes is subtracted from this maximum.

A distance of 0 therefore means that two codes only ever occur together, i.e. never
without the other. A distance corresponding to the maximum means that these codes
never occur together. Please note that due to the reduction to a maximum of 2
dimensions (i.e. on one map) and this consequent angle of view, two codes may
appear visually closer together than the distance matrix would suggest.

The codes are clustered by means of a hierarchical cluster analysis using the distance
matrix. Average linkage is used as the clustering method.

If the option Size of code symbols reflects code frequency is enabled, the
determination of symbol sizes is similar to the Visual Tools Code Matrix Browser and
Code Relations Browser: MAXQDA determines the smallest and largest code frequency
of all displayed symbols and then divides the distance between these two values into
seven equally-sized value ranges. The smallest value range receives the smallest symbol
and the largest the largest symbol. In addition, the maximum distance between the
displayed code frequencies is taken into account. For example, if codes occur only
once or twice in the displayed documents, this distance is very small, and neither the
smallest nor the largest symbols will be used, but two medium-sized ones, so as not to
over-emphasize the difference.

The following graphic shows which symbol sizes are used at which distance between
the smallest and largest values (the range). If the smallest displayed value is e.g. 5, and
the highest is 8, then the range is 8-5 = 3. The cells with value 5 are then assigned the
smallest symbol from row "3", the cells with value 8, the largest from this row. If all
the visualized numbers are identical, a medium-sized symbol will be displayed for all
values.
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Determination of symbol size as dependent on distances

Document Map: Arranging documents
according to Similarity
The Document Map is a visual tool that displays selected documents as though they
were arranged on a map. The greater the similarity between two documents with
regard to codes assigned to them, the closer their circle symbols are located to each
other; the less similar they are, the further away they are from each other. If required,
the variable values of the documents can also be taken into account when
determining their similarity. Documents that are similar in terms of their code
assignments and variables can be marked with matching colors. Optionally, the size of
the circles themselves can be set to reflect the number of code assignments made in
the respective document.
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The Document Map

The Document Map is an ideal tool for visually grouping of cases (documents) and can
serve as a basis for type formation or for more in-depth explorations of the identified
groups.

Generating a Document Map

To generate a Document Map:

Select Visual Tools > Document Map in the MAXQDA main menu. An empty1.
document map will appear with its own menu.
In the Document Map window, under Start > Select Documents, select the2.
documents you want to place on the map.
Via Start > Select Codes, select the codes you want to take into account when3.
determining the similarity between documents.

MAXQDA will now place all the selected documents on the map.

Select the analysis mode

Two different modes can be selected in the Start tab to determine the distances
between the documents:

Frequency of Codes/Variable Values – The frequency with which a code has been
assigned in a document is taken into account. So if the code "Parents" was assigned
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twice to Document A and three times to Document B, this is considered a difference.

Occurrence of Codes/Variable Values – Only whether a code has been assigned to a
document at all is taken into account. In the above example, Documents A and B
would count as identical with regard to the code "Parents", because the code was
assigned in both cases – how often the code was assigned does not matter here.

Depending on the selected calculation mode, different similarity or distance measures
can be selected. These are described in detail in the Similarity Analysis for Documents
section.

Please note: When several documents are located in the same place because they were
coded identically with regard to the currently selected analysis mode, the number of
documents in this location is displayed instead of just one document. The
corresponding documents are listed in full when you move your mouse cursor over
them.

Taking variable values into account

By clicking on the Start > Select Variables icon, you can also select document variables
to be taken into account when determining the similarity between documents, in
addition to codes. If the calculation mode Frequency of Codes/Variable Values is
selected in the Start tab, variables of the types "integer" and " decimal" can be
selected. If the variant Occurrence of Codes/Variable Values is selected, variables of the
types "Text", "Date" and "Boolean" can be selected.

As there may be missing values for the selected documents in a document variable,
you have the option of choosing between two alternatives as to how to proceed in
this case:

Missing values: Set to 0 – The variable value is set to 0. Selecting this option usually
only makes sense in the Frequency of Codes/Variable Values mode.

Missing values: Exclude Documents – Documents with at least one missing value for
the selected variables are not placed on the map. In brackets behind this option you
can see how many documents are affected and therefore not visible on the map.

Document Map interactivity

The Document Map is interactive:

Click on a document to select it in the "Document System".●

Double-click a document to open it.●

https://m22.maxqda.com/help-mx20/mixed-methods-functions/similarity-analysis-for-documents
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Hover your cursor over a document name or icon: A tooltip will appear displaying●

which of the selected codes have been assigned in this document.
Right-click a document and choose Remove to delete it from the map. The map will●

then regenerate itself with the remaining documents.
Right-click on a document and select Activate Documents in this Cluster to select●

only the documents of the clicked color in the "Document System". This allows you
to perform anal-yses that only take into account the documents in this cluster.

Context menu for a document displayed on a Document Map

Customizing the display

In the Format menu you will find several options for interactively adjusting the
appearance of the Document Map:

Adjusting the Document Map in the Format tab

Number of Codes – Displays in brackets after the document name how many of the
selected codes occur in the document.

Size Reflects Number – The more the selected codes have been assigned in the
document, the larger the circle will be symbolizing that document.

Font Size Reflects Number – The more the selected codes have been assigned in the
document, the larger the font of the document.

Grid – Displays or hides a map grid – just as on real maps – to better estimate the
relative distances between documents. The grid works with a fixed resolution of 100
pixels. Distances can therefore only be compared within one map using the grid, not
between different maps.

Color: Cluster / Document System / Uniform – Specifies how the documents are to be
assigned a color. Cluster: documents are assigned a color according to their group
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affiliation. You can determine the number of clusters in the numeric field. Document
System: color is taken from the "Document System". Uniform: all document symbols
are assigned the same color.

Comparing and refining clusters

To better assess the similarities of the documents in a cluster and the differences
between the clusters, the function Display > Typology Table: Cluster is available. This
opens the following window:

Typology table for comparison of individual clusters

The selected codes and variables are listed in the first column. The other columns are
made up of clusters.

In the Occurrence of Codes/Variable Values analysis mode, the number of documents
in which the code or variable value occurs is specified in the typology table. In the
Frequency of Codes/Variable Values analysis mode, the mean value and standard
deviation of the documents are displayed instead.

In the example above, the first cluster consists of seven documents, the other two of
one and two documents, respectively. The first row shows that the code
"Grandparents" was assigned on average 0.4 times in Cluster 1, three times in Cluster
2 and not at all in Cluster 3. And from the last line it can be seen that the people in
Cluster 1 are on average 20.4 years old.

Tip: The table is interactive. If you change the number of clusters in the Document
Map while the window is open, the number of columns in the typology table
automatically changes.

The allocation of individual documents to clusters can also be saved as variables so
that these can be used later for grouping the data. To do so, select Start > Save
Cluster As Variables. The Data Editor for document variables will open, to which a new
column with the cluster allocation will have been added.
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Exporting a Document Map and calculations

The Start tab provides functions for exporting and refining the map as well as its
underlying calculations:

 Export Matrix – Saves an Excel file with the following contents: A distance matrix,
coordinates - and a similarity matrix if the analysis mode "Occurrence of
Codes/Variable Values" was selected.

Save As Map in MAXMaps – Creates a new map in MAXMaps – the tool for
Concept Maps in MAXQDA – and inserts the contents of the Document Map here.
You can edit the map later in MAXMaps.

 Save to Clipboard – Saves a high-resolution image of the map to the clipboard so
you can paste it directly into a report or presentation.

 Export – Saves the display as an image file in PNG or SVG format. If you select
Excel (XLSX) as the export format, the same calculations are exported as when you
select the Export Matrix option.

Notes on Document Map calculations and display

The classic multi-dimensional scaling method is used to locate the documents on the
map.

For this purpose a distance matrix of the documents is calculated for the selected
analysis mode Frequency of Codes/Variables as described in the section Similarity
Analysis for Documents. If the evaluation mode Occurrence of Codes/Variable Values is
selected, the resulting similarity matrix is first converted into a distance matrix. Since
the similarity values can be a minimum of 0 and maximum of 1, the conversion is
performed by subtracting each similarity value from 1.

A distance of 0 means that two documents are identical with regard to the number or
frequency of the selected codes and the considered variable values.

Please note: Due to the reduction to a maximum of two dimensions (i.e. the mapping
of the document positions onto one plane) and the viewing angle taken, two
documents can appear visually closer together than the distance matrix would suggest.

The clustering of the documents proceeds according to a hierarchical cluster analysis
using the distance matrix. Average linkage is used as the clustering method.

If the option Code Size Reflects Code Frequency is switched on, the same principle is

https://m22.maxqda.com/help-mx20/mixed-methods-functions/similarity-analysis-for-documents
https://m22.maxqda.com/help-mx20/mixed-methods-functions/similarity-analysis-for-documents
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used to determine symbol sizes as with a Code Map.

Document Comparison Chart: A Visual
Comparison of Coded Text
This visualization works for a number of documents at one time and offers a sort of
mix between the Document Portrait and the Codeline. Simply choose the documents
and codes that you wish to include in the visualization by activating them before
calling up the function.

Please note: Only texts and table documents can be analyzed with the Document
Comparison Chart.

The Document Comparison Chart shows the documents on the y-axis and the
paragraph numbers on the x-axis, making it possible to compare the flow of codes in
each document. The cells show the codes that exist in each paragraph of each
document with a bar assigned the same color as the code it represents. Each code that
is present in the paragraph is represented by a colored section of the bar. If a code is
used more than once in a paragraph, it is still only visualized once. To give you an idea
how this works, see the screenshot below. In this example, you can see 10 paragraphs
for three different documents. You can see that there were no coded segments in any
of the documents in the first paragraph. In “Doc 1,” the first coded segments are in
paragraph two, where two blue and one red code are visualized.

 1 2 3 4 5 6 7 8 9 10
Text 1 ■ ■ ■ ■ ■ ■ ■ ■ ■ ■

Text 2 ■ ■ ■ ■ ■ ■

Text 3 ■ ■ ■ ■ ■

If several codes appear in the same paragraph, the colors of both codes are listed in
the cell of the chart provided for that paragraph. By default, each paragraph is the
same width, regardless of how many characters it includes. In the case of several
codes, the available space is assigned proportionally to the coded segments in the
paragraph, taking into account how frequently a code has been assigned in the
paragraph - not how extensive the segment is. If a code occurs three times in the
paragraph, another code only once, then the first code gets ¾ of the area, the second
only ¼ of the area.

Like in Document Portrait, codes and colors must correspond in a meaningful way.

https://m22.maxqda.com/help-mx20/visual-tools/code-map-position-codes-according-to-similarity
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Otherwise the diagram will have no meaning for you.

You can open the Document Comparison Chart by selecting Document Comparison
Chart via the Visual tools tab.

The visualization looks like this:

Example of a Document Comparison Chart

The Document Comparison Chart is particularly useful for the analysis of structured
documents. In this case, all the documents have the same number of paragraphs and
allow for a direct comparison. You are more or less looking at a Document Portrait for
each selected document at the same time.

Interactive links with source files

As in all visualizations, the symbols representing the coded segments are interactive,
meaning you can jump directly to the coded segments in the original document in the
“Document Browser” by double-clicking on the symbol.

Standardize document length

In order to be able to compare texts of different lengths with respect to their
sequences of their coded segments, the Document Comparison Chart offers the
Standardize Document Length option , which you can find as a symbol at the far left
of the toolbar. Activating this function means that MAXQDA does not present the
analyzed texts in a paragraphs, but divides them into 100 equal sections and visualizes
the coded segments present in each section.

Adjust window width

Activating the option Fit to window width compresses the display horizontally to
fit your window. This is particularly useful for publications in which the entire coding
process of several documents needs to be displayed on one page.
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Usually you will use this option together with standardized document lengths, so that
all documents in the window can be compared directly with each other, even if they
are of different sizes.

The slider in the toolbar can be used to adjust the width of the columns, i.e. the
"resolution" of the subdivision with vertical lines.

Exporting the Document Comparison Chart as an image file

The Export  icon allows you to export the current display of the Document
Comparison Chart so you can later insert it into a word processing file or Powerpoint
slide.

Click on the camera icon  to copy the actual view into the clipboard. Now you can
open Word, PowerPoint, or other programs and paste the image into it by choosing
Ctrl+V (Windows) or cmd+V (Mac).

Document Portrait: Visualize a Document
This visualization is for a specific document, making it a case-oriented function. The
document is shown as a picture of all the coded segments based on the order and
colors of the codes.

You can access the Document Portrait for the displayed document in the “Document
Browser” window…

by selecting Visual Tools > Document Portrait from the menu,●

by right-clicking on a document and selecting Document Portrait in the context●

menu that appears.

The results of this function are only meaningful if you have made use of the
opportunity to assign colors to codes. The visualization of a document can only be
fruitful if this association of colors makes sense to you. Here are a few examples:

Imagine a psychologist has coded an in-depth interview in a way that categories●

related to aggression have red colors and categories for quiet and friendly behavior
have green colors. Now a Document Portrait would show with you in a single glance
how often the interview shows aggressive behavior and when during the interview
this happened.
In biographical research, the particular representations can be chosen for critical life●

events, thus making it easy to get an idea of the life course of a person and the
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concentration of critical events.
For thematic analysis, it may be useful to associate different colors to different topics.●

Now, you can easily see which topics dominate the discussion and which topics are
closely related.

Tip: The document portrait can’t be used for coded image files and PDFs.

What is a Document Portrait and what does it show?

A Document Portrait shows the sequence of codes for a selected document. To better
understand what happens, it is useful to take a look at the “Overview of coded
segments” for a selected document. All coded segments are listed in this overview.
The first column displays the color associated with the code. This is the material that is
used to “paint” document portrait. Only those colors displayed in the first column of
the overview table will appear in the visualization. In the overview table, all segments
are equal regardless of their size. The Document Portrait, however, takes the size of
the segments into account and “weights” the color according to the segment’s size.

The color attributes of the codes associated with the document are displayed in a
matrix with 1,200 little squares (arranged in 30 rows, each one with 40 squares). The
representation starts with the first square on the left in the first line, and ends with the
last square on the right of the last line. The picture is set up in the same way as a
television screen, where an electronic stripe goes along the screen from left to right.
All 1,200 squares are divided up according to the share of the coded segments. If a
document only had segment coded with a blue code, then the Document Portrait
would be totally blue. If this segment were coded with two codes, red and blue, the
Document Portrait would consist of 600 blue and 600 red squares. If two segments
were coded (again with red and blue codes) and the first segment were twice as
extensive as the second, the picture would start with 800 hundred red squares
followed by 400 blue squares.

Thus, Document Portrait displays the structure of documents in terms of codes as a
colorful picture. This helps to immediately identify the basic tone of a document, for
instance, if emotions have been coded with meaningful colors (aggressive= red,
tolerant= green, and so on).

Try out the Document Portrait – right-click on a document of your choice in the
“Document System” and choose Document Portrait. Of course, meaningful results can
only be obtained if you have assigned colors that make sense for your codes.
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Example of a Document Portrait

Document Portrait visualization options

Visualize entire text document or coded text - This button lets you toggle back and
forth between the two visualization options. If you choose to visualize the entire
document, the visualization will include white squares for sections of the document
that have no code assigned to them. The other options only visualize segments of the
document that were coded.

Mixed colors for overlapping codes (yes/no) - This setting decides how segments
should be visualized that are coded with more than one code. If the above option is
off, each of the colors of the codes used to code the same segment will be listed
sequentially, one after the other, similar to how it works in the “Overview of coded
segments.” If the option is turned on, the colors of each assigned code are mixed
together.

Display nodes as circles (on/off) - This icon lets you switch the symbols in the
visualization back and forth between squares and circles.
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Sorted by document - The sorting of the coded segments visualized in the
Document Portrait is determined by their occurrence in the document.

Sorted by color - The coded segments are sorted by colors, same colors are
grouped.

Sorted by color frequency - In this special display option the portrait will be “tidied
up”: all symbols with same colors are stacked like in a bar chart and the bar with the
most tiles is placed left. Only the most frequent 20 colors will be visualized.

The size of the document portrait can be adjusted using the drop-down menu from
the symbol toolbar. Two square and three rectangle sizes are available.

Interactive link with the source material

The square or circle symbols in the Document Portrait are also directly connected to
the original data, which means you can click on any symbol to call up that coded
segment in the “Document Browser.” (This is not possible if you have chosen to mix
colors for overlaps.) If you right click on a symbol you will find the option Retrieve
coded segments with this color which will list all coded segments with the chosen
color in the “Retrieved Segments” window.

Exporting the Document Portrait as an image file

The Export symbol allows you to export the current display of the Document Portrait
so you can later insert it into a word processing file or Powerpoint slide.

Click on the camera icon to copy the actual view into the clipboard. Now you can
open Word, PowerPoint, or other programs and paste the image into it by choosing
Ctrl+V (Windows) or cmd+V (Mac).

Codeline: The Sequential Visualization of a
Document
The Codeline is a case-based visual function that displays a sequential view of a
document’s coded segments. The Codeline vizualisation is available for texts, PDF
documents. tables and also for videos. The picture is quite similar to that of a score of
a piece of music. For a text, the x-axis displays its paragraphs, starting with §1 and
ending with the last § of the particular text. The y-axis displays the codes. The cells of
the Codeline matrix are filled with a colored symbol, if the code has been assigned to
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the paragraph.

The basic idea behind the visualization can be seen below. There are 12 paragraphs
and three codes shown. You can see that nothing was coded in the first paragraph of
any of the documents. In the second, eleventh, and twelfth paragraph, Code1 is used.
In paragraph five, both Code2 and Code3 were used. This shows you already how you
can use this visualization. It gives you a vizual overview of a document, so for the
phases of an interview you can quickly identify which codes appear and co-occur.

 Paragraph
 1 2 3 4 5 6 7 8 9 10 11 12

Code1  ■         ■ ■

Code2     ■ ■ ■ ■   ■  
Code3    ■ ■     ■  ■

You can open MAXQDA's "Codeline" either

via the main ribbon menu: Visual Tools > Codeline or●

by selecting Codeline in the context menu for a text, table, or PDF document●

Codeline options

When you call up the Codeline, MAXQDA offers the following options:

Only for activated codes – this limits the codes to be included in the visualization to
those that you have already activated in the “Code System.” If you have activated a
subcode, also its parents will be integrated in the vizualisation.

Aggregate on the 1st level – this option means that only top-level/parent codes will be
visualized. The subcodes of each parent code will be handled as if they were instances
of the parent code.

Use weight filter – if you select this option, MAXQDA will open another dialog after
clicking OK, in which you can set a range for the coding weight. Only those segments,
that fit into this range will be displayed in the Codeline.
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Options for the Codeline visualization

Codeline display

Unlike the Document Portrait, the Codeline tool can be used even if you have not
associated meaningful colors to your codes. The Codeline graphics display the color,
but if you have not selected colors, only green symbols will be displayed. The function
of Codeline is to show where in a document the different codes have been applied,
and this diagram also makes sense and can be interpreted without color
differentiation.

What can the Codeline be used for?

Codeline gives a good overview of the coding and can therefore be used universally.●

The diagram may be of use for exploration – just follow a particular code, see when●

it appears and which other codes appear near it.
The opportunity to display only selected codes enables comparing two or more codes●

in the course of an interview.
When analyzing focus groups, you can see at a glance which speakers react to each●

other and what the topics are in relation to the speakers.
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Example of a Codeline visualization

What does MAXQDA's Codeline display?

MAXQDA's "Codeline" creates a "codes x paragraphs" table for texts.●

The codes are listed in the sequence of the text's paragraphs, starting with the first●

paragraph, i.e. the beginning of the text. The paragraphs form the X-axis, i.e. the
diagram has exactly as many columns as the text has paragraphs.
If a code has been assigned within the paragraph, you will see its code color●

depicted as a rectangle in the corresponding column. If codes have been assigned to
several paragraphs consecutively, you will see a continuous bar.
When a parent code is collapsed, the subcodes are added to this parent code and●

displayed in the color of the parent code.

Codeline for table and PDF documents and for audio and video files

The Codeline function is available for all document types that MAXQDA supports, with
the exception of images. Depending on the document type, different units will be
used for the columns:

Text Paragraphs
Table Rows
PDF Pages
Audio- und VideodateiSeconds or minutes, depending on the lenght of the document

and the place available

Display options

Above the Codeline you will see a toolbar, which offers several options for the display:

Unit: paragraph – if you select this option all paragraphs will be displayed with the
same width, independent from their content. Furthermore, the whole paragraph width
will be filled with the color of the code, no matter how large or small the coded
segments within this paragraphs are.

If you deselect this option the Codeline will consider how many characters have been
coded with a code and only those parts will be colored, not the whole paragraph. The
column headers will display the number of the paragraphs, but the column width will
be proportional to the length of the paragraph.

The option works identically for the other document types: selecting the option 
Unit: Row / Page / Second / Minute all units will be displayed with the same width and
just a single coded segment in a unit will led to unit width that is filled completely.
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Create hierarchical codes – If the option is activated, the codes are displayed in the
tree structure of the code system. Even if the “Only activated codes” option is
selected, non-activated upper codes are also included to preserve the tree structure. If
the option is deactivated, all codes are displayed on one level. If the “Only activated
codes” option is activated, then only the activated codes can be displayed.

Fit to window width – selecting this option will "compress" the Codeline into the
horizontal space of the window. This is very helpful for any publication in which you
want to include an image of the whole Codeline, but in which the space is usually
limited to a page size. The proportions of the visualized coded segments will stay the
same, only very short coded segments get a special treatment: they will be reduced to
a minimum of a thin vertical line only, but will not be excluded from the view.

You can use the slider next tot he icons to adjust the column width.

Interactive link with source files

The display of the coded segments is interactive. If you hover the mouse over a
symbol, a tooltip appears with the code or subcode name and the position. Double-
clicking on the symbol highlights the appropriate segment(s) in the “Document
Browser” or Multimedia Browser.

Exporting Codeline as an image file

The Export  icon allows you to export the current display of the Codeline so you can
later insert it into a word processing file or PowerPoint slide.

Click on the camera icon  to copy the actual view into the clipboard. Now you can
open Word, PowerPoint, or other programs and paste the image into it by choosing
Ctrl+V (Windows) or cmd+V (Mac).

Word Cloud: Visualize Word Frequencies
Word clouds are used to visualize the most common words in a text. They are ideal for
exploring large amounts of text and creating informative visualizations for
presentations.
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Word Cloud

Generating a word cloud

Word clouds can be generated for individual documents, document groups, document
sets, or for all the documents in a project. Right-click on the level in the "Document
Browser" for which you want to generate the word cloud and select the entry Word
Cloud.

Alternatively, you can also open the Word Cloud function via the icon with the same
name in the Visual Tools tab. A dialog box will then open in which you can select the
relevant documents.

Word Clouds in the Visual Tools tab
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Stop list: Excluding words in the word cloud

So that your word cloud does not consist mainly of insignificant words or words
bearing very little meaning, you can create a stop list of these words. The easiest way
to do this is to open the Word frequencies function in the Start tab. The table that
appears will list all the words in the text in their order of frequency.

Double-clicking on the green icon in front of a specific word will put it in the stop list,
which means it won't be considered for word clouds. You can also select several
words in the list (using Ctrl + or cmd + the left mouse button or Shift + the left mouse
button for an area in the list) and then right-click and select Add to Stop List to
transfer them to the stop list. An icon with the same name is also available in the
toolbar.

Word frequency list

When you click the Refresh and apply stop list, the word cloud is regenerated
excluding words from the stop list.

Tip: You can always right-click a single word in the word cloud and select Add to Stop
List to exclude it from the word cloud. To re-create the word cloud without the
excluded words, click the Rearrange icon.

Editing the stop list

The option Edit stop list displays the complete stop list used for word clouds in the
current project. You can remove words from this list or add new words, although the
way of doing this described above, by clicking in the frequency list, is actually much
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easier. Here you can also save and load already defined stop lists in order to exchange
them between projects.

Tip: "MAXQDA Plus" and "MAXQDA Analytics Pro" users can also edit the stop list via
MAXDictio > Stop List and easily exchange entries between different lists.

Working with the word frequency list

Via Start > Word frequencies you can open a list of all the words contained in the
analyzed texts. This list shows, amongst other things, how often each individual word
occurs. It is also possible to combine several words to one. To do this, click and drag
one or more words onto another word with your mouse.

Adjusting the display

You can use the numerous options in the Start and Display tabs to customize the
appearance of the word cloud, including the number of words displayed, their font,
their shape, and color.

The Start tab

Functions in the Start tab

Word frequencies – Opens a list of all words contained in the analyzed texts (without
the stop words) and shows their frequencies. Words can easily be transferred from the
word frequency list to the stop list.

Edit Stop List – Opens the list of all excluded words and lets you import existing stop
lists.

Words – Specifies how many words are visualized. You can use the slider to
incrementally remove rarer words. If several words occur with the same frequency,
words starting with letters earlier in the alphabet are selected first.

Zoom – Allows you to zoom in and out of the visualization. At 100%, the word cloud
is displayed fully maximized within the current window size.

Minimum Frequency – Defines the minimum number of times a word must occur in
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order to be displayed.

Characters to be disregarded – Clicking on the button with the three dots opens a
small dialog box in which you can enter characters that should be cut off from words
and ignored during counting. The selected characters then apply to all word-based
functions in MAXQDA and MAXDictio.

Case Sensitivity – If this option is activated, a distinction is made between capitalized
and non-capitalized words. For example, the words "earth", "Earth" and "EARTH"
are treated as three different words.

Ignore Numbers – Excludes all "words" consisting only of numbers.

Language Options – Change the language to Japanese to create word clouds from
Japanese texts.

Rearrange – Regenerates the word cloud, placing words in different random locations.

Copy to Clipboard – Copies the current view to the clipboard so you can easily paste
the word cloud into a report or presentation.

Export – Exports the current view as an image file for further processing.

The Display tab

Functions in the Format tab

Shape – Lets you define the outer borders of the word cloud. There are various
variations to choose from:

predefined forms (circle, ellipse, square, triangle)●

most frequent word●

a word you have entered●

a custom-selected image (is converted into a black and white image with the black●

area filled in, hence black and white images are best)
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Example of a custom-selected image as a word cloud contour

Please note: For some selected shapes you need to increase the number of words to fill
in the shape completely. It is also helpful to use the Smallest Word slider to adjust the
size differences of the words (and thus the required space) to fill the shapes evenly.

Alignment – Lets you define the alignment of words. The following options are
available:

Horizontal: All words are displayed horizontally●

Vertical: All words are displayed vertically●

Horizontal and vertical: Words are randomly aligned horizontally and vertically, the●

most common word is always displayed horizontally
30/45 degrees: Some words are additionally displayed at the selected angle●

diagonally upwards or downwards.

Colors – Lets you choose from a range of different color schemes.

Font / Bold – Lets you specify the font.

Word distance – Defines the minimum distance between words

Smallest word – Defines the size of the smallest word. The smaller this size is, the
greater the difference in size compared to the most common words will be.

Size by – Defines the size of the words. Here you can choose from the following:

Frequency: The more frequently a word occurs, the larger it is.●

Rank: The higher the rank of a word in the word frequency list, the larger the word.●

If you choose this option, the absolute difference between the word frequencies is
irrelevant.
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Number of documents: The larger the word, the more documents it appears in. The●

number of documents can be seen in the list of word frequencies. This option only
makes sense if you are analyzing several documents, as otherwise there will be no
size difference between the words.

Scale – Influences the differences in size between common and rare words. The
following options are available, which refer to the dimensions set under "Size by":

Linear: The font size is linearly proportional to the word frequency.●

Most frequent smaller: The font size is proportional to the root of the word●

frequencies. As a result, the common words appear smaller in relation to the
"Linear" option.
Most frequent greater: The font size is proportional to the square of the word●

frequencies. This makes the common words appear larger in relation to the "Linear"
option.

Largest word – Lets you set the placement of the largest word: centered, somewhere
near the edge, or at random.

Rearrange – Regenerates the word cloud, placing words in different random locations.

Display the occurrence of a word in the texts

The word cloud is interactively linked to the original texts:

Clicking on a word will list all the occurrences of that word in the analyzed texts.●

If you hover your cursor over a word, the frequency of the word will appears above it●

(regardless of the selection made in "Size by:...").
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13 - Visual Tools (Concept Maps)

What Does MAXMaps Do?
MAXMaps allows you to visualize connections. MAXMaps is primarily intended to
graphically represent the different elements of MAXQDA (codes, documents, memos,
coded segments) visually on a workspace, a so-called map, and to put them in relation
to one another. It is also possible to create maps that are not related to the MAXQDA
project.

MAXMaps can be used for different purposes:

Maps can help to explore and organize data. They allow you to develop your ideas●

and to communicate them to your research team.
Maps can also be a valuable tool for scientific explanation and can help to visualize●

complex relationships and theories. For instance, you can create tables and
worksheets to gain a better perspective of the different elements within a project.
MAXMaps can also be used for presentations and lectures. The different layers of a●

map may be displayed in arbitrary order; thus, a variety of different options for
designing presentations are available.

With MAXMaps, it is possible to display:

The relationships between different codes and categories.●

An overview of different facts and phenomena within the research field.●

The different memos belonging to a document or a group of documents.●

The results of a Grounded Theory study.●

The context or important facts of the research, e.g. photographs of locations or●

persons.
A graphical overview of the research methods used.●

A research timeline.●

The research design and characteristics of the sample.●

MAXMaps can also have different functions for researchers. You can, for instance, use
MAXMaps to organize and manage your code system. Or you can link codes, text, and
memos in a hypothetical order to then further test the relationships in a second step.

MAXMAps offers multiple automatic templates to support the creation of maps for
different scenarios, e.g. to visualize the relationship of different cases.

MAXMaps is not merely a graphics tool that works with icons and symbols, though.

https://m22.maxqda.com/help-mx20/maxmaps/model-templates-in-maxmaps
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All the elements used in a map are interactive, meaning they are connected to the
MAXQDA project. This makes an icon that symbolizes a text document not only a
passive icon, but allows you to double-click on the icon to open the document in
MAXQDA’s “Document Browser.” Then you can read and browse through the
document. The same is true for memos. As soon as you click on the memo symbol, the
memo appears and can be read or even modified. In the case of symbols for coded
segments, one click displays the segment, which allows you to examine and compare
different segments of your map.

MAXMaps allows you to define connections and relationships as you choose. These
connections may be hypothetical -- they do not even have to be consistent in logic
while you are designing the maps because you are always free to make changes. As a
result, you can “play” with different models and relationships. For example, a code
“attitude” may appear as a condition of another code “behavior” in Map A and as the
result of the code “behavior” in Map B. Constructing, testing, and modifying different
models is a an important aspect of analysis, thus making it counterproductive to be
consistent with links and relationships right from the beginning.

MAXMaps not only allows you to define links and relationships, it also offers a way to
make links and relationships that have already been implemented in your project
visible. Examples are memos that have been assigned to a document: MAXMaps can
import all the connected memos automatically. These memos are displayed as symbols
and you can open and check them. The same is true for codes: If you have imported a
code in your map, all the memos linked to this particular code can also be imported
automatically. Moreover, you can search and insert all of the codes overlapping with a
code on your map and automatically connect them to the code.

These features do not establish new links or new relationships, but they allow for
completely new perspectives to your data. Connections that have likely been hidden in
listings or tables can now come to the foreground. New views and relationships
become visually apparent and much easier to understand. The connections between
different elements of the diagram are not restricted to hierarchical relationships as
with the “Code System” in MAXQDA. In MAXMaps, relationships can be represented
in a more complex way, for instance as networks or any other type of model.

This visual method of data display is supported by the variety and flexibility that
characterizes MAXMaps. All elements used in a map may be designed individually.
Codes, memos, and texts are not always displayed with the same symbols and colors.
You can select different symbols, colors, fonts, and sizes, or even import your own
symbols unique to each element of your map. All labels, images, and symbols can be
managed individually. You can also import your own photographs, icons, or clip art.
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The MAXMaps Interface
A project's maps are created and managed in their own interface called "MAXMaps".
MAXMaps is accessed via the first icon on the left side of the Visual Tools tab. The
following interface will appear in a separate window:

The MAXMaps window when you open this function

The MAXMaps interface is divided into several areas. On the left you'll see the "List of
Maps", which will contain a single entry called "New Map" when MAXMaps is
opened for the first time. Later, as shown in the figure, all your created maps will be
listed. The space on the right displays your map, the space in which you can model it,
insert objects, position them and link them etc.

At the top you will see a menu with several tabs. In the "Start" tab, you'll find
everything you need to create and edit a map. Use the "Insert" tab to insert new
codes, texts, images and shapes into the map. The "Format" tab and "Line Format"
tab appear as soon as you select an element or a line to display all available formatting
options.

Tip: You can reduce the ribbon menu by clicking the  icon to make more space
available for your map. The "List of Maps" can also be hidden by clicking on the small
cross at its window edge to further widen the working area.
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Undocking your "List of Maps"

You can undock the "List of Maps" window to move it somewhere else on your
screen. To do this, click on the small double-window icon at the top right-hand edge
of the list to release it from its fixed position at the window edge. You can place the
undocked window whereever you like, dragging and dropping it, even to a second
monitor. To re-dock it, drag the window to the left edge of the MAXMaps window.

Undocking the List of Maps

Undoing actions

At the top right of the MAXMaps window there are two arrow icons to undo and
restore your last action.

Undo icons in MAXMaps

The Undo function always only applies to the currently open map. As soon as you
open another map or close the MAXMaps window, the "back-up memory" is deleted.
The global undo function of MAXQDA has no effect on saved maps in MAXMaps.
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Zoom function

Using the zoom options at the bottom right of the screen, you can zoom in and out,
and jump to your first object, the "origin" of a map.

Zoom options in MAXMaps

Create a Map and Add Objects
Creating a map

To create a new map, click the New Map icon on the Start tab. A new map is
immediately inserted into the "List of Maps" with the default name "New Map" and
an empty workspace is provided. The default name can be changed at any time by
right-clicking and selecting the Rename option in the context menu.

Any number of maps can be created. They are saved in MAXQDA, but can also be
exported in the form of JPG or SVG files and then inserted into text files. The storage
of maps in the MAXQDA project file is done automatically every minute, as well as
when the MAXMaps window is closed. No separate command is required to save.

Tip: You can add a comment to each map, for example to note the status of a map
("first sketch", "finished") or important hints for a checked assumption. Click on the
comment symbol in the header of the "List of Maps" and enter a comment in the
window that appears. The comment is displayed as a symbol next to the name of the
map and can be opened by double-clicking on it.

You can create folders in the "List of Maps" where you can arrange your maps for a
better overview. To create a new folder, click the icon at the top of the page window.
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Types of objects in MAXMaps

The following distinction is made between elements on a map:

Standard objects.●

Free objects.●

Connecting objects.●

"Standard objects" originate from MAXQDA, e.g. a code, a text, or a memo. They can
only be inserted into a drawing pad once. So a document can be contained within a
map once only. Modifications on standard objects have no effects on the MAXQDA
project. For instance, if you modify the name of a text imported from MAXQDA, the
name in MAXQDA’s “Document System” nevertheless remains the same. Objects
removed from the drawing pad are not simultaneously removed from the MAXQDA
project. No matter how you arrange an object, connections to the MAXQDA database
will always be preserved. This also means that a text that is represented only as a
picture will open via double-click in MAXQDA’s “Document Browser.”

"Free objects" are not connected with items of the current MAXQDA project. In this
sense, they are independent of the analyzed data.

"Connecting objects" are lines, which interconnect two objects.

Both standard and free objects consist of an object label and an object picture.
Standard objects receive the appropriate icon from MAXQDA as a picture and the
appropriate name from MAXQDA as a label. For example, as with a MAXQDA
document, the document name will be taken from the “Document System”.

"Connecting objects" can also be labeled and the type and characteristics of the
connecting line can be customized.

Inserting objects into your map

Each object that is imported into the workspace – be it a code, a memo, a text, a
coded segment, or a so-called free object – consists of two elements:

A picture, and●

A label.●

When importing a MAXQDA object, the MAXQDA default icon (or "symbol") is
carried over as the picture and the MAXQDA name as the label. For example, when
importing a code, the code icon from the list of codes and the code name are carried
over.
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Code, memo and document after import

Both the label and the icon can be changed, or a image, a diagram, symbol or photo
can be imported. The label can also be changed along with the font type, font size,
and other properties.

How to import standard objects from MAXQDA

There are three ways to import an element from MAXQDA:

hold down the Alt/option key and double-click on the selected object while in●

MAXQDA,
click on the element with the right mouse button and select the Insert in map option●

from the context menu, or
drag and drop the element into the map with the left mouse button.●

The selected element is inserted into the drawing area at the next free point as viewed
from the top left.

The following MAXQDA elements can be inserted. The brackets state where the
elements are located in MAXQDA:

Documents (Document System).●

Document groups (Document System).●

Document sets (Document System).●

Codes and subcodes (Code System).●

Code memos and Memos on code sets(Code System).●

Memos attached to parts of documents (Document Browser).●
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Memos attached to documents, document groups or document sets (Document●

System).
Free Memos ("Memo Manager", "Overview of Memos").●

Coded segments (Retrieved Segments, Overview of Coded Segments, Docuemtn●

Browser, Multimedia Browser).

All these functions are only available with the "MAXMaps" window open. The object
is always imported into the currently open map.

For documents, codes, subcodes and coded segments, the assigned color is always
adopted. The assigned memo icon is always used for memos.

Tip: The fastest way to import objects is by holding down the Alt/option key and
double-clicking on the selected item.

Importing multiple documents or codes at once

You can import all documents or codes currently activated in the MAXQDA project
into an open map at once:

Select the desired codes or documents in the MAXQDA window. For example, you1.
can use the Mixed Methods > Activate Documents by Variables function to select all
documents with a specific property.
Then right-click on the white space in MAXMaps and select Insert Activated2.
Documents or Insert Activated Codes.

Inserting a new code

From the Insert tab in the MAXMaps window, you can create a code and paste it into
a map by clicking on the Insert New Code icon. The dialog for creating new codes
appears, where you can specify the name, color, and description of the new code. The
code is inserted into the MAXQDA project at the top of the "Code System" and then
its label with the codename is inserted as a label in the opened map.

Alternatively, this can be done by right-clicking on the white area of MAXMaps and
selecting the Insert New Code option.
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The Insert tab in the MAXMaps window

Inserting a background image

You can insert a background image for each map, which is displayed behind all
objects. Right-click on the white workspace and select Insert Background Image.
Background images are always inserted in their original resolution and can be changed
as desired in their displayed size.

To change the image later, either right-click it and select Change Image... or insert a
different background image, then replace the existing one.

Inserting free objects

The term "free objects" refers to objects that are not part of MAXQDA. Go to the
MAXMaps Insert tab to add one of the following free objects to your map:

New texts (a label without a visible icon is added)●

New images from a file, e.g. a photo, a map or chart●

Standard shapes such as squares, circles, and arrows●

By clicking on New Code, New Text or New Image in the Insert tab, the new object is
inserted into the map at the next free position seen from the top left. For images you
have to select a graphic file. This file will then be saved in the MAXQDA project. In the
MAXMaps options, which can be accessed via the gear symbol at the top right of the
window, you can determine the quality with which images are saved in the map.

This is how you can insert one of the standard shapes (rectangles, circles and arrows):

Click on the desired shape. The mouse pointer changes to a large cross.1.
Drag the shape to the desired position on the map by holding down the mouse2.
button and dragging the cross.
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Inserting free objects in Maps

Tip: Hold down the Shift key ⇧ to retain the proportions when dragging the mouse.
As a result, a square will remain a square and a circle will remain a circle.

Similarly, "free objects" also consist of an image and a label, except that no image is
displayed when a new text is inserted and no label is displayed when images or
standard shapes are inserted. Image and label can be shown or hidden at any time.

Importing related MAXQDA objects

In MAXMaps, it is possible to import analytically related objects to an already imported
object, for example the coded segments of a code or the text of a memo.

To import related objects, right-click a MAXQDA element on a map. Depending on the
object selected, the context menu contains different options for importing.
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Context menu for the document icon in a map

The following list provides an overview of the import options for different objects:

Document icon

Import Memos - All memos that are contained in the selected document are inserted
into the workspace and linked to the document icon. The document memo from the
"Document System" is also inserted (if available).

Import Codes - Depending on the selection, all or the activated codes assigned in the
clicked document are inserted into the workspace and linked to the document icon.

Import Summaries - Depending on the choice of all or of activated codes, the
summaries that were written in the clicked document are inserted into the workspace
alongside the corresponding codes. The document is connected to the codes by lines,
which are also connected to the summaries by a line.
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Import document memos

Document group or document set icon

Import Summaries - Depending on the choice of all or activated codes, the summaries
that were written in the clicked document group or document set are inserted into the
workspace alongside the corresponding codes. The document is connected to the
codes by lines, which are also connected to the summaries by a line.

Import Paraphrases - All paraphrases that were written in a document of the clicked
document group or document set are inserted into the workspace and connected to
the icon by lines.

Code icon

Import...> Code Memo - If a code memo exists, it is inserted into the workspace and
connected with the clicked code symbol by a line.

Import...> Linked Memos - All memos that are linked with the clicked code are
inserted into the workspace and connected with the clicked code symbol by lines.

Import...> Co-occuring Codes - All codes associated with the selectedcode on the
same segment are inserted into the map. The inserted codes are connected with
dashed lines to the selected code icon. Optionally, the line strength can represent the
frequency: the thicker the line is represented, the more overlaps with the associated
code exist.

Import...> Subcodes - All subcodes up to the selected level are inserted into the
workspace and connected with the clicked code symbol. Subcodes on lower levels are
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ignored. Optionally the line thickness can represent the frequency: The thicker the line,
the more encodings were made with the subcode.

Import..> Coded Segements -Symbols (coding strips) for the coded segments of the
clicked code are inserted and connected to the code. The following dialog appears
before the import, in which you can select which segments and how they are to be
imported:

Import options for coded segments

At the top, select how many segments you want to import. If less than existing
segments are imported, it is also possible to prioritize according to highest weight or
largest segment. Change label to coded text or comment causes the text of the coded
segment or the comment on the coded segment to be automatically adopted as label
instead of the mere indication of origin.
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Imported segments of a code

Coded segment icon

Insert the text of the coded segment as a label - If the coded segment consists of a
text, a PDF or a table, the entire coded text is accepted as a label.

Insert the text of the associated summary as a label - If a summary exists for the code
and source document in the summary grid, the entire text of the summary is accepted
as a label.

Inserting a coded image segment as an "icon" - If the image segment is coded in a
PDF or an image, the coded section is taken to symbolize for the segment.

Memo icon

Insert memo text as a label - The text of the memo is adopted as a label for the
activated memo icon.

Deleting objects

Each object can be deleted from the map

The object is first selected with the mouse. You can also select multiple objects by1.
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highlighting them with the mouse.
Press the Delete key, or click the Remove from Map icon. Alternatively, you can also2.
right-click on the object and choose Remove From Map from the context menu.

The object and its connections to other objects are then removed from the map.

Please note: Removing objects from a map has no impact on your MAXQDA project
data. If you remove a code from a map, it will remain in the code system.

Customize Objects in MAXMaps
You can easily customize the look and position of objects to create a map that suits
your analysis.

Selecting and moving objects

To do this, you must first select the objects you want to customize. Click an object
with the mouse, or drag a frame that covers multiple objects to select several objects
at the same time. Selected objects are indicated by their additional blue frame.

If several objects are already selected, you can add additional objects for selection or
remove individual objects from the selection by clicking the objects while holding
down the Shift key.

Use the key combination Ctrl + A (Windows) and cmd + A (Mac) to select all objects
on a map.

Selected objects can be moved anywhere on the workspace by holding down the
mouse button.

The "Format" menu tab

The properties of selected objects are adjusted in tab Format and Line Format. The
menu items appear in the upper part of the window as soon as

The Format menu tab

The Format tab is divided into different areas:
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"Label" Area

Here you define the appearance of the label of an object. You can adjust the font and
font size as well as the font color. The text width is specified in relative units: A width
of 10 means that the label is a maximum of 10 times as wide as the symbol.

By default, labels are displayed below a symbol. Click on the icon highlighted in the
next image to display the label above or not at all:

Options for label position

"Symbol" Area

Depending on the object type, there are different forms for the symbol, for example,
the different document symbols for a document from the "Document System".

You can also use a different image than the standard MAXMaps icons:

First click on the large Symbol icon and then select Add own icon... from the drop-1.
down menu...
A file dialog appears in which you can select any image from your computer.2.
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Add own image as symbol

You can use the Display icon option to hide an icon so that only the label text remains
visible.

Tip: In order to hide all code symbols, for example to only operate with the code
names on the map, it is not necessary to switch the symbol to invisible for each
individual code. In the tab Start you will find the option Display Symbols > Codes,
which works like a switch: Click the option to hide all code symbols at once and click
the option again to show all symbols that are visible. Here you can also show or hide
the symbols of the Coded Segments.

"Object" Area

Here you can define the following properties for the entire object:

The layer on which the object is located.●

The addition of a frame to the entire object in any color.●

"Link" Area

In this area, you can assign two different links to an object after you have clicked the
Geo-Link/External Link icon:

External Link - Click on the three dots to select a file.

Geolink - Click on the three points to select a KML file.

Add geo link to an object

To access the link later, right-click the object and select Open External Link or Open
Geolink.
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Copying object properties

MAXMaps makes it possible to transfer properties from one object to other objects.
This of course makes it easier to give objects a uniform appearance. The function is
available for all objects, including link objects. In this case it is possible to transfer the
color and the line type from one link line to another.

Symbol for copying object properties

Here's how you do it:

Select the object whose properties are to be transferred to others.1.
Click on the Copy format icon in the Format tab or the Line Format tab.2.
Select the object to which you want to apply the format.3.

Tip: If you double-click on the icon in the toolbar, the "Copy format" mode remains
activated. Each object that you then click on is given the format originally selected. To
exit the mode, press the Esc key or click the Copy format icon again.

Copying objects

Single or multiple selected objects can be copied to an internal clipboard of MAXMaps
using the function Start > Copy Object (or the key combination Ctrl/Cmd+C). Start >
Paste Object (or the key combination Ctrl/Cmd+V) inserts the objects into the next free
space in the top left corner of the map, while of course preserving their design.

You can also right-click directly to the destination and choose Paste from the context
menu. The objects will then be inserted into the map in place.

Please note: Keep in mind that MAXQDA objects such as documents, codes and
memos can only be present once on the same map and may be ignored during
insertion.
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Increasing and decreasing the size of objects

The following options are available for changing the size of selected objects:

Click on the blue dot at the lower right selection frame and pull the object larger or●

smaller while holding down the mouse button.
On the Format tab, set the desired size in the number fields.●

On the Format tab, click Increase Size or Decrease Size.●

Change the size of an object with your mouse

Change the size of an object in the format tab

The size ratio of symbol and label to each other can be adjusted by selecting the font
size in the object properties.

Adding and editing labels

Double-click a text in the workspace to edit the text in place. Hold down the Shift key
⇧ and press the Enter key to insert a line break.

If an object does not yet have a label, you can add it by right-clicking on the object
and selecting the Add Label function.
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Add a text to the symbol of a free object

Sometimes you may want to write a text in a free object such as a rectangle or a circle.
This can be done, of course, by creating another object via Insert > New Text and
placing it on top of the other object.

However, it is also possible to write a text that is linked to the object directly in the
free object: To do this, right-click on a free object and select Add Text from the
context menu.

Add text to an element

Tip: Double-clicking on the symbol of a free object directly opens the edit field for
entering and editing a text. The Format tab can be used to adjust the formatting of
the text. Selected formatting always applies to the entire text.

Grouping objects

Objects can be grouped so that their distances remain constant.

To do this you first have to drag a frame around the objects with the mouse. As an1.
alternative, you can also select individual objects to be grouped by clicking them
one by one while pressing the Shift⇧ key. In the same way, the selection can also
be undone for individual objects.
In the Start tab, click Group Objects, your selection will become a fixed group.2.
Alternatively, the option is also available after right-clicking on one of the selected
objects in the context menu.

The objects of a group can't be selected individually, but are always selected together.
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A change of object properties in the Properties window has the same effect on all
objects in the group, including changes in the size.

The group can be split up by clicking on the group and then clicking Ungroup objects
in the Start tab. Alternatively, the option is also available in the context menu for the
group.

You can group and ungroup objects with the icons framed in red.

Image exchange - importing images

The icons displayed in MAXMaps for MAXQDA object such as codes or documents,
are the standard MAXQDA icons - however, these can be exchanged against another
imported image, as follows:

Click the object with your right mouse button and select Change Image ... from the1.
context menu.
Instead of the default icon, you can now use any other image. The image formats2.
JPG, PNG and TIF are allowed.

Alternatively, you can use the Format tab to change the icon to a custom image by
first clicking the Icon button and then selecting Add own icon... from the pop-up
menu that appears.

Move objects to the front or back

To design a map in such a way that it reflects your ideas, you need to be able to
determine which objects should be placed in the foreground.

The procedure is quitte intuitive:

Click the object you want to move. You can also select several objects at the same1.
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time with the mouse.
Click the Bring Level Forward or  Send Level Back icons in the Start tab to2.
arrange the sequence of your objects in the map. By clicking on the arrow below
these icons, the options Bring to Front and Send to Back are also visible, which
place an object all the way forward or back.

You can move objects further forward or back with the icons framed in red.

Alternatively, click on an object with the right mouse button and select one of the
positioning options in the Arrange menu. This menu also displays the key-shortcuts,
for example ⇧ + PgDown for "Move to back".

Aligning objects

To align several objects to each other, first select them. Then select the Align option in
the Start tab, which will give you several options:

The objects can be aligned horizontally, vertically or at the same distance from each
other. It is also possible to align the objects in a semicircle or circle. The alignment of
the objects always refers to the symbol of the object. Only if this symbol is hidden and
only the label is visible does the option refer to the text.
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The 'Align' option in the 'Start' tab.

Layers
Objects can be assigned to different layers. If you ignore this option, all newly inserted
objects will be assigned to the same standard “Base” layer. The Layer option makes it
possible to display or to remove parts of the drawing, so you can, for example, design
a presentation that gradually increases in complexity. You can start building a model
with only a few elements and gradually increase the number of elements that are
displayed, thus creating a structure that continually gains complexity.

The Layer function can be activated by clicking the layer icon in the Start tab. This will
open a window in which the existing layers are listed. At first, this includes only the
“Base” layer. You can define a new layer by selecting New.



13 - Visual Tools (Concept Maps)   429

Layer window

Any object on the drawing pad can be assigned to a certain layer. Just choose the
option Layer after selecting the object with the right mouse button and assign the
object to the desired levelin the menu.

Assigning an object to a layer

To display a level, simply put a checkmark in front of the desired layer in the dialogue
window.

Tip: You can also assign a selected object in the Format or Line Format tab using the
Select Layer function.

The Object Library
The object library is a helpful tool for simplifying the organization of your objects. You
can fill the library with any formatted object, so that you have quick access to the
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same shape in the future. To add an element to the library right-click on the object
and select Add to library.

Add object to the library.

The selected object will be saved to your library and the "Library" window is opened
automatically on the left of the MAXMaps window.

The Library window on the right side of the MAXMaps window.
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The Library window can be opened or closed via the Library button in the Start tab at
any time.

Double-click on an object in the library to insert it into your map. All formatting is the
same as in the original.

At the top of the Library window are two icons that allow you to insert objects from
the library onto the map, and delete objects from the library.

Linking Objects
To link between objects, click the Link icon in the Start tab to activate MAXMaps' Link
Mode. In this mode, you can't select or move objects, but only create directional or
non-directional linking lines between two objects.

Activating Link Mode in the Start tab.

Objects are linked to one another by clicking on one object and dragging the
connection line to the target object while holding down the mouse button.

If you later move objects on the desktop, the connections are preserved and move
with the objects.

Formatting lines

Connectiing lines can be adjusted regarding line thickness, line color, line type, label
and arrow direction.

If you click on a line, the "Link" mode is deactivated, the line is selected and the tab
Line Format opens to display options to adjust the line appearance.

To select multiple lines at once hold down the Shift key ⇧ while clicking on the lines
and adjust their properties all at once.
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In the Properties window you can adit the appearance of a linking line.

Tip: You can also format connecting lines as curved connections. To do this, click the
 icon in the Format tab.

Print, Export and Organize Maps
Printing a map

Any map created in the MAXMaps module can be printed in high quality. To start the
print procedure, click the Print icon at the top right of the MAXMaps window.

Adding maps to the "Document System" as new image documents

You can add a map as a new image document to the "Document System" at any
time, which allows you to analyze it further as an image. To do this, right-click on the
name of the map in your "List of Maps" and select Insert as Document.

Once you have added the map to your "Document System" you can analyze the map
like any image in MAXQDA, e.g. you can code parts of the image and add memos.

Copying maps to the clipboard

You can copy the current display of your map to the clipboard at any time, from
where you can then paste it into a report, presentation, or graphics program. In the
Start tab, click the Copy to clipboard icon.

Copying a map to the clipboard
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Exporting a map as a graphic file

Maps can be exported in different formats. Thus, you can use them with other
software programs, such as Microsoft Word or PowerPoint. To start the export
procedure, click the Export Map icon in the Start tab.

The options dialog window for exporting a map.

The following file formats are available: SVG, JPG, PNG and EMF for windows.

How to export and import a map

All maps are stored in the MAXQDA project file (MX20 file) along with the rest of the
files. Maps can be transferred from one MAXQDA project to another project:

Right-click a map in the "List of Maps" and select Export (MAXQDA Format).1.
Assign a file name and location for the exported file created with the extension2.
MOD.
In the target project, which can also be on another computer, open MAXMaps,3.
click on New Map (not on the symbol) in the Start tab so that the associated menu
opens and there you select the Import Map entry.  

Importing map into a target project.

The connection between MAXQDA objects (such as codes and documents) on a map
and the MAXQDA project will, of course, be lost when importing a map. This is
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because completely different codes and documents can exist in the target project.

Exporting and importing images

All images that you insert into a map or use as a symbol, are not stored in the
MAXQDA project, but instead in the MAXQDA folder for external files. This also
applies to coded image segments that have been inserted as symbols. If you have
imported images into a map, MAXQDA will additionally create a compressed ZIP file
with the images used when exporting the map as a MOD file in the same folder.

If you want to open the map on a different computer, you have to extract the images
from the ZIP file in the MAXQDA folder for external files on that computer. MAXQDA
does this work for you:

Open any MAXQDA project then, in the Home tab, click on External Files and select1.
Unpack Bundled Data Files from the menu that appears.
In the file dialog window, select the ZIP file created on the other computer.2.
MAXQDA then unpacks all the files from the ZIP file to the external files folder.

Synchronize Map with MAXQDA Project
Data
The interesting thing about working with MAXMaps is that it always has a connection
to the MAXQDA project data. In the case of a code symbol this means, for example,
that when moving the mouse over the symbol in the map, the memo assigned to the
code appears at the mouse pointer and that a double-click opens the "Overview of
Coded Segments" associated with the code.

The following connections exist between the MAXQDA elements of a map and the
project data:

Document group and document set icon

with mouse-over: display a preview of the memo of the document group or●

document set at the mouse pointer (if available)
with a single click: focus the document group or the document set in the●

"Document System".

Document icon

https://m22.maxqda.com/help-mx20/import/external-files


13 - Visual Tools (Concept Maps)   435

with mouse-over: display the document memo at the mouse pointer (if available)●

with a single click: focus the document in the "Document System"●

when double-clicking: Document is opened in the "Document Browser"●

Memo icon

wwith mouse-over: display the memo preview at the mouse pointer●

with a single click: focus the memo (depending on the memo type in "Document●

System", in "Code System", in the "Document Browser", in the "Multimedia
Browser")
when double-clicking: open the memo●

Code icon

with mouse-over: display of the code memo preview at the mouse pointer●

with a single click: focus the code in the "Code System"●

when double-clicking: open the "Overview of Coded Segments" for this code (for●

codes that have been inserted into a map by creating a model, only the segments
that were taken into account when creating the model are displayed in the overview)

Symbol of a coded segment

with Mouse-Over: Preview of the segment at the mouse pointer●

with a single click: focus the code in the "Code System", document is opened in the●

"Document Browser" or "Media Browser" and moved to the position of the coded
segment

Activating documents and codes

It is also possible to activate a document or a code from MAXMaps. To do this, select
one or more documents, right-click on a selection and choose Activate Document /
Code from the context menu. The selected documents are activated in the "Document
System" in addition to any already activated documents.

Tip: You can also add one or more selected codes to an existing or new code set in the
"List of Codes" by using the context menu. Select the Add to Code Set function.

Opening code frequencies

In the Start tab, there is the Code Frequencies option, which allows you to show how
often the respective code was used in the data for MAXQDA codes in your map. The
code frequencies are displayed in brackets after the code name.
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Code frequencies are displayed after the code name.

The code frequencies are dynamically linked to the original data. So if you delete or
complete a coded segment, the numbers brackets for each corresponding code in
MAXMaps are ajdusted accordingly. Exceptions are codes that have been inserted into
a map by creating a model. For these, the number in brackets indicates how many
codes were included in this code at the time the model was created. The number is
not updated with these codes, but the models always provide a snapshot of the code
frequencies at the time ti was created.

Model Templates in MAXMaps
MAXQDA's model templates provide a unique tool for visualizing specific perspectives
on the data material. Very often, the research process focuses attention on parts of
the data, such as a specific document, a specific code, a common occurrence of codes,
or specific hypotheses and theoretical aspects described in memos. For such situations
the models in MAXMaps offer quickly accessible solutions, which can be adapted to
the respective circumstances and wishes by appropriate options well. MAXQDA then
produces a corresponding diagram and makes it available in the MAXMaps
workspace. This map can be further edited and supplemented in MAXMaps.

The following models with focus on documents are available:
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Single-Case Model

All relevant data attached to a document is illustrated in the map. This includes all
appropriate memos, codes, and coded segments. Instead of the coded segments, the
summaries or paraphrases of the document can be output. The Single-Case Model can
be created for documents, document groups, document sets and focus group
participants. There is also a version with hierarchical code placements available.

Example of a Single-Case Model

Two-Cases Model

This model visualizes which codes occur in both of the selected documents, document
groups or document sets, and also which codes only occur in one of the cases.

The following models with a focus on codes are available:

Single-Code Model

Displays a selected code in the map and the associated coded segments or summaries,
as well as the code memo and the memos associated with the code.
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Code Theory Model

This model is especially helpful for the development of theory. It automatically displays
all memos (with their ideas and hypotheses) attached to a specific code.

Code-Subcodes-Segments Model

A code and its subcodes are placed on the map. Each code or subcode is connected to
their coded segments. This model is also available in an hierarchical version.

Hierarchical Codes-Subcodes Model

A code and its subcodes are placed on the map. The hierarchical levels of the subcode
are displayed like the levels of a building.

Code Co-Occurence Model

This model illustrates the associations and intersections between selected codes. The
model can be made more complex by including the subcodes in the visualization. As
an alternative to directly co-occuring codes on a segment, the proximity or occurrence
of codes in a document can also be analyzed.

Creating a new model

To create a new model, follow these steps:

Click on New Document Model in the Start tab of MAXMaps and selected a model1.
from the dropdown menu.
MAXQDA creates a new blank map with the name of the model as a title and will2.
display a short tutorial on how to insert MAXQDA objects: Depending on whether
you are creating a case-oriented or a code-oriented model, you will now need to
drag objects from your "Document System" or "Code System" onto your map
(these are displayed directly in MAXMaps).
As soon as the documents or codes have been selected, a preview of the finished3.
model appears on the map. On the left side you will find all the options available
for creating the model. You can try any option - the preview of the map
automatically adjusts with each option change.
To finish creating the map, click the Use Model button at the top of the options4.
area.
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Interactive model building

These models allow you to explore the data in a unique way. All elements of the map
are synchronized with the data of the MAXQDA project, i.e. a mere movement of the
mouse over certain elements of the drawing layer displays a preview of the contents of
the symbolized memos or coded segments. A double-click on the symbol of a coded
segment takes you directly to the corresponding position in the document.

> Single-Case Model (Coded Segments)
Function of this model

In this model, a case from the “Document System” is at the center of the analysis
(Document, Document Group or Document Set). After selecting the model from the
menu, the caseto be analyzed is dragged onto the MAXMaps workspace. The purpose
of the visualization is to make the memos, codes, and code segments for the selected
case accessible.

Model display in the map
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An example of the Single-Case Model

The elements of the model will be displayed in the map with the document in the
middle of the workspace and the other elements arranged in a star pattern around it.
If memos are included, they are positioned at the top of the map.

The various elements are connected to the document by non-directional connecting
lines. The line thickness between the document and the code symbolizes the number
of segments available for each code in seven levels - the thicker the link line, the more
segments are available with that code. Of course, it can happen that a document has a
large number of codes or memos assigned to it, or that a large number of places in
the document have been coded. For this reason, maximum numbers for codes and
memos to be displayed and the number of coded segments and selection criteria can
be set as options.

Creating a new model and determining its structure

After you have selected a Single-Case Model (Coded Segments) in the Start tab via
New Document Model, drag a document, a document group or a document set from
the "List of Documents" to the MAXMaps workspace.
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An options dialog will appear, in which you can select the following elements for the
display:

Memos associated with the case or associated code.●

Codes associated with the case.●

Segments from this case associated with the codes shown.●

Tip: You can also call up the model directly from the "Document System" by right-
clicking on a document, a document group or a document set and choosing Single-
Case Model > Single-Case Model (Coded Segments).
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The Single-Case Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
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Memo options

For each memo type, it is possible to select separately whether they are to be
integrated into the model: Document memos, memos in the document, code memos
and memos linked with code.

Code options

Display only activated - Only the currently activated codes that occur in the case will be
inserted into the map.

X most frequent codes - Limits the number of codes to be displayed in the map. If less
codes are to be displayed than are assigned to the case, a ranking is created according
to the number of segments present, i.e. the codes with the most coded segments are
displayed, of course only in relation to the case selected for the model.

Code size reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMap uses three different
sizes for code representation: Codes whose frequencies are in the range of a standard
deviation around the mean are represented in a medium size. Codes with more or less
coded segments receive a larger or smaller symbol. If the code frequencies are close
together, MAXMaps uses only the smallest or the smallest together with the mean
symbol size.

Line width reflects code frequency - If this option is enabled, lines are drawn thicker
the more segments are assigned to the code.

Arrange codes by frequency/code system - Use this option to determine how the codes
are arranged. Sort by frequency starts on the right with the code with the most coded
segments, sort by code system starts with the code that is at the top of the code
system.

Coded Segments options

Display coded segments, max. X - If this option is enabled, an adjustable number of
associated segments are displayed for each code, so that you can get a visual
impression of the code frequency.

If there are more segments for the code than the desired maximum number, the
segments are selected either by highest priority or by largest segment (segments with
larger area have priority).

Change label to: coded text/comment - If this option is enabled, the comment for the
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coded segment or the coded text for text coding is used as label instead of the mere
indication of origin.

Change symbol to: coded image - If this option is enabled, the default symbol for
coded images is replaced by the default symbol for coded images.

> Single-Case Model (Summaries)
Function of this model

This model focuses on a case from the "list of documents" (document, document
group or document set). The purpose of the visual representation is to present the
summaries belonging to the case and to make them accessible for exploration. In
addition, the memos belonging to the case can be presented.

Model display in the map

An example of a single case model with summaries is shown in the following figure.
The case is centered, the codes to which summarys have been written form a circle
around the case and the summaries branch from each code. In addition, the memos
belonging to the case can be displayed.
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Creating a new model and determining its structure

After you have selected a Single-Case Model (Summaries) in the Start tab via New
Document Model, drag a document, a document group or a document set from the
"Document System" to the MAXMaps workspace.

An options dialog will appear, in which you can select the following elements for the
display:

Memos associated with the case or associated code.●

Codes associated with the case.●

The options are described in detail in the Single-Case Model (Coded Segments).

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Tip: You can also call up the model directly from the "Document System" by right-
clicking on a document, a document group or a document set and selecting Single-
Case Model > Single-Case Model (Summaries).

https://m22.maxqda.com/help-mx20/maxmaps/the-one-case-model
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> Single-Case Model (Paraphrases)
Function of this model

This model focuses on a case from the "list of documents" (document, document
group or document set). The purpose of the visual representation is to present the
paraphrases belonging to the case and to make them accessible for exploration. In
addition, the memos belonging to the case can be presented.

Model display in the map

An example of a single case model with paraphrases is shown in the following figure.
The case is centered, the codes to which summarys have been written form a circle
around the case and the summarys branch from each code. In addition, the memos
belonging to the case can be displayed.

Creating a new model and determining its structure

After you have selected a Single-Case Model (Paraphrases) in the Start tab via New
Document Model, drag a document, a document group or a document set from the
"Document System" to the MAXMaps workspace.

An options dialog will appear, in which you can select the following elements for the
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display:

Memos associated with the case or associated code.●

Codes associated with the case.●

The options are described in detail in the Single-Case Model (Coded Segments).

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Tip: You can also call up the model directly from the "Document System" by right-
clicking on a document, a document group or a document set and selecting Single-
Case Model > Single-Case Model (Paraphrases).

Single-Case Model for Focus Group
Participants
Function of the Model

The Single Case Model for focus group speakers is structured in the same way as the
Single Case Model, except that the center of the graphic is not a document or a
document group, but a single focus group participant.

Display in a map

An example of a single case model for a focus group participant is shown in the
following figure. The participant is placed at the center, the codes assigned in his
speech contributions outside and - if requested - the corresponding coded segments in
another outer circle and the memos at the upper edge:

https://m22.maxqda.com/help-mx20/maxmaps/the-one-case-model
https://m22.maxqda.com/help-mx20/maxmaps/the-one-case-model
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Example for a Single-Case Model for Focus Group Participants

Creating a new model and determining its structure

After open a singe case model for focus group participants via the New Model menu
in the Start tab, drag a focus group participant from the "Document System" to the
MAXMaps workspace.

The following options dialog window will appear, allowing the same settings as the
dialog window for the single case model. Instead of a document memo, however, you
can display the speaker memo. Only the memos in the document that are within a
speech contribution of the selected participant are taken into account:



13 - Visual Tools (Concept Maps)   449

Options for map model settings

> Single-Case Model (Code Hierarchy)
Function of this model

As with the normal  Case Model, a case in the form of a document, a document group
or a document set is the focus of this model template. Unlike the normal single case
model, however, the codes used in the case are not arranged in a circle around the
case, but from top to bottom while maintaining their hierarchy. No coded segments
are shown in this model.

https://m22.maxqda.com/help-mx20/maxmaps/the-one-case-model
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Presentation in the map

This then looks like as in the following figure. The hierarchy of codes is symbolized by
arrows: A code pointed to by an arrow represents a subcode of the code at which the
arrow starts.

Example of an 'individual case model with code hierarchy'

Create a new model and determining the structure

After opening a Single-Case Model (Code Hierarchy) via the New Document Model
menu in the Start tab, drag a document, a document group or a document set from
the "Document System" into the map. The following options dialog window will
appear:
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Options for map settings

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Memo options

You can select which memos are to be integrated here: The corresponding memo
from the "Document System" (document memo), the memos that were assigned in
the evaluated documents of the case, the memos of the codes that were assigned in
the case, and the memos that are linked with such a code.

Code options

Display only activated - When this option is selected, only the codes from the code
system that are currently activated are taken into account.

X levels of subcode - Here you can set how many hierarchy levels of the code system
should be considered. 1 means: only the codes of the highest level are to be included;
2 means: also their subcodes are displayed, if they have been assigned in the case, and
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so on.

X most frequent codes - Here you can define the maximum number of top-level codes
to be displayed. MAXMaps selects the codes with the most coded segments for the
display, for codes with the same frequency the code above is preferred in the code
system.

Line width refelects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMap uses three different
sizes for the code representation: Codes whose frequencies are in the range of a
standard deviation around the mean value are represented in an average size. Codes
with more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.
Usually the option Aggregate frequencies for parent codes will be enabled so that the
frequencies of the subcodes are taken into account when determining the size of the
codes above. Otherwise, the subcodes may be displayed much larger than their upper
codes, because the upper codes were only used very rarely or not at all.

Tip: You can also call up the model directly from the "Document System" by right-
clicking on a document, document group or document set and choosing Single-Case
Model > Single-Case Model (Code Hierarchy).

> Two-Cases Model
Function of this model

Using the two-cases model, you can visualize the extent to which codes, e.g. Relevant
topics, occur in two cases or only in one case. The frequencies of the codes can be
produced per case and their memos can also be integrated.

With the two-cases model, you can contrast two documents, document groups,
document sets or a mixture of these levels.

Model display in the map

The following figure shows an example of this model:

The two selected cases (documents in this example) are compared at a fixed●

distance.
At the middle between the two cases you will see the the codes that appear in both●

documents.
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The pages contain the codes that were used in only one case at a time.●

The connection lines indicate the frequency of code usage.●

Example of a Two-Case Model

Creating a new model and model options

Select New Document Model > Two-Cases Model in the Start tab, and drag two
documents, document groups or document sets from the "Document System" onto
the map. The following options dialog window will appear:

Map options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Memo options

Document/Document Group/Document Set memos - If this option is enabled, the two
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memos belonging to the cases from the "Document System" are integrated into the
map.

Code options

Display only activated - When this option is selected, only the codes from the code
system that are currently activated are taken into account.

X most frequent codes per column - The maximum number of codes displayed on the
sides and in the middle of the map is equal to the number you select here. If the codes
have the same frequency, the code above in the code system is preferred.

Code size reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMap uses three different
sizes for the code representation: Codes whose frequencies are in the range of a
standard deviation around the mean value are represented in an average size. Codes
with more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.

Label lines with code frequency - This option ensures that the frequency with which a
code has been used in a given case is indicated on the lines.

> Single-Code Model (Coded Segments)
Function of this model

A code from the "Code System" is the focus of this model. The purpose of this model
is to display the selected code with all its connected memos and coded segments.

The Single-Code Model is similar to the Single-Case Model, except that a code is the
focus rather than a document.

Model display in the map

The icon for a selected code is placed in the center of the map and other elements in a
circle around it. Lines connect all the codes and coded segements and memos are
placed under the heading and the code memo is connected to the code by a line.
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Example of a Single-Code Model

Creating a new model and determining its structure

Once you have selected the Single-Code Model (Coded Segments) via the New Code
Model menu in the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear, in which the following elements are selected for
display:

Memos: both the code memo and any memos linked to the code.●

Coded segments.●
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The Single-Code Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Memo options

You can select which memos are to be integrated into the map here. The code memo
of the selected code and the memos linked to the code are available for selection.

Coded Segments options

Display coded segments, max. X - If this option is enabled, an adjustable number of
associated segments are displayed for each code, so that you can get a visual
impression of the code frequency.

If there are more segments for the code than the desired maximum number, the
segments are selected either by highest priority or by largest segment (segments with
larger area have priority).

Change label to: coded text/comment - If this option is enabled, the comment for the
coded segment or the coded text for text coding is used as label instead of the mere
indication of origin.
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Change symbol to: coded image - If this option is enabled, the default symbol for
coded images is replaced by the default symbol for coded images.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Single-Code Model (Coded Segments).

> Single-Code Model (Summaries)
Function of this model

The focus of interest in this model is a code from the "Code System". The purpose of
the model is to represent the summaries written for the topic of the code and, if
necessary, to integrate the memos related to the code into the representation.

Model display in the map

The symbol of a selected code is placed in the middle of the workspace and the
summaries written on the topic of the code are placed around the document. Code
and summaries are connected by undirected lines, the memos are placed under the
heading.

Example of a Single-Code Model
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Creating a new model and determining its structure

Once you have selected the Single-Code Model (Summaries) via the New Code Model
menu in the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear, in which the following elements are selected for
display:

The Single-Code Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Memo options

You can select which memos are to be integrated into the map here. The code memo
of the selected code and the memos linked to the code are available for selection.

Summary options

Only for activated documents - Restricts the display of summaries to the currently
activated documents.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Single-Code Model ( Summaries).

> Code Theory Model
Function of this model

This model is similar to the Single-Case Model. This model also focuses on one code,
but instead of displaying the code's coded segments it displays subcodes and memos.
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Model display in the map

The code icon is put in the center of the map with the subcodes arranged in a circle
around it. Subcodes can be arranged on two hierarchical levels, with the first level
forming an inner circle around the code, and the second level forming an outer circle.
The memos are connected to the codes/subcodes with a line. Since memos can be
linked to more than one code, each code may be connected with several lines.

Code Theory Model without subcodes. Code memos and linked memos of subcodes will be displayed
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Code Theory Model with integration of subcodes on 1st level: subcodes are displayed in a circle around the code. Memos are displayed in
an outer second circle. The code memos and linked memos are imported, too.

Code Theory model with integration of subcodes on two levels: The subcodes are displayed around the main code; the subcodes of the
2nd level are highlighted in orange in the example

Creating a new model and model options

Select New Code Model > Code Theory Model in the Start tab and drag a code from
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the "Code System" into the map. A dialog window with model options opens up:

The Code Theory Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Memo options

Code memos - If this checkbox is selected, the code memos from the "Code System"
are displayed in the map.

Memos linked with codes - If this option is selected, all memos linked to a code on the
surface will also be included in the map.

Subcode options

Display subcodes up to level X - You can choose whether and up to which level
subcodes are displayed (1 = only include the direct subcodes; 2 = also include the
subcodes of the subcodes).

Only activated codes - You can use this option to restrict the display of subcodes to
the currently activated subcodes.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code Theory Model.

> Code-Subcodes-Segments Model
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Function of this model

This model creates a map with a selected code, its subcodes, and the segments coded
with these codes. This model is similar in many ways to the Single-Case Model except
that a code is the focus, rather than a document.

Model display in the map

The icon of the selected code is placed in the center of the map. The subcodes of this
code (and their subcodes if any) are arranged in a circle around it and connected to
the code by non-directional connecting lines. Their coded segments (of the code and
its subcodes) also placed around them with non-directional connecting lines.

The Code-Subcodes-Segments model

Creating a new model and determining its structure

Once you have selected the Code-Subcodes-Segements Model via the New Code
Model menu in the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear:
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The Code-Subcode-Segments Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Subcode options

Display only activated - The displayed subcodes are limited to the currently activated
codes. You can also set the maximum number of subcodes to be displayed.

(all,1,2,3) levels of subcodes - You can specify whether only the direct subcodes (level
1) of the selected code or subcodes of other levels are to be displayed.

Line width reflects code frequency - If you set this option, the connecting lines to
codes with many coded segments are drawn thicker than for codes with few coded
segments.

Arrange codes by frequency / code system - This option determines the order of the
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codes. Sorting by frequency starts on the right with the code with the most coded
segments, sorting by code system starts with the code that is at the top of the code
system.

Coded Segments options

Display coded segments, max. X - If this option is enabled, an adjustable number of
associated segments are displayed for each code, so that you can get a visual
impression of the code frequency.

If there are more segments for the code than the desired maximum number, the
segments are selected either by highest priority or by largest segment (segments with
larger area have priority).

Change label to: coded text/comment - If this option is enabled, the comment for the
coded segment or the coded text for text coding is used as label instead of the mere
indication of origin.

Change symbol to: coded image - If this option is enabled, the default symbol for
coded images is replaced by the default symbol for coded images.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code-Subcodes-Segments Model.

> Hierarchical Code-Subcodes Model
Functions of this model

The Code-Subcodes Model is useful for illustrating the hierarchical structure of a code
and its subcodes in combination with the code frequencies.

Display in the map

The icon for the selected code is placed directly under the heading of the model.
Underneath the, the direct subcodes are placed at a small distance, and a row
underneath them the subcodes of the subcodes, etc. Arrows point from each code to
its subcodes. Codes with many coded segments can be displayed larger than codes
with few coded segments.
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Example of a Hierarchical Code-Subcodes Model

Creating a new model and determining its structure

Once you have selected the Hierarchical Code-Subcodes Model in the New Code
Model menu of the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear:

Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Subcode options

Display only activated - When this option is selected, only the subcodes of the selected
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code that are currently active are taken into account.

X levels of subcodes - An 1 here means: Only the direct subcodes are to be included; a
2 means: their subcodes are also displayed and a 3 means MAXMaps also displays the
subcodes of the subcodes.

Line width reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMaps uses three different
sizes for the code representation: Codes whose frequencies are in the range of a
standard deviation around the mean value are represented in an average size. Codes
with more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.
Usually the option Aggregate frequencies for parent codes will be enabled, so that the
frequencies of the subcodes are taken into account when determining the size of the
codes above. Otherwise, the subcodes may be displayed much larger than their upper
codes, because the upper codes were only used very rarely or not at all.

Only for activated documents - When creating the model and determining the code
sizes, only the currently activated documents are taken into account if this option is
selected.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Hierarchical Code-Subcodes Model.

> Code Distribution Model
Functions of this model

The Code Distribution Model is suitable for illustrating how often a selected code
occurs in which documents.

Display in the map

The symbol of the selected code is placed in the middle and around it the documents
in which the code was assigned are displayed in a circle connected by lines. If desired,
the frequency of a code can be displayed on the connecting line. The code frequencies
can also determine the line thickness and the size of the document symbol.
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Example of a Hierarchical Code-Subcodes Model

Creating a new model and determining its structure

After you have selected the Code Distribution Model in the Start tab via New Code
Model, drag a code from the "Code System" to the MAXMaps workspace. The
following options dialog will appear:

Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
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Document options

Only activated documents - If this option is selected, only documents that are currently
activated will be integrated into the map.

Document size reflects code frequency - Use this option to display documents with
many coded segments larger than documents with few segments. MAXMaps uses
three different display sizes: Documents with frequencies in the range of a standard
deviation around the mean value are displayed in a medium size. Documents with
more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.

Arrange documents by code frequency / document system - You use this option to
determine the sequence of the documents. Sort by frequency starts on the right with
the document with the most coded segments, sort by "Document System" with the
document that is at the top of the list in the document system.

Line options

Label lines with co-occurence frequency - Shows how often the code was assigned in
the linked document on the lines.

Line width reflects co-occurence frequency - If this option is enabled, the more
segments are assigned to the code in the respective document, the thicker the
connection lines will be drawn.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code Distribution Model.

> Code Co-Occurrence Model
Function of this model

The "Code Co-occurrence Model" serves to visualize the co- occurrence of codes as a
network structure. The same three modes as for the Code Relations Browser and the
Code Map are available for the analysis of the co-occurrence:

Code Intersection - It is evaluated how often two codes have been assigned to a●

segment together. It is sufficient if the codes overlap; they do not have to cover
exactly the same area.
Code Proximity - It is evaluated how often two codes were assigned at a definable●

https://m22.maxqda.com/help-mx20/visual-tools/code-relations-browser-visualizing-overlapping-codes
https://m22.maxqda.com/help-mx20/visual-tools/code-map-position-codes-according-to-similarity
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distance in the same document or the same media file. You can determine the
maximum distance.
Code Occurence - It is evaluated how many documents contain two codes. The●

position of the two codes is irrelevant; they must both have been assigned at least
once in the document.

The subcodes of the selected codes can be included in the model.

Model display in the map

The following example shows the structure of the model:

The selected codes are placed in a circle on the work surface.●

MAXQDA evaluates which codes occur alongside the selected codes and places them●

in an outer circle around the selected codes.
Codes that occur alongside the selected codes are linked with gray lines. Relations●

between the codes in the outer circle are ignored.
If desired, the subcodes of the selected codes can be inserted and linked to their●

upper code with a red line. The line is drawn regardless of whether the subcodes
occur alongside their upper code.
It is possible to display the frequency of the co-occurrence on the connecting lines●

and for it to determine the line width.
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The Code Co-Occurrence Model

Creating a new model and determining its structure

Switch to the Start tab and click New Code Model.1.
Select the appropriate Code Co-occurence Model from the menu that appears,2.
depending on the analysis mode you require.
Drag one or more codes from the "Code System" onto the MAXMaps workspace.3.
To select multiple codes in the list, hold down the Ctrl/Cmd key and click on the
desired codes.

After the code selection has been completed, the following option dialog appears:

Code Co-Occurrence Model options

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.

Code / subcode options

Display only activated - The evaluation can be limited to the currently activated codes.
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Only for activated documents - If this option is enabled, only the common occurrence
of the selected codes in the currently activated documents is taken into account during
creation.

X levels of subcodes - You can choose whether and up to which level subcodes are
included (0 = do not display subcodes; 1 = include only the direct subcodes; 2 = also
level 2, i.e. include the subcodes of the subcodes etc.).

X min. number of co-occurences - If the number set here is not reached, the
connection is not drawn. So only connecting lines between codes are shown, which
occur together at least as often as defined here.

Code-symbol-size - You can select here whether all codes should be displayed in the
same size or whether the analysis results should be taken into account for the code
size. With the option By frequency of overlapping coded segments, the system
evaluates how often the code occurs together with other codes, i.e. the sum of the
numbers on the connecting lines is taken into account. The option By frequency of
overlapping codes evaluates how many other codes on the map a code has relations
with, i.e. how many connecting lines a code has.

Line options

Label lines with co-occurence frequency - If this option is enabled, a number is
displayed on the connecting lines between two codes indicating how often the two
codes occur together.

Line width reflects co-occurence frequency - Select this option to make connecting
lines between codes with many relations appear thicker than between codes that are
less common.

Options for codings to consider

Weight filter - By selecting a range of segment weights, the entire representation can
be limited to encodings of a specific relevance. If, for example, the range is set to 80
to 100, only those overlaps will be taken into account for the representation where
the segment weights lie within this required range.

Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code Co-occurence Model (Code Intersection).
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Options in MAXMaps
By clicking on the Options  symbol in the top right corner of the MAXMaps window,
a dialog will open where you can view and change standard settings.

The MAXMaps Options window

Apply grid – this option “snaps” your objects to a grid, which is visualized in the
background. This allows you to more easily line up objects in straight lines, and the
grid will not be shown in exported pictures.

Reduce imported images to this size – this setting determines how imported images
are handled. You can select "300px", "600px" (= standard), "1,200px" or “Original
size”. The longest side of an imported picture is then reduced to the maximum pixel
size. Background pictures are always imported in their original size.

Visualize internal links – when this box is checked, internal links are visualized by a
blue line between documents, as soon as documents are inserted into a map.

Display comment in tooltip of coded segment - when this box is checked, comments
to a coded segment are displayed as tooltips, when you hover the mouse cursor on
the coded segment while having the synchro mode activated.

Auto-save maps in cache [minutes] - when this box is checked, a temporary copy of
the map is saved to cache at the set interval

Use code and document color as border - Check this option to display code and
document symbols with colored borders in their respective code/document color. If
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this option is unchecked all symbols are displayed with black borders and a small color
symbol.
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14 - Paraphrasing

Paraphrase Text Passages and Image
Segments
Paraphrases are summaries of individual sections of your data, written in your own
words. MAXQDA makes it easy to write paraphrases for sections of text and image
segments and then categorize these paraphrases in order to systematize and group
them. These paraphrase functions can be used, among other things, to work
systematically with summaries of text sections and the formation of categories.
Paraphrasing is often carried out within the framework of qualitative content analysis:
it is used especially in the interpretation of data material and as the basis for inductive
classification (Kuckartz, 2016, Mayring, 2015, Schreier, 2012). But paraphrasing is
useful in general whenever you need only to summarize the important contents of a
text, e.g. when a journalist paraphrases the key statements of an interview.

Activating "Paraphrase Mode"

Paraphrases can be created for text and PDF documents as well as image segments:

Open the document or image you want to paraphrase in the "Document Browser"1.
window
Turn on "Paraphrase Mode" by clicking the Paraphrase icon (not the text) on the2.
Analysis tab, or by pressing Ctrl+Shift+P (Windows) or cmd+Shift+P (Mac). The icon
will be highlighted in blue, indicating that paraphrasing mode is active.

Activated Paraphrase Mode

Writing new paraphrases

While "Paraphrase Mode" is active, highlight the section of the document or image1.
you want to paraphrase.
Immediately after you let go with your mouse, MAXQDA will display a window in2.
which you can write a paraphrase. A paraphrase has a maximum of 255 characters
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including spaces.

Paraphrasing window

Pressing the Enter Key (↩) or clicking on OK closes this window.3.

Tip: To include a line break in your paraphrase, press Shift + Enter (⇧+↩).

The newly-created paraphrase is then displayed to the right of the document or image
in the sidebar of the "Document Browser". The paraphrased segments are highlightes
in a green color, so you can immediately see which segments have already been
paraphrased.

Paraphrases displayed in the sidebar of the Document Browser

Paraphrases in text documents cannot overlap with existing ones. So, when you
highlicht a section that is already (partially) paraphrased, the paraphrase window will
not open up. Paraphrases in images can partially overlap with existing ones. It is not
possible however to paraphrase an image segment that is completely enclosed by an
existing paraphrase.

Please note: While Paraphrase Mode is switched on, no context menu can be opened
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in the "Document Browser" and it is not possible to edit the text document at the
same time.

Editing or deleting paraphrases

To edit a paraphrase, double-click the paraphrase text in the "Paraphrase Column"
next to the text. The window with the paraphrase opens again in which it can be
edited.

To delete a paraphrase, click on the red cross in the top right corner of the paraphrase
text.

Editing and deleting paraphrases

Deactivating Paraphrase Mode

Paraphrase Mode is deactivated in the same way it is opened by clicking on the
Paraphrase button in the Analysis tab. The sidebar of the "Document Browser"
remains visible to shows the paraphrases next to the documents.

"Paraphrase Mode" is automatically deactivated when you open another document or
select another tab in the menu.

Displaying paraphrases in the sidebar of the “Document Browser”

You can display or hide the "Document Browser" sidebar independently of Paraphrase
Mode when you want to display your paraphrases at any time. Right-click in a
document and select Sidebar > Paraphrases.



14 - Paraphrasing   477

Displaying paraphrases in the sidebar

Tip: Adjust the width of the sidebar by clicking and dragging the vertical separator
with the mouse.

The "Paraphrased Segments" entry in your "Code System"

The process of paraphrasing is independent of coding, i.e. the process neither requires
coding of the data material (from a methodological point of view) nor does it generate
codes. However, an entry "Paraphrased segments" appears in the MAXQDA code
system as soon as first paraphrase in a project is created. This entry is very similar to a
code and gives you access to all paraphrases in the current project. You can use the
entry similarly to a code to call up all paraphrases for selected documents in the
"Retrieved Segments" window:

Activate a document that includes paraphrases in your “Document System“.●

Activate the "Paraphrased Segments" code in your "Code System".●
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Paraphrased texts of an interview in the “Retrieved Segments” window

The "Paraphrased Segments" entry in your "Code System" has some special features:

You can’t delete it, rename it or use it for coding.●

By default, it is displayed at the bottom of the code system. In the local settings●

(accessible by clicking on the gear in the window title), you can choose to display it
at the top of the code system instead.
Coded segments cannot be added to or copied from it.●

Paraphrases are not indicated by a coding stripe in the "Document Browser".●

Paraphrases are ignored in Document Portraits and also when creating document●

models in MAXMaps.
Paraphrases are displayed in the Codeline.●

Paraphrasing and teamwork

If you’re working in a team and have split the documents to be paraphrased between
your team members, you can use the Merge projects function (in the "Home" tab) to
merge the projects of each individual team member into a single project.

You can find further details about working in teams here.

Print document with paraphrases in the margin

It is possible to print the document currently displayed in the "Document Browser"
and output the created paraphrases at the edge of the page. To do this, choose
Paraphrase > Print Document with Paraphrases.

https://m22.maxqda.com/help-mx20/teamwork
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MAXQDA will then display the following print preview:

Options for printing documents with paraphrases

Adjust your printing settings on the left.

Paraphrase Column Width - define how much wide the paraphrases space should be.

Highlight paraphrased Segments - displays paraphrased segments with colored
background.

Categorize Paraphrases
To systematize and group paraphrases, you can categorize them by means of codes.
This function supports, among other things, the development of categories.

To start the categorization of paraphrases, proceed as follows:

Activate the individual documents which include the paraphrases you would like to1.
work with.
Select Analysis > Paraphrase > Categorize Paraphrases (you have to click on the text2.
"Paraphrase", not on the symbol above it).
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The following interactive table window will then appear:

Interactive table window for categorizing paraphrases

A code tree is displayed in the left field. When you open the function for the first time,
it will still be empty. You can enter new categories here and then assigned them to
individual paraphrases. The number at the end of the code line tells you how often the
category occurs in your paraphrases. If you activate the function again later, all codes
which have already been assigned to a paraphrase will be displayed in the code tree.
So, you can easily pause your work on paraphrases and pick it up again later.

In the right field, all the paraphrases in your project will be displayed – each listed in a
separate row. The number of currently listed paraphrases is displayed in the upper
right corner of the window.

The individual columns contain the following information:

Document – Indication of origin, in which document and at which position the
paraphrase was created

Paraphrases – Contains the paraphrase that has been written for the paraphrased text

Codes – The list of codes applied to the paraphrases

Paraphrased text – Contains the text that was paraphrased (this column is
automatically hidden when the interactive table window is opened); <IMAGE> is
displayed for paraphrased image segments, not the paraphrased image segment itself.

The table can be adjusted like all MAXQDA tables: The width and position of columns
can be changed with the mouse, or by right-clicking on a column header. A click on
the heading sorts the column in ascending order, another click in descending order.

The lines with the paraphrases can be sorted by drag and drop with the mouse so that
similar paraphrases can be arranged one below the other, which is very helpful for
categorization. Sorting remains as long as the project is open. When new paraphrases
are added, they are appended at the bottom.
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Please note: All other MAXQDA functions are locked, while the paraphrases function is
open.

The toolbar

At the top of the “Categorizing Paraphrases” window there is a toolbar with the
following functions:

Quit – closes the Smart Coding Tool. Alternatively, you can click the X to
close the window.

Display all codes – if this option is activated, not only the codes that have been
newly created in the opened window or already assigned to a paraphrase as code are
displayed in the "Code System", but all codes in MAXQDA.

Display only paraphrases from the selected category – if this option is enabled and
you click on a category in the Code System, only the paraphrases of the selected
category will be displayed.

New code – creates a new category in the code system, which can be used to
categorize your paraphrases.

Only activated documents – only the paraphrases of activated documents are
displayed. The display of frequencies in the code tree is adjusted accordingly. If the
documents were activated when this function was opened, this option is automatically
activated.

Filter – applies the filters you can define by right-clicking on the column heading
and selecting Set filter.

Reset all filters – removes filters from all columns.

Display search toolbar – lets you to enter a search term to search for text in all or
specific columns.

Display parent code – in addition to the code, the "Codes" column also displays its
parent code.

Display paraphrased text – displays column containing paraphrased texts.

Undo – undoes the last action in the window.

Redo – redoes the last action in the window.
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Creating and assigning new categories

Paraphrases can be categorized using codes. You can always create a new code and
assign it directly to a paraphrase:

Right-click on the paraphrase and select New code.1.

Selecting a function from the context menu of a paraphrase

In the dialog window that appears, you can enter a code name and assign a code2.
color. You can also enter a description of the new code in the "Code Memo" text
box.
After clicking OK the new code is added, displayed in the code tree on the left side3.
and assigned to the paraphrase.

This categorization is immediately made clear by the addition of the code in the
“Codes” column.

Applies category in the “Codes” column

To assign a pre-existing category to a paraphrase, click and drag the row with the
paraphrase to one of the displayed codes in the code tree.

You can also create categories without assigning them directly to a paraphrase:

To do this, click the New code icon in the toolbar,●

Use the key combination alt+N (Windows) or cmd+option+N (Mac) or●
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right-click on the top entry of the code tree and select New code.●

Please note: All changes made to the code system in this window, including the
addition of new codes, are automatically incorporated into your overall “Code
System”.

Removing assigned categories

To remove a category assigned to a response, click the cross that appears when you
move the mouse over a code in the "Codes" column.

Removing a category assigned to a paraphrase

Customizing your category system

Your category system can be customized throughout the entire analysis process. You
can change the order of codes with the mouse and even insert them as sub-subcodes.
By right-clicking on a code, all the functions from the overall "Code System" are
available to customize your code system here:

Delete code●

Sort subcodes (alphabetically or by category frequency)●

Change code color●

Create or edit code-memo●

Exporting paraphrases

Your current display can be exported via the usual icons at the top right of the
window. All the rows (paraphrases) in the right field are always exported.

 Open as Word document – Creates a temporary Word document and displays it in
the program to which this format has been assigned on your computer. To save the
created file permanently, you need to save it from Word to a different location.

 Open as Excel spreadsheet – Creates a temporary spreadsheet in XLS / X format
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which is opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

 Export – MAXQDA creates a table as an Excel file (XLS / X format), as a web page
(HTML format) or as a text document (Word or RTF format) after you have entered a
file-name and location. The exported file is opened immediately.

Paraphrases Matrix
In the Paraphrases Matrix, paraphrases you have written for cases or groups can be
displayed together and compared in a table view. The table columns are formed by
either documents, document groups, or document sets, and their respective
paraphrases are listed in each column.

The Paraphrases Matrix

Opening the Paraphrases Matrix

To open the Paraphrases Matrix:

Select the function Analysis > Paraphrases > Paraphrases Matrix in MAXQDA's main1.
menu.
A dialog window will appear in which you can drag and drop documents,2.
document groups or document sets from the "Documents System". Each row in
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the selection window will later form a column in the Paraphrases Matrix.

Column selection window

Click OK and MAXQDA will display the Paraphrases Matrix.

Functions in the toolbar

In the Paraphrases Matrix itself, you can access the following functions in the toolbar
at the top left of the window:

 Display origin – displays the source documents below your paraphrases. Clicking
on this source selects the relevant paraphrased segment in the "Document Browser".

 Zoom out/in – minimizes/maximizes the display of the paraphrases in the
columns.

x of y columns – Lets you specify how many columns are to be displayed next to each
other in the window at the same time.

 Refresh – opens the options dialog window to let you regenerate the paraphrase
matrix again to adopt new matrix specifications.

Exporting the Paraphrases Matrix

The contents of the Paraphrases Matrix can be exported using the usual symbols at the
top right of the window.

 Open as Word document – Creates a temporary Word document and displays it in
the program to which this format has been assigned on your computer. To save the
created file permanently, you need to save it from Word to a different location.
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 Open as Excel table – Creates a temporary spreadsheet in Excel format, which is
opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

 Export – Creates a Word file (DOCX format), an Excel file (XLSX format), or a web
page (HTML format) once you have assigned a file name and location. The exported
file is then opened directly.

Overview of Paraphrases
The Overview of Paraphrases is available in the "Document System" on all levels
(document, document group, document set) and lists all existing paraphrases for the
selected level in an overview table typical to MAXQDA. The paraphrase text is always
completely visible; in other words, long paraphrases are displayed across several rows.

The Overview of Paraphrases

The Overview of Paraphrases is very useful for getting an overview of the paraphrases
of a project, for reviewing them and adapting them if necessary.

Accessing the Overview of Paraphrases

To open the Overview of Paraphrases, right-click on a document, document group or
document set in the "Document System". Then select Paraphrases in the menu that
appears.

The Overview of Paraphrases will then appear with all the paraphrases from the
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documents at the selected level. The overview is interactive:

Click a row to display the paraphrased segment in the "Document Browser" in order●

to, for example, compare your paraphrased text with the original segment.
Double-click into the cell with the paraphrase itself to edit the paraphrase directly in●

this table.

Like all overviews in MAXQDA, you can sort the table by clicking on a column header
and arrange the columns in any order by clicking and dragging the column headers
with your mouse. You can also filter, search and export the Overview (see Managing
Table Overviews).

Overview of Paraphrased Segments
The "Overview of Paraphrased Segments" can be accessed via the "Code System" and
is very similar to the "Overview of Coded Segments". This overview contains all the
paraphrases in your project and displays the paraphrased text of the selected
paraphrase in the preview area. In contrast to the Overview of Paraphrases, it also
displays the original paraphrased segments and contains additional columns with
information such as the size of the paraphrased segment. The paraphrases themselves
are only displayed in one row.

The Overview of Paraphrased Segments

The "Overview of Paraphrased Segments" is very useful for seeing an overview of the
paraphrases in your project together with your paraphrased segments in a single
window.

https://m22.maxqda.com/help-mx20/screens-and-menus/managing-table-overview
https://m22.maxqda.com/help-mx20/screens-and-menus/managing-table-overview
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Accessing the Overview of Paraphrased Segments

To access the Overview of Paraphrased Segments double-click Paraphrased Segments
in the "Code System". Alternatively, right-click on Paraphrased Segments and select
the corresponding option in the context menu.

Accessing the Overview of Paraphrased Segments in the “Code System”

Tip: By default, the Paraphrased Segments entry is displayed in the bottom row of the
"Code System". Alternatively, you can display this entry at the top. To do this, click on
the gear symbol in the "Code System" to open the local settings and check the option
with the same name.

The Overview of Paraphrased Segments is interactive:

Click on a row to display the paraphrased segment in the “Document Browser”.●

Double-click on the paraphrase text to edit it directly in the Overview.●

The individual columns of the Overview have the following meanings:

Document group, Document name, Beginning, End – Specifies the source of the
paraphrased segment.

Weight – A weight can also be assigned to a paraphrase (as with codes). The weight
can be used, for example, to identify paraphrases that you are unsure about and that
you would like to look at again later, either yourself or as a team.
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Created / Created by – These columns indicate when and by whom the paraphrase
was created.

Area – Size of the paraphrased segment (text segments in characters, image segments
in square pixels).

Coverage – Size of the paraphrased segment as a percentage of the total size of the
document.

Like all overviews in MAXQDA, you can sort the table by clicking on a column header
and arrange the columns in any order by clicking and dragging the column headers
with your mouse. You can also filter, browse and export the Overview (see Managing
Table Overviews).

Coding paraphrased segments

You can code the listed paraphrased segments with a new code or with an existing
code. To do this, click on the corresponding icons in the toolbar:

 Code paraphrased segments  – codes the paraphrased segments with an existing
code from your code system. To select an existing code, you must first click on it once
in the "Code System".

 Code paraphrased segments with new code – codes the paraphrased segments
with a newly created code.

If individual rows are selected, only these are coded, otherwise all currently listed
segments are coded with the code.

https://m22.maxqda.com/help-mx20/screens-and-menus/managing-table-overview
https://m22.maxqda.com/help-mx20/screens-and-menus/managing-table-overview
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15 - Summarizing

The Idea behind the Summary Grid
The systematic analysis of texts or other information is often about analyzing the data
systematically within a structural framework, summarizing it and then grouping it in
different categories.

The idea is to look for theoretical explanations for certain phenomena as well as for
similarities and differences between texts. In this process, it is important to focus on
what the research participants precisely said. But on the other hand, the researcher
should also detach from the participants own words. His aim is to sum up and express
what was said abstractly, and to eventually present it in a way that is understandable
for the recipient. During this analytical procedure, the “raw data”, that is for example
interview transcripts, records, field notes etc., should be accessible at all times. The
Summary function is available in MAXQDA for this purpose.

MAXQDA's Summary function distinguishes two work stages and offers two individual
working environments for these stages:

First, the phase of Summary Creation and second, the phase of Summary Analysis and
Summary Presentation. For the second phase, results tables (so-called "Summary
Tables") based on the summaries are available, as well as summary matrices for
comparing summaries for individual cases and groups.

The summary functions can be called up in the menu ribbon in the Analysis tab:

Summary functions in the Analysis Tab

In order to create summaries, the segments that you want to analyze must already be
grouped thematically. This might have been done with the use of structured
interviews, thematic coding, or automatic coding. If the text is already coded with a
Code System, a structure texts * codes already exists; you can view it using the Code
Matrix Browser.

You can picture the summary level as a thematic grid, i.e. a matrix documents x
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categories (codes). MAXQDA has a matrix like this called the Code Matrix Browser
(CMB). It displays the texts in the columns and the categories in the rows.

The Summary Grid is a second analytical level that contains the summaries written by
researchers for every node of the CMB. The user writes individual summaries and can
edit them later, e.g. by adding or altering the information. The idea is to present the
summaries in overview tables at a later stage of the analysis. This grid allows every
summary to stay linked to the original text segment from the raw data.

Create and Edit Summaries
To create and edit summaries, click on the Summary Grid symbol in the Analysis tab.

MAXQDA then opens a new window called “Summary Grid.” The window itself is
divided into three areas:

Left window: the thematic grid, the Code Matrix Browser display (Documents x1.
Codes).
Middle window: the coded segments, so exactly what is normally listed in the2.
“Retrieved Segments” window after double-clicking a node in the Code Matrix
Browser.
Right window: the summary, this is where the summary is displayed, created and3.
edited.

Window “Summary Grid”

In the right summary window you can write or change a summary for the selected cell
of the first column. The selection is made by simply clicking on a cell in the first
column. The summary is automatically saved when you switch to another node in the

https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
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first column or close the window.

Tip: Selected text passages in the middle column "Coded Segments" can be dragged
into the right summary window by holding down the left mouse button. This makes it
easy to add original quotations to the summary.

You can adjust the content of the columns and rows of the grid on the left with two
buttons:

Only activated documents –only documents that have been activated in the
“Document System” will appear as columns.

Only activated Codes –only Codes that have been activated in the “Code System”
will appear as rows.

Additional buttons offer the following functions:

Names, columns: none –in the left window, the document names will not be
displayed in the column header.

Names, columns: short – in the left window, the document names will be appear
in the column header in short form.

Names, columns: full – in the left window, complete document names will be
displayed in the column header.

 Display nodes as squares – existing codes will be symbolized as squares in the left
pane.

  Display nodes as circles – existing codes will be symbolized as circles in the left
pane.

 Display origin - displays each coded segment's position in the document and the
weight assigned to it in the middle column "Coded Segments". The source data are
interactive: Click on the entry, MAXQDA loads the corresponding document into the
"document browser" and marks the segment.

 Display comments on coded segments - shows the corresponding comment in the
middle column "Coded Segments" below the coded segments - if you have written
one for the segment.

 Display memos - Displays all memos attached to the segment in the middle
column "Coded Segments" below the coding. Click on the memo title to open the
corresponding memo.
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 Standardize font – with this setting, you can standardize the text font, size, and
line spacing to create a consistent display of your text segments. Font styles such as
bold and italics are not affected by this setting.

Summary tables– opens the “Summary Tables” window.

Summary Tables
A Summary Table is an overview table of summaries and document variables for
selected documents and codes. It serves as a compilation of the summaries for
selected topics. Summary Tables are a useful tool for presentations and publications.

To create summary tables and to view the summary tables that you have already
created, click the Summary Table icon in either

in the Analysis tab●

on the toolbar of the Summary Grid window.●

This will open the Summary Tables window. On the left side you find a list of the
Summary Tables you have already created and in the window on the right you can
view the Summary Table that is currently opened.

“Summary Tables” window

To create a new Summary Table, click the button  in the toolbar. A dialog window

https://m22.maxqda.com/help-mx20/summary-grid/summary-tables
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will appear that offers three options:

You can decide whether to include all documents or only activated documents. This●

defines the rows of the Summary Table.
You can select any number of codes, to be displayed in the columns of the Summary●

Table.
You can choose which document variables should be output as supplementary●

information. All variables that are placed in the “Variables for first column” pane will
appear in the first column with the document name. All variables that are placed in
the “Variables in own column” pane will appear in their own columns after the
codes.

Dialog to create a new Summary Table

By clicking OK, the table will be created according to the parameters you have chosen:
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Summary Table

The Summary Table lists all summaries for the selected codes.

In the first column of the Summary Table, you can see the document group and
document name. In addition, the variable values of the variables chosen are displayed
underneath each document. This enables you to receive further information about a
certain case in the Summary Table.

All table functions of MAXQDA are available:

You can change the order of columns by clicking and dragging with the mouse.●

You can hide or display columns (right-click on the column header and choose Select●

fields).
You can order columns alphabetically by clicking on a column header.●

The table is in plain text format, so the entire table is formatted with the same font.

Please note: You can edit any cell of the Summary Table individually, that means you
can modify the summaries displayed. Changes in the content of the Summary Table
will also affect the summaries. This means that the content of the corresponding cell in
the Summary Grid will also change accordingly. You can also change the variable
values of the variables that are displayed in their own columns – this has no effect on
the document variables themselves.

Each cell of the Summary Table is connected invisibly to the assigned coded segments.
These can be viewed in the window “Retrieved Segments” by right-clicking in the cell
of the Summary Table and choosing “Display associated coded segments.”
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Interactive cells in the Summary Table

Transforming a Column of the Summary Table as a Document Variable

Let’s say one column of your Summary Table contains short and similar summaries for
a topic in an interview study. This analytic work can be easily used as a document
variable in MAXQDA, e.g. to activate interviewees where you have written the same
summary: Right click on the column heading and choose Transform into document
variable. MAXQDA will now create a new document variable that contains the
summaries as values and will be named as the column. If the variable already exists,
MAXQDA will add a number to the name. Please note that the values will be
shortened to 63 characters. The column in the Summary Table remains.

Swap Rows and Columns of a Summary Table

You can use the icon  in the toolbar of the Summary Table to rotate the view by
90°, which means you swap the rows and the columns for display. The documents will
be displayed in the columns then and the codes (and the variables displayed in an own
column) in the rows.

Opening, Deleting, Duplicating and Renaming Summary Tables

To open an existing Summary Table, double-click on the name of the Summary Table
in the left panel. You can also right-click on the name of a table to open a context
menu that allows you to open, rename, duplicate or delete the table.
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Context menu on a table name

Please note: The Summary Table is dynamically linked to MAXQDA data. As soon as
you open a Summary Table, it scans your project for deleted documents, codes or
variables, so that they can be removed or updated if necessary. Deleting variables in
the project or changing variable values not only affects the first column, but also the
variables in their own columns.

Insert summary table as a table document in the "Document System"

The displayed summary table can be stored as a table document, so that you can then
evaluate the data with all of MAXQDA functions. To do this, click the  Insert
summary table as a table document icon in the "Document System" that appears in
the toolbar.

Summary Explorer
The Summary Explorer allows you to compare the summaries of different cases or
groups in a clear table. The Explorer's columns are formed by documents, document
groups or document sets, each column containing the respective summaries of the
currently selected code (topic).
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The Summary Explorer

The Summary Explorer can be used to answer questions such as "What are the
differences between Indiana and New York students in terms of career aspirations and
concerns? The summary explorer shown above compares summaries (written by
researchers) of the statements made by students in Indiana with summaries of the
statements made by students in New York. The Indiana group consists of 3
documents, and for each of these 3 documents a summary was written under the
code "Career". All 3 summaries are displayed in the corresponding column.

Opening the Summary Explorer

To start the Summary Explorer:

Select Analysis > Summary Explorer in the MAXQDA main menu.1.
A dialog window will appear into which you can drag and drop documents,2.
document groups or document sets from the "Document System" and codes from
the "Code System". Each row in the upper area of the dialog window will later
form its own column in the Summary Explorer.
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Dialog window for selecting columns

Click OK, and MAXQDA will open the Summary Explorer.

The Summary Explorer columns always display the summaries associated with the code
selected on the left.

Functions in the Toolbar

In Summary Explorer, the following functions are available in the toolbar at the top left
of the window:

 Display codes with hierarchy – If this option is activated, the codes are displayed in
a hierarchical tree structure. The non-activated parent codes may be displayed to
retain its hierarchical structure. When the option is deactivated, the codes are
displayed in a linear list. Should you have selected the option Only activated codes
when generating the Explorer, only the activated codes will be displayed.

 Display origin  – Displays the source documents, locations within documents and
the code weights in brackets below the coded segments. Clicking on the displayed
source document imports the correspond-ing document into the document browser
and highlights the coded segment.

 Zoom out/in – Minimizes/maximizes the display of the summaries in the
columns.
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x of y columns – Allows you to specify how many columns should be displayed next to
each other in the window at the same time.

 Refresh  – Reopens the options window for the Summary Explorer, which lets you
customize the columns and included documents and codes.

Exporting the Summary Explorer

The contents of Summary Explorer can be exported using the usual icons at the top
right of the window. All the codes selected in the Explorer's dialog window are taken
into account for the export.

 Open as Word document – Creates a temporary Word document and displays it in
the program to which this format has been assigned on your computer. To save the
created file permanently, you need to save it from Word to a different location.

 Open as Excel table – Creates a temporary spreadsheet in Excel format which is
opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

 Export – Creates a Word file (DOCX format), an Excel file (XLSX format), or a web
page (HTML format) once you have assigned a file name and location. The exported
file is then opened immediately.

Overview of Summaries
The Overview of Summaries allows quick access to the summaries of selected
documents. It is accessible from the context menu at all levels of the Document
System. Right-click on a document, document group, document set, or the root of the
Document System and select Overview of Summaries. A listing in table form will
appear, as is typical in MAXQDA, and which contains all existing summaries of the
documents in question, displayed in the upper pane. As usual, the context of the
listing will be noted in the upper left corner.
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Overview of Summaries

The “Document” and “Code” columns contain information on the "node" from
which the summary is derived, the “Preview” column contains the first 63 characters
of the summary, and the “Position" column lists all the positions from which the
underlying coded segments originate. The figure below illustrates the first summary
from the document "Joanna" and is part of the code "Significantly Positive." In this
document four text segments were coded with this code, namely in paragraphs 27,
29, 31 and 35.

In the Reports tab you can open an Overview of Summaries containing all the
summaries of your open project.
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16 - Comparing Cases & Groups
MAXQDA allows you to compare different groups on a qualitative and quantitative
basis. In the case of qualitative analysis, coded contents and, where appropriate,
supplementary comments are compared. In the case of quantitative analysis, variant
code frequencies are compared. The groups are formed by document groups,
document sets or individual documents.
You can use this feature for many forms of comparison, because the functionality is so
flexible that it allows for not only group comparisons, but also comparisons of
individual cases, and combined comparisons of groups with individual cases.

Qualitative Data: Content of Coded
Segments
The comparative analysis of cases and groups is one of the most important techniques
of qualitative research. In MAXQDA there are numerous possibilities to compare the
data material, for example to display only the statements of certain groups of persons
in the "Retrieved Segments" or to compare visualizations, such as Document Portraits,
for different cases.

The MAXQDA function Compare Cases & Groups allows you to easily compare coded
data (qualitative data) and code frequencies (qualitative data transformed into
quantitative data). This chapter on qualitative data therefore focuses on the
comparison of coded data.

A prerequisite for performing a case or group comparison is that groups exist in your
"Document System", either as document groups, document sets or as individual
documents. To combine documents with certain variable values in a document set,
you can use the Activate by Document Variables function.

A comparison of coded segments can be performed as follows:

Select the function Analysis > Compare Cases & Groups > Qualitative. An options1.
dialog window will appear with two sections:

https://m22.maxqda.com/help-mx20/visual-tools/document-portrait-visualizing-a-document
https://m22.maxqda.com/help-mx20/mixed-methods-functions/activation-by-document-variable-variables-as-selection-criteria-for-the-coding-query
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Options dialog window for comparing coded contents

Drag at least two document groups, document sets or individual documents from2.
the "List of documents" into the upper "Groups" area with the mouse button
pressed down. You can also merge document groups, document sets and
documents. Entries can be deleted at any time by clicking on the X at the end of a
line.
Drag several codes from the "Code System" into the lower "Codes" area by3.
holding down the mouse button. Click on the Insert activated codes button to add
all activated and not yet selected codes below. You can adjust the sequence of the
codes later by holding down the mouse button.

After clicking OK MAXQDA creates an interactive segment matrix and displays it
directly. The selected groups form the columns and the selected codes the rows of the
matrix. The cells contain the coded segments so that the coded contents for the
selected groups can be compared with each other.
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Results table for the comparison of coded contents: Interactive Quote Matrix

The functionality of the Interactive Quote Matrix is described in detail here.

Quantitative Data: Code Frequencies
The comparative analysis of cases and groups is one of the most important techniques
of qualitative research. In MAXQDA there are numerous possibilities to compare the
data material, for example to display only the statements of certain groups of persons
in the "Retrieved Segments" or to compare visualizations, such as Document Portraits,
for different cases.

The MAXQDA function Compare Cases & Groups allows you to easily compare coded
data (qualitative data) and code frequencies (qualitative data transformed into
quantitative data). This chapter on quantitative data therefore focuses on the
comparison of code frequencies.

A prerequisite for performing a case or group comparison is that groups exist in your
“Document System”, either as document groups, document sets or as individual
documents. To combine documents with certain variable values in a document set,
you can use the Activate by Document Variables function.

A group comparison for code frequencies is performed as follows:

https://m22.maxqda.com/help-mx20/mixed-methods-functions/interactive-quote-matrix
https://m22.maxqda.com/help-mx20/visual-tools/document-portrait-visualizing-a-document
https://m22.maxqda.com/help-mx20/mixed-methods-functions/activation-by-document-variable-variables-as-selection-criteria-for-the-coding-query
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Open the function Analysis > Compare Cases & Groups > Quantitative. An options1.
dialog window will appear with two sections:

Drag at least two document groups, document sets or individual documents from2.
the "Document System" into the upper "Groups" area with the mouse button
pressed down. You can also combine document groups, document sets and
documents. Entries can be deleted at any time by clicking on the X at the end of a
line.
Drag several codes from the "Codes" into the bottom "Codes" area by keeping the3.
mouse button pressed down. Click on the Insert activated codes button to add all
activated and not yet selected codes below. You can adjust the sequence of the
codes later by holding down the mouse button.

Click on OK and MAXQDA creates a  crosstab. The selected groups form the columns
and the selected codes form the rows of the matrix:

https://m22.maxqda.com/help-mx20/mixed-methods-functions/crosstab
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Crosstab as result of a case or group comparison
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17 - Variables

Document and Code Variables in
MAXQDA
In MAXQDA you can store information in variables both for documents and at code
level. For the speakers of a group interview there are additional speaker variables
which are explained in detail in the chapter analysis of focus groups.

Document variables

Document variables are associated with an entire document, (e.g. the person
interviewed in an interview transcript). In these cases, you can assign socio-
demographic information like gender, age, education level, etc. that can then be
analyzed in conjunction with the actual text.

In the following example, the age and gender of all five respondents was noted, in
addition to whether they were members of an NGO:

Example of application of Document Variables

Code variables

The development of code variables in MAXQDA makes it possible for you to define
variables within a document and to use their values as selection criteria during the
evaluation process. In this way, you can, for example, activate codes by defined
criteria.

https://m22.maxqda.com/help-mx20/focus-group-analysis/can-maxqda-support-focus-group-analysis
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Managing variables

Two views are available in MAXQDA for handling variables: the variable list and the
data editor. In the variable list, all variables defined in the project are listed in tabular
form. The data editor displays the data table as a rectangular matrix "rows times
columns" in a similar way to statistics programs. The columns always contain the
variables, the rows contain the documents for the document variables and the rows
contain the codes for the code variables.

The List of Document Variables

The List of Document Variables can be opened via Variables > List of Document
Variables.

When you open the List of Document Variables in a newly created project, the system
variables displayed in the image are already defined:

Document group – contains the name of the document group that a particular●

document is a part of
Document name – contains the name of the document●

Created by – contains the name of the user who was logged in when the document●

was imported or created
Created – contains the date the document was imported/created●

Modified by – contains the name of the user who last edited the document, codings,●

memos or links.
Modified – contains the date of last editing.●

Coded Segments – contains the number of coded segments in the document●

Memos – contains the number of memos in the document●

System Variables in the “List of document variables”

The system variables are indicated with a red symbol in the first column of the list of
variables. System-defined variables cannot be modified or deleted. User-defined
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variables are indicated with a blue symbol in the first column - these variables can be
modified or deleted as desired.

The List of Code Variables

The List of Code Variables can be opened via Variables > List of Code Variables.

When you open the List of Code Variables in a newly created project, the system
variables displayed in the image are already defined:

Parent code – Names of the codes at the following (higher) level (if applicable)●

Code – Code name●

Coded segments (all documents) – Number of segments coded with this code●

Coded segments (activated documents) – Number of segments coded with this code●

in current activated documents (code needs to be activated)
% Coded segments (all documents) – relative frequency of "Coded segments (all●

documents)"
% Coded segments (activated documents) – relative frequency of "Coded segments●

(activated documents)"
Created by – User who created the code●

Creation date – Date and time at which the code was created●

Modified by - User name of person who last edited the document, codings, memos●

or links.
Modified - Date of last editing.●

Documents – Number of documents in which the code appears●

System variables in the “List of code variables”
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Sorting the List of Variables

The list of variables can be sorted in alphabetical or reverse alphabetical order just like
any other table in MAXQDA. Simply click once or twice on the column header you
would like to sort by.

Tip: To restore the original sorting, click a column header with the right mouse button
and select the sorting.

Toolbar

Both the List of Document Variables” and the List of Code Variables can be managed
from the toolbar, which contains identical symbols for both lists.

Import data – allows import of spreadsheets in XLS/X format.

List of document variables  – switches from the Data view to the Variable view.

Data editor – switches from the Variable view to the Data view.

New variable – creates a new variable.

Delete selected items – deletes selected variables.

Convert to boolean variable – converts selected variables into dichotomous
boolean variables.

Convert to text variable – converts selected variables into text variables.

Document / Code Variable Statistics – generates a frequency table or chart for the
indicated variable.

Create and Edit Variables
You can add new variables to both the “List of document variables” and “List of code
variables”:

Select List of Document Variables or Code Variables from the Variables tab●

Click on the New variable  icon in the toolbar.●
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Creating a new variable with the icon in the toolbar

The following window will appear:

Defining a new variable

You can now insert a name for the variable and choose its type. The name can contain
up to 63 characters including There are five different types of variables to be chosen
from:

Text●

Integer●

Decimal●

Date/time●

Boolean (true/false)●

When creating an integer or an decimal variable, you also have the option of defining
whether it is a metric or a categorical variable. The variable for age, for example, can
be handled in various ways: if you want to enter the age in years, you are dealing with
a metric variable, for which you may want to establish a mean. If you have defined
ages into categories (e.g. 1 = under 18, 2 = 18-30, 3 = 31-50, 4 = 51+), then you are
dealing with a categorical variable, for which you would not want to find a mean
value.
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You can also select what value should be inserted automatically for those cases where
there is a missing value. This is especially important if you are planning to do a
statistical analysis later.

Note: Document variables are created for the entire project, which means you cannot
create different variables for each document group.

For better readability of variable values in MAXQDA, it can often be more convenient
to use text variables instead of number variables. In a table column with the variable
"familial status", the variable "married" will be more readable than a numeric code
(like "2").

The number of variables is not limited in principle, that is, variables can be removed
from the list or added to the list at any time. By clicking on the New variable button,
you can mae new definitions. In the event that you want to define a large number of
variables and, if necessary, the values for the cases already exist in a table-like structure
or even as an SPSS record, you can save time by importing the file.

Rename and Delete Variables

Variables can be given a new name at any time. Double-click on the variable, and
enter the new name.

Renaming a variable in “List of document variables”

Renaming a variable is possible at any time and does not affect the variable’s stored
values.

Deleting a variable is done in the same way as renaming it. Select the variable you
want to delete with the mouse. Now the focused variable is highlighted in green. Then

https://m22.maxqda.com/help-mx20/variables/importing-data-excel-spss
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click the Delete variable  button in the toolbar. When you delete a variable, the
whole column including all its values will be removed from the table.

Change Variable Type

MAXQDA allows for changes in variable types for existing variables:

Document variables, which display how often a code exists (their source is●

acknowledged as “code”) can be transformed into a binary variable by clicking on
the  "COnvert to boolean variable" button. After it is transformed the variable will
not show, how often a code has been assigned in the document, but if it has been
assigned in this document or not.
User defined variables “Integer,” “Decimal,” “Date/Time” and “Boolean” can be●

transformed into text variables by clicking the .

The Data Editor
When working with variables, two views are available in MAXQDA: the variables view
and the data view in the Data Editor. The Data Editor is similar to statistics programs in
that the data is displayed as a rectangular matrix with a “rows x columns” structure.
The variables are displayed in the columns; while the rows display the document
variables for documents or the code variables for codes. For document variables the
table will contain as many rows as there are documents in the “Document System”;
for example, in an interview study, the number of rows will correspond to the number
of interviewees. For the code variables, the codes correspond to the cases.

Opening the Data Editor for Document Variables

The Data Editor for Document Variables can be opened in 3 ways:

via Variables > Data Editor for Document Variables,●

from the "List of Document Variables" by clicking on the Data Editor icon●

in the “Document System” window, by selecting Variables in the context menu.●

When called up at the top level, the table contains all the documents; at the
document group level, the data table contains only corresponding documents, and
at the document level, only data.

A table will appear, in which the selected documents and their corresponding variable
values are listed. System variables can be recognized by the black column heading; this
cannot be modified in the table. User-defined variables are indicated with a blue
heading; their values can be adjusted by double-clicking the appropriate cell.
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Data Editor for Document Variables

In the Data Editor for Document Variables it is possible to access a document by right-
clicking the appropriate row. A context menu will appear which lists the same options
for opening the document as in the "Document System".

Opening the Data Editor for Code Variables

The Data Editor for Code Variables can be opened in 3 ways:

via Variables > Data Editor for Code Variables,●

from the List of Code Variables by clicking on the Data Editor  button, or,●

in the “Code System” window, by selecting Variables in the context menu of a code.●

If you click on a code, which does not contain subcodes, only the variable values for
this code will be listed in the table. If the code contains subcodes, the variables of
the subcodes will also be listed.

A table will appear which lists the selected codes and their corresponding variable
values.

An extensive context menu, the same as in the “Code System”, is also available for
individual codes.

Entering variable values in the Data Editor

To insert variable values into the Data Editor:

Double-click on the cell of the table where you would like to insert a value. Use the
Enter key to jump to the next line to enter the variable values for your variables. Use
the Tab key to jump to the next column to enter the values case by case.

The values that have already been given to any of the cases in the column are in the
drop-down list, sorted alphabetically. You can view this list and select a value from it
by clicking on the triangle to the right of the cell you double-clicked on.

If the value isn’t available in the drop-down list, you can simply type in the value after
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double-clicking in the cell.

Tip: Drop-down lists are less useful when a variable has many different values (e.g. the
exact income of every interviewee). Even if the value was in the drop-down list, it
would be faster to type it in than to search for it. You can stop the program from
displaying a column’s drop-down list by right-clicking on the column header and
selecting (to uncheck) List of values.

Options for the variable value in the Quick List

The Data Editor toolbar

At the top of the Data Editor there is a toolbar, which provides easy access to multiple
functions including the following:

Import data – allows you to import a table (in SPSS format SAV or Excel format
XLS/X) for code variables

Data editor – switches from the Variable view to the Data view.

List of document variables – switches from the Data view to Variable view.

Open As Excel Table - A temporary table in XLS/X format is created and displayed
in the program associated with this format. To permanently save the created file, you
have to save it to a different location from Excel.

 Open as HTML table - A temporary HTML table is created and displayed with the
standard browser set. To permanently save the created file, you must save it under a
different location from the default browser.

 Export – MAXQDA creates a table as an Excel file (XLS/X format), as a web page
(HTML format) or as a text document (Word or RTF format) after you have assigned a
file name and location. The exported file is opened immediately.

Managing tables

If you have created a large number of variables, it quickly becomes difficult to see then
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entire table at one time. You can view more columns at one time by making the
columns thinner (click and drag the separator between column headers), but
eventually even this does not suffice.

Of course there is the possibility to scroll through the table to the right and it is also
possible to change the order of the variables in the table by grabbing a variable
column with the left mouse button pressed and moving it to any other place in the
table. However, it is simpler to click the Select Columns icon in the toolbar. There are a
number of possibilities to influence the display in the variable table.

Variable selection of columns to be viewed

Besides (un)checking the boxes one by one, you also have the following options:

select all fields●

deselect all fields●

only system fields (those automatically created by MAXQDA)●

hide or show variables by checking or un-checking the box in front of the variable●

name
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Importing Data from Excel and SPSS
There are several situations in which you might want to import document variables
into MAXQDA, such as:

If you want to analyze responses to open-ended questions in combination with the●

quantitative socio-demographic information that you acquired for each of those who
filled out the survey. Usually, you will already have this quantitative data in a matrix
of some sort, and re-entering that information into MAXQDA would just cause you
unnecessary work.
If you did statistical analysis on material that you exported from MAXQDA and now●

want to reimport the results of your statistical analysis into MAXQDA. You could, for
example, have done a cluster analysis for 40 interviews and now want to import the
cluster assignments from each individual interview.

Importing document variables from Excel

MAXQDA can import data from XLS/X files. The data must be organized as follows:

Document group Document name Variable 1 ... Variable N

Group 1 Text 1
Variable value for
Text 1

 
Variable value for
Text 1

Group 1 Picture 1
Variable value for
Picture 1

 
Variable value for
Picture 1

The first two column headers serve as markers for assigning variable values to the
documents and are required for successful import. Every row must have an entry for
the document group and document name columns. Only if these exact group and
document names are found in the “Document System” of the MAXQDA project, will
the variables and variable values be imported. You can then include as many different
variable columns as you wish.

Please note: The variable values for documents that do not belong to a document
group can also be imported. In order to do so, the appropriate cell in the “Document
Group” column must be left empty.

After preparing and saving the document, you can start the import procedure by
going to Variables > Import Document Variables. Alternatively, you can click on the
Import data (document variables)  symbol in the “List of document variables.”
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Icon for importing document variables

A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.

MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are●

created.
Variables that already existed will be updated with the new values in the import file.●

Empty values (“system missings”) for variable types integer and decimal will be●

imported as -999.

Tip: An easy way to set up an Excel file for importing new values is to first export the
variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the
variable list. An Excel file with all of the current variables will open up, and you can
then add new columns for new variables and update variable values that you want
changed. All you have to do after that is save the Excel file and import it into
MAXQDA.

Importing document variables from SPSS

You can also import a data matrix for the document variables from a SPSS data file
(extension SAV). For the import MAXQDA needs to match the cases oft he SPSS data
file with the document names in the opened MAXQDA project. Therefor it is
necessary, that the data file contains a variable (a column) for the document group as
well as a variable for the document name.

Please start the import procedure by going to Variables > Import Document1.
Variables. Alternatively, you can click on the Import data (document
variables) symbol in the List of Document Variables.
Then choose a SPSS data file in the appearing file dialog.2.
A new dialog will appear, that allows you to set several options:3.
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Options for importing a SPSS data file

In the upper part you can select which variables (= columns) contain the information
about the document group and the document name to match the cases with the
appropiate document name. MAXQDA will choose the first two columns of the SPSS
data file, if the data file doesn’t contain variables that are labelled with “DocGroup”
and “DocName.” You will find the variable labels in brackets behind the variable
names for better navigation in the list of variables.

Furthermore, you can switch on two additional options:

Import variable label instead of variable name – If you choose this option, MAXQDA
won’t import the variable names, but their labels, which are usually longer and easier
to read and to understand. You should use this option, if you want to import a SPSS
data file that has been created by exporting the document variables from MAXQDA.
Then it will be easy to update a variable which values have been changed in SPSS.
Please note that the length of variable names in MAXQDA is limited to 63 characters,
so a longer name may be truncated.

Import value labels instead of values – usually, standardized answers will be
represented in SPSS by numbers, e.g. a 1 may be used for “female” and a 2 for
“male”. If you see these numbers only in MAXQDA without knowing what a “1” and
“2” means, it won’t be very useful, so this option should only be deactivated if you are
sure you want to import the values instead.

A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.

MAXQDA does the following during the import:
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All variables in the import file that did not yet exist in the MAXQDA project are●

created.
Variables that already existed will be updated with the new values in the import file.●

If you have defined missing values in SPSS only the first missing value (defined in●

section “Discrete missing values” in the SPSS dialog) will be imported (only for
variable types integer and floating).
System variables won’t be changed.●

If the import file contains identical document names in the same document group,●

the last case will overwrite the previous ones.
Empty values (“system missings”) for variable types integer and decimal will be●

imported as -999.

Importing code variables from Excel

MAXQDA can import data from XLS/X files. The data must be organized as follows:

Code Variable 1 ... Variable N
Parent code 1Code 1 Variable value for code 1  Variable value for code 1
Parent code 1 Code 2 Variable value for code 2  Variable value for subcode 2

The first column heading is the unambiguous assignment of variable values to a code,
so this column and its heading are mandatory. Each line must designate a code in the
corresponding column. For subcodes, the entire path must be specified in the code
system, in which the codes are separated by a backslash.

Tip: To insert a backslash “” on a Mac, use the keyboard command option+⇧+7.

Only when a code, which matches this information exactly, is found in the “Code
System” will the variable be imported. You can add as many variables as required in
the subsequent columns.

After preparing and saving the import data, you can then start the import procedure
by going to Variables > Import Code Variables. Alternatively, you can click on the 
Import data (code variables) button in the List of Code Variables.

A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.

MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are●

created.
Variables that already existed will be updated with the new values in the import file.●
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Tip: An easy way to set up an Excel file for importing new values is to first export the
variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the
variable list. An Excel file with all of the current variables will open up, and you can
then add new columns for new variables and update variable values that you want
changed. All you have to do after that is save the Excel file and import it into
MAXQDA.

Exporting Data to Excel and SPSS
MAXQDA provides basic functions for the statistical analysis of variables, and makes it
possible to create frequency tables and diagrams for individual variable values. For
further analysis, such as cluster or factor analysis, it is necessary to export the data
table of document or code variables in order to perform the statistical analysis in the
appropriate program.

To export the variables:

Click on the  Export button in the toolbar of the Data Editor or select Variables >1.
Export Document Variables or Export Code Variables.
Give the exported file a name. You can also select exactly where you want to save2.
the file.
For the file format, you can choose between:3.

Excel (XLS/X)a.
SPSS Data File (SAV), which is only available for the document variables andb.
works fine in most statistics programs,
SPSS Syntax File (SPS), which is only available for the document variables,c.
Text (TXT, tab delimited)d.
Rich Text Format (RTF)e.
Website (HTML).f.

Select OK.4.

Exported data matrix in Excel

Tip: The variable matrix can also be transferred via the clipboard. You can either select
the entire matrix using the keyboard shortcut Ctrl+A (Windows) or cmd+A (Mac), or
select individual rows by clicking on them while holding down the Ctrl (Windows) or
cmd (Mac) button. Use the keyboard shortcut Ctrl+C (Windows) or cmd+C (Mac) to
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copy the selected data onto the clipboard.

Displaying Document Variables for
Documents and Coded Segments
Displaying Document Variables as Background Information for Documents

Often there is a desire to quickly find background information to a document in the
"Document System", such as the age of an interviewee or whether he or she is a
member of a non-governmental organization (NGO). For this purpose, you can select
document variables whose respective values are displayed as quick info at the mouse
pointer in the "Document System":

Open the local settings in the "Document System" window by clicking on the gear1.
in the toolbar of the window.

Local settings in the Document System

Then check the Display variable values in tooltip option and click Select Variables.2.
The following selection window appears:
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Window for choosing document variables

If you now move the mouse over a document in the "Document System", the values
of the selected variables appear in the quick info text. The following figure shows that
the interviewee "Theresa" is older than 25.

Quick info display of variable value in a document

Displaying Document Variables as Background Information for Coded
Segments

Some background information about the case is not only useful for the documents.
This can also be very helpful for coded segments, since these are often viewed
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separately from their document and it could be difficult to identify the relevant
document and compile the relevant background information when looking through a
combination of coded segments. Therefore MAXQDA offers numerous possibilities to
display the variable values of coded segments from the original documents of the
segments.

As it is rarely helpful for the analysis to see all variable values of a document, it is first
necessary to select some document variables:

Open Variables > List of Document Variables.1.
Activate the check mark in the Favorite variable column with a mouse click to select2.
the document variable for display.

Select document variable as favorite variable

Display in the "Retrieved Segments".

After you have marked document variables as favorites, you can output these selected
variable details in the "Retrieved Segments". To do this, make sure that the Display
favorite variables option is selected in the window toolbar. The selected variable
information then appears directly below each document name as shown in the
following figure (when sorting the segments by document):

Display favorite variable in the Retrieved Segments window

Display in the "Overview of Coded Segments"

In the "Overview of retrieved segments", you can display the favorite variables as
separate columns, so that you can view the variable values of the corresponding
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document for each segment. To do this, click on the Display favorite variables icon in
the toolbar of the "Overview of retrieved segments".

Display variable information on export

If you export the "Retrieved Segments", you can also export the associated variable
values of the document for each segment. For more information, see Print and Export
Retrieved Segments.

https://m22.maxqda.com/help-mx20/segment-retrieval/print-export-retrieved-segments
https://m22.maxqda.com/help-mx20/segment-retrieval/print-export-retrieved-segments
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18 - Mixed Methods

General Information about Mixed Methods
in MAXQDA
MAXQDA is one of the pioneers in the field of method integration. Functions for
combining qualitative and quantitative data are already found in the very first versions
of the program in the late 1980s and early 1990s. With the option to manage a data
set of standardized, quantitative data parallel to the texts, the foundation was laid.
Since version 10 there is a further tool in the form of code variables, which allows the
definition of variables below the case level of a document and since version 12.2 there
is a fully integrated statistics package "Stats" for carrying out descriptive and
inferential statistical calculations, the results of which can be used directly for the
integrative analysis of qualitative data.

In the Mixed Methods Tab, functions are available which either link documents and
variables, e.g. the topics from qualitative interview material with the variables from
standardized interviews, or which carry out quantitative evaluations based on the
coding carried out. The first are so-called joint displays in which both qualitative and
quantitative data, results or conclusions are presented together. Guetterman, Creswell
and Kuckartz (2015) present various mixed method designs and suitable joint displays
in an overview article. MAXQDA offers several joint displays suitable for common
mixed method designs. These designs include in particular

Convergent Designs (qual. and quan. study parallel)●

Explanatory Designs (qual. study after quan.)●

Exploratory Designs (qual. study before quan.)●

The Mixed Methods Tab

Overview of Mixed Methods Functions

Activate Documents by Variables – lets you activate documents to be included in the●

Coding Query based on document variable values. You could, for example, use this
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function to identify what men between the ages of 40 and 50 said about migration
issues.>
Interactive Quote Matrix – creates a Word file showing what different groups said●

about a theme based on certain variable values that you specify. Each group’s coded
segments for the specified codes are in a different column. You could, for example,
choose to see how those with various levels of education differ on their approach to
combating homelessness.
Crosstab – works parallel to the Code Matrix Browser, except that this function●

doesn’t work on the document level. Instead, you can create groups based on your
variable values and compare how often each of these groups talks about each
theme. You could, for example, compare how often men talk about relationships in
your life satisfaction interviews in comparison to women.
Quantitizing – This is the transformation of qualitative coding information into●

quantitative variables. Quantitizing allows you to store the code frequencies as
document variables, such that for each document you have information about how
often a code appears in that document. This information can then be analyzed
statistically or used for the selection of cases.
Typology Table – shows an overview of variable values for qualitative typologies that●

you have created (e.g. for people with various views on combating their own
homelessness). You could see, for example, what the mean age, gender breakdown,
and average time already homeless is for the “apathetic pessimists” in comparison to
the “proactive optimists.”
Similarity Analysis for Documents – selected documents are analyzed on the basis of●

existing coded segments and document variables for their similarity, and the results
are presented in a similarity or distance matrix.
Side-by-side Display of Results – This joint display compares the results of a●

qualitative study with those of a quantitative study.
QUAL Themes by QUAN Groups – This joint display is used to compile coded●

segments or summaries in a table for groups formed on the basis of variable values.
Statistics by QUAL Groups – The result of this function corresponds to the typology●

table and divides documents into groups according to codes assigned to them. This
joint display allows you to compare average values, standard deviations and absolute
and relative frequencies of selected variables for these groups.

In the “Code System” window there are functions available, that allow you to use the
code frequencies for each document as document variables:

Transform code into document variable or categorical document variable – Codes●

can be added as document variables that specify how often the code occurs in the
document ("Quantitizing" as described above) or which subcode occurs most
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frequently in a document. The latter is particularly useful for evaluative qualitative
content analyses.

Activation by Document Variable
The selection of documents for the analysis, such as searches for coded segments, can
be done easily by hand: You can activate all the documents of the project, the
documents of a particular document group, or even a single document. But more
complex selective coding searches are difficult to do by hand.

For this reason there are also automatic activation options. With the Activate by
Document Variables function, you can choose to activate documents based on the
variable values that have been assigned to them. If you have defined variables for
gender, age, and education level, for example, you could choose to select only those
documents that represent women over the age of 40 that have at least a high school
education. These activations can be made by entering the appropriate formulas. The
formula syntax in MAXQDA is similar to that of statistics programs like SPSS.

The Activate by Document Variables function always processes the entire project. You
can access the function by

selecting Activate Documents by Variables in the Mixed Methods tab or,●

by right-clicking on the Documents icon in the “Document System” and choosing●

Activate Documents by Variables from the context menu that appears, or
clicking the icon with the same name in the "Document System"●

Accessing the function from the context menu or the icon in the “Document System”

After clicking on the appropriate button, a dialog window will appear where you can
enter the formulas for activation. In the example mentioned above, we would want to
activate only document with women over the age of 40 with a high school education.
The dialog window is made up of the following sections:
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A section for the logical formulas and the buttons to create a new formula, delete●

the currently selected formula, or delete all formulas.
Checkboxes for selecting operators.●

Icons for opening or saving formulas.●

Dialog field for activation by variable

All logical conditions must have the following components:

variable name / operator / value

If you have created a variable called “Education” and defined the education levels as
"low", "intermediate" and "high", we would use the following formula in order to
activate those documents that are interviews with participants with a rather low
educational level:

Education = low

To create such an condition in MAXQDA, proceed as follows:

Double-click on the variable "Education" from the list of variables on the left side of1.
the window. You will see the following text in the condition window:
Education = <empty>
The only thing that is missing at this point is the variable value. On the right side of2.
the screen you will see a field where you can enter the value. Here you could enter
“low,” or simply click on the arrow to open the drop-down menu and select a
value from the list of all the values that have been entered for a document up to
that point. In our example above, "low", "intermediate" and "high" would be in
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the menu. Using this menu helps you to avoid any typos.
For numeric variables, MAXQDA inserts the value 0 in each newly inserted
condition. For Boolean variables, you can use "0" for "false" and "1" for "true".
Since the “=” operator is used most often, it is automatically selected when you3.
start a new formula. If you want to use a different logical operator, simply choose it
from the right side of the window and MAXQDA automatically replaces the "="
operator.

The operators have the following meanings:

= (equal to) Selects variable values that are the same as the formula value.

< (smaller than) Selects variables values that are smaller than the formula value.

≤ (smaller or equal to) Selects variables values that are smaller or eqaul to the formula
value.

> (larger than) Selects variable values that are larger than the formula value.

≥ (larger or equal to) Selects variable values that are larger or equal to the formula
value.

≠ (unequal) Selects variable values that are not the same as the formula value.

⊃ (contains) This operator is only offered for text variables. Selects variable values that
contain the formula value within their text.

Tip: It is possible to specify the condition that a non-numerical variable value should be
<empty>. Then all documents to which no variable value was assigned will be
selected.

Results of activations by document variables

Once you have entered the correct logical formulas, you can start the automatic
activation. Click on the Activate button.

MAXQDA then checks the variable values assigned to each document to check
whether it matches the formulated criteria. The documents that matched the criteria
are now activated (marked red) in the “Document System.”

Tip: The status bar at the bottom of the MAXQDA window shows you how many
documents have been activated.

If you want to activate documents frequently based on the same criteria, it is
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recommended that you save the activation model as a document set. To do so, select
the option New set from the dialog window. MAXQDA will then create a document
set containing the activated documents. This new document set can be activated at
any time in the Document System, without having to call up the function for
automatic activation via document variables.

Complex Logical Formulas

It is also possible to combine various logical formulas. The basic units of these
combinations are still the formulas in their basic form:

variable name / operator / value

Combining formulas just means that you are connecting two of these basic formulas
with an operator.

In the above example, we used the condition "Education=low" to activate all
documents of participants with a rather low level of education.

If you want to further limit the results, so that you only see what participants over 30
years with a low level of education had to say, you need to define a second condition,
namely "Age > 30". In addition, you need to combine these conditions by a logical
AND. The second condition, would be created just like the first condition:

Double-click on the variable Age from the list of variables. The new condition will4.
look like this: [Age] = <empty>
Type in "30" for the value and choose the operator >(larger than).5.
MAXQDA automatically inserts the OR operator. To use the AND operator instead,6.
select the appropriate option in the right-hand pane. According to the schema, any
number of other logical combinations can be added. Click the Activate button to
begin.

In this way, you can add as many combinations of logical formulas as you want. You
can then click Activate to start the activations.

The combination operators OR and AND have the following affect on the results of
your activation process: If you choose the OR option, MAXQDA looks for documents
that meet at least one of the various formulas’ criteria. If you entered the formulas
“Education = low” OR “Age > 30,” you will get all the documents of participants with
a low level od education as well as participants older than 30 years. For our example,
then, the OR option would not be appropriate. We want both formulas to be met, so
we would need to use the AND operator, so that it looks as follows:



18 - Mixed Methods   532

A complex logical formula (AND-combination)

Deleting formulas

It is possible to go back and delete a formula at any time:

Click on the row you wish to delete.●

Click on the  Delete button.●

Changing and saving formulas

After starting the automatic activation process, the dialog window is no longer seen.
The formulas, however, will still be in that window the next time you open it.

You can change the logical formulas (operators and values) at any time:

Click on the Formula in the dialog window, and select another operator.●

If you want to change the value, simply enter the new value or select it from the●

drop-down menu.

After you have changed the formula, click on the Activate button to restart the
activation.

You can also save a formula, so that you can have quick access to it at a later time.
Just click on the Save  symbol at the bottom of the dialog window. You can then
give it a name and choose where you want to save it.

Files for saved logical formulas are saved by MAXQDA as .LOA (logical activation) files.
To open a saved formula, choose Open and navigate to the place you saved the .LOA
file. It makes sense to set up a folder for all of your LOA files, so they are easy to find.

Using code variables for Activation by code variables

It is not only possible to activate documents based on their document variables; you
can also activate codes based on their assigned code variables. The Activate by Code
Variable function can be accessed by right-clicking on the top level entry (Code
System) in the "Code System" and choosing the Activate Codes via Variables option in
the context menu.
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Activate by Code Variables function in the “Code System” context menu

Crosstab
The Crosstab function has some similarities to the Code Matrix Browser, except that
documents are analyzed grouped by document variable. Social groups, such as men
and women, or people with different personal background, etc. can be compared
based on variable values. All of the variables that are in your project can be used to set
up a group.

Crosstab is a visualization of the relationship between document variables and codes.
The following example displays the number of times each code occurred in interviews
in rural and interviews in urban areas.

Crosstab example based on regions

Creating a Crosstab

1. Choosing your codes

As usual in MAXQDA, the selection of codes is done via activation. The selection
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should be completed before using the Crosstabs function, otherwise all codes will be
displayed in the Crosstab.

Tip: You can open the crosstab function by right-clicking on a code from the context
menu. In this case, only that specific code is shown in the cross table.

2. Define columns

The definition of the columns is done by defining appropriate variable conditions
(formulas) in the dialog window, which is similar to the Activate by Document
Variables dialog window.

To do this, open the Crosstab function in the Mixed Methods tab.

After activating codes and selecting Crosstab, you will have the option to create logical
conditions that will be used to assign documents to each column. The window is
broken up into the following sections:

A list of all the document variables in the project.●

A section for the definition of logical conditions (formulas).●

Buttons for selecting operators and values.●

Buttons for opening and saving logical conditions (formulas).●

The Crosstab dialog window

If you have created a variable called “Region” and used the value “urban” for urban
regions and “rural” for rual regions, we would use the following formula in order to
create a crosstab that compares the code frequencies for the two types of regions:
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Select the option Insert all variable values as conditions.1.
Double-click the desired variable "Region" in the left pane of the window.2.

MAXQDA then lists the formulas for all variable values in the middle pane of the
window. In the example, it would look as follows:

[Region] = urban

[Region] = rural

The Crosstabs created in this way would look as follows:

Crosstabs comparing the number of coded segments for each code by region

Tips for defining columns

If there are many different possible values for a certain variable, you can choose to
delete those that you don’t want to include in the visualization. If, for example, you
had a variable “level of organization” with possible values “very high,” “high,”
“medium,” “low,” and “very low,” you might only want to compare the two
extremes. To do so, click on the element you wish to remove from the list in the
Formula row and click the Delete  symbol.

You can also compare groupings based only on specific variable values by not
checking the box to Insert all variable values as conditions. Instead, you would simply
create a formula and add single values by following these steps:

1. Double-click on the desired variable in the list of variables to set it as a condition
(formula).

2. Insert the appropriate variable value in the field on the right side of the window or
choose it from the drop-down list. The drop-down list will have all the values that
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were assigned to the chosen variable. Choosing the value from the list helps you avoid
any typos that would cause you to get false results.

3. Repeat the first three steps to set up each column of the Crosstabs.

When you click OK, the table will be displayed.

You can also save formulas, so that you can have quick access to them at a later time
and don’t have to reenter them one by one. Just click on the Save button at the
bottom of the dialog window. You can then give it a name and choose where you
want to save it.

Files for saved formulas are saved by MAXQDA as .LOA files. To open a saved set of
formulas, choose Open and navigate to the place you saved the .LOA file.

Functions in the toolbar

The Crosstab function can be accessed from the Mixed methods tab or from the
context menu of a code.

The Crosstab toolbar at the top of the window offers the following in addition to the
usual export functions:

Interactive Quote Matrix – Displays the coded segments from the table in an
interactive window.

Code Hierarchy – Displays code system with or without code hierarchy.

Number of segments – Displays absolute frequencies, meaning the number of
segments of the respective codes for the variable form of the respective column.

Row percentage – The percentage share of the cell calculated across the row
(horizontal percentage calculation).

Column percentage based on the sum of coded segments (row “SUM”) – The
percentage share of the cell calculated across the column (vertical percentage
calculation).

Column percentages based on the number of documents “N (documents)” – The
column percentage in terms of the number of documents in the column (the option
Count hits per document only once will be selected automatically).

Count hits per document only once – The unit of analysis is set to Document. Each
document is analyzed based only on whether the code has been assigned or not; the
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frequency with which a code occurs within a document is not taken into account.

Sum – displays the sum of rows and columns.

Highlight highest values – for better interpretation of the results higher values are
highlightes in green.

Refresh – recalculates the values in the table.

Interactive connection to source files

The cells in the crosstab are interactively linked to the data material in your project.

Double-click on a cell to list its segments in the "Retrieved Segments" window. This●

action automatically activates both the documents and codes connected with the
cell.
Right-click on a cell and choose Activate Documents from the context menu. This●

activates the connected documents without changing your current code activation
selection.

Crosstab suitability

Crosstabs are well suited for the analysis of sub-categories and their distribution in
sub-groups of the sample. Imagine you have asked how students prepare for
examinations, and the different options (e.g. reading books, working together with
colleagues, etc.) are defined as codes. With the Crosstab function, you can compare
various groups with each other. Are female students participating more in training
groups? Do male students read more text? The options to view the values as row or
column percentages make the interpretation of the data even easier.

Quote Matrix
The “Quote Matrix“ is based on the same idea as the Crosstabs function, i.e. to create
a joint display of themes and quantitative variables. The Quote Matrix does this on a
more detailed, non-aggregated level. Here the coded segments themselves are listed in
the cells of the matrix, not only the number of coded segments for that particular cell.
In the example below, we can see a comparison about what married and single people
said about certain themes.

Code Family status = married Family status = single
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emotions Happiness does not remind me of
one event. It makes me think of my
life.  Even though there are bad
times, overall I am very happy with
the way I turned out as a human
being and I like were my life is
headed.
New York/Joanna: 34 - 35 (100)

Sadness reminds me of the death of
my grandmother (Dec. 90') and my
grandfather (June 96'). Their deaths
effected my life greatly.They were
like my second parents.
New York/GINA: 12 - 12 (100)

I feel as if I am very healthy and I
know that I have a firm background
on what being healthy means because
of my interest in Nutrition and
Exercise. I always to try to eat better
and make the right choices and
exercise on a regular basis.
New York/Milly: 11 - 11 (100) 

educationMy career now is college. I am
graduating this weekend from my
Community Health Undergraduate
program at Hofstra University. I am
continuing my undergraduate studies
at CW Post in the fall to get a BS in
nutrition. Getting my RD is my major
career choice.
New York/GINA: 17 - 17 (100)

I would like to improve my
dedication to working out. I am the
type of person who will work out 5
times a week for a month straight
and then is slowly turns into less days
a week until it is none. I get
distracted by school work, my job or
just being tired.
New York/Silvia: 42 - 42 (100)

My major is Dietetics and I am
planning on working with children at
either a center or a Children's Hospital
and do meal plan counseling for
children that need special diets
because of sickness, or whatever the
case may be.I know that will not be
happy in my occupation unless I work
with children.
New York/Vincent: 12 - 12 (100) 

MAXQDA creates a table that shows the same coded segments that would be
numerically listed in the Crosstab, but here they are displayed as text. In theory, it
would be possible for you to create a Quote Matrix on your own by doing retrievals in
MAXQDA for each group and copying them from the “Retrieved Segments” window
into a table in Word, but the resulting table would contain only the segments
themselves and no source data.To create a Quote Matrix, proceed as follows:

First, activate the codes you wish to include in the Quote Matrix.1.
From the Mixed Methods menu tab select Quote Matrix. The following dialog2.
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window will open, in which you can define the columns of the matrix:

Defining columns for the Quote Matrix

You can find a detailed description on how to select variables for matrix columns in
the Crosstabs chapter.

When you click OK, a dialog window will open in which you can create a file name
and select the location where the Quote Matrix will be saved. The matrix can be saved
as an Excel, HTML or RTF file. For a matrix with many columns, Excel format is
recommended, for a matrix with few columns, RTF format is recommended. The file
will open automatically upon export.

Tip: You can also generate a Quote Matrix directly from the Code Matrix Browser or
Code Relations Browser or Crosstab by clicking the Quote Matrix symbol.

Quote Matrix with Comments

You may have added a comment to one or multiple coded segments. These comments
can be displayed in the Quote Matrix in addition to or as an alternative to the coded
segments. This is especially interesting if the comments contain a short summary of
the coded segments or important notes about them.

To display the comments instead of the coded segmente, go to the Mixed Methods
menu tab and click on the word Quote Matrix below the Quote Matrix symbol to open
up a drop down menu. Here you can click on Quote Matrix with Comments or Quote
Matrix with Coded Segments and Comments.

https://m22.maxqda.com/help-mx20/mixed-methods-functions/crosstab
https://m22.maxqda.com/help-mx20/05-coding/creating-comments-for-coded-segments
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Interactive Quote Matrix
The Interactive Quote Matrix displays the same content as the regular Quote Matrix,
except that the data is not exported but displayed directly in MAXQDA in an
interactive window. The Interactive Quote Matrix is therefore usually preferable to the
regular Quote Matrix.

Follow these steps to open an Interactive Quote Matrix:

Activate the documents and codes you wish to include in the matrix. If none are1.
activated, all documents and codes will be included.
Open the function via Mixed Methods > Interactive Quote Matrix.2.
Use variable conditions to determine which documents are to be displayed in the3.
columns (a separate column is created for each variable condition). You can find a
detailed introduction to deinfing columns in the section on Crosstabs.
If necessary selected the options Only for activated documents and/or Only for4.
activated codes.
Click OK – MAXQDA will open a new window with the interactive display:5.

Interactive Quote Matrix

https://m22.maxqda.com/help-mx20/mixed-methods-functions/quote-matrix
https://m22.maxqda.com/help-mx20/mixed-methods-functions/crosstab
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The first column displays a list with the codes you selected. MAXQDA automatically
adds the parent codes of the activated codes in order to retain the code system's
hierarchical structure.

Tip: If you selected the option Only for activated codes, you can change this later in
your “Code System” to adjust the selection of displayed codes in the interactive quote
matrix.

The other columns are the results of your selected variable conditions: for each defined
condition, a column is displayed. These columns contain the coded segments of the
documents which meet the respective variable condition. The number of documents
per column is indicated in the column headings.

Click on a code in the code tree to list its coded segments in the columns. The column
headers indicates how many coded segments are displayed in the column.

Tip: The Interactive Quote Matrix function can also be opened directly from the Code
Matrix Browser or from a Crosstab. When working with the Code Matrix Browser or a
Crosstab, click the first icon on the very left. The Interactive Quote Matrix can also be
opened by selecting: Analysis > Compare groups > Qualitative.

Toolbar

Along the top edge you will see a symbol toolbar with the following functions:

Display codes with hierarchy – if this option is activated, the codes are displayed in
a hierarchical tree structure. The non-activated parent codes may be displayed to
retain its hierarchical structure. When the option is deactivated, the codes are
displayed in a linear list. Should you have selected the option "Only activated codes"
when creating the matrix, only the activated codes will be displayed.

Display origin – shows the source documents, locations within documents and the
code weights in brackets below the coded segments. Clicking on the displayed source
document imports the corresponding document into the document browser and
highlights the coded segment.

Display comments for coded segments – displays all the comments on coded
segments (if any).

Display memos – displays below the coded segments the titles of memos that are
present at the level of the coded segments. Clicking on the displayed memo title
opens that memo.
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 Standardize font – with this setting, you can standardize the text font, size, and
line spacing to create a consistent display of your text segments. Font styles such as
bold and italics are not affected by this setting.

 Zoom out – minimizes the display of the segments in the columns.

 Zoom in – magnifies the display of the segments in the columns.

x of y columns – adjusts how many columns (x) of the total columns (y) are visible.

Refresh – reopens the options window for the Interactive Quote Matrix, which lets
you customize the columns and included documents and codes.

Exporting the Interactive Quote Matrix

The Quote Matrix can be exported using the usual icons at the top right of the
window. The segments of all displayed codes are always exported. If you limited the
quote matrix to activated codes, only these activated codes are exported.

Open as Word document  – Creates a temporary document in DOC / X format
which is opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

Open as Excel spreadsheet – Creates a temporary spreadsheet in XLS / X format
which is opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

Export – MAXQDA creates a table as an Excel file (XLS / X format), as a web page
(HTML format) or as a text document (RTF format) after you have entered a filename
and location. The exported file is opened immediately.

Typology Table
This function offers yet another way to combine quantitative data and your codes or
categorical variables. It is called a Typology Table, because it is able to calculate various
variables and their percentages (means, standard deviations, etc.) for qualitative
typologies.

The table is set up similarly to the following example from Creswell and Plano’s book
“Designing and Conducting Mixed Methods Research” (2011: 292):
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Example of a Typology Table

This table shows a comparison between two types of patients, “Depressed” patients
(27 persons) and “Not Depressed” patients (21 persons). The last column p-Value
shows the statistic significance of the mathematical means. The first row "Age" shows
the average age of both groups and the standard deviation in brackets.

The row “Women” contains the number of women and their percentage. This means
that of the 27 depressed persons 21 are women, which is exactly 79% .

As we can see, the rows consist of variables, metric variables to be exact, and specific
values of categorical variables – either text or numerical variables. The columns follow
the pattern of Crosstabs, meaning the values of any categorical variables can be
selected.

Example of a Typology Table

To create a Typology Table, proceed as follows:

Select  Typology table from the Mixed Methods menu tab.1.
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For categorical variables, all respective variable values are listed in the dialog2.
window. For non-categorical (metric) variables, the variables themselves are listed.
For easy differentiation, non-categorical variables appear in red. Check the variable
values and variables you would like to include in the Typology table and to compare
between groups.
Select the Exclude missing values option when the missing values of non-categorical3.
variables should be ignored. This will usually be the case.
When you click Continue a second dialog window will appear in which you can4.
define the columns of the Typology table, and where you can specify the elements
that should be compared with one another.
Create a variable condition (formula) for each desired column, for example5.
“Depressive = Yes” and “Depressive = No”. The quickest way to do so is by
double-clicking the variable in the variable column. When you click OK, MAXQDA
will display the Typology table.

The Typology Table toolbar

At the top of the Typology Table you will find a toolbar that – besides the usual export
options – offers the following fucntions:

  Highlight lowest value per row – for better interpretation of the results the value
highest in row is highlighted in red.

  Highlight highest value per row – for better interpretation of the results the value
lowest in row is highlighted in green.

  Refresh – updates display via recalling the function.

Interactive connection to source data

The typology table is linked to the data in your MAXQDA project interactively:

Double click on a cell, that shows the number of documents (and no mean value), to●

activate these documents in the "Document System".
Double click on a cell of of the first column, where the cell shows a variable value, to●

activate all documents that fit the clicked variable criteria.

Side-by-side Display of Results
Definition: The purpose of the side-by-side display is to array quantitative and
qualitative data of a Mixed Methods project together.
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Side-by-side displays are used to display the results of a qualitative and a quantitative
study together by sorted themes. The display is structured like this:

 Qualitative Results
(Document A)

Quantitative Results
(Document B)

Theme 1
(Code 1)

Coded segments / Summaries Coded segments / Summaries

Theme 2
(Code 2)

Coded segments / Summaries Coded segments / Summaries

Theme 3
(Code 3)

Coded segments / Summaries Coded segments / Summaries

The side-by-side display has two columns. Each column displays coded segments or
summaries for each of the two studies. The rows of the table are made up of themes,
in this case your codes.

This joint display is especially suitable for convergent designs, where a qualitative and a
quantitative study are conducted independently or for the final integration of an
explanatory or exploratory design.

Creating a new side-by-side display

Navigate to the Mixed Methods menu tab and click the Side-by-Side Display entry.
From the dropdown select to create a new display for either Coded segments or
Summaries. MAXQDA will open the following dialog:

Creating a side-by-side display
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Drag and drop a document from the “Document System” into each of the fields for1.
“Qualitative study” and “Quantitative study” with your mouse. Drag another
document into a field to replace a document you already selected.
Drag and drop any number of codes from the “Code System” into the “Themes”2.
box on the left. Codes can be rearranged with the mouse. Codes can be removed
from the “Themes” box by dragging the code out of the box or selecting the code
and pressing Del key (Windows) or cmd-Backspace (Mac).
Check the box next to Include comments of coded segments to include comments.3.
If a comment exists, it will be displayed below the coded segment in the final
display. This option is not available for side-by-side displays created for summaries.
After clicking OK, a dialog window will appear where you enter a file name and4.
select the location on your computer to save the display to.

MAXQDA generates an Interactive Quote Matrix with two columns for a side-by-side
display with coded segments, so that you can explore this display interactively. You
can find further information on how to work with this results window in the following
section of the manual: Interactive Quote Matrix.

For a side-by-side display with summaries MAXQDA creates a text file in RTF format
and opens it in word processing programs such as Word.

Similarity Analysis for Documents
The Similarity Analysis for documents can be used to check the similarity or
dissimilarity of various documents in terms of code frequency. The values of document
variables can also be included.

Starting the Similarity Analysis

Activate all documents you would like to include in the Similarity Analysis.1.
It is also helpful to activate all codes you wish to use for determining similarity.2.
From the Mixed Methods menu tab, click  Similarity Analysis for Documents. A3.
window will appear that contains all previously created similarity and distance
matrices.
Click on the  New Similarity/Distance matrix symbol to begin the similarity4.
analysis.

Setting the parameters for the analysis

A dialog window will appear in which you can select the codes and variables and
specify the type of analysis.

https://m22.maxqda.com/help-mx20/mixed-methods-functions/interactive-quote-matrix
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Setting options for the analysis

In the upper section, you can add the codes you wish to include in the analysis. You
can add all activated codes directly via the Paste activated codes button.

Next, select the type of analysis:

Existence of code – Generates a similarity matrix that considers only whether the
selected codes occur in the document or not.

Code frequency – Generates a distance matrix that takes the distance of individual
codes into consideration.

Similarity measures with the option “Existence of Code”

To calculate similarity, various options are available. All of the calculations are based
on a four-field table of the following type that is generated for each paired
combination of documents (in the background):

 Document A
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Code/Variable value
exists

Code/Variable value
does not exist

Document
B

Code/Variable value
exists a b

Code/Variable value
does not exist c d

a = Number of codes or variable values that are identical in both documents.

d = Number of codes or variable values that do not exist in both documents.

b and c = Number of codes or variable values that exist in only one document.

The calculation options differ in, among other things, the extent to which field "d", or
non-existence in both documents, is considered a match.

Simple match = (a + d) / (a + b + c + d) – Both existence and non-existence are
counted as a match. The result is the percentage match.

Jaccard = a / (a + b + c) – Non-existence is completely ignored.

Kuckartz & Rädikers zeta = (2a + d) / (2a + b + c + d) – Existence is counted twice,
non-existence once.

Russel & Rao = a / (a + b + c + d) – Only existence is considered a match, but non-
existence reduces the similarity.

Please note: If you include more than one code into the analysis that does not exist in
multiple documents, it may be better to use a coefficient who ignores non-existing
codes (Jaccard) or values them less (Kuckartz & Rädiker zeta, Russel & Rao). Otherwise
you may receive a high similarity score, even if the codes are not assigned very
differently. The non-existing codes will dominate the existing codes in this case.

Distance measures with the option “Code Frequency”

To calculate the distance between two documents based on “Code frequency”, the
following options are available in which the code frequencies of two documents will
be compared:

Squared euclidean distance = The sum of squared deviations (higher deviations will be
rated higher as lower ones because of squaring the deviations).

Block distance = The sum of absolute deviations.
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Please note: Since it is also possible to include variable values in the analysis, all code
frequencies and variable values are z- standardized previously beforehand.

Including variables

If you want to include variables in addition to codes in the similarity analysis, click the
Integrate variables button. If you selected “Existence of code” as the type of analysis,
you can then select which variable values MAXQDA should evaluate in the dialog
window. If the selected variable value exists in both documents, this is evaluated as a
match (type "a"). In the dialog window, only variables of type "text", "true/false",
"Date" as well as categorical integers or floating-point numbers are listed.

Selecting variable values in the “Existence of Code” analysis

If you selected "Code frequency" as the type of analysis, another dialog window will
appear that contains only integer or floating-point variables, that are not marked as
"categorical".
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Selecting variable values in the “Code frequency” analysis

Dealing with missing variable values

You can choose how missing values are handled:

Set missing values to 0 – If a variable value does not exist, it is set to 0 due to the z-
standardization of the average. In this option, the document with the missing value is
taken into account in the analysis.

Ignore documents with missing values – If in a document of one of the variable values
is missing, the entire document will be ignored in the analysis.

The final similarity or distance matrix

The following figure shows a similarity matrix for five interviews. The selected
documents are listed both in the rows and in the columns:
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Similarity matrix for five interviews

The default shadowed color helps to interpret the cells, which in a similarity matrix can
have a value of 0 (no similarity) to 1 (identical): The darker the green, the more similar
the two documents are in terms of the selected code and variable values. In the figure,
for example, you can see that "Sam" completely coincides with "Jamie" both in their
codes and their variable values.

The matrix is sortable: Click on a column header to sort the documents in the rows
according to their similarity to the clicked document.

The Similarity Analysis toolbar

In addition to the usual export options, the following functions can be accessed from
the toolbar:

New similarity/distance matrix – Calls up the dialog window where you can create
a new matrix.

Delete – Deletes the selected matrix.

    Names, columns: none, short, full – Controls column width.

No color highlight – Turns off green highlighting.

Color highlight refers to whole matrix – The highlight color takes into account the
value of the cell. The same values will have the same highlight color in the table.

Color highlight refers to columns – In each column, the colors are graduated from
white to green. In this way, you can see at a glance which documents are particularly
similar to the document in the column. The same values in the matrix may be different
colors.

Color highlight refers to rows – In each row, the colors are graduated from white
to green. In this way, you can see at a glance which documents are particularly similar
to the document in the row. The same values in the matrix may be different colors.

Distance matrices look identical to similarity matrices, however their interpretation is
the reverse: The lower the value in a cell, the more similar the two documents are.

The list of existing similarity and distance matrices

In the left pane of the window you can see the similarity and distance matrices created
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earlier in the project. They can be renamed with a double-click, or deleted by clicking
the Delete icon in the toolbar.

Tip: In order to ensure the transparency of the analysis process, the matrix name and
selected settings will be displayed in the tooltip if you hover over a matrix name.

Qualitative Themes by Quantitative Groups
Definition: This joint display integrates data by arraying the qualitative data (segments
or summaries) as one dimension and the groups formed by the quantitative data as
another dimension.

This joint display is used to compare coded segments or summaries for groups of
documents. Documents are grouped based on variable values. The following table is a
schematic representation of a joint display for the document variable “Occupation”.
Document groups are created based on their occupational status:

 Document variable: Occupation
 unemployed

(N = x documents)
employed
(N = y documents)

self-employed
(N = z documents)

Theme 1
(Code 1)

Coded segments /
Summaries

Coded segments /
Summaries

Coded segments /
Summaries

Theme 2
(Code 2)

Coded segments /
Summaries

Coded segments /
Summaries

Coded segments /
Summaries

Theme 3
(Code 3)

Coded segments /
Summaries

Coded segments /
Summaries

Coded segments /
Summaries

Each column displays coded segments or summaries from those documents with the
corresponding variable value, separated into rows by themes (= codes).

This joint display is especially suitable for explanatory designs, but could also be useful
for convergent (parallel) designs.

Creating a new display

Navigate to the Mixed Methods menu tab and click on the QUAL Themes for QUAN
Groups entry either for Coded segments or Summaries. MAXQDA will open the
following dialog:
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Creating a joint display “Qualitative themes by quantitative groups”

Select which groups to compare by selecting a document variable and up to four1.
variable values from the drop down menus. MAXQDA will include all documents
with the corresponding variable value in the final columns of the display.
You can limit the display to only include currently activated documents by checking2.
the box next to Only for activated documents.
Drag and drop any number of codes from the “Code System” into the “Themes”3.
box on the left. Codes can be rearranged with the mouse. Codes can be removed
from the “Themes” box by dragging the code out of the box or selecting the code
and pressing Del key (Windows) or cmd-Backspace (Mac).
Check the box next to Include comments of coded segments to include comments.4.
If a comment exists, it will be displayed below the coded segment in the final
display. This option is not available for displays created for summaries.
After clicking OK, a dialog window will appear where you enter a file name and5.
select the location on your computer to save the display to.

MAXQDA then exports the side-by-side display in a RTF document which can be read
by Word and opens the document. The result of this display is similar to the result of a
Quote Matrix.

Statistics by Qualitative Groups
Definition: This joint display integrates a qualitative typology as one dimension with
the quantitative data as another dimension.
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This joint display is used to compare types that have been constructed from the
qualitative data by statistical values such as mean, standard deviation, etc. The types
are created based on the existence of codes in each document. The following table is a
schematic representation of this kind of joint display:

 Coded with …
 subcode A subcode B subcode C
Variable 1
(numerical)

Mean (Standard
deviation)

Mean (Standard
deviation)

Mean (Standard
deviation)

Variable 2
(categorical)

Total (%) Total (%) Total (%)

Documents N (%) N (%) N (%)

Each column holds all documents, in which the selected subcode occurs. It is therefore
important that only one of the subcodes is assigned to each document. An example
could be an evaluative qualitative text analysis where the code “self assurance” has
the subcodes “low,” “medium,” and “high”. If one of the subcodes is assigned to
each document, they can now be used to create this joint display.

This joint display is suitable for convergent (parallel), as well as explanatory and
exploratory designs.

Creating a new display

Navigate to the Mixed Methods menu tab and click the Statistics for QUAL Groups
entry. MAXQDA will open the following window:

Creating a joint display “Statistics by qualitative groups“
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Create groups by dragging a code that has subcodes (but no sub-subcodes) from1.
the “Code System” window to the “Groups” field at the top of this window. Select
up to 4 subcodes from the drop down menus below.
You can limit the display to only include currently activated documents by checking2.
the box next to Only for activated documents.
Click the “Choose document variables…” button to call up the variable selection3.
window. Select which variable values to include for categorical variables.

Choose document variables for the Joint Display “Statistics by qualitative groups“

Click OK to include your selection and click OK again to create the joint display.4.

The result of this display is equal to that of a typology table.

Transform a Code into a Document
Variable (Quantitizing)
A code in the “Code System” can be transformed into a document variable, indicating
how often the selected code appears in each document. The document variable is
dynamic. MAXQDA will automatically update the document variable, i.e. increasing
the variable value if a new segment is coded with the code. This feature is particularly
useful as it allows the user to export code frequencies along with variables, or activate
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documents based on certain code frequencies for analysis.

To transform a code into a document variable, right-click the code and select
Transform into a Document Variable.

Transform a code into a document variable

MAXQDA will generate a document variable, with the same name as the code, as a
numeric variable. The program will automatically insert the code frequency of each
document into the appropriate cell of the column. It opens along with the “Data
editor” of the document variable and positions it in the appropriate column. The
content of this variable can't be edited manually. MAXQDA updates the variable
dynamically: If you add or delete an encoding for the transformed code, the variable
value is automatically updated.
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Code ”Friends” converted to a document variable

Hint: To transform multiple codes into document variables at once, activate all of the
codes first, then click the Quantitizing entry in the Mixed Methods menu tab.

You can recognize variables transformed from codes in the "List of Document
Variables" by the green square icon in the first column and the "Code" entry in the
"Source" column.

The transformed code can be binarized by clicking the Convert to boolean variable
icon in the "List of Document Variables". The variable then no longer indicates how
often the corresponding code occurs in the respective document, but whether it
occurs (1) at all in the document or not (0).

Transform code to boolean variable
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Transform a Code into a Categorical
Document Variable
Evaluative categories in (qualitative) content analyses

In many research projects, forms of evaluative qualitative content analysis are used.
The standard steps are to: (1) define evaluative categories, usually with ordinal
variables, (2) code text segments, and (3) analyze the data descriptively and
statistically. A good example of this form of analysis process is found in Philipp
Mayring’s chapter on qualitative content analysis found in “A Companion to
Qualitative Research” (Flick, et al., 2004), which describes scaled variations of structure
content analysis.

In one of Mayring’s detailed examples from a study on student teachers, a category
called “self confidence” is created with three options: “high,” “medium” and “low”
(see below). These categories were developed from the material – one can see from
the following figure that the categories are not only precisely defined, but also
empirically supported with the help of the anchor examples in the material.
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The coding process, which is standard procedure for content analysis, has the
researcher working through the entire data set and assigning evaluative codes to
appropriate text segments that have to do with “self-esteem.” This means that every
single text segment that connects to self-esteem will be assigned the code “high,”
“medium” or “low” on the basis of the coding guidelines established.

At the end, each case (in the case of interviews, a case would be an interviewed
person) can be analyzed as a whole and given a summary characterization as having
“high,” “medium” or “low” self-esteem. Cases characterized as having high self-
esteem can then be compared with those with low self-esteem. Code frequencies can
also be compared and used in combination with other categories in crosstabs.

Principles of application in MAXQDA

The method for evaluative content analysis can be done in MAXQDA in the following
way. First, the category “self-esteem” is created as a code with the subcodes “high,”
“medium” and “low.” The definitions of these codes along with anchor examples can
be created as code memos.
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Now the material will be analyzed, meaning that each document is read line by line.
The text segments that have to do with self-esteem are identified and then coded with
the appropriate code (e.g. “high” self-esteem). After an entire text has been worked
through in this way, the researcher will have one of the following situations:

Text segments about self-esteem in this document were all coded with the same●

subcode (e.g. “medium” self-esteem). In this situation, the entire case can be said to
have a medium level of self-esteem.
Text segments about self-esteem in this document were coded with various●

subcodes, but one of those subcodes obviously occurs more often (e.g. three with
“high” self-esteem and one with “medium” self-esteem). In this situation it makes
sense to give the whole case that level of self-esteem that is coded most often.
Text segments about self-esteem in this document were coded with various●

subcodes, and none of them clearly occur more often than the others (e.g. two with
“medium” self-esteem and two with “high” self-esteem). In this situation, a quick
categorization cannot be made, so the coded segments should be compared to one
another by the coders, who then make a decision about which categorization is
more appropriate.
No text segments were coded with self-esteem subcodes, meaning the document●

does not contain any information about this theme. None of the subcodes can be
used to categorize this document, and will need to be treated as a “missing” value.

The “Transform into a Categorical Variable” function

After coding the appropriate text segments, the “Self-esteem” code can be
transformed into a categorical variable by right-clicking on the code and selecting the
appropriate option in the menu that appears.
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Calling up the “Transform into a categorical doc-variable” function in a code’s context menu

After this option is selected, MAXQDA performs the following actions:

A new categorical variable is created in the List of document variables with the1.
name of the code that it was created from (in this case, “Self-esteem”).
All cases (documents) in the “Document System” are evaluated according to the2.
rules explained above.
a) Each case is assigned the value of the subcode that occurs the most often.
b) If there are two or more subcodes used the same numbers of time, it is labeled
“undefined.”
c) If none of the subcodes are used at all, no value is assigned. If the table is
exported to a statistical software, empty values are usually treated as “missing.”
Immediately afterwards MAXQDA opens the "Data Editor for Document Variables".3.
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Data editor with the new categorical variable “Self-esteem”

Note: If a subcode has further subcodes, then these subcodes and their codings are
not included in the evaluation for the categorical variable. Only the direct subcodes are
taken into account.

Dynamic properties of categorical variables

In MAXQDA‘s List of document variables, the categorical variables have a special
status. One recognizes them in the list, because they have a green square in the first
column and are created from a “Code” as seen in the “Source” column; categorical
variables are defined as text variables, and the texts are taken from the “Code
System” (in this case “high,” “mid” or “low”).

The newly-created categorical variable “Self-esteem” in the List of document variables

Categorical variables are dynamic, which means they are updated automatically when
new segments are coded in the documents. This is also the case for documents that
are imported after the categorical variable has already been created; when one codes
this new document, the variable label changes accordingly.

Tip: If a subcode has further subcodes, they will not be included for the evaluation of
categorical variable values. Only direct subcodes of the codes that were transformed
into a categorical variable are evaluated.

Categorical variables in the context of MAXQDA's mixed methods
functions

Categorical variables lend themselves very well to use with MAXQDA’s mixed methods
functions. With the Activate documents via variables function, for example, one can
choose to activate only those documents with a certain variable value. This is helpful
for answering research questions such as “How do student teachers with low self-
esteem experience their situation in the school system? How do they approach
disciplinary issues?”
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The Crosstabs function offers an aggregated overview of the number of coded
segments in certain categories in the “Code System” for each of the three self-esteem
variables. The self-esteem characterizations are shown in the columns on the x-axis,
and the selected codes are shown in the rows on the y-axis. Using the self-esteem
example, the Crosstabs function could count the number of times that student
teachers with low self-esteem talk about disciplinary issues in comparison to the
number of times student teachers with high self-esteem talk about the issue. One can
then easily call up the document segments counted in each cell in the “Retrieved
Segments” window.

One can also use the Quote Matrix to see a detailed table of the document segments,
each column holding those segments that occur in documents with a specific
categorical value. In our self-esteem example, one column could hold those statements
about a certain topic that come from student teachers with high self-esteem, and the
other column could display those statements from teachers with low self-esteem.

The Typology Table uses categorical variables similar to the way the Crosstabs function
does; a table is created with the categorical variable values in the columns. In this case,
however, the variables are analyzed rather than the categories. One could look, for
example, what percentage of people with high self-esteem are older than 30 years
and what percentage are younger, or whether good grades in teacher certification
exams seem to connect in any way to self-esteem, etc.
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19 - Analyzing Videos

Video Analysis with MAXQDA
With MAXQDA you can directly import, play, transcribe and code video footage for
video analysis. The Multimedia Browser lets you play and code videos using the same
approach you would use for text analyses. The standard tools for coding texts are also
available for video analysis, including:

Adding to comments to coded segments in videos●

Adding weight scores to coded segments in videos●

Displaying and hiding coding stripes●

Attaching memos to specific time positions in videos, e.g. to make notes or add●

interpretations, hypotheses or evaluative ideas
Linking video clips to other video clips or text segments. e.g. sections in your●

transcript

The following tools are also available especially for video analysis:

Exporting still images for publications●

Saving still images as image documents in MAXQDA for further analysis●

Exporting short video clips, e.g. for presentations or analysis sessions●

Transcribing short sections or entire videos●

Linking videos and transcripts via timestamps●

Import Videos
Before you import video files into MAXQDA, you should briefly check their format and
size.

Supported video formats

MAXQDA supports the following standard video formats:
MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP, WMV on Windows

In general, we recommend the MP4 format with the H.264/AVC video codec.
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Recommended resolution

These days you can record videos in very high resolution, which in turn leads to
extremely large files. When analyzing videos with MAXQDA, your video will be
displayed in its own window, which usually doesn’t fill the entire screen. An HD
resolution (720p) will therefore be sufficient for working with videos in MAXQDA. If
you are using a retina or 4K monitor, a Full HD resolution (1080p) may also be
appropriate.

The size of a video file depends on its resolution, frame rate and data rate. A frame
rate of 25-30 frames/second and a data rate of approx. 1,500 kilobits/second are
usually sufficient.

To check the format, resolution, frame rate and data rate of a video file, follow these
steps:

Windows:

Right-click on the file and select Properties.1.
In the window that opens, select the Details tab. Here you can find the relevant2.
information in the "Video" section.

Mac:

Open the video file in the QuickTime Player.1.
Press the key combination cmd+I. A window with the relevant information will2.
open.

Converting videos

You can use the following programs to convert videos into a supported format and
reduce the resolution if necessary.

Windows: XMedia Recode

This program is available free of charge online and has a small file size itself (10 MB):

Drag your video file into the upper window area of XMedia Recode, and then click1.
the row containing the video to select it for editing.
Select the output format in the lower window area, e.g. the profile "HTML 5" with2.
"HTML 5 1280×720 HD (mp4)", corresponding to a resolution of 720p.
At the bottom of the window, select where you want the converted video to be3.
saved.

https://www.xmedia-recode.de/
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Click the "Add to queue" button at the top and then the "Encode" button.4.

Mac: Quicktime Player

QuickTime, which is installed by default on Mac computers, allows you to save videos
in MOV format:

Open your video in the QuickTime Player.1.
In the File menu, select Export as > 720p ... (or 1080p...).2.

Adding a video file to a MAXQDA project

To import a video into an open MAXQDA project, clicking on the Video icon on the
Import tab.

Importing data via the Import Tab

Audio and video files are generally not imported directly into a MAXQDA. Instead,
they are stored in the MAXQDA Externals folder and linked to a text document in
which you can, if necessary, save a transcript.

When importing an audio or video file, MAXQDA creates a new text document with
the name of the media file and assigns the newly added document the inserted media
file. The media file itself is copied to the “MAXQDA_Externals” folder so that it
remains available for MAXQDA later if you move the file from its original location or
delete it. If a file with the same name already exists in the Externals folder, MAXQDA
asks if the existing file should be overwritten.

In the “Document System”, you will recognize a text document with the associated
media file by the additional symbol displayed in addition to the document symbol: a
musical note  for audio files and a video camera  for video files.

Audio and video files in the “Document System“
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Folder for externally stored files

You can adjust the location of the external address in the MAXQDA settings. The
settings are called up via the gear wheel at the upper right edge of the window.

Open settings

Edit settings for saved files

Please note the following notes when saving video files:

To avoid slower processing speeds, video files should ideally be stored on the local●

hard disk.
If the file is very large, you can also store it on an external hard disk connected to●

your computer via a fast USB 3 port.
Only save video files to network folders if you have a very fast cable network.●

To protect confidential video files, you can store them in an encrypted folder. Such●

folders can be created with the open source software Veracrypt and integrated into
your computer as a virtual drive. However, encryption can lead to a loss of
performance when accessing the videos.
To prevent potentially very large amounts of data from being copied to the●

MAXQDA_Externals folder when importing, you can specify the original storage
location of your videos as the "Folder for externally stored files" in MAXQDA's main
preferences.
When you open a media file for the first time, MAXQDA creates a file with the●

extension .dat in the folder for external files. This file has the same name as the
media file. MAXQDA needs this .dat file to be able to display the media file quickly,
so it should not be deleted.

https://www.veracrypt.fr/en/Home.html


19 - Analyzing Videos   568

For more information about external files, see Managing External Files.

Assigning audio/video files to a text document

You can also assign a media file to an existing text document. To do so, right-click on
the document and select Link Audio/Video File in the context menu.

Alternatively, open the Properties window  from the context menu. Here you can
add or modify links to media files at any time.

Assigning an audio/video file to a document

Tip: In this dialog window you can also easily check which media files are linked to
your text documents.

The Multimedia Browser
You can play and analyze audio and video files in
MAXQDA’s Multimedia Browser.

To open an audio or video file in the Multimedia
Browser, right-click the document in the "Document
System" and select Open Audio File or Open Video File.

Alternatively, you can also open a media file directly from
the "Document Browser":

Open the text document to which the audio or video1.
has been assigned (e.g. by double-clicking on its name

https://m22.maxqda.com/help-mx20/import/external-files
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in the "Document System").
Click on the icon Open video file (file name) or 2.
Open audio file (file name) in the "Document
Browser" toolbar.

Open the Multimedia Browser in the Document Browser

If the text document is empty, i.e. there is no transcript,
MAXQDA automatically opens the video in the
Multimedia Browser as soon as you open the
corresponding text document.

The Multimedia Browser looks like this:

The Multimedia Browser window

The Multimedia Browser is composed of the following
areas:

The upper panel shows the video.●

Underneath, there is a toolbar containing the functions●

to adjust the view and playback and the functions for
coding. Here, you can also see the current playback
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position and the total time of the media file.
Beneath the toolbar, preview pictures are shown.●

Underneath, you can see the waveform of sound of the●

media file, and below this, there is a time line where
you can see the current playback position precise to the
second.
Under the time line there is a bar for the timestamps of●

the transcripts.
At the very bottom is an area where the coded●

segments are visualized by bars.

For audio files, the video window and preview pictures
are not shown.

The blue vertical line and the blue bar underneath the
time line indicate the current playback position.

The following functions are available on the toolbar:

 Control Panel – opens the window with playback
options

 Display previews – displays previews beneath the
toolbar

Please note: The previews are loaded the first time you
display a preview - this can take a few minutes with large
files.

Insert Internal Link (Anchor/Target)– sets the start and
end point of a reciprocal internal link

 New memo (Alt/option+⇧+M) – creates a new
memo in the current playback position

 Previous memo (⇧+F3) – jumps to the memo to the
left of the current clip position

 Next memo (F3) – jumps to the memo to the right of
the current clip position

 Set clip start (F7) – sets the beginning of a clip
segment at the current playback position
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 Set clip end (F8) – sets the end of a clip segment at
the current playback position

 Play clip (F9) – plays the segment selected on the
waveform

 Remove clip (F10) – removes current clip marks from
the waveform

5 seconds back (⇧+F12) – jumps back 5 seconds from
your current playback position

Play/Pause (F4 or F5) – starts/pauses playback

5 seconds forward (F12) – jumps 5 seconds forward
from your current playback position

 Slider – helps you jump to a
certain position

Copy video image to clipboard - copies the currently
visible video image to the clipboard, e.g. for inserting it
into a Word document

Insert video picture as image document in 'document
system' - inserts the currently visible video image as an
image document in the "Docuemtn System", e.g. to be
able to code segments of the image.

Export coded video clips - in the dialog window that
opens, specify the quality and resolution of the clips and
select the codes whose coded video segments you would
like exported.

On the far right of the waveform, there are other icons
that you can use to adjust the zoom for the waveform.

 zooms out of the waveform, reduces the number of
preview pictures for videos.

 zooms the view to 100%. This view is configured by
default and is usually ideal for coding.

 shows the complete media file in the Multimedia
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Browser; this gives you an overview of the waveform of
the complete file (unless it's very long). This view is
usually not suitable for coding.

 zooms into the waveform, increases the number of
preview pictures for videos. This makes it easier to
navigate to single pictures and words and code more
specifically.

Control media files with your keyboard

Media files can be controlled via function keys, e.g. you
can jump forward 5 seconds with F12.

Please note: For information on how to use the function
buttons with a Mac computer, please see the Frequently
Asked Questions.

To start and stop playback, you can use the F4 or F5 or:

Pressing Ctrl (Windows) or the Shift button ⇧ (Mac)●

twice, or
if the Multimedia Browser window is open, by clicking●

in within the video window, the playback can also be
started and stopped with the Space key.

Code Videos
Coding in the Multimedia Browser

Video files (as well as audio files) can be coded in the
same way as texts in MAXQDA. To do so, open the video
file in the Multimedia Browser as described in the section
above.

You start by marking a segment of the waveform (a so-
called “clip”). Typically, you will want to set the
beginning and end of a segment in a media file precisely,
as the scene and content can change completely from
one moment to the other. For this reason, MAXQDA
offers a number of functions that allow you to mark an

https://m22.maxqda.com/help-support/faq#fndtn-panel11645
https://m22.maxqda.com/help-support/faq#fndtn-panel11645
https://m22.maxqda.com/help-mx20/19-analyzing-videos/the-multimedia-browser
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audio or video clip:

To roughly mark a segment, keep the left mouse●

button pressed and select the segment by dragging the
cursor over the waveform. The time limits are displayed
underneath the beginning and end marks.
You can easily alter the time limits of the clip by moving●

the whole blue-marked segment or by clicking and
dragging the outer borders of the segment in the
waveform.
By using the right and left arrow keys, playback is●

moved by one-tenth of a second. If the playback
precisely matches the beginning or end of a clip, the
clip is enlarged or reduced accordingly.
To play the marked clip, click the icon Play clip or press●

the F9 key.

Marking a clip

You will usually play a media file and then pause exactly
at a position where you want to set a new coding. To do
this:

Press the button Play/Pause  or the F4 key.1.
When the playhead is at the designated position, click2.
the button Set clip start  or press the F9 key. If
necessary, use the arrow keys on the keyboard or by
clicking and dragging the clip borders to fine-tune the
start of the clip.
Resume playback and pause at the position where you3.
want to end the coding. Click the button Set clip end

 or press the F10 key. If necessary, make a fine-
adjust the clip.
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Setting the clip limits at the current playback position

You can now code the selected segments as usual, for
example by (a) dragging and dropping the marks on to a
code, (b) clicking on an emoticode, or (c) by clicking a
color code. Right-clicking on a marked segment opens a
context menu that contains three options that are
relevant for coding:

Context menu on a marked clip

Selecting long passages in a video

To selct a segment in a video, you can click and drag the
mouse in the waveform. This can be impractical if the
passage you want to mark is very long. You can save
time by doing the following:

Place the playback position at the beginning of the1.
passage.
Use the scroll bar to scroll to the approximate end of2.
the passage. Then click the waveform while holding
down the Ctrl key (Windows) or cmd key (Mac).

MAXQDA will then mark the entire area between the
two positions. The clip boundaries can be adjusted as
usual with the small sliders.
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Displaying coded segments in the Multimedia
Browser

The coding is indicated by a horizontal coding strip in the
"Multimedia Browser", the code name appears on the
left below the coding strip. In addition, the waveform is
colored with the color of the code in the corresponding
time domain. If several codings are superimposed, the
color is mixed in the waveform. For encodings with an
emoticode, the symbol is visualized on the coding strip.

Clicking on a coding stripe selects the coded segment on
the waveform. Double-clicking plays the clip.

Visualization of codings in the Multimedia Browser

Right-clicking on a coding stripe opens a context menu
containing the usual options:

Modify weight●

Edit comment●

Delete●

Please note: Coded segments that have a comment are
marked with a white square on the left-hand side of the
coding stripe.

The display of the coding stripes can be adjusted. To do
this, right-click in the grey area where the coding stripes
are displayed; it is important not to click on a coding strip
but next to it. The following dialog appears:
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You can select to display only encodings of selected
people or codes with a specific color. Particularly
important for video analysis is the bottom option Display
code favorites at the top. It ensures that all codes that
you have defined as favorites under Codes > Code
Favorites are always displayed at the top of the
"Multimedia Browser". A separate line is reserved for
each of the favorite codes, creating a kind of score view.
This view is ideal, for example, for structuring the video
or identifying the key players in the video.

Tip: By clicking on the asterisk, you directly open the
window with the code favorites and can add further
codes from the "List of codes".

Transcribe Videos
This manual contains a separate chapter on
"Transcription", which provides a detailed explanation of
how to use MAXQDA's Transcription Mode to transcribe
video or audio files and of how to use timestamps to link
transcripts with media files. In addition to the functions
described there, MAXQDA provides an additional tool for

https://m22.maxqda.com/help-mx20/transcription-audio-video/transcription-mode
https://m22.maxqda.com/help-mx20/transcription-audio-video/transcription-mode
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transcribing short sections of videos:

Often only specific scenes from videos need to be
transcribed, for example in order to perform a more
detailed analysis on these scenes. In these cases you have
the option of transcribing individual passages in the
Multimedia Browser.

Follow these steps:

Open the video file in the Multimedia Browser.1.
Right-click on a point in the waveform from which you2.
want to start transcribing.
Select the Transcribe item from the context menu that3.
appears when you right-click the waveform.

Starting a transcription of a selected video clip

MAXQDA will then open Transcription Mode so that you
can start transcribing straight away. The starting time of
your selected video sequence is automatically added to
the transcript. Additionally, a timestamp is set to link the
transcript with the video. Clicking on the timestamp will
play the video from the corresponding time position in
the Multimedia Browser.

The beginning of a partial transcript with the start time added to the text

Export Video Clips
You may find it useful to export only short extracts of
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your video material for presentations or analysis sessions.
You can export selected clips as distinct video files using
the Multimedia Browser. These clips can also be inserted
as new video files into your MAXQDA project.
Additionally, you can also export already coded video
clips as video files.

Exporting selected video clips using the
Multimedia Browser

You can export a selected clip from the Multimedia
Browser or insert it into your MAXQDA project as a new
document:

Select a sequence in your video material in the1.
Multimedia Browser.
Right-click on this sequence and select Export Video2.
Clip in the context menu.
In the dialog window that opens, specify the quality3.
and resolution of the clip you would like to export.

Exporting a selected video clip from the Multimedia Browser

Options for exporting video clips

To insert a selected video clip as a new document into
your "Document System” - in other words, to add it as a
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new document to your open MAXQDA project - select
Insert as New Document in the context menu for the
selected clip.

Exporting coded video clips

To export a single coded segment of a video, select
Export Video Clip for that coded segment. This function
is available in the context menu when you right-click on
the following:

In the Multimedia-Browser: coding stripes●

In the “Retrieved Segments“ window: source●

information or rows in the displayed table
In the Overview of Retrieved Segments: rows in the●

displayed table

Exporting a video clip from the “Retrieved Segments“ window

Please note: Even if several rows are selected in the table
view of the "Retrieved Segments" window or that of the
Overview of Retrieved Segments, only the video segment
you have specifically clicked on will be exported.

From the Multimedia Browser, you can also export all the
coded video segments of one or more codes:

In the toolbar, click on the Export coded video clips1.
icon.
In the dialog window that opens, specify the quality2.
and resolution of the clips and select the codes whose
coded video segments you would like exported.
Click OK and a window will open in which you can3.
specify a location to export these clips.
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Exporting coded video clips from the Multimedia Browser

Dialog window for exporting coded video clips

Analyze Coded Videos
Once you have finished coding a video, you have a wide
range of analysis options at your disposal, using the full
range of MAXQDA tools:

Visual Tools > Code Matrix Browser: Compare●

distribution of coded segments for individual videos or
groups of videos
Visual Tools > Code Relations Browser and Analysis >●

Code configurations: Detect simultaneous occurrences
of codes
Visual Tools > MAXMaps: Create concept maps, if●

necessary with MAXQDA’s model templates like the
individual case model
and much more …●

The following section describes several functions in
greater detail, i.e. to highlight certain specific features
relating to videos or because some are particularly suited
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to video analyses thanks to their time structure.

Retrieve coded videos in the "Retrieved
Segments" window

Coded video segments can be retrieved and compiled in
the same way you would retrieve any other coded
segments in the "Retrieved Segments" window, through
activation and the Complex Coding Query function.
When working with videos, the "Retrieved Segments"
window will display the first image of the video clip as a
preview. For audio clips, a (standardized) image of a
waveform is displayed.

The source information includes the start and end times
of your audio and video clips.

Tip: Click on the source information to play the video
segment in the Multimedia Browser.

Audio and video clips in the “Retrieved Segments” window

Displaying video progressions in the Codeline
visual tool

The Codeline is an excellent tool for visualizing the
chronological progression of coded segments in a video
file. Like in a musical score, selected codes are displayed
in their respective colors, one below the other. For
example, you can display structural codes (i.e. "opening
stage", "discussion stage", "closing stage") parallel to
topic codes.

https://m22.maxqda.com/help-mx20/segment-retrieval/logical-combinations-codes
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The Codeline for video files

Follow these steps:

Activate the codes you want to display in the1.
Codeline. If you would like all your codes to be
displayed, you don’t need to activate any.
Right-click on the text document with the video file in2.
the "Document System" and select Codeline in the
context menu.
In the dialog window that opens, select your preferred3.
options, e.g. Only for activated codes.
In the top left corner of the Codeline window, click4.
the icon Codeline for linked media file. Otherwise, a
codeline for the transcript will be displayed.
You can use the Fit to window width option to5.
expand and compress the entire progression to suit
the Codeline window.
The Unit: second/minute option should be switched6.
off, otherwise the times will always be "rounded" to
the nearest full second/minute.

You can find further information about the Codeline tool
here.

Define and compare code coverage

You can use the Code Coverage tool to add up the time
covered by certain coded video segments and compare
these aggregate times between different videos. This tool
could be particularly useful if you want to, for example,
analyze whether groupwork phases were coded for
longer periods of time in a “lesson” video than in other
videos.

https://m22.maxqda.com/help-mx20/visual-tools/codeline-the-sequential-visualization-of-a-document
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Code Coverage: results table for coded videos

Follow these steps:

Activate the videos in the "Document System" that1.
you would like to include in your analysis.
Activate the codes you want to display in your results2.
table. If you would like all the codes to be displayed,
you don't need to activate any.
Select Analysis > Code Coverage in MAXQDA's main3.
ribbon menu and select Video in the drop-down
menu.
In the dialog widow that opens, specify whether you4.
want to compare the documents individually or in
document groups or document sets.

You can find further information about the Code
Coverage tool here.

Add Memos and Links to
Videos
Attaching memos to time positions in videos

As well as coding them, you can also add memos to
media files to make notes or record your thoughts,
hypotheses, interpretations, and much more about
particular time positions. The memos can also be used to
subdivide a video file so that you can quickly "navigate"
through the video.

You can attach memos for notes to any playback
position. To attach a new memo,

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/code-coverage
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Right-click a position of the waveform●

Or click the button New memo  in the Multimedia●

Browser toolbar or
Or use the keyboard shortcut Alt+⇧+M (Windows) /●

option ⌥+⇧+M (Mac)

Creating memos

You can jump back and forth between the memos of a
media file at any time by using the Previous / Next Memo
icons or the associated keyboard shortcuts ⇧ + F3 and F3
in Multimedia Browser toolbar.

Setting internal links in video clips

Internal links in MAXQDA are used to connect two parts
of the project, for example a part of a video with an
interview section. This creates a hyperlink, which you can
click to jump back and forth between the linked sections.

Follow these steps to set an internal link in a video file:

Select part of a video in the Multimedia Browser.1.
Right-click on the marker and select Insert Internal2.
Link (Anchor/Target). Alternatively, you can use the
key combination Ctrl+L (Windows) or cmd+L (Mac).
This sets the start of the link.
Select another sequence in the video and repeat step3.
2. This sets your link target.
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Insert Internal Link

In the Multimedia Browser a link icon will now appear in
the waveform, which you can click to jump to the linked
section.

Link icon in the “Multimedia Browser“

You can connect a video clip to another video clip or
connect a video clip to a text section in a document or
memo. For example, a passage of text that talks about a
particular video scene can be linked to that video scene
via an internal link.
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20 - Analyzing Focus Group Data

How Does MAXQDA Support Focus Group
Data Analysis?
Conducting focus groups and group interviews occupies an important role in social
and market research. Focus groups offer a high potential for diverse analyses,
therefore there are many new features available in MAXQDA that allow for the simple
and effective analysis of focus group data. For simplicity we use only the term “focus
groups” in MAXQDA and in this manual, although the functions are all suitable for the
analysis of group interviews as well.

Transcripts of focus groups can be imported so that the contributions of the●

participants are automatically coded while importing.
Individual participants can be activated directly in the "Document System", so you●

can easily compile the statements of individuals on selected topics. Background
information on the participants, such as age and professional experience, can be
stored as variables for focus group participants and used for the specific and
comparative analysis of groups.
The "Overview of Focus Group Speakers" can be used to answer questions such as●

the following: Who has spoken at what frequency? How extensive are the
contributions of each speaker, in words or characters?
Use the Code Matrix Browser and the Crosstab for focus groups to create●

visualizations such as "Themes x Speakers", with which participants or groups of
participants can be compared by diverse themes, arguments, positions, and
viewpoints in the allocation of codes.

Using the Lexical Search for Contributions
from Speakers
MAXQDA’s lexical search can be limited to individual contributions from Focus Group
speakers:

Activate the participants whose contributions you would like to search in the1.
“Document System”.
Access the function via the Lexical Search function in the Analysis tab.2.

https://m22.maxqda.com/help-mx20/import/importing-focus-group-transcripts
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In the window that appears, enter the desired search terms and select Only in3.
activated documents/activated focus group contributions.

Search the contributions of focus group participants

The Overview of Focus Group Participants
The "Overview of Focus Group Participants" provides important information about the
individual speaker, such as the number and scope of their respective contributions,
and also allows you to store additional information about each speaker in the form of
variables. To access the overview, right-click on a focus group in the "Document
System" and choose Overview of Focus Group Speakers.

The following window will open:
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The Overview of Focus Group Speakers provides important information

The first two columns are used to identify the participants and their respective focus
group transcript. The percentages of contributions and the characters always appear in
the displayed table. If you have assigned a particular color to a participant, it will
appear in the first column of the table.

In top of the window are several icons, whose special functions in relation to the focus
group analysis are explained here:

Only activated focus group speaker - Reduces rows to those of participants
activated in the “Document System”. This is especially handy if you want to exclude
Moderators from the overview: Activate only the other participants and click the icon.

Statistics - Presents the values of all the columns displayed in a frequency table or
chart, excluding the “speaker” and “focus group” columns. More information on
frequency tables and charts can be found here.

Data Editor - Turns on the Variable View, in which the variable values are visible.

List of variables - Switches to Variable View, where you can define new variables
and adjust and edit existing variables. More information on the use of variables in
focus group analysis is provided in the next section.

Tip: You can call up the summary table not only for individual focus groups transcripts,
but also for the participants of all the focus groups in the MAXQDA project. To do
this, right-click at the top level in the "Document System " with the mouse and select
the appropriate entry. A corresponding overview is also available in the context menu
of an individual participant, referred to here as “Overview of speaker variables”.

Editing Variables for Focus Group Speaker

You can store background information for each participant in a focus group for
selective analyses and comparisons; for example, comparing the statements of older
and younger participants. First open the "Overview of focus group speaker" from the
context menu in the "Document System" (either at the top level for all focus groups in
the project, or at the level of a single focus group).

Tip:You have direct access to the speaker variables via the Variables tab. Click on List
of Speaker Variables to open the "Overview of Focus Group Speakers" table which
contains every speakers from all focus group documents in your project.

As seen above, the default overview contains multiple columns of information that

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
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MAXQDA compiles for the participants. You can add more columns for information
such as, for example, age, profession, or professional rank.

Creating new variables

Adding new variables is done in the same way as in other overviews of variables in
MAXQDA:

Click on the List of Variables icon to switch to Variable View.1.
Next, click on the New Variable icon.2.

A new window will appear, in which you can define the name and type of the new
variable.

Creating a new variable

After clicking OK, you will see that a line has been added with the newly added
variable in Variable View.

Newly added variable in Variable View

Entering values for the participants

Click on   Overview of focus group speakers to return to the normal view. On the far
right you will see a newly added column, in which you can enter values for each
participant. The editable column can be easily recognized by its blue column heading,
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unlike the black headings of the columns automatically generated by MAXQDA.

Entering data for a variable

The variable values for participants can be used:

To activate only selected participants with specific values for further analysis or●

in a Crosstab for focus groups to compare groups of participants.●

Importing speaker variables from Excel

MAXQDA can import speaker variables from XLS/X files. The data must be organized
as follows:

Speaker Focus Group Variable 1 ... Variable N

Speaker ADocument name
Value of Variable 1 for
Speaker A

...
Value of Variable N for
Speaker A

Speaker B Document name
Value of Variable 1 for
Speaker B

...
Value of Variable N for
Speaker B

The first and second column serve the unambiguous assignment of variable values to a
speaker, so these columns and their headings are mandatory. Each line must designate
a speaker and the corresponding focus group in the corresponding column.

Only when a speaker, who matches this information exactly, is found in the “Code
System” will the variable be imported. You can add as many variables as required in
the subsequent columns.

After preparing and saving the import data, you can then start the import procedure
by going to Variables > Import Speaker Variables. Alternatively, you can click on the 
Import data button in the Overview of Focus Group Speakers.

A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.

https://m22.maxqda.com/help-mx20/focus-group-analysis/crosstab-for-focus-groups
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MAXQDA does the following during the import:

All variables in the import file that did not yet exist in the MAXQDA project are●

created.
Variables that already existed will be updated with the new values in the import file.●

Tip: An easy way to set up an Excel file for importing new values is to first export the
variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the
variable list. An Excel file with all of the current variables will open up, and you can
then add new columns for new variables and update variable values that you want
changed. All you have to do after that is save the Excel file and import it into
MAXQDA.

Coding Query for Coded Segments
The central principle for the compilation of coded segments in MAXQDA is the
activation of codes and documents. This principle also applies to the analysis of focus
groups, however in this case you have the possibility to activate not only the focus
group transcript as a whole, but also all or certain participants in the Document
System. In this case, only the contributions of activated participants will be taken into
account in the analysis.

Selecting participants for analysis through activation

To activate a participant in the "Document System" for analysis, proceed exactly as
when activating a document. You can right-click the on participants and select
Activate from the menu, or simply click on the gray circle by icon of the participant. To
activate or deactivate all the participants in a focus group, you can use the commands
Activate all Speakers or Deactivate all Speakers in the context menu of the focus
group.



20 - Analyzing Focus Group Data   592

Activate all speakers of a focus group

MAXQDA analysis of focus groups applies either to the entire document or to
individual participants of the selected focus group, but never a mix of these two levels.
For this reason, the transcript and the participants can never be activated together,
following the principles below:

When you activate a transcript, its participants will be deactivated.●

When you activate a participant, its transcript will be deactivated.●

When you activate a document group or all documents, focus group participants will●

be disregarded or deactivated if necessary.

During the search for participant statements, MAXQDA can help you by performing
the following standard tasks:

Find everything that the participant Lucas said in a focus group

Activate the corresponding focus group in the “Document System”.1.
Activate “Lucas” in the “Code System”.2.

MAXQDA will list all of the contributions from Lucas in the “Retrieved Segments”
window.

Find everything that the participant Lucas said in multiple focus groups

Activate all focus groups in the “Document System”.1.
Activate all codes for “Lucas” in the “Code System”.2.

MAXQDA will list all of the contributions from Lucas from all focus groups in the
“Retrieved Segments”.

Find everything that Lucas said regarding a particular theme, for example
“Stress due to the financial crisis”:

Activate “Lucas” in the “Document System” in all of the transcripts you wish to1.
include.
Activate the theme code “Stress due to the financial crisis” in the “Code System”.2.

MAXQDA will list all of the contributions from Lucas related to this theme in the
“Retrieved Segments” window. The participant is also indicated in the indication of
origin, so you can easily associate the contribution with the participant.
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Statements of a participant on a topic in the “Retrieved Segments” window

Find everything that multiple participants said in a focus group

You can always activate multiple participants simultaneously. MAXQDA takes all
activated participants into account during the Coding Query.

Enable focus group speakers based on their variable values

You can also activate individual participants based on their variable values. To do this,
right-click on root document in the "Document System" and select the entry Activate
focus group speakers by variable values from the context menu. Alternatively, you can
click on the icon Activate via ...  in the toolbar of the "Document System" window:

Activate Focus Group Speakers by Variables

The same window which is used to activate documents based on their variable values
will then appear. You can then select any of the values listed in the Overview of Focus
Group Participants. This also makes it possible to select participants with many or few
contributions and speeches.

Complex Coding Query

The Complex Coding Query function also allows you to limit the search to the
statements of a particular speaker as coded segments. This function follows the same
logic as the simple Coding Query: When you activate the focus group transcript, the
search takes the whole document into account, whereas when you activate an
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individual participant, this participant’s contributions are treated as a document.

Suppose you have assigned thematic codes in a transcript, and also coded the
communication sequence so that there is a Code System of the following type:

Themes

Financial Crisis●

Sense of Security●

...●

Communication sequence

Objections●

Support for the statement●

...●

If you want to find all the statements in which Lucas presents an objection to an earlier
statement about the "financial crisis", you can do so using the Complex Coding
Query:

Activate the participant “Lucas” in the “Document System”.1.
Activate the codes “Financial Crisis” and “Objections”.2.
Call up the Analysis > Complex Coding Query function.3.
Select the “Overlapping” function, which searches for instances in which two4.
codes, namely “Financial Crisis” and “Objections” occur simultaneously.
Ensure that the Only in activated documents / activated focus group contributions5.
function is selected.
When you click on Home, MAXQDA will list the results in the “Retrieved6.
segments”.

View Coded Segments per Speaker
MAXQDA’s Code Matrix Browser is the ideal tool with which to illustrate and analyze
the distribution of coded segments in different documents. This tool is in the form of a
table, in which the documents make up the columns and the codes make up the rows.
In the analysis of focus groups, often it is not the transcript as an individual document
that is the central focus, but rather the analysis of the contributions in multiple
documents, to be considered separately from each other.

The MAXQDA Code Matrix Browser therefore offers the opportunity to automatically

https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
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perform exactly this analysis and visualize the distribution of codes per speaker:

Open the Code Matrix Browser via the Visual Tools tab.●

In the window that appears, select the option Focus Group Speakers. If you would●

like to visualize the codes of an individual participant (or to exclude the moderator
from the visualization), you can activate these elements in advance, and additionally
select the option Only for activated focus group speakers.

Code Matrix Browser options

When you click OK, MAXQDA will open the Code Matrix Browser, whose columns are
made up of the participants.

Codes per speaker

The size of the squares provides information about how many coded segments from
the four thematic codes are present in the contributions of each speaker. The image
above demonstrates the frequency of encodings on the four issues made by Lucas,
Miles, Lisa, Casey, and Parker. The larger the square, the more encodings have been
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made with the code in question. It is evident from the image that Lucas a high amount
of coding occurred regarding "Stress due to the financial crisis", whereas Parker made
no contribution to this theme.

In the presentation of focus groups, The Code Matrix Browser operates in the same
manner as usual: Double-clicking on a cell will display the corresponding coded
segments in the “Retrieved Segments” window and clicking on the Display nodes as
values  presents the information as code frequencies rather than square. The
functions of the other buttons in the Code Matrix Browser are described here .

Note: If a project has multiple focus groups, all or all activated participants from all
focus groups will be displayed in the Code Matrix Browser. The order of participants
from left to right corresponds to their order in the "Document System" from top to
bottom.

The Interactive Quote Matrix for focus group participants

Using MAXQDA’s Interactive Quote Matrix, you can synoptically compile coded
segments. This can be illustrated as follows: Behind every square in the image above is
a certain number of coded text segments, which can be easily compiled by, for
example, double-clicking on the square. A Quote Matrix contains not only the text
segments that lie behind a square, but also compiles the text segments of all the
squares together in a table.

To create an Interactive Quote Matrix, click the Interactive Quote Matrix button in
the Code Matrix Browser toolbar. MAXQDA will open the Interactive Quote Matrix in a
new window. The Quote Matrix can be exported using the usual icons at the top right
of the window (Excel-Table, HTML-Table, or RTF-Document).

Excerpt from a Quote Matrix in Excel

An indication of origin appears below each segment: The contribution in the upper left
is from a statement by Lucas from paragraph 11 of the transcript, and encoded with a
weight of 0. You can export the Interactive Quote Matrix as a Word file, an Excel table

https://m22.maxqda.com/help-mx20/visual-tools/code-matrix-browser-visualizing-codes-per-document
https://m22.maxqda.com/help-mx20/mixed-methods-functions/interactive-quote-matrix
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or a website (HTML format) via the usual icons at the top right.

Crosstab for Focus Groups
MAXQDA offers the opportunity to save background information on each focus group
speaker in the form of variables. Suppose you have divided participants into two age
groups: With the Crosstab for focus groups, you can easily compare the thematic
coding for these two groups. The Crosstab for focus groups functions essentially the
same way as the “normal” crosstab: The codes form the columns and the groups of
focus group speakers form the rows, while the respective code frequencies are
presented in the cells.

You can find the Crosstab for focus groups function in the Crosstab menu of the
Mixed Methods tab. The following window appears, in which you can define the
speaker groups.

Define speaker groups for the columns

Each line in the middle column of the window forms a column in the final crosstab. In
the image above, the option Insert all variable values as conditions has been selected
and the variable "age group" has been automatically transferred to the middle pane
with with a double mouse-click. MAXQDA has automatically inserted a row for both
occurring values, "20 - 29" and "30 - 39".

Please note: In the crosstab, MAXQDA evaluates all participants that meet the
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conditions in the second column of the window - regardless of whether they come
from one or more focus groups. You can restrict the evaluation to include only
currently activated participants using the Only activated focus group speakers option.

The final crosstab appears as follows:

Crosstab for focus groups

The example is read as follows: none of the 20- to 29-year-olds have been assigned
the code “Health problems”, and 100% of the 30 to 39-year-olds.
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21 - Analyzing Tweets and Surveys

Analyze Tweets
The analysis of tweets based on coded segments can reach its limits if you want to
analyze thousands of tweets. It's hard to keep an overview of the whole picture,
simple automatic coding reaches its limits and manual codings are practically
impossible. Analysis functions are needed that enable you to keep track of larger
amounts of data and to make targeted comparisons between authors, etc.

For this purpose, MAXQDA offers a special analysis view for imported twitter data,
with which you can evaluabte tweets according to numerous criteria, such as:
contained words, hashtags, authors, countries and/or sources.

A prerequisite: Your project includes Twitter data

A prerequisite for using the Twitter analysis functions in MAXQDA is that you have
already imported Twitter data into your MAXQDA project. You can recognize
imported Twitter data in the "Document System" by their Twitter symbol. Twitter data
imported with MAXQDA version 12 cannot be used for the analysis described below.

Twitter data in the “Document System”

Follow these steps to begin a Twitter analysis

Select the function Analysis > Twitter > Analyze Tweets1.
In the dialog window that appears select all twitter documents that you would like2.
to include in your analysis.
Click on OK and the following analysis will appear:3.

https://m22.maxqda.com/help-mx20/import/importing-twitter-data
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Twitter analysis display

All analyzed tweets are listed in descending order by release date. The first column
contains the profile picture, the second the Twitter name and real name of the author.
When you start your analysis, no profile pictures will be displayed - you can display
them via the Profile pictures icon. The pictures are loadedd and gradually displayed. If
an image has already been loaded for an author, it will be used; there will be no
update. Some authors have not posted an image on Twitter, for the column "Type"
indicates whether it is a tweet, a retweet or an reply.

In the tweets, hashtags and mentioned Twitter accounts are highlighted in color. Click
a link to view it in your computer's internet browser.

The other columns contain the following information:

Retweets - how often the tweet has been retweeted. This number is an indicator of
the tweet’s popularity.

Likes – the number of likes a Tweet received.

Followers – how many followers the author had at the time they published the tweet.
This number is an indicator of the author’s popularity.

Tip: This table can be arranged by clicking on each respective column’s header.

Filter tweets

Using the filter panel on the left, you can filter the tweets according to several criteria.
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You can also expand and collapse the filter area by clicking on the filter header.

The number in brackets behind the filter always refers to the total number of all
analyzed tweets on the basis of that filter. This means that it will remain constant,
even if you turn on several filters. The current number of listed tweets is displayed at
the top of the icon toolbar.

Please note: Within a filter range, an OR function is applied: If you set a "Tweet" and
"Retweet" in the "Type" area, both tweets and retweets are displayed. The individual
filter areas are connected with AND: If you put a check mark in the "Retweet" area
and a check mark in the area "Most frequently used hashtags" for "#Berlin", only
retweets with the hashtag #Berlin will be listed.

These filter areas are always available:

Types – always contains the three filter options "Tweet", "Retweet" and "Reply".

Most frequently used words – Lists the most common words in descending order.
Internet links and mentioned accounts will be ignored. All the words currently
contained in the stop list for the word cloud will also be filtered out.

Most frequently used hashtagss – lists the most common hashtags in descending
order.

Authors by number of tweets – lists the most active authors in descending order. Only
the analyzed tweets are considered.

Authors by number of followers – lists the authors with the largest reach in
descending order. Their number of followers is used as an indicator of reach.

Mentioned accounts – lists the most frequently mentioned accounts in descending
order.

Languages – lists the most frequently used languages in descending order. (The
language is identified by Twitter automatically).

Sources – lists the most frequently used devices and programs from which the tweets
were sent in descending order.

Create word clouds and word frequency lists

You can create word clouds with the most frequently used words in the currently
displayed tweets as well as a list of all the words contained in them:
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If needed, filter tweets according to selected criteria.●

Click on the word cloud icon to create a word cloud like the following:●

Word cloud for tweets

To make your word cloud display only the most relevant words, you can transfer less●

important words into a stop list to exclude them. The easiest way to do this is to click
on the button on the Word frequencies button at the bottom of the window to
display the list of all the words that appear.



21 - Analyzing Tweets and Surveys   603

Transferring words from the word frequency list to the stop list

The word frequency list is sorted in descending order. To transfer a word to the stop●

list, double-click the green icon in the first column. The green icon then changes to a
stop symbol. Alternatively, select one or more lines with the mouse, and then click
the Add to stop list symbol in the toolbar.
Click the circular arrow in the toolbar to Refresh and apply stop list. The word cloud●

and word frequency list will then be regenerated, taking into account your new stop
list.

The filters for the tweets allow you to create and compare word clouds between
different groups of authors.

Tip: In MAXDictio, the add-on module for word-based analysis, you can manage
various stop lists and always transfer these words to your "stop list for word clouds".

Frequency analyses and charts

You can also create frequency tables and charts from the tweets under specific filters.
Information on the reach of tweets (their followers) as well as their publication times
and weekdays are added:

Filter your tweets according to specified criteria.●

Click the chart icon in the top toolbar to request a frequency analysis.●
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Frequency table for the most common languages in which tweets were written.

You can use the arrows at the top of the window to toggle between individual●

frequency tables.
Click on the chart symbol in the upper left corner to display the table as a horizontal●

or vertical bar chart or pie chart. For more information refer to the Frequency tables
and charts for subcodes

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-charts-subcodes
https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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Chart displaying the most common languages in which tweets were written.

MAXQDA generates the following charts with associated frequency tables:

Chart Bars represent Categories
Weekday Number of tweets Days
Time Number of tweets Hours
Type Number of tweets Tweet, retweet, reply
Most frequent words Number of tweets 15 most frequently used words (options

for making this anaylsis case-sensitive
and/or taking word cloud stop-lists into
account). The category "Other" can also
be displayed.

Most frequent
hashtags

Number of tweets 15 most used hash tags. The category
"Other" can also be displayed.

Author by number of
tweets (real name) /
Author bz number of
tweets (Twitter
name)

Number of tweets 15 authors with the highest amount of
tweets. The category "Other" can also be
displayed.

Authors followers Number of followers 15 authors with the most followers. The
category "Other" can also be displayed.

Source Number of tweets 15 most common sources. The category
"Other" can also be displayed.

Retweets Number of retweets Specified categories from 0 to a 100+
Likes Number of likes. Specified categories from 0 to a 1,000+
Followers Number of followers. Specified categories from 0 to a

1,000,000+

Export current display

Your results can be exported using the usual icons at the top right of the window.
These functions always export the entire table.

Open as Excel spreadsheet – Creates a temporary spreadsheet in XLS / X format
which is opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

Open as HTML spreadsheet – Creates a temporary HTML spreadsheet which is
opened in your default browser. To permanently save the created file, you must save it
in another location on your computer.

Export – MAXQDA creates a table as an Excel file (XLS / X format), as a web page
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(HTML format) or as a text document (RTF format) after you have entered a filename
and location. The exported file is opened immediately.

Autocode Tweets
MAXQDA can automatically code the text of up to 100 authors and 100 hashtags
from imported Twitter data. When you import Twitter data, a dialog window will
appear in which you can enter the author names and hashtags you wish to autocode.
Alternatively, you can open the function via Analysis > Twitter > Autocode Tweets.

Autocode Twitter data dialog window

In the dialog window, all exisiting Twitter document are listed. From here, you can
choose which documents you wish to autocode. If the dialog window was opened
automatically following an import, the most recently imported documents are already
preselected. Before you can start the autocoding process, you must first select the
hashtags or author names you wish to encode. To do so, use the Select hashtags and
Select Authors buttons. A new dialog window will appear, in which the selected
hashtags and author names are listed:
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Selecting hashtags for autocoding

In the "Hashtag" column, the different hashtags are listed, and in the "Tweet"
column you can see the number of tweets in which the hashtag appears. In the upper
left corner you can see how many different hashtags were found in total; the top right
shows how many of these hashtags are currently selected.

How do you select the entries with the hashtags that are relevant to your analysis?

Select the desired row. As usual, you can select multiple rows by holding down the●

Ctrl key (Windows) or cmd key ( Mac ). Your selection will be highlighted in green.
Click the green checkmark  symbol in the upper toolbar. A green checkmark will●

appear in front of the the selected hashtags.

This procedure can be repeated as desired, or reversed by selecting a row and clicking
on the Stop icon to deselect an entry. Note that a maximum of 100 entries can be
selected.

When you click OK, you will return to the Autocode dialog window, where you can
proceed in the same manner with author names. When at least one hastag or author
name is selected, the Autocode button becomes available and can be clicked.
MAXQDA then begins the autocoding process, which may take a moment depending
on the number of entries. The resulting new code “Autocode Twitter data” with the
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date will be inserted at the top of the Code System.

The automatically inserted code in the Code System

In the automatically generated code, "Tweet hashtag" and "Tweet author" appear as 
subcodes of the selected hashtags and author names. For the analysis, they are
automatically sorted in descending order of frequency. The hashtags and author
names that appear most often in the tweets are at the top. The codes can be
managed like any other code - for example, you can change the color or arrangement,
depending on what makes the most sense for your analysis.

Please note: Via Analysis > Twitter > Autocode Tweets you can open the autocode
function as often as needed. It is therefore not necessary to perform the autocoding
process immediately after import.

Analyzing Coded Tweets

Once you have autocoded your tweets, all the usual MAXQDA twitter analysis tools
are available. For example, you can use the Coding Query to determine which tweets
were written by specific authors:

Activate one or more documents with Twitter data in the Document System.1.
Activate the codes with the relevant author names in the Code System.2.
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The result will be a compilation of all relevant tweets, which will appear in the
“Retrieved Segments” window. If you are using MAXQDA Plus and therefore have
MAXDictio available, you can use this compilation of tweets to perform a simple word
frequency analysis. Go to the MAXDictio tab, select Word Frequencies and check the
option Only in retrieved segments.

Further analysis options, especially when delaing with several thousand tweets that
have not been autocoded, MAXQDA offers further analysis options including filters,
word-based functions and statistics.

Categorize Survey Data
How does MAXQDA help you categorize survey responses?

MAXQDA helps you analyze responses to open questions in surveys efficiently and
effectively with its interactive table window. These responses are listed in a table and
can be categorized with existing or newly formed codes.

A prerequisite for using this function is that all the responses to a question have been
coded. This should be the case if you used the Survey Data Import function to import
your survey responses. The name of the code will normally correspond to the text or a
shortened version of the survey question.

Each code will contain the responses to one of your survey questions

Starting the function

MAXQDA’s interactive interface lets you analyze each of your survey questions:

Should you wish to analyze only a selection of responses of individual interviewees,1.
activate these documents.
Click on the following function: Analysis > Categorize Survey Data2.
Drag the code that contains the responses to your survey question from the code3.

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-and-diagrams-for-variables
https://m22.maxqda.com/help-mx20/import/importing-text-from-a-tablespreadsheet-e-g-answers-to-open-questions
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system to the following window that appears:

Choose the code that contains the responses to your survey question.

If you activated a selection of documents, you can use the Only activated4.
documents function (You can turn this display of activated documents on or off at
any time later).

Click on OK and the interactive table window will appear, divided into two sections:

Interactive table window for categorizing survey responses

In the leftmost field of the window, you will see a reduced code system that displays
the selected question code. New categories can be inserted here as subcodes and then
assigned to the individual answers. The number at the end of the code line tells you
how often the code was assigned to the documents you are currently analyzing.

In the table immediately to the right, you see a list of the responses - each in a
separate line. The number of currently displayed lines, i.e. the responses to be
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categorized, is indicated in the upper right corner of the window. At the beginning,
this number corresponds to the number of people who answered the question.

The individual columns contain the following information:

Document – The source of the response.

Responses – The texts of responses of people who answered your survey.

Codes – A list of the codes assigned to the response or part of the response; only the
codes that are currently visible in the code system on the far left are listed here. The
question codes, whose answers are currently being evaluated, are never shown here.

Comments – Freely editable text field (up to 255 characters) for notes: useful for the
developing suitable categories.

Like all MAXQDA table widows, the individual fields can be adjusted: The columns can
be adjusted in width and position with the mouse or hidden with a right-click on a
column heading. A click on the heading sorts the column in ascending order, another
click in descending order.

Please note: All other MAXQDA functions are locked while the window for
categorizing survey responses is open.

Toolbar

At the top, you will see a toolbar with the following functions:

Quit – closes the interactive table window. Alternatively, you can also click
the X to close the window.

All codes – displays all your project’s codes. When turned off, only the selected
codes and subcodes are displayed.

New code – creates a new subcategory which can be used to categorize the
responses in the code system. The new categories are always added as the last
subcategory. Only subcodes to existing codes can be generated, no codes at the top
level.

Only activated documents– Only the answers of the currently activated documents
are displayed. The frequencies displayed in the code tree are adjusted accordingly.

Filter – applies filters, which are defined by right-clicking on a column heading and
selecting the Set Filter, to all columns.
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Reset all filters – removes all filters from all columns.

Display search toolbar – lets you to enter a search term to search for text in all or
specific columns.

Display parent code – in addition to the code, the "Codes" column also displays its
parent code.

Display comments – displays comments field.

Creating new categories

In order to categorize individual responses, you first need some categories, of course!
If you have already defined some or all of these categories before you begin your
analysis, you can define them as new subcodes of your question code.

Click on the symbol New code.1.
In the dialog window that appears, enter the code name. To better distinguish2.
between sub-categories, you can use assorted colors. You can also enter the
description of these categories (i.e. which responses they are applied to) into the
"Code-Memo" field.
Click Add code to create a second and third code, and so on. Click OK to finish3.
creating new codes.

Please note: All changes made to the code system in this window, including the
addition of new codes, are automatically incorporated into your overall “Code
System”.

If at the beginning of the analysis, you haven’t defined any categories are defined and
you would rather develop these from the material, you can start by reading some of
the responses and then create one or more suitable subcodes.

Tip: You can also use the comment column to collect ideas for categories for the first
few responses, and define appropriate categories after working through several of
them.

Assigning categories

To assign a response to a category, click and drag the row with that response to one
of the displayed codes in the hierarchical code tree. This allocation is immediately
displayed in the "Codes" column. To assign a category to only part of a response,
double-click on the text, select the desired portion of text, and drag it to one of the
categories in the code system. Even if you add the same code to multiple sections of a
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response, the code name is listed only once in the "Codes" column.

Assigning a category to part of a response.

Tip: By right-clicking on a row and selecting the function Create and apply new code,
you can directly add a code and assign it to the entire answer.

Removing assigned categories

To remove a category assigned to a response, click the cross that appears when you
move the mouse over a code in the "Codes" column. All allocations of the deleted
category will then be removed from the response.

Removing a category assigned to a response.

Customizing your categorization system

You can adapt your categorization system throughout the entire analysis process. You
can change the order of codes with the mouse as well as add subcodes. By right-
clicking on a code, all the functions from your "Code System" are available to
customize your code system in this window:

Delete code●

Sort subcodes (alphabetically or by category frequency)●

Change code color●

Create or edit code-memo●
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Click on a code in the code tree to list all your coded segments under this category
(the categorized answers to the survey question or parts of it). This way, you have an
overview of the contents of individual categories. The blue highlighted row in the code
system indicates which code is currently selected. The name of the selected code is
also displayed at the top left of the window.

Display contents of a category

Please note: The “Codes“ column always only shows the code names that were also
assigned to the selected code.

Working with comments

In the comments column, you can write a comment regarding each response.
Comments can be used to summarize long responses, ideas for new categories, or for
categories in the process of being developed. They are also good for noting notes
along the lines of "still unclear", “come back to this later" for hard-to-categorize
responses.

Double-click a cell in the "Comments" column to enter a new comment or edit an
existing one.

Comments are stored for the code selected in the "Code System" and are highlighted
in blue.

Adding a comment to a response.

Pausuing and restarting your categorizations

You can pause your current categorization at any time by clicking on the button Quit
or by closing the window. All your categorizations will be stored as codes in your
MAXQDA project.
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To pick up where you left off, restart the function via Analysis > Categorize Survey
Responses and select the code that contains the responses to your survey question.

Exporting your current display

 Open as Word document – Creates a temporary Word document and displays it in
the program to which this format has been assigned on your computer. To save the
created file permanently, you need to save it from Word to a different location.

Open as Excel spreadsheet – Creates a temporary spreadsheet in XLS / X format
which is opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

Export – MAXQDA creates a table as an Excel file (XLS / X format), as a web page
(HTML format) or as a text document (Word or RTF format) after you have entered a
filename and location. The exported file is opened immediately.
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22 - Frequencies

Frequency Tables and Charts for Variables
MAXQDA lets you create frequency tables and corresponding charts for document
variables, code variables and focus group speaker variables. You can open this
function from the ribbon menu:

Variables > Document Variable Statistics●

Variables > Code Variable Statistics●

Variables > Speaker Variable Statistics●

Variable Statistics options

After you click onone of the variable statistics options a split “Choice of Variables”
window is displayed below: Exisiting variables are listed on the left side; already
selected variables are moved to the right. The arrow buttons in the middle allow you
to transfer variables from one window to the other. You can also do this by double
clicking on the variable name.

Please note: To select multiple variables, hold down the Shift, Ctrl (Windows) or cmd
(Mac) key.
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Statistics and Graphics: Choose Variables

Please note: System variables that are created and managed by MAXQDA are marked
in red; codes that have been transformed into variables are marked in green.

Both lists can be alphabetized by clicking on the column headers. By selecting Only
activated documents you can limit the analysis to currently activated documents, for
example the transcripts of selected interviewees. The corresponding option Only
activated codes is also available for code variables.

Tip: The statistics functions for variables can also be accessed directly with the   icon
in the „List of document variables“ and „List of code variables“. MAXQDA then
begins the statistical analysis for the selected variables, taking all documents, codes,
and speaker into account that are visible in the data editor.

When you click OK MAXQDA will begin the statistical evaluation and display the
results as frequency tables and charts.

The results window displays the results of the first selection of variables in a table. The
“Frequency” column shows how many of the analyzed documents contain the
variable value in question.
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Frequency Table

Tip: Click on the column headers of the first two columns in order to modify the order
of the table rows. For example, you can sort the frequency of categories in ascending
or descending order.

The first column lists the various categories of the variable; the second column lists the
absolute frequency; and the third lists the corresponding percentages. The fourth
column shows percentages based on valid values, meaning missing values are
excluded. If there are no missing values among the variables in question, the
percentages of the third and fourth columns will be identical.

You can customize the order of the rows within the table by clicking on the column
header of the first and second columns. For example, you can sort the table in
ascending or descending order in regards to categorical frequency.

Toolbar functions

The results window has a toolbar at the top. From here you can:

Open the chart view by clicking the  button●

Flip forwards   or backwards , between variables●

Print results, or●

Export results as an Excel file●

Charts

When you switch to the chart view with the   button, a bar chart of the variables in
question appears in the place of the table view.



22 - Frequencies   619

Horizontal bar chart of the document variable “Age”

Note: The order of chart segments is determined by the order of the rows in the table,
and can be modified accordingly.

You will see two toolbars at the top of this window. The upper toolbar is the same as
the frequency table, and you can switch at any time to the table view. On the right
side of the toolbar you will see three buttons, with which you can choose between pie
chart, horizontal and vertical bar chart. The chart can be customized using the options
in the lower toolbar

Display labels – hide or show categorical labels of bar and pie charts on the x-axis.

Display data values – hide or show the data label, meaning frequency of variable
values or subcodes.

Display percentages – show relative, rather than absolute frequencies.

Display missing values – hide or show missing values category.

Display legend – hide or show the legend, which is switched “off” by default in
bar charts.

Display scale – hide or show the scale axis in bar charts.

Display title – hide or show diagram title.

Display text – hide or show textual description of diagram.
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One color – use the same color for all pie or bar chart segments.

Color gradient – add color gradient to pie or bar chart segments

Change color scheme – opens window for color scheme selection.

Customizing chart captions, colors and font sizes

When creating charts, MAXQDA sets an initial color scheme. To customize your charts,
double-click on the selected segment and choose your desired color. Click on the
Change color scheme  button to select between three preset color schemes.

Double-click on the title or description to customize content.

Formatting, such as font, font size and font style, can be changed via the dialog
window that appears when you right-click on the title, description or another label.

Modify color and font size in charts

Printing and export charts

Like frequency tables, charts can be printed and exported. Charts will be exported in
PNG format, or as vector graphics in SVG format.

Missing values in frequency tables and charts

MAXQDA will treat the following as missing variable values:
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For numerical and text variables, values set as “Missing values” in the “List of●

variables” will be treated as missing.
For text variables, blank fields will also be treated as missing.●

Descriptive statistics

When evaluating numerical variables the Descriptive statistics  symbol is appears in
the top toolbar. Clicking on the icon produces an output of the usual parameters such
including mean value and variance.

Frequency Tables and Charts for Subcodes
With MAXQDA you can create frequency tables and charts for subcode frequencies.
You can open this function in the ribbon menu via Codes > Subcode Statistics.

The split “Choice of Codes” dialog box: on the left side, all existing codes that have
subcodes are listed; on the right side your selected codes appear. In the middle, arrow
buttons allow you to transfer codes from one window to the other. You can also do
this by double clicking on a code. Click on the column header of either list in order to
alphabetize content.

Please note: To select multiple variables at once, hold down the ⇧ Shift key, or Ctrl key
(Windows) or cmd key (Mac)
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Statistics for subcodes: choose codes

For codes containing subcodes, this function can also be called up directly from the
Code System. Right-click on the code and select Statistic of subcodes. In this way, you
can also access the statistics functions for codes that are not at the top level of the
code system.

The analysis can be restricted to currently activated documents and subcodes. To do
so, check the appropriate boxes.

Selecting units of analysis for statistical evaluations

At the bottom of the screen, you will find options for the unit of analysis. The
following options are available:

Documents (count all subcodes) – This option corresponds, in principle, to an
evaluation of multiple responses. In this case, the analysis is performed assuming that
when several subcodes can be coded in a document, the subcodes are not mutually
exclusive. MAXQDA analyzes the number of documents to which a subcode has been
assigned. All subcodes that occur in a given document will be counted, on a per-
document basis. This type of analysis would typically be employed to answer the
question "What percentage of cases (= documents) mention the theme (= code) XY
?".

Documents (count most frequent subcode only) – In this case, the analysis is
performed under the assumption that subcodes are mutually exclusive, meaning that
subcodes can be interpreted as categorical variables. On a per-document basis, only
the subcode that occurs most frequently is taken into account. If two or more
subcodes occur with the same frequency within a document, a new “not defined”
category will appear.

Coded segments – This option analyzes the number of coded segments per subcode.

Please note: Regardless of which unit of analysis is selected, not only the direct
subcodes of the selected parent codes, but also the subcodes of subcodes, will be
included in the analysis. All lower-level codes will be aggregated with the top-level
code, and only this code will be displayed in the results table.

Once you click OK, MAXQDA begins the statistical calculation, after which the results
will be displayed as frequency tables and diagrams.

The window shows the table view of the first selected variables:
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Frequency Table

The first column of the table lists the different subcodes of the table; the second
column, the absolute frequency; the third column, the corresponding percentages. The
fourth column shows the percentages based on valid values, meaning documents
without analysed codes are not taken into account. If there are no missing values, then
the percentages will be identical in the third and fourth columns.

Tip: Click on the column headers of the first two columns in order to define row order.
For example, you can sort in descending or ascending order of category frequency.

Table values

The meaning of the table values depends on which unit of analysis has been selected:

Unit of Analysis: Document (count all subcodes) – The table will show the number of
documents in which the respective subcode was assigned. For each document, all
subcodes that occur in the document will be counted. At the end of the table, the
number of documents is displayed in which none of the analysed subcodes occur.

Unit of Analysis: Document (count most frequent subcode only) – The table will show
the number of documents in which the respective subcode was assigned. Subcodes
are mutually exclusive. For each document, only the most frequently occurring
subcode will be counted. At the end of the table, the number of documents is
displayed in which none of the analysed subcodes occur.

Unit of Analysis: Coded Segments – The table will show how often a subcode was
assigned, meaning how many coded segments exist for this code.

Example: We are analyzing how the code "people" was assigned in 7 interviews in a
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MAXQDA project. The code has the subcodes "Partner", "Siblings", "Parents", and
"Friends". If we create a Subcode Statistics table with the unit of analysis "Coded
Segments" the result table lists how often each of the subcodes was used across all of
the 7 interviews. See below how many of the total 40 coded segments fall into which
subcode. 

Unit of Analysis: Coded Segments

If you instead select the unit of analysis "Document (count most frequent subcode
only)" a new column "Percentage (valid)" is displayed. As you can see below 5 of the
analyzed documents don't have any of the subcodes in question assigned to them.
The last column calculates the percentages based only on the 5 documents with any of
the selected subcodes. The first line tell us, that in two documents the subcode
"Partner" is the most frequently assigned subcode. For another two document the
subcode "Siblings" is the most frequent subcode and in one document "Parents" is
the most frequently assigned subcode.

Unit of Analysis: Codument (count most frequent subcode only)

If you select the option "Document (count all subocdes)", MAXQDA counts for each
subcode, in how many of the documents it occurs. Once again you can see that only
five of the documents have any of the subcodes assigned to them. The subcode
"Parents" occurs in five documents, the subcode "Partner" occurs in three
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documents, and so on. The percentage columns shows how large the percentage of
documents with the subcode in question is.

Unit of Analysis: Codument (count all subcodes)

The following table explains the structure of the last table schematically:

Subocde "A" Number of documents in which Code "A" occurs.

Subcode "B" Number of documents in which Code "B" occurs.

Subcode "C" Number of documents in which Code "C" occurs.

DOCUMENTS with code(s)
Number of documents in which at AT LEAST ONE of
the analyzed subcodes occurs.

DOCUMENTS without code(s)
Number of documents in which NONE of the analyzed
subcodes occurs.  

ANALYZED DOCUMENTS Number of documents total.

Toolbar functions

You will see a toolbar at the top of the results window. Here you can:

call up charts by clicking the  icon●

flip forward  or back  between main codes●

print results, or●

export results as an Excel file or as a Website in HTML format.●

Charts

Once you have switched to the Chart view by clicking on the  icon, a bar chart of
the selected subcode appears in the place of the table view.



22 - Frequencies   626

Horizontal bar chart representation for the subcodes of the “World Problems” code

Please note: The order of columns, bars and segments is determined by row order in
the frequency table.

You will see two toolbars at the top of this window. The upper toolbar is the same as
the frequency table, and you can switch at any time to the table view. On the right
side of the toolbar you will see three buttons, with which you can choose between pie
chart, horizontal and vertical bar chart. The chart can be customized using the options
in the lower toolbar.

Display labels – shows categorical labels of bar and pie charts on the x-axis.

Display data values – shows the data label, meaning frequency of variable values or
subcodes.

Display percentages – shows relative, rather than absolute frequencies.

Display missing values – shows missing values category.

Display legend – shows the legend, which is switched “off” by default in bar
charts.

Display scale – shows the scale axis in bar charts.

Display title – shows diagram title.



22 - Frequencies   627

Display text – shows textual description of diagram.

One color – use the same color for all pie or bar chart segments.

Color gradient – add color gradient to pie or bar chart segments

Change color scheme – opens window for color scheme selection.

Customizing chart captions, colors and font sizes

When creating charts, MAXQDA sets an initial color scheme. To customize your charts,
double-click on the selected segment and choose your desired color. Click on the
Change color scheme  button to select from among three preset color schemes.

Double-click on the title or description to customize content.

Formatting, such as font, font size and font style, can be changed via the dialog
window that appears when you right-click on the title, description or another label.

Customize color and font size

Please note: When window size is modified, font size will be automatically modified
accordingly.

Printing and exporting charts

Like frequency tables, charts can be printed and exported. Charts will be exported in
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PNG format, or as vector graphics in SVG format. In Windows, the vector format EMF
is also available, which can be enlarged without quality loss and can be easily imported
into Microsoft Office programs.

Code Frequencies
You can always see how many segments and how many documents were coded with
selected codes as a table and diagram. Since the documents often correspond to
specific cases (e.g. interviews), the following function can be used to quickly analyze
for how many cases a particular topic has been coded.

Follow these steps:

Activate the documents you want to include in your analysis. If you want to include●

all the documents, you don’t need to activate anything.
Start your analysis via Analysis > Code frequencies.●

The following dialog window will appear, to which you can drag the codes to be●

analyzed from the "Code System" using the mouse. To insert more than one code,
you can activate it at any time and then use the Add activated codes The Only for
activated documents option is automatically selected if documents were activated
when the function was opened. Deselect this option to analyze all documents
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Analyze codes for the analysis of code frequencies

After clicking OK the following frequency table will appear, which shows in how many
documents the code occurs.

Documents per code

Frequency table: documents and their respective codes

The bottom three rows contain the following information:

DOCUMENTS with code(s) – refers to the number of documents in which at least one
of the analyzed codes occurs.

DOCUMENTS without codes – refers to the number of documents in which none of
the analyzed codes occur.

ANALYZED DOCUMENTS – refers to the sum of the two numbers directly above and
gives the number of all analyzed documents.

In the first row of the table above you can see that the “Emotions“ code occurs in 8
documents, which comes to 24.2% of the analyzed documents.

Segments per code

If you click on the blue arrow in the toolbar, MAXQDA switches the display to
"segments with code". Segments are then counted rather than documents. The
results table shows how many segments the listed codes have been assigned to in the
selected documents.
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Frequency table: segments with codes

In the second line of the table you can see that the "Emotions" code has been
assigned to 22 segments within the analyzed data. This corresponds to 26,2% of the
analyzed coded segments.

Code frequencies displayed as a chart

By clicking on the chart symbol in the upper left corner, the currently displayed
frequency table can be displayed as a bar, column or circle chart. Refer to the 
Frequency Tables and Subcodes section for further information on charts.

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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Code frequencies as a chart

Export and print code frequencies

The current display can be printed and exported via the usual symbols on the top right
corner of the window.

Copy to clipboard - copies the current status to the clipboard to allow you to then
paste it into a report, presentation or graphics software.

Print – displays the printing dialog window for the currently displayed window.

Export – In the table view, you can export the table to an Excel spreadsheet (XLS /
X format) or a webpage (HTML format). A graph file is exported in PNG or SVG
format. The EMF format is also available under Windows. Both the SVG and the EMF
format are well-suited to being used for large posters due to their lossless scalability,
but the SVG format cannot be directly imported into Microsoft Office products.

Code Coverage: Extent of Code
Assignments
With the help of the code coverage function, you can find out to what extent the
document has been coded with particular code. Code coverage comparisons can be
applied to multiple documents, document groups and document sets. For texts, coded
symbols (including spaces) are compared, in images the coded area, and in videos the
coded time.

Starting the function

Follow these steps to define your code coverage:

First, activate the documents and the codes that you want to include in the analysis.1.
If you want to analyze all documents and all codes, you do not need to activate
anything.
Click on the Code Coverage function in the Analysis tab and select in the appearing2.
menu whether you want to analyze (a) texts, tables or PDF documents (b) images,
or (c) videos.
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Select the “Code coverage“ function in the Analysis tab

Please note: The “Images“ function also includes image codes in PDF documents, and
the “Videos” function includes audio files.

The following dialog window will then appear in which you can choose to split the3.
results by document, document group, or document set.

Selecting whether to compare documents, document groups or document sets

The results table for two coded videos, for example, could look like this:

Code coverage:  Results table for a coded video
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The results table displays the documents, document groups or document sets in the
columns, and the selected codes in the rows. In the cells, the extent of the document
which is coded with a code with be given as a percentage. In the example above, you
can see that 50% of video recording in "Class 6a" was coded with the code "group
work", whereas in "class 6b" this percentage came only to 34%. The drop-down
menu allows you to define what results are displayed in the cells:

Percentages: none – the absolute numbers are displayed, i.e. the coded characters
including spaces (in texts), the coded area (for pictures) and the coded time (for
videos).

Percentages of “coded“ – the result cells indicate what percentage of the coded
length, area, time of the document was coded with the given code. The sum of the
percentages will exceed 100% if the analyzed codes overlap each other at points in
the document.

Percentages of entire text/entire image/entire video – the result cells indicate what
percentage of the entire document was coded with the respective code. So here it
does not matter how much of the text document, image or video was coded overall.
The sum of the percentages exceeds 100% if the evaluated codes overlap each other
at one or more points in the document.

Row percentages – the result cells indicate what percentage of all evaluated
documents, document groups or document have been coded with each respective
code. Each row then indicates how the coded segments are distributed as a
percentage of the individual documents, document groups or document sets.

The three rows on the bottom end of the table are always displayed and contain the
following information:

NOT CODED – provides the length/area/time of the document, document group or
document set that has been coded with none of the currently displayed codes.

CODED – provides the length/area/time that has been coded with any of the currently
displayed codes.

TOTAL TEXT / AREA / TIME – provides the total extent of the document, document
group or document set.

Toolbar

A toolbar with the following functions is located at the top of the "Code Coverage"
window:
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 Only activated documents – restricts the display of the columns to currently
activated documents.

 Only activated codes – restricts the display of rows to currently activated codes.

No color highlight – turns off color highlighting of the result cells.

Color highlight refers to columns – the column with the highest value is dark
green, that with the smallest is white. The closer a value is to the highest value, the
darker its green highlight.

 Color highlight refers to rows – the row with the highest value is dark green, that
with the smallest is white. The closer a value is to the highest value, the darker its
green highlight.

 – in this drop-down menu, select the values to be
displayed. When starting the function, “percentages of coded" is automatically
selected.

 Show decimals – for easier readability of the percentages, decimal places are
switched off by default and can be displayed via this symbol.

Chart view – creates a frequency table with the calculated values for each column.
The frequency table can be turned into a diagram to visualize these results.

Exporting results tables

The current view of the result table can be exported using the usual icons on top right
of the window. When the highlight is turn on, this is also included.

 Copy current display as an image to clipboard – copies the currently visible table
as a graphic to the clipboard so it can be pasted directly into a publications or
presentation.

Export – MAXQDA creates a spreadsheet as an Excel file (XLS / X format), as a
webpage (HTML format) or as a text document (RTF format) after you have entered
filename and location. The exported file is immediately opened.

Displaying results tables as a chart

Your results can be displayed as frequency table or as a chart. In the "Percentage"
column, the percentages are displayed relative to the total area, in the column
"Percent (Valid)" relative to the encoded area.
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Clicking on the diagram symbols above the frequency table show a vertical or
horizontal bar chart, or a pie chart. By activating the missing values, the graphic
figures show the percentages related to the total area.

Code coverage: results table for coded videos

Refer to section Frequency Tables and Charts for Subcodes for information on creating
and customizing charts.

Code Configurations: Analyze Code
Combinations
Code configurations enable you to examine the co-occurrence of codes in a document
or segment; They are particularly suitable for analyzing code combinations. Code
configurations can effectively support a multi-dimensional analysis as well as the
formation of types through identifying patterns.

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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In the case of the Simple Code Configurations, you select individual codes for the
analysis. In the case of Complex Code Configurations, you select parent codes whose
subcodes are evaluated. Let us look at an example of how code configurations may be
used in your analysis:

Example

Imagine you have carried out a video analyses in several situations in a kindergarten, to
determine which games are played by which teachers with which children. Each
analyzed situation is entered as a separate document in the Document System, and in
the Code System there are three parent codes for your three analysis dimensions, each
with three subcodes:

Parent code 1:
Which teacher

Parent code 2:
Which child

Parent code 3:
Which game

Ms. Mathilde
Mr. Wolters
Ms. Berkempers

Finn
Mareike
Joshua

A ball game
Knight’s castle
Board game

Simple Code Configurations are especially suited to analyzing combinations of
subcodes within one dimension. The results table has the following structure:

Finn Mareike Joshua Segmente

x x  5

 x x 3

x  x 2

Selected codes form the columns and the combination of these codes are marked with
a symbol (here an “x“). In the last column, you can see in how many segments the
combination occurs. For example, you can see in the first row of the table that the
game between Finn and Mareike occurs in 5 segments. The remaining rows reveal that
it never occurred that all three children played together as a group, since there is no
row with an x for each row.

The number of documents can also be displayed in lieu of the number of segments.

Complex Code Configurations are particularly suited to the analysis of interrelationship
between several dimensions. The results table has the following structure:

Which teacher? Which child? Which game? Segments

Ms. Mathilde Finn Ball game 10

Mr. Wolters Mareike Knight’s castle 6
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Mr. Wolters Joshua Ball game 3

The columns contain the parent codes, i.e. the analyzed dimensions. The cells contain
the subcodes, i.e. the manifestations of each individual dimensions. In the last column,
MAXQDA displays in how many segments of your data material the three subcodes of
each respective row co-occurred. So, in the first line, you can see that a ball game
between Ms. Mathilde and Finn occurred in 10 situations.

The number of documents can also be displayed in lieu of the number of segments.

Analyzing simple code configurations

To perform a simple analysis of code configurations, select the following function:
Analysis > Code Configurations > Simple Code Configurations.

A dialog window will appear into which you can drag-and-drop codes from the "Code
System" with your mouse. Alternatively, the activated codes can be transferred to the
selection window by clicking the Add activated codes button.  The Remove code(s)
button can be used to remove selected codes from the selection window again.

Selecting codes for simple code configurations

Units – Selecting the unit “Segments” analyzes in how many segments within your
data these codes co-occur. By selecting “Documents”, it doesn’t matter where the
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codes occur in your documents; what is important is that the code occurred in the
documents at all. With the unit “Documents”, it is irrelevant if the code occurs
multiple times in a given document – one occurrence is sufficient to be counted.

Differentiation – Here, you determine whether the results table should be divided into
documents, document groups, or document groups. This allows easy comparison of
cases or groups of cases. If you selected "Documents" as your unit, you cannot select
a breakdown by document.

Selecting the option Only activated codes, restricts the analysis to activated
documents.

Click OK to start the analysis and MAXQDA will produce the following results table:

Simple Code Configuration: Results table when choosing segments as your unit

The first columns of the results table are headed with the names of the selected codes
and provide information on the occurrence of the respective codes. If the code occurs
on a segment, a blue square is shown in the column. Each line contains a different
combination (or "configuration") of the analyzed codes.

In the upper right corner of the window, you will find information on how many
combinations actually occurred in the evaluated documents and - behind them in
brackets - how many could maximally have occurred.

Please note: If a combination of codes does not exist, this row will not be listed in the
table. Only the segments with at least one of the selected codes have been analyzed.
So, when the unit "Segments" is selected, rows that do not contain any of the
evaluated codes will not be displayed.

The "Segments" column indicates the number of times a particular combination
occurs in the documents analyzed. The "Percent" column contains the corresponding
relative frequency. The second row in the table above shows that Finn and Mareike
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have played together in 5 situations (corresponding to 25% of the analyzed
segments).

The "Number of codes" column displays how many codes occur in that combination.
As the table above never displays 3 in this column, one can conclude that no situation
has been observed in which all 3 children played together.

If you selected a differentiation for documents, document groups or document sets,
additional columns are added for each selected unit at the end of the table - in the
example above for the two documents "Day 1" and "Day 2". The display in the
columns can be switched between absolute numbers and row or column percentages
with the three symbols in the toolbar. In the above table, the column percentages are
selected so that the results for the individual documents can be directly compared with
the values in the "Percent" column.

Please note: If you selected Documents as your unit, the results table is displayed as
follows:

(1) In the results table, the column headed "Segments" with corresponding to the
numbered unit is instead headed "Documents". It specifies how many analyzed
documents contain the respective combination of codes.

(2) If there are documents that do not contain any of the analyzed codes, the results
table will contain a row without blue squares.

(3) A "Detailed View" table is also displayed in which you can see which combination
of the selected codes is contained within each document. The table basically
corresponds to the "Code Matrix Browser" visual tool, with interchanged rows and
columns.

Analyzing complex code configurations

To perform a complex code configuration, select the following function: Analysis >
Code Configurations > Complex Code Configurations.

A dialog window will appear, into which you can drag-and-drop parent codes from
the “Code System“ with your mouse.  MAXQDA then automatically lists their
respective subcodes from which you can exclude individual subcodes from the analysis
by unchecking their selection box.
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Selecting codes for complex code configurations

The settings in this dialog window are the same as described above for the simple
code configurations.

Click OK and a MAXQDA will produce the following results table:
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Complex code configuration: Results table when choosing segments as your unit

The first columns contain of your selected parent codes. Each line contains a
combination of the subcodes, and the "Segments" column tells you how often these
combinations occur in your data. For example, from the first line of the above table,
you can see that Ms Berkempers plays the game of a “knight’s castle" with Joshua
seven times. This accounts for nearly 26% of all your coded observations.

At the right side of the table, MAXQDA will display columns containing frequencies in
the individual documents, document groups, or document sets, if you selected to
analyze them. The values in these additional columns can be switched to column
percentages or line percentages.

Toolbar

Am oberen Rand befindet sich eine Symbolleiste mit folgenden Funktionen:

 Filter – applies the filters you can define by right-clicking on the column heading
and selecting Set filter.

Reset all filters – removes filters from all columns.

 Statistics – displays the results as a frequency table. This frequency table can also
be switched to a chart to visually display the results.

Number – the additional columns with documents, document groups or document
sets will display their absolute numbers.

Row percentages – the additional columns with documents, document groups or
document sets will display their row percentages.

 Column percentages –  the additional columns with documents, document groups
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or document sets will display their column percentages.

Interactive results tables

The code configuration tables are arranged according to combination frequencies - by
clicking on a column header, this arrangement can be adjusted. The order of the
table’s columns can be changed by clicking and dragging the header with the mouse.

Tip: The result tables of the simple and complex code configurations are interactive. A
double-click on a line with a code combination lists all associated coded segments in
your "Retrieved Segments" window.

Exporting results tables

The current display can be exported using the usual icons at the top right of the
window. The selected rows are always exported - if no rows are selected, the entire
table is exported.

  Open as Excel spreadsheet – Creates a temporary spreadsheet in XLS / X format
which is opened with the program associated with this format on your computer. To
permanently save this file, you must save it in another location on your computer.

  Open as HTML spreadsheet – Creates a temporary HTML spreadsheet which is
opened in your default browser. To permanently save the created file, you must save it
in another location on your computer.

  Export – MAXQDA creates a table as an Excel file (XLS / X format), as a web page
(HTML format) or as a text document (Word or RTF format) after you have entered a
file-name and location. The exported file is opened immediately.

Displaying results as a chart

A click on the chart symbol on the top left will display the current table as a horizontal
or vertical bar chart or as a pie chart. If you selected "Documents" as your unit, you
will see in the  row, the number of analyzed documents in which none of the
respective codes occur. Refer to the section Frequency Tables and Charts for Subcodes
for information on creating and customizing charts.

https://m22.maxqda.com/help-mx20/statistics-and-graphics-functions/frequency-tables-charts-subcodes
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Simple code configuration for segments as a vertical column chart
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23 - Report & Export

Smart Publisher for Coded Segments
Smart Publisher is a convenient report generator. It exports selected retrieved
segments in a formatted Word document report, including title page and table of
contents. The structure of the report is determined by the “Code System:”

An individual chapter will be created for each top-level code.●

A subchapter will be created for each subcode.●

Coded Segments of each code form the content of each (sub)chapter.●

Opening the Smart Publisher

Smart Publisher can be accessed via the main ribbon menu: Reports > Smart Publisher.

Opening Smart Publisher

When Smart Publisher is called up, a dialog window will appear in which you can
select the codes to be included in the report. When top-level codes are selected, their
corresponding subcodes will automatically be included in the report. You can also
choose to include coded segments only from activated documents.
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Selecting top-level codes for Smart Publisher

Smart Publisher settings

The following dialog window displays the various report options:
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Smart Publisher settings

“Title“ settings

Title – The title, which will appear on the first page of the report.

Subtitle – The subtitle, which will appear on the first page of the report.

Image files 1 and 2 – Selection of up to 2 image files, which will appear on the first
page of the report. If the field is left blank, no image will appear.

”Header and Footer” settings

Reports can be formatted to include headers and footers, which will appear on each
page after the title page.

Header – Header text
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Footer – Footer text

“Options” settings

You can limit the output to segments where a weight was assigned in a defined
area.<

Comment – Below a coded segment, its comment is also output.

Use code alias instead of code name – The code alias will be used in the place of the
code name as a heading, if defined for the respective code (see Creating a Code Alias).

“Coded Segments sorted by” settings

In this part you can set how the coded segments within each chapter of the report are
sorted. You can sort segments by their documents position in the ”Document Sysetm”
or by their assigned weight scores.

“Source information” settings

In the “Source information” you will find numerous options for the information to be
included for each coded segment.

Document – Displays document group and document name.

Position – Displays the beginning and the end of the coded segment (as well as
paragraph numbers for textual data).

Weight Score – Displays the weight of the coded segments.

Created by – Displays the name of the user who coded the segments.

Creation date – Displays the date on which the segments were coded.

Quotation marks – text segment will be placed in quotation marks

The following figure shows an extract from a report that was generated using Smart
Publisher. The displayed segment comes from the paragraphs 35-36 of the document
“Jon” from the document group “New York.” It was encoded with a weight of 100.
The segment was assigned the code “Significantly Positive:”

https://m22.maxqda.com/help-mx20/codes-2/the-properties-window-for-codes
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Extract from a Smart Publisher report

The report

The finished report is in the form of a Word document (for Windows in DOCX format,
for Mac in RTF format), which includes a title page, table of contents, a page that lists
of all the documents included in the report, and the main section including all of the
exported segments. If a header/footer was included, it will appear on all pages aside
from the title page. If an end page was included, it will appear at the end of the
report.

All elements of the report are formatted using the Word template (DOT format).
Formatting of the final report can be modified; for example, you can easily insert
additional pages or content.

Alias names for codes

Smart Publisher uses the code names from the “Code System” as headings for the
individual subchapters of the report. However, you may wish to assign an alternate
name to some or all of the subchapters in the report. This may be the case if the 63
characters per heading allowed by the system are not enough, and you wish to create
a longer name, or if, in other cases, a shorter heading would be more appropriate. For
this reason, MAXQDA allows you to create a “code alias” of up to 225 characters.

In order to assign a code alias, right-click on the code in the “Code System” and select
“Properties”. A dialog window will appear, in which you can enter the code alias.
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Assigning a code alias in the Code properties window

From the menu Codes > Code alias table you can call up a table, in which you can
conveniently create code aliases for multiple codes, and can see for which codes a
code alias has been assigned.

Code Alias Table

Adjusting the Smart Publisher layout

It is possible to customize the layout of Smart Publisher reports. To do this, you will
find a settings file in the MAXQDA installation folder, the contents of which you can
customize. The file is located in the subfolder "Resources\Docx2HtmlConverter":

Windows: local installation

C:\Programs\MAXQDA2020\Resources\Docx2HtmlConverter

Windows: portable installation on USB stick

(Flash Drive)\MAXQDA 2020\Docx2HtmlConverter
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Mac: local installation

Applications folder > Right-click on MAXQDA2020.app > Show Package Contents:
Contents / Resources / Docx2HtmlConverter

Mac: portable installation on USB stick

USB Flash Drive > MAXQDA 2020 Portable for Mac > Right-click on
MAXQDA2020.app > Show Package Contents:
Contents / Resources / Docx2HtmlConverter

The file in which you can change the appearance of all used styles is "SP_Formats.ini".
The structure for each element is as follows:

[Default_Format]

StyleName = "MQ_Header1"
FontName="Calibri"
FontSize = 11
LineSpacing = 1.2
SpaceAfter = 6
Indent = 12.5

For example, to use your the font that is used in your corporate design, change the
entry next to FontName from "Calibri" to the appropriate text font.

Codebook with Category Definitions
The “Export Codebook" function allows you to automatically generate a Codebook –
i.e. a category manual. The codebook lists all or selected codes in the order of the
Code System and also outputs the associated code memo for each code. The
completed Codebook therefore contains the category definition of each individual
code, provided that this was recorded in the code memo. This saves a lot of work in
the creation of the annex for a research report, especially since it provides the
opportunity to unify the font for all memo text.

The Codebook is created in Word document format and can therefore easily be
opened with word processing programs. It includes a cover page with the title
"Codebook", the project name and the creation date. On the following page, the
Code System is listed in a table. In the main section, the respective codes with their
associated memos are listed in the order of the Code System.
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The Codebook function is accessed through the menu Reports > Codebook. A
window will appear in which you can specify the Codebook options in more detail.

Setting options for the Codebook

In the top section of the window, you can specify which codes should be included in
the Codebook.

Only codes with code memos - Set this option to exclude codes that have no memo in
the codebook.

Only top level codes - If you select this option, only the codes in the top level of the
Code System, with their associated code memos, will be included. Subcodes will not
be included.

Only activated codes - In this case, only activated codes will be included in the
Codebook. You can decide whether (inactivated) subcodes should also be included:
Include subcodes. This option is not available if you have selected Only top level codes.

Other options can be set in the lower section:

Standardize memo fonts - If the font, font size, etc. varies between memos, they can
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be uniformly displayed in the Codebook using this option.

Number Codes - If this option is selected, the listed codes will be numbered according
to their hierarchy in the Code System.

Include parent code in code name - If this option is selected, the code path will be
specified as a heading for the subcodes.

Export code system with frequencies - If this option is selected, a column containing
the code frequency will be added in the table overview of the code system.

After confirmation, select a name and location for the file before the Codebook is
created and opened.

Summaries with Coded Segments
You can always create a report in Word-format (DOCX), which will display your
compiled summaries together with the corresponding coded segments in a table
overview.

Follow these steps to create the report:

Click on the Summaries with Coded Segments symbol in the Reports tab and select1.
the menu option Summaries with Coded Segments.
A dialog window will appear with several options.2.
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Options for creating a report of your summaries with coded segments

Only for activated documents – only summaries from activated documents are
included.

Only for activated codes – only summaries for activated codes are included.

Include comments – under the coded segments, the corresponding comments (if any)
are also included.

Standardize text formatting – given that coded segments can be formatted very
differently, you can use this option to standardize the font format.

Click OK and enter a name and location for the report. MAXQDA opens the●

exported document immediately.

Report: “Summaries with Coded Segments“

For each selected code, your report will display the coded segments of the selected
documents in one column and the summaries in another column. You can use this
examine these summaries and review each of them with reference to their underlying
coded segment. The report presents your summaries in a transparent and
comprehensible way.

Reports: Summaries – without coded segments

You can also create reports that only present your summaries: Reports > Summaries
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with coded segments > Summaries. The “Coded segments“ column is not displayed –
only the codes and their respective summaries.

Report Summaries

Export documents
You can export your documents in various ways, for example, for documentation
purposes. There are three places in MAXQDA where you can start the export process:

Every opened document can be exported directly from the "Document Browser" by●

clicking on the  icon top right.
If you right-click on a document name in the "Document System", you will find the●

entry Export Document in the context menu. The same applies to a document group,
where you can use Export Documents to initiate the export process for all the
grouped documents.
In the Reports menu you can find an Export option, which contains an extensive●

menu for exporting individual data from MAXQDA, including the options to export
single or multiple document:
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Export options in the „Reports“ menu

If you select All Documents or All Activated Documents, you have to select a folder in
your file system where you want MAXQDA to save the documents. Document groups
are saved as subfolders.

Export transcripts with paragraph numbers, coding stripes and memos

For the documentation of a research paper with interviews, it's often necessary to
include selected or all transcripts of the finished publication. To this end, MAXQDA
offers you the option not only of exporting the pure transcripts as text files, but also of
exporting the paragraph numbering, the code assignments made and any attached
memos with the transcripts and saving these as PDF files:

To export individual transcripts, right-click them in the "Document System" and●

select Export Document from the context menu.
To export several transcripts simultaneously, select Export Documents from the●

context menu of a document group.

The following dialog box will appear:
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Transcrip export options

The following settings are available for exporting text documents:

Export as PDF document / Text document / Excel document - Sets the export format.
To include coding stripes and memos with the export, you need to select the PDF
document option.

As table with paragraph numbers - Each paragraph of the text is written in a separate
row of the table and the paragraph number is added in the first column (this option
can only be selected when exporting as a text document - it cannot be combined with
the visualization of codes and memos).

Export timestamps - If the document contains timestamps (e.g. an interview
transcript), you can export these timestamps. The start point of the corresponding
section is added at the beginning of the respective section.

Visualize coded segments - The coding stripes are placed to the left of the text (this
option can only be selected when exporting as a PDF document). Only those code
assignments are exported that are currently selected in the "Document Browser" via
the display menu for the coding stripes. The colored background of texts is also
included.

Visualize memos - If this option is selected, the memo symbols are displayed to the left
of the text. The memo text itself is not exported.

Width of the coded segments' column - Defines how much space should be used for
the display of the coding stripes and memos.
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The listed export options are not available for PDF, image and table documents - these
are saved as they are stored in the MAXQDA project file.

Project Information
The function Reports > Project Information collects information about the current
project and shows the completed report in a separate window. Specifically, Project
information contains the following data :

Report date●

Name of the MAXQDA project file●

Project Memo (from the root of the Document System)●

Number of document groups, document sets, and the individual document types●

Number of codes, coded segments, and code sets●

Number of memos●

Number of document and code variables●

Number of internal links●

Project information can be copied to the clipboard with the Copy button, and from
there transferred into another program such as Word.

Project information
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Print Preview
You can start a print process from within lots of functions and windows in MAXQDA.
A preview window will appear that allows to set borders, headers and footers etc.

For some functions – e.g. when printing the document displayed in the „Document
Browser“ window“ – some additional settings are offered in the left window pane.

Overview of Import and Export Options
MAXQDA offers a variety of options for exporting data to other software programs
like SPSS or Microsoft Office programs.

The following table lists many, but not all, possibilities for trasnferrring your data.

Data Type Option in MAXQDA Format
Single document Right-click on Document Name and select

Export Document

Click on the Export icon in the "Document
Browser"
Texts can be highlighted in the "Document
Browser" with Ctrl+A (Windows) and
cmd+A (Mac) and exported via the
clipboard

DOCX for texts, XLSX
for tables, PDF for
PDF files and original
image formats for
images
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Highlighted
segments in a text,
table or an image

Ctrl+C (Windows), cmd+C (Mac) in the
"Document Browser" window or right-
click on the highlighted segment and select
Copy to copy the selected segment to the
clipboard

Object in the
clipboard

One or more coded
segments

In the "Overview of Coded Segments", for
example, select segments with Ctrl or cmd
and a mouse click and then select an
export variant or copy it with Ctrl+C or
cmd+C to the clipboard.

XLS/X, DOCX, HTML,
RTF, clipboard

All coded segments
in the “Retrieved
Segments” window

Reports > Export > Retrieved Segments or
with the icon in the “Retrieved Segments”
window

 XLS/X, DOCX,
HTML, RTF, clipboard

Coded segments for
a single document
(teamwork)

Right-click on the document and select
Export teamwork

.MEX (internal
format)

Memos Export in the Overview of Memos DOCX, RTF, XLS/X,
HTML

Memos for a
document (for
teamwork export)

Right-click on the document and select
Export teamwork

.MEX (internal
format)

Memos for a
document

Right-click on the document and select
Overview of Memos

DOCX, RTF, XLS/X,
HTML

Text of a memo Copy to clipboard with Ctrl+C or cmd+C
or the Export icon in the Memo window

Windows clipboard

List of variables Variables > List of Document Variables or
List of Code Variables and then click on the
Export icon in the toolbar.

.HTML, XLS/X

Variable table
(export)

Variables > Export Document Variables or
Export Code Variables or click on the
Export icon in the “Data editor”

XLS/X, SPSS, TXT
(tab-delimited), RTF,
DOCX

Variable table
(import)

Variables > Import Document Variables or
Import Code Variables

XLS/X, SPSS, TXT
(tab-delimited), RTF,
DOCX

Variables & variable
values for a
document
(teamwork)

Right-click on the document and select
Export teamwork

.MEX (internal
format)

Export variable values
for a document

Right-click on a document, select Overview
of Variables, and click on the Export icon in
the toolbar

XLS/X, SPSS, TXT
(tab-delimited),
DOCX, RTF
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Code frequencies
table

Visual Tools > Code Matrix Browser and
click the Export icon

or

Highlight the cells of the table that you
want to copy and hit Ctrl+C or cmd+C to
copy them to the clipboard

Table: XLS/X, HTML,
DOCX, RTF, DOCX
Image: PNG, SVG

Code frequencies Reports > Overview of Codes and click the
Export symbol

XLS/X, HTML, RTF,
TXT (tab-delimited)

Exporting project components as Excel files

One possibility for exporting is worth noting in particular. If you select the following
option in the ribbon menu, Reports > Export > Project Components as Excel File,
MAXQDA will generate an Excel file that lists the following contents in the individual
tables of an Excel file:

"Document System" with code frequencies●

"Code System" with code frequencies●

Memos●

Coded segments●

Document Variables and their values●

Code Variables and their values●

Links●

Summaries●

Anonymize Projects
If you have sensitive data in the text documents of a project, you can save it
anonymously as a project copy. A prerequisite is that the sensitive text areas have been
coded with a specific code. When saving, all texts that have been coded with this code
are replaced by XXX and rendered anonymous. If different codes have been used for
different types of information, these code names can all be added to the anonymous
text list, e.g. "People", "Places" and "Jobs".

Follow these steps:

Start the function by going to Home > Save anonymized project as. MAXQDA will●

then display the following dialog window:
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Options dialog window for the selection of codes, the texts of which should be anonymized

Drag all the codes, the texts of which should be anonymized, from the Code●

System“ into the dialog window.
Select the option Include code name to show the codename in brackets at the●

beginning of each anonymized text area. This is useful, for example, if you have used
several specific codes for the anonymized texts ("person", "place", etc.). If more
than one of the selected codes has been assigned to one text, only the name of the
parent code is displayed.

The project copy can then be passed on to others. The anonymized text locations in
the project file look like this:

Anonymized project with the selected “Display code name“ option

Please note: This function only works for text documents, not to PDF files or other
document types.
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Export and Import REFI-QDA Projects
“The REFI-QDA Standard enables interoperability between Qualitative Data Analysis
Software (QDAS or CAQDAS) programs. Its purpose is to enable users to exchange
processed data between programs. It is an open standard and any program can
implement it, thus increasing the number of software programs that can ‘talk’ to one
another.” (www.qdasoftware.com).

The REFI-QDA Standard makes it possible to exchange projects between all software
packages that support the XML exchange format. Software vendors include Atlas.ti,
f4Analyse, NVivo and QDA-Miner. MAXQDA supports both exporting a MAXQDA
project in the developed XML exchange format and importing a project from such an
XML file.

The REFI-QDA Project file contains specifications for the following MAXQDA
components:

Documents and document groups●

Codes●

Internal links●

Memos (and log book)●

Coded segments●

Comments assigned to coded segments●

Document variables (or more precisely: document group variables, which do not exist●

in MAXQDA)

The REFI-QDA Project file does not contain specifications for the following MAXQDA
components:

Document sets●

Table documents●

Summaries●

Paraphrases●

Complex concept maps●

Code variables●

Speaker variables●

Stopp lists (word clouds and MAXDictio)●

Dictionaries (MAXDictio)●

The exchange possibilities are therefore limited, because the REFI-QDA Project does
not support all elements from all software packages. Even if it would support all
elements, it should also be noted that, the project logics of the individual software

http://www.qdasoftware.com/
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packages differ and therefore complex projects can never be transferred one-to-one.
Additionally, not all QDA programs support all elements, for example not all programs
support working with PDF files.

The format is therefore not suitable for a teamwork situation where multiple
researchers work on the same project data with different software packages.

Note: The same initiative also developed the "REFI-QDA Codebook" standard for the
exchange of codebooks (with code tree incl. memos). This standard has been
supported since MAXQDA version 2018.1 and is available via the menu functions
Codes > Export/Import Code System.

Import a „REFI-QDA Project“

How to import a REFI-QDA Project into MAXQDA:

Click on Open Project - either in the Start dialog that appears immediately after1.
MAXQDA starts, or in the Home tab if you have already opened a project in
MAXQDA.
In the appearing file dialog, select an REFI-QDA Project file and click2.

Important notes for importing:

Text documents are imported as plain text.●

Annotations of coded segments (comments) are shortened to 255 characters.●

Memos which are assigned to the whole project are imported as free memos.●

Coded text segments in PDF files are imported as coded image segments.●

Document group classifcations, and variables are not imported●

Audio and video files are copied to the external files folder and have an empty●

transcript. Any existing associated transcripts are imported as separate document.

Export a „REFI-QDA Project“

To save the opened MAXQDA project in the REFI-QDA-Project format with the file
extension .qdpx, click on Save Project As in the Home menu and select "REFI-QDA
Project" as the file format.

Important notes for exporting:

The export includes text documents, PDF documents, images, audio, and video.●

Text documents are exported as plain text.●

PDF text codings are not exported●

In-media codings are not exported●
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Transcripts with linked media files are not exported (remove linked media before●

exporting and manually transfer and re-link media files)
Focus group speaker codes and their segments are not exported. Paraphrase codes●

and their segments are not exported. Emoticode codes and their segments are not
exported.
The project memo, all code set and document set memos are exported as „free“●

notes.
Document variables are exported as case variables.●

The QDPX file that is created during the export contains all documents of the project
including externally saved files as well as linked audio and video files. The export
process may therefore take a while and the resulting file can be quite large.

Archiving for data reuse
To enable the reuse and sharing of research data, MAXQDA allows you to easily
generate a back-up of the data of a project with one click, via the Archive Data
function. A clear and easy to understand folder and file structure is created containing
all collected data, optionally as a compressed ZIP file. The intention behind the Archive
Data function is to make the data collected in research projects and the related
metadata available to the scientific community and other interested members of the
public in a simple data format that can be easily viewed and does not require training
or the purchase of specialized software. The data is therefore available in standard
formats such as DOCX (Word), PDF, XLSX (Excel) and MP4 (video).

When archiving the data associated with a MAXQDA project, the data is always
exported in the form of documents (interview transcripts, field notes, PDF documents,
focus group transcripts, etc.), the structure of the project's document groups being
adopted as the folder structure. Optionally, the following data can also be exported:

Statistical data (document variables with standardized information)●

Media data (audio and video files attached to documents)●

Metadata (memos from the "Document System", which usually contain information●

and documentation on the project and the data collected)
Overview of themes (the code system including code memos)●

Starting the data archival process

To archive the data of your open project, choose the Archive Data entry in the Home
tab. The following option dialog window will appear:
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Archiving project data for reuse: Options dialog window

At the top, select which data (in addition to documents) you want to export:

Statistical data (variables) – Integrates document variables into the exported archive.

Media data (audio and video files) – Integrates not only the transcripts, but also the
associated audio and video files in the exported archive.

Meta data (memos in “Document System“) – Integrates memos assigned to
documents and document groups as well as document sets into the exported archive.
The project memo, at the top of the "Document System", is also exported.

Themes (code system) – Integrates your code system into the exported archive.

There are two more options in the lower section:

Only activated documents – Restricts the export to the currently activated documents.

Compress into single file (ZIP) – If this option is selected, the archive is not stored in a
single folder, but in a single compressed ZIP file, using the folder structure described
below.

Click OK and you will be given the option to select a folder in which the archive should
be stored.

MAXQDA then exports all selected data according to the following system:

In the Documents folder, all or only the activated documents (if so selected) are●
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saved in their respective format. The structure of the subfolders corresponds to the
project's document groups. Text documents are exported in DOCX format, table
documents in XLSX format and image documents in their respective original format.
The Statistical data folder stores the data table and the "List of Variables", both in●

Excel and SPSS format. Of the system variables, only the document group and the
document name are exported.
Audio and video files associated with the documents are stored in the Media data●

folder, also in their "Document System" structure. The media file is given the name
of the document to which it is attached.
Information on the collected data is stored in the Meta data folder. These are the●

following memos from MAXQDA: the project memo that is attached to the root
folder in the "Document System" and the memos attached to document groups and
documents. Only the memo texts and memo titles are exported, but no further
information about the memos. The memos are also stored in the structure given by
the "Document System": the project memo and the document group memos at the
top level, then the document memos in their respective folders. If there are no
memos in a document group, a subfolder is not created.
The code system is saved as an Excel file under the name "Themes.xlsx", including●

attached memos, at the top folder level.
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24 - Teamwork

How Does MAXQDA Support Teamwork?
In the context of scientific research, the evaluation of documents is often a collective,
rather than individual endeavor. This raises the question how MAXQDA allows for
teamwork.

This teamwork is possible in three principle forms, depending on how the team
members want to work together.

Handing over a complete MAXQDA project to another team member – Different●

people work with the same master version. They perform online searches, text
retrievals, and other kinds of analysis with this master version. But, they do not
perform code and memo procedures simultaneously on the master version. The
MAXQDA project is therefore passed from team member to team member, each
time for further processing.
Exchanging coded segments, memos, summaries, etc. of a single document,●

document group or entire project among team members– A MAXQDA project with
all the documents to be processed is duplicated for each team member. Each
member works on a pre-arranged part of the project, for example only segments
coded with selected codes, or only certain documents. At the end, the coded
segments, memos, etc. are transferred from the respective projects into a master
project.
Merging MAXQDA projects – Members of the team edit the documents of a●

MAXQDA project in collaboration. For example, team member A codes as document
1 to 4 team member B codes documents 5 to 8, and team member C edits
documents 8 to 12. Each member is working in a separate project that contains only
the documents that he or she is responsible for. At the end, all three projects are
merged.

MAXQDA also offers additional functions that are useful for teamwork:

MAXQDA allows you to assign rights for individual users. For example, you can set it●

up such that others cannot make changes to text documents to ensure that everyone
is always working with the same data body.
Finally, there is a function that checks for intercoder matches. MAXQDA helps you to●

check and improve the quality of your coding work by comparing yours with other
members in your team.

Important: MAXQDA is a single-user, not a multi-user program. Simultaneous use of

https://m22.maxqda.com/help-mx20/teamwork/transferring-a-maxqda-project-to-other-team-members
https://m22.maxqda.com/help-mx20/teamwork/transferring-coded-segments-memos-variables-etc-from-one-project-to-another
https://m22.maxqda.com/help-mx20/teamwork/transferring-coded-segments-memos-variables-etc-from-one-project-to-another
https://m22.maxqda.com/help-mx20/teamwork/merging-two-maxqda-projects
https://m22.maxqda.com/help-mx20/teamwork/calling-activating-user-management
https://m22.maxqda.com/help-mx20/teamwork/problem-intercoder-agreement-qualitative-research
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the same project file at the same time is not possible. Various people cannot make
changes to the same file at the same time.

The sort of functionality that is currently available in MAXQDA does not blend with the
logic of multi-user software. A typical example of a multi-user program is the kind
used by airlines for flight bookings. Such programs only work when one user’s ability
to change something requires that the other users be given read-only permissions.
MAXQDA, though, is set up so that a user can write or change a memo, modify coded
segments, etc. at any time. All of these functions would be limited – if not made
impossible all together – with a multi-user system. For these reasons, one has to
accept that simultaneous work by various team members on the same project file is
not possible. MAXQDA does, though, make it easy to separate a project into various
files, have team members work on them at the same time, and then later bring them
together in one file.

Transfer a MAXQDA Project to Other Team
Members

In this form of collaborative teamwork, the entire study is transferred as a MAXQDA●

project from one computer to another, ensuring that all team members are always
working from the same database. Two people can never simultaneously code
different documents of the study or create memos on different computers. However,
all evaluation work in which no new codings are made, no new memos are written
and no variable values are changed, are of course possible without any problems
simultaneously.
The transfer of MAXQDA projects is very easy: MAXQDA saves all aspects of the●

project in a MX20 file. If you name a project “Interview Study” it will be saved on
your computer as “Interview Study.mx20.”

The project file contains all … The project file does not contain …
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• Documents
• Codes
• Memos
• Variables
• Coded segments
• Summaries
• Document links
• Text links
• External links
• Diagrams made in MAXMaps
• Similarity and Distance matrices
• The MAXDictio dictionary

• External documents (e.g. PDF files, images, audio
and video files)
• Externally saved geographical references (KML
files)
• Saved search formulas (SEA files = search files)
• Saved selections for logical activations and other
 mixed methods functions (LOA files = LOgical
Activation files)
• Saved Code Systems in MTR format

The project file can be transferred to other team members in the form of a single file.
It can also be sent by email. It can also be saved in the shared folder of a cloud system,
such as Dropbox or Onedrive.

If the MX20 project file is opened on any other computer where MAXQDA 2020 is
installed, the entire project appears with all its components.

If you want to set up the project, so that various members of the team can work on it
at the same time, it is recommended that you start by importing all documents into a
MAXQDA project on one computer, and then sending a copy of that file to everyone
in the team. This saves you the work of importing the files on each individual’s
computer and guarantees that everyone will have the exact same data set.

Sharing projects that include external files

If you have assigned audio or video files to documents in your project, or if image or
PDF documents were not imported into the project, they are stored in the MAXQDA
folder for external files (you can customize this folder in MAXQDA's preferences via
the gear symbol at the top right edge of the window).

How to exchange all files of a project between teammates including the externally
stored files is described in detail in the section External Files on the subheading "How
to transfer external files from one computer to another?".

Transfer Coded Segments, Memos,
Variables, etc. Between Projects
Quite often, teamwork starts as follows: researchers work on the same data in parallel

https://m22.maxqda.com/help-mx20/import/external-files
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- each on their own project file on their own computer. One person only assigns
selected codes to the data, for example, the other only processes selected documents.
Both use already existing codes and add new codes, write new memos, paraphrases
and summaries. In these cases, MAXQDA allows you to transfer the codes, codes,
memos etc. from one project file to another.

Of course, this teamwork presupposes that everyone is working with the same data
material. To make sure this is the case, it is best to import the existing data (e.g.
documents, variables, interview notes as memos etc.) into a MAXQDA project file on a
computer and then distribute the project file to all team members. Of course, it often
makes sense to define already fixed categories as codes in the "Code System".

Please note: The team members can change the order of the documents in their
project files and also add further documents. Transferring color assignments to
documents is also straightforward. However, you should neither change document
names nor edit the imported texts.

In principle, we are dealing with the following situation, where for the sake of
simplicity in the example we are assuming that we are working with only two
MAXQDA projects. The procedure is basically the same with three, four or more files.

Exemplary initial situation (differences between projects are printed in italics)

In the example, interview 4 is only available on computer 1, interview 5 only on
computer 2. The set of documents does not have to be completely identical in the
sense that all documents of one project must also be available in the other.
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Neither does the code system have to be identical. Though, of course, in a research
group you should make sure that the same category, i.e. the same code, always has
the identical name and hasn't been given a different name by different team
members.

Tip: Of course, the projects don't have to be stored on different computers. It is not a
problem if they are stored on the same computer.

How does the transfer process work?

Suppose "Interview 1" was coded on computer 1 by colleague 1 with added memos.
How can you now make the results of this work accessible to colleague 2 on computer
2, especially if colleague 1 on computer 1 redefined some codes during their work and
colleague 2 also continued working on the project file separately?

This it how it works in MAXQDA: colleague 1 exports all the relevant information to be
transferred from their project file into a MAXQDA exchange file with the extension
"MEX" and sends this file to colleague 2. Colleague 2 then imports that information
into their own project file.

Teamwork export and import procedure

You will recognize a MEX file by the double arrow in the file symbol and by the file
extension MEX. The abbreviation MEX stands for MAXQDA EXchange format.

Teamwork export: saving data to an exchange file

To start the export process, select Teamwork > Teamwork Export: Export Data to
Exchange File in the Analysis tab.
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Start Teamwork Export

A dialog box will then appear in which you can select the following options a step at a
time.

Select your codes and documents

First select the documents whose data you want to export. In the dialog box, you can
select individual documents or all documents in a document group or document set at
once. It is also possible to select the documents you activated before starting the
export procedure.

After clicking on Next >> a dialog box for the code selection will appear. At the
bottom, you will see how many codes are currently selected and how many coded
segments occur in the previously selected documents.

Select documents (left)
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Select codes (right)

Assign a file name and select a storage location.

Clicking Next >> will assign a file name and select a storage location. MAXQDA will
then export all the data (codes, code assignments, memos, variables, summaries,
paraphrases etc.) of the selected documents into the export file.

Importing the exchange file into the target project

You can import the exchange file data into any MAXQDA project that has the same
text (in this example "Interview 1").

Select Teamwork > Teamwork Import: Import Data from Exchange File in the Analysis
tab. A dialog box will appear that guides you through the import process a step at a
time:

First select a MEX file. MAXQDA will analyze the file and then display the following:1.
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Teamwork: Import data
In this dialog box, you have to check the correspondence between the source and
target texts. If the texts in the MAXQDA projects have the same name, all you have
to do is double check the automatic allocations made by MAXQDA. If the texts
have different names, you have to allocate each text to the appropriate matching
text yourself.
If the document does not yet exist in the project, you can select the <New
Document> option to import the document from the exchange file. You can
deselect a document in the first column if necessary - it will then be ignored during
the import process.
When you click Next >> the following dialog box will appear for the code selection.2.
New codes, i.e. those that do not yet exist in the opened project, will be
immediately recognizable by the green font in the displayed list of codes.
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In the dialog box, select all the codes that you want to import.

Select codes
In the third step, select the data you want to import. MAXQDA only displays the3.
data types in the dialog box that are contained in the MEX file. You can deselect
individual elements, such as variables or paraphrases, to ignore them during the
import process. The other options determine how conflicting code assignments are
to be dealt with - these are described in more detail below.
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Options for the teamwork import
Click Import to start the import process.4.

Please note: Before MAXQDA starts the teamwork import process, a backup of your
opened project's status is automatically saved to your backup folder. The import
process cannot be reset by clicking on the Undo arrow in the upper right corner of the
window.

Code conflicts

When importing a code, it may happen that the same code has already been assigned
to the corresponding segment. This segment may also have other segment boundaries
than the code you want to import. Since the rule in MAXQDA is that a segment in a
document can only be coded once with the same code, you can use the pop-up menu
to specify which segment boundaries should "win" during import process:

Overwrite existing segment boundaries with imported ones – This is the default●

selection: in the case of a conflicting code assignment, the segment boundaries of
the imported coded assignment override those in the opened project file.
Preserve existing segment boundaries – In the event of a conflict, the existing coded●
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assignment "wins", i.e. no changes are made to the segment boundaries.
Use outer segment boundaries of the code assignments – In cases of conflict, the●

outermost segment boundaries of the two code assignments are used.
Use inner overlapping area of code assignments – In cases of conflict, only the●

overlapping area of the two code assignments is taken as the coded segment.

Each code assignment in MAXQDA also includes a comment and a weight. In the
event of a conflict, you can instruct MAXQDA whether the existing comments and
weights should be retained or overwritten by the imported ones:

Overwrite existing comments with imported comments – When this option is●

activated, the comment of the imported coded segment always "wins", that is, it
overrides the comment in the opened project file. If the imported coded segment has
no comment, this is ignored, i.e. an existing comment is never overwritten by an
empty comment.
Overwrite existing weights with imported weights – If this option is enabled, the●

weight of the imported coded segment always "wins".

When importing summaries, you can also control how MAXQDA should proceed if a
summary already exists for a document in a code:

Do not change existing summaries – With this setting, only those summaries are●

imported that were empty in the project file. In case of a conflict, the imported
summaries are ignored and not imported.
Overwrite existing summaries with imported summaries – With this setting, in the●

event of a conflict, the summaries already existing in the project are deleted and
overwritten by the imported ones.
Add imported summaries to existing ones – In case of a conflict, the imported●

summaries are added to the existing summaries.

What exactly happens during the import process?

Code assignments:

All code assignments already present in the document are retained or adapted●

depending on the option selected.
Previously non-existing code assignments are inserted into the opened project.●

If a coded segment with a code or subcode not yet contained in the "Code System"●

is found in the exchange file, this code is inserted into the "Code System" at the
corresponding position. Codes with the same name at the same position are
considered identical, but their color is irrelevant.

Memos:

https://m22.maxqda.com/help-mx20/summary-grid/idea-behind-summary-grid
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All in-document memos are imported (exception: memos at the same location with●

the same title).
Document memos in the "Document System" are only imported if there is no memo●

in the document yet. Existing document memos remain unaffected.
Code memos are dealt with in the same way.●

Paraphrases:

A paraphrase to be imported is ignored if a paraphrase already exists at the same●

location in the current project.

Variables:

Variables that do not yet exist in the list of variables are added and their values are●

imported.
Existing variables are overwritten with the value from the import file.●

Start your teamwork in the "Document System"

You can also start the export for a document, document group or document set
directly in the "Document System". To do this, right-click an entry and select
Teamwork > Teamwork Export: Export Data to MAXQDA Exchange File from the
context menu.
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Start teamwork export for “Interviews New York“ from within the “Document System”

In the picture you can see that you can open the complementary function Teamwork
Import for a document, a document group or a document set directly in the
"Document System" context menu.

Merge Two MAXQDA Projects
Another teamwork feature in MAXQDA is the option to merge two projects. The
“Merge projects” function causes all elements of a second project to be added to a
project you currently have open. To do this, follow these steps:

1. Open one of the two projects you want to merge.

2. Choose Merge projects from the Project menu tab.

3. Select the second project from the dialog window, which will be in the form of an
MX20 file.

The following dialog window will appear:

Options for merging projects

Because a MAXQDA project can contain only one project memo, one memo per code,
and one Logbook, you can choose, in the top section, what content should be kept
and what should be overwritten. When the default settings are left as is, the existing
data in the already opened project will remain unchanged.
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In the bottom section, two options are available that allow you to determine how
MAXQDA should handle documents whose identical name already exists in the
project.

Don’t import already existing documents – When the projects are merged, by default,
all documents from the imported project are inserted into the open project. When you
select this option, already existing documents will be ignored, thus not imported. For
example, if the open project contains the document group “Interviews” with
documents A, B, and C, and the imported project contains the document group
“Interviews” with the documents A, B, and D, document D will be imported and
inserted into a second document group. Documents A, B, and C will be ignored.

Merge document groups with same name – This option is available only when the
previous option is selected. In this case, no further document groups with the same
name will be created, and the imported documents will be integrated into the already
existing document group. This means if the document group “Interviews” with
documents A, B, and C already exists, only document D will be imported.

When you click OK, MAXQDA then starts the merging process, which may take some
time, depending on the size of the two projects.

Please note: Before merging the projects, MAXQDA automatically creates a backup of
the current project in the selected backup folder.

The merge function is carried out in the following manner:

All document groups of the imported project will be inserted with their documents,●

possibly generating duplicates. If a text group entitled “Interviews” exists in both
projects, the resulting merged project will have two text groups of this name. The
options above can be set so that already existing documents are ignored and so that
no duplicate document groups are created.
All memos of both projects will be inserted.●

Coded segments will be merged; in the case that a code or subcode does not exist in●

the new project, it will be created. Codes with the same name and same position will
be considered identical; their color is not relevant.
Summaries will be imported.●

All internal and external links will be imported.●

Maps in MAXMaps will be imported and added to the existing maps.●

Each variable will be analyzed to determine if it already exists in the project.●

- If the variable does not exist in the open project, a variable of that name will be
created. The variable values of the documents in the open project will be set to 0 or
to the preset missing value for numerical variables, or empty for text variables.
- If a variable exists with another type declaration, it will be created. Suppose the
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open file contains the text variable "marital status" and the file to be added contains
a numerical variable of the same name. The result is that after import two variables
entitled "marital status" will exist; for the old project the numerical variable will be
set to 0 and for the new project the text variable will be left blank.
Codes that have been transformed into variables will be ignored.●

Intercoder Agreement
When assigning codes to qualitative data, it is recommended that certain criteria be
set. You assume, for example, that coding is not arbitrary or random, but rather that a
certain level of reliability will be reached. The MAXQDA Intercoder Agreement
function makes it possible to compare two people coding the same document
independently of each other. In qualitative research, the purpose of comparing
independent coders is to discuss the differences, figure out why they occurred, and
learn from the differences in order to improve coding agreement in the future. In
other words, the actual percentage of agreement is not the most important aspect of
the tool. This percentage is, however, provided by MAXQDA.

It is always the goal of qualitative analysts to achieve as high a level of agreement as
possible between independent coders. It is not, however, focused on getting to a
standard coefficient that is statistically necessary as in quantitative research. Rather,
the focus is on a practical improvement of the coding quality. For this reason, one
doesn’t focus on the coefficient or percentage of agreement (i.e. the percentage of
matching code assignments). Instead, qualitative researchers want to address and edit
the code assignments that do not match, so that they can move on with more
accurately coded material.

The intercoder agreement procedure

Checking the intercoder agreement involves the following:

Two coders process the identical document independently and code it according to●

mutually agreed code definitions. This can be done on the same computer or on
separate computers. Of course, it is important that both coders cannot see what the
other person has coded.
The two identical documents coded by different coders must be contained in the●

same MAXQDA project. The documents must have the same name, but must be in
different document groups or document sets!

The following procedure is recommended:
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Create a project with the documents to be coded. The documents must be1.
contained in one or more document groups; or, alternatively, one or more
document sets.
Make sure that the necessary codes are included in the "Code System".2.
Make a copy of the project file and pass it on to the second coder.3.
Both coders write their names behind all document groups or document sets.4.
Both coders independently code the data and add new codes if necessary.5.
Use the function Start > Merge Projects to merge both projects into one. The6.

"Document System" will look like this: 
Now MAXQDA's Intercoder Agreement function can be used to compare the code7.
assignments.
Once the comparison is complete, these added documents can be deleted.8.

Opening the Intercoder Agreement function

You can start the procedure via Analysis > Intercoder Agreement to check whether
two coders agree or disagree in their assignment of codes.

Starting the Intercoder Agreement function via the Analysis menu

The following dialog box will appear, in which you can adjust the settings for checking
the intercoder agreement.
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Options for testing intercoder agreement

Select the document group or document set with the document assigned to Coder 1●

in the upper drop-down menu and the document assigned to Coder 2 in the lower
drop-down menu.
You can limit the analysis to the currently activated documents and/or codes by●

selecting the appropriate options.
In the lower area you can choose between three alternative analysis levels:●

Option 1 (document comparison level): Code occurrence in the document

The criterion is the occurrence or absence of a code in the document (i.e.: code occurs
vs. code does not occur). This option can be useful, for example, if you are working
with relatively short documents, such as free text responses to a survey, and with a
large number of codes.

Option 2 (document comparison level): Code frequency in the document

The criterion is the frequency of the occurrence of the code in the document; more
precisely, the match (agreement) frequency of the assignment of the code.
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Option 3 (segment comparison level): Min. code intersection rate of X%
at the segment level

The system checks whether the two coders "agree", that is, whether they match in
their coding of individual segments. This option is the most advanced of the three and
is the most commonly used option for qualitative coding. A percentage value can be
set to determine when two coded segments are considered to match.

Since texts in qualitative analysis processes are not often subdivided into fixed text
units, the system checks the correspondence for each segment coded by the two
coders (Analysis: Segments of Both Documents). This means that each coded segment
is analyzed for a match. Alternatively, you can choose to analyze only the segments of
document 1 or the segments of document 2. This can be helpful, for example, to test
the extent to which one coder matches a reference example for code assignments.

Results for option 1 "Code occurs in the document".

MAXQDA generates two tables, the "code-specific results table" with the analyzed
codes and the "result table" with detailed information on each compared document.

The code-specific results table

The "code-specific results table" lists all evaluated codes and indicates for how many
documents the coders match in their assignment of the code:

Code-specific results table for the option “Code occurs in the document”

The example table indicates on the top right that a total of 6 codes were analyzed.
There was disagreement (indicated by a stop sign in the first column) only for the code
"Resource scarcity ...", and only within one document (indicated by the column "No
Agreement"). The numbers in the Agreement, No Agreement, and Total columns refer
to the number of documents.
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The "Percentage" column indicates how high the percentage agreement is in relation
to the respective code. The <Total> line is used to calculate the average percentage
agreement - in the example, it is 94.44%.

The detailed result table with evaluated documents

The result table lists all evaluated documents and thus provides detailed information
on the agreement of individual documents.

Results table for the “Code occurs in the document” option

The table has the following structure:

The first column displays a green symbol if Coders 1 and 2 have assigned the same●

codes to the document. In this case, there are no "disagreements" and the
percentage agreement is 100%.
The "Agreement" column displays the number of code assignments that match●

between Coder 1 and Coder 2 for this document.
The "Percentage" column displays the percentage agreement (i.e. the relative●

number of matching code assignments). The percentage agreement is calculated as
follows: Matches / (Matches + Non-Matches). For Interview 3, the example shows a
value of 6 / (6+1) codes = 85.71 % - this is the proportion of codes that match in
Interview 3.
The last column indicates a kappa value that contains a random correction for the●

level of agreement (calculation: see below).
The last line "<Total>" adds up the matches and mismatches. The number in the●

"Percentage" column corresponds to the average number of matching codes, in the
example it is 95.24 percent.

The header contains further information:

On the left you can see the number of code assignments carried out by the two●

coders, which can often already give first indications of the same or different coding
behavior. In the example, one coder has coded 12 segments and the other has
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coded 14.
The number of analyzed documents and the relative number of identically coded●

documents are shown on the right: In the example these are 2 of 3 documents,
corresponding to 66.67 %.

In addition to the usual MAXQDA functions for opening the function again and for
filtering and exporting the results, the toolbar also contains the following important
tools:

Display only disagreements – Hides all matching rows and provides quick access to
documents where the coders do not match.

Ignore unassigned codes / Count unassigned codes as matches - Here you can decide
whether any given codes that were not assigned by both coders, should be considered
as matches or should be ignored. The difference can explained using the following
table:

Coder 1 Coder 2 Agreement?

Code A X X yes, always

Code B X no, never

Code C depending on selected option

Code C was included in the intercoder agreement check but was neither assigned by
Coder 1 nor by Coder 2 in the document. In this case, if you select the option Ignore
unassigned codes, code C will be ignored and the relative number of matching code
assignments is 1 of 2 = 50%. If the other option is selected, the match is 2 of 3 = 67
%, because code C is taken into account.

Interactive results table

The results table is interactive. Double clicking on a row opens the Code Matrix
Browser for the relevant document:
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Testing the occurrence of codes in two documents with the Code Matrix Browser

The title bar shows the compared document, in the example "Interview 3". The view
immediately shows where the two coders disagreed: Coder 1 has assigned the code
"scarcity of resources ...", but Coder 2 has not.

Kappa calculation (Rädiker & Kuckartz)

In the "Kappa (RK)" column, the results table indicates a randomly corrected value for
the percentage agreement. It takes into account the probability of two people
randomly selecting and assigning the same codes in a document (if they simply
randomly selected codes without considering the data material). The calculation only
makes sense if you select the option Count unassigned codes as matches and is
therefore only visible if this option is selected.

Kappa (Rädiker & Kuckartz), abbreviated to Kappa (RK), is calculated as follows:

Ac = Agreement by chance = 0.5 to the power of the number of codes selected for
analysis
Ao = Agreement observed = percentage agreement
Kappa (RK) = (Ao – Ac) / (1 – Ac)

The random correction is generally very small, because the probability for the random
match very quickly becomes negligible with an increasing number of codes.

Results for option 2 "Code frequency in the document"

With this analysis option, agreement is deemed to apply when two coders have
assigned a code with the same frequency in the document. The difference between
the frequencies is irrelevant: if one coder assigns a code A once and the other three
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times, or if the difference is once vs. six times, both situations are always considered to
be a disagreement.

The results for this second analysis option corresponds, in principle, to the first option -
with the following exceptions:

Code-specific results table: The number of documents for which the frequencies per●

code is a 100% match is displayed in the cells.
Results table with analyzed documents:●

The cells indicate how many codes were assigned equally frequently by botha.
coders in the document.
The "Kappa (RK)" column is never displayed.b.
Double-clicking on a row also displays the Code Matrix Browser. Here squaresc.
of different sizes now indicate the differences in the coded characteristics of the
clicked document.

Results for option 3 „Min. code intersection rate of X% at the segment
level“

With this option, the system checks at the segment level whether the codes match. If,
for example, Coder 1 has coded 12 segments and Coder 2 has coded 14, then 26 test
operations are performed and the detailed results table includes exactly 26 rows.

It is often the case that coders deviate slightly from each other when assigning codes,
e.g. because a person has coded one word more or less. This is usually irrelevant in
terms of content, but can lead to an unnecessarily small percentage match if
absolutely identical coding is required, and lead to "false" non-agreements.

You can therefore specify in advance in the options dialog box when two code
assignments are to be treated as as a match. The criterion used is the percentage of
the intersecting area of two code assignments. The following question is answered:
How large is the intersecting area of two code assignments in relation to the total area
covered by the two code assignments with their outermost segment boundaries?

The entry is made as a percentage and the threshold value can be set in the dialog
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box. The default value is 90%, but can be set higher for testing purposes and then
reduced step by step if there are too many "false alarms".

Here, too, two results tables are generated: the code-specific results table and the
detailed agreement table.

The code-specific results table

The Intercoder Reliability results for the individual codes (segment comparison level)

This table has as many rows as the number of codes included in the intercoder
agreement check. Codes that were not assigned by either of the two coders are
ignored. The table provides an overview of the matches (agreements) and non-
matches (disagreements) in code assignments between the two coders. It also
indicates where the weak points are, i.e. for which codes the desired percentage
agreement is not achieved.

Each code indicates the total number of segments coded (Total column), the number
of matches (agreements), and the code-specific agreement percentage. In the <Total>
row, the (non-)matches are added so that an average percentage agreement can be
calculated. In the example, this is 71.43%.

The detailed results table with analyzed segments

The second table allows for an exact inspection of the intercoder agreement, i.e. it is
possible to determine for which coded segments the two coders do not match.
Depending on the selected setting, the table contains the segments of both coders, or
only those of one coder, and indicates whether the second coder has assigned the
same code at this location.
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The Intercoder Reliability results for all coded segements

Agreement in the assignment of a code to a given segment is indicated by the green
symbol in the first column. A red icon in this column indicates that there is no
agreement (no match) for this segment.

Tip: Clicking on the first column header sorts the column so that all red rows in the
table are listed at the top and you can inspect and discuss any discrepancies step by
step. By clicking on the  icon, only the problematic segments are displayed.

Interactivity of the Results Table: Compare Segments

The results table is interactively linked to the original data and allows for a targeted
inspection of the analyzed segments:

Clicking on a row highlights both associated documents in the "Document System"●

and opens them by default in their own tabs, highlighting the clicked segment. In
the toolbar you can change the setting from Display in two tabs to Display in two
document browsers - then the document coded by "Coder 2" will be displayed in a
separate window. This option is especially useful if you are working with two
screens.
Double-clicking on the small square in the "Coder 1" or "Coder 2" columns focuses●

the corresponding document in the "Document Browser" at the location of the
segment in question. This makes it easy to jump back and forth between the two
documents and judge which of the two coders applied the code according to the
code assignment guidelines.
If you click on a row with your right mouse button, a context menu will appear as●

shown in the picture above, allowing you to transfer the code assignment, or lack
thereof, from one document to the other directly. For example, select the option
Adopt the solution of Coder 1.
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Coefficient Kappa for exact segment matches

In qualitative analysis, the analysis of intercoder agreement serves primarily to improve
coding instructions and individual codes. Nevertheless, it is also often desirable to
calculate the percentage of agreement, particularly in view of the research report to be
generated later. This percentage of agreement can be viewed in the code-specific
results table above, in which individual codes as well as the ensemble of all codes are
taken into account.

Researchers often express the desire to indicate not only percentage compliance rates
in their research reports, but also to include chance-corrected coefficients. The basic
idea of such a coefficient is to reduce the percentage of agreement to that which
would be obtained in a random assignment of codes to segments.

In MAXQDA, the commonly used coefficient “Kappa (Brennan & Prediger, 1981)” can
be used for this purpose: In the results table, click on the Kappa symbol to begin the
calculation for the analysis currently underway. MAXQDA will display the following
results table:
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Intercoder coefficient Kappa (Brennan & Prediger, 1981)

The number of codes that match is displayed in the upper left corner of the four-field
table. In the upper right corner and the lower left corner you will find the non-
matches, meaning one code, but not the other, has been assigned in a document. In
MAXQDA, the intercoder agreement at the segment level takes into account only the
segments to which at least one code has been assigned; therefore the cell on the
lower right is, by definition, equal to zero (as document sections will be included in the
analysis only if they are coded by both coders).

"P observed" corresponds to the simple percentage of agreement, as it was displayed
in the "<Total >" line of the code-specific results table.

For the calculation of "P chance", or chance of agreement, MAXQDA employs a
proposal made by Brennan and Prediger (1981), who dealt extensively with optimal
uses of Cohen's Kappa and its problems with unequal edge sum distributions. In this
calculation, the random match is determined by the number of different categories
that have been used by both coders. This corresponds to the number of codes in the
code-specific results table.

Please note: If the coders have assigned the same number of codes to a segment and
two or more codes have been analyzed, you should include the Kappa value listed in
the results in your report of publication. If the coders have assigned a different number
of codes to a segment or only one code has been analyzed, you should include the
second Kappa value listed in the results.

Prerequisites for the calculation of randomly corrected coefficients such as
Kappa

For the calculation of coefficients such as Kappa, segments must normally be defined
in advance, and are provided with predetermined codes. In qualitative research,
however, a common approach is that not to define segments a priori, but rather to
assign the task to both coders of identifying all document points that they view as
relevant, and to assign one or more appropriate codes. In this case, the probability that
two coders code the same section with the same code would be lower, and hence
Kappa would be greater. One could also argue that the probability of randomly
occurring coding matches in a text with multiple pages and multiple codes is so
insignificant that Kappa corresponds to the simple percentage agreement. In any case,
the calculation should be carefully considered.
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User Access Management
MAXQDA supports teams working on projects with an optional user management
system, in which you can set different rights for different groups of users.

Please note: The admin system is not designed to ensure secure of your projects, just
for working together in teams.

To activate the user management system, select Home > Teamwork > Activate User
Management from the ribbon menu.

Activating user management

The user who activates the user management will automatically become administrator
and has to set a password for his/her username.

Set admin password

Caution: Note your password carefully! Without this password, the MAXQDA project
can no longer be opened.

Once the administrator has been established, user management can only be opened
with a valid administrator name and password. The next time the project is opened a
login window will appear and you'll be prompted for a valid username and password.
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Login window

In the default configuration, only administrators are able to open the user
management, add users or change rights.

The User Management window

In the main user management window, you can create new users, remove existing
users, and define the rights of individual user groups.
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Main user management window

On the left side of the user management window, the various levels (Admin and Levels
1-3) are displayed. The right side of the window contains information about each user,
which can be created or edited here; it is also here that users can be assigned to one
of four user groups.

Adding a new user

Click on the Add user  button to add a new user. The new user settings can
subsequently be edited:

User: Here you can set the username (= Login name), with which the user can log into
the project.

Group: Here you can set the level within the hierarchy to which the user is assigned.

Name: Here you can enter the user's real name.

Comments: In this field, you can post comments regarding the user.
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The properties of a user can be modified at any time by clicking on the username in
the left side of the window.

Deleting users

To delete a user, select the username in the left side of the window and click the 
Delete user button. You will be required to confirm your selection.

User passwords

User passwords can be managed in two ways. If no password has been set by an
admin, each user must first log in and set his own password. Alternatively, the
administrator can set an initial password and communicate it to the other users. In
order to set the initial password, click the Set initial password button. The users can
then access the MAXQDA project with this password, and set their own passwords
upon first use. Only the user will know this new password. If a user forgets his
password, the administrator can reset it by clicking the Reset user password button.
The administrator can also reset the initial password in this way.

Initial password

The purpose of the initial password is to act as a barrier to entry into the project. New
users must enter this password the first time they log into a locked MAXQDA project,
before setting their personal passwords.

Hierarchical levels

When you click on a particular level in the left side of the window, the rights of the
users at this level will be displayed on the right side of the window. Aside from the
Admin Level, users can be placed in three different groups, from Level 1 to Level 3. In
a research project, the levels can be established, for example, in the following way:

Level 1: Project leaders●

Level 2: Research associates, who can import and delete texts, work with the “Code●

System,” and write, edit and delete memos
Level 3: Student associates, who work primarily on the coding of material●

The following image displays the default Level 1 functions. For example, the top three
functions are reserved by default for the Admin Level. User rights can be modified at
any time by clicking on the red or green icon in front each program function. Any
number of users can be assigned to each level, including the Admin Level. At least one
administrator must be defined in any case, meaning the last entry in this list cannot be
deleted.
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Define user rights for various levels of the hierarchy

Modifying user settings

Click on a username in the left side of the window in order to modify settings in the
right side.

Importing and Exporting the Entire Admin System

It is possible to export the entire Admin System of a MAXQDA project, including
usernames, passwords and user rights. Click on the Export button on the lower
edge of the main window. The data will be saved in MXUSR format, which is, of
course, encrypted. This file can be imported into another MAXQDA project by clicking
on the Import button, thus saving the administrator a lot of time.

Deactivating the User Management system

It is possible to deactivate user management at any tim by opening the User
Management window via Home > User Management > Deactivate User Management
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and checking the corresponding box at the lower edge of the window, then closing
the window.

Option “Deactivate user management”

All usernames and passwords will be saved in the project, so it is possible to reactivate
the user management at any time.
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25 - MAXApp

MAXApp for iOS

MAXApp for iOS is the perfect MAXQDA companion for your tablet and smartphone!

Perfect for field work, the app allows you to take notes, take or import photos and
videos, and record audio. All of your data can be effortlessly coded and structured in
MAXApp and then imported to MAXQDA via Dropbox or iTunes.

Table of Contents

Create a MAXApp project1.
Create or import data2.
Code your data3.
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Manage your codes4.
Manage memos5.
Add locations6.
Settings and saving options7.
Export your MAXApp projects to MAXQDA8.

1. Create a MAXApp project

As a first step, you need to create a MAXApp project. For doing that, just click + and
enter a name for your project.

Now you can find your project in the project list. Click on the new project to open it
and start importing or editing your data.

2. Create or import data

After creating and opening a project you can add your data.
With MAXApp you can work with four different types of data and documents: Text
documents, pictures (taken with camera or imported from gallery), videos (recorded or
imported from gallery) and audio (recorded).

Create or import your data by selecting one of the presented options.
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For example, click Text Document to create a document you can write in. Enter a
name for your document in the box that pops up. After naming it the document
opens automatically and you can type or insert text.

All of your created and imported data is now listed in the Document System and you
can easily switch between your documents.

3. Code your data

Just as in MAXQDA, one of the main functions of MAXApp is helping you “code”
your data, that is, to assign a textcode or emoticode to a particular part of a document
or the document itself.
You can code text segments within your texts, while pictures, videos and audios can
only be coded as a whole.
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Coding text segments with text codes

Open a text document you want to code. Double-click on a word of your text or select
the segment you want to code and tap on "Text Code". You will be redirected to the
list of text codes of your project.

Enter the name of your text code into the field Create new text code and assign it to
the selected text segment by clicking on + Create new text code.

Every code you created is saved in the code list in your project. Whenever you want to
code a segment with a text code you’ve already created, just mark the segment you
want to code and choose Text Code as usual. The code list appears and you can assign
the existing code to the segment you have chosen by clicking on it.

Code text segments with emoticodes

If you want to assign an emoticode to a text segment just mark a segment in your text
document and click emoticode.
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The emoticode browser appears. Just choose from one of the various icons by clicking
through the different tabs. After coding other text segments the same way, our text
document looks like this:

Tip: You can easily switch between your emoticode and text code browsers by clicking
the respective icon.

Coding the whole document

Every type of document can be coded as a whole with a text code or emoticode. You
can use emoticodes or text codes to code the whole document. The codes are
displayed underneath the document’s name. The advantage: All codes can also be
viewed in the document browser.

To code a whole document click the C icon beneath the name of your document.

You will be redirected to the code list. Now you can choose between text codes and
emoticodes and code the whole document the same way as it is explained above for
text segments.

4. Manage your codes
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Delete codes from whole document

If you want to delete codes from the whole document click on one of the codes
beneath the document name.

The code list appears. You can either delete all the codes by clicking on the trash icon
on the top of the document or delete single codes by swiping the selected code to the
left until the delete button appears.

Deleting codes from text documents

If you want to delete a code from your document you need to click on the code icon
next to the text. The text segment or word which belongs to this code is shown. Select
Remove Code to delete the coded segment.

Adding your most used codes to your favorites

As in most qualitative research processes, you will use some codes more often than



25 - MAXApp   705

others. You can save time if you use the option to mark your favorite codes and collect
them in one single folder.

For marking Text codes as your favorites just click on the star icon next to the codes in
your code list.

The code is now marked as one of your favorites. Now, if you click on the star icon on
the bottom right corner, you switch to the folder where only your favorite text codes
are listed.

If you want to mark emoticodes as your favorite codes, just open the emoticode
browser and click on the edit star icon.

Now every icon is marked with a little star, meaning that you can choose the
emoticodes you want to add to your favorites folder by clicking on them.

The codes you chose are automatically saved as a favorite. You can reach the folder by
clicking on the tab marked with a star.
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5. Manage memos

How to create memos in MAXApp

Important information, suggestions, and ideas concerning your MAXApp projects or
documents can be written down in a memo. Click the memo icon in your project or
document list to add or edit a memo.

Enter or edit the text and then save by clicking Done.

The memo icon changes its color into yellow to indicate an existing memo. Click on it
to view the content.

Delete memos

To delete a memo open it and click on the trash icon
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6. Add locations

Add geolinks automatically

MAXApp connects your documents automatically with the location where they were
created, unless you haven’t deactivated this function in the App settings of your
device. The icon’s color is red when a location is defined. Additionally the address is
shown beneath the document’s title.

Adding geolinks manually
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After clicking the map icon, you will view your current location on the map (if no
location was defined). Here you can edit or delete the location.

If you want to change the location, just move the needle on the map to the right
location. For doing so just click on it and hold your finger down while you are moving
the needle to the right location. You can zoom in or out the map if you need a more
detailed view. After you have chosen a new location, click Save to link the document
to this location. The new location will be shown beneath the document`s name in the
list of your documents.

If you want to delete a location, click on the trash icon.
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7. Settings and saving options

Open the MAXApp settings by clicking the settings icon in the project list view.

Here you can edit your user name, choose if your pictures and videos should be saved
in your library, and determine the quality of your video and audio recordings.

8. Export your MAXApp projects to MAXQDA

Export to Dropbox

You can export your MAXApp projects to MAXQDA via Dropbox or iTunes.
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For example, if you want to export your project to dropbox, just open a project, click
the sharing icon and Dropbox export.Now you need to allow Dropbox to export your
projects.
Your project will be saved to this location: Dropbox/Apps/MAXApp for iOS/(name of
the project).

Exporting to iTunes

In case you don’t want to save your data in a cloud or you just don’t use dropbox, you
also have the possibility to export your project to iTunes.
For doing that make sure your device is connected to your computer via USB cabel and
choose iTunes export instead of Dropbox export.

Synchronize your device and click on Apps in the left navigation.
Now scroll down to File Sharing and choose the Documents you want to import from
the list. You can easily drag the files on your desktop.
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Importing into MAXQDA

After exporting your project from MAXApp you can import your saved data from
Dropbox (or iTunes) to MAXQDA.

To do so, open MAXQDA and choose the option Import MAXApp Project. In the folder
of your MAXApp project you will find an .xml-file. Choose this file so that all
documents with the corresponding codes, memos, and locations are imported into
MAXQDA.

Your MAXApp documents and codes can now be viewed and further analyzed in
MAXQDA.

Downloading data from Dropbox website

If you haven’t installed Dropbox on your computer, you can log-in online and
download the file with all of your MAXApp data from the web interface.
For doing that just choose Apps/MAXApp/[Name of the Project] in your Dropbox
Folder and continue the same way presented above.
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MAXApp for Android

MAXApp  for  Android  is  the  perfect  MAXQDA  companion  for  your  tablet  and
smartphone!

Perfect for field work, the app allows you to take notes, take or import photos and
videos, and record audio. All of your data can be effortlessly coded and structured in
MAXApp and then imported to MAXQDA via Dropbox.
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Table of Contents

Create a MAXApp project1.
Create or import data2.
Code your data3.
Manage your codes4.
Create memos5.
Add locations6.
Settings and saving options7.
Export your MAXApp projects to MAXQDA8.

1. Create a MAXApp project

The first step you need to do is to create a MAXApp project. See how easy it is to start
working with MAXApp.

Click + to create a new project.
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Enter a name for your project.

Now you can find your project in the project list. Click on the new project to open it
and start importing or editing your data.
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2. Create or import data

After you have created and opened a project, you can add some data. Click + and you
will see the following options:

Create or open your data by selecting one of the presented options. Now enter a
name for your document.

All of your documents are displayed in a list.
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With MAXApp you can work with four different types of documents: Text documents,
pictures (taken with camera or imported from gallery), videos (recorded or imported
from gallery) and audio (recorded).
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3. Code your data

Code your data with MAXApp: Texts, pictures, videos and audios. You can code text
segments within your texts, while pictures, videos and audios are to be coded
completely by using emoticodes or self-created text codes.

Coding text segments

Open a text document which you want to code. Double-click into the field and select
the segment, you want to code. Click + CODE to open the code browser.

The code browser has two views: The emoticode browser and the text code browser.
Here you see the emoticode browser. Click

to open the text code browser.
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Enter the name of your text code into the new window and assign it to the selected
text segment by clicking on "+".

An example

In this example we want to code a part of the text with an apple emoticode. Therefore
we mark the segment, open the emoticode browser and select the apple symbol.
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We want to code another segment with a new text code: "Surgery". We select the
segment, open the text code browser, enter the new text code and use it directly by
clicking the "+" icon.
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After coding other text segments the same way, our text file looks like this:

Coding with already existing text codes

To use already existing text codes, first mark the text segment, which you want to
code and open the text code browser.
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The text code browser consists of three parts:

1. The textfield where new text codes can be created●

2. The Used Codes, with which you have already coded (here we haven`t used codes●

yet - thus the field is empty)
3. The Code list with all of your created codes●

Choose one of the codes in your Code list, to assign it to the pre-selected text
segment.

The text segment is now coded.
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Coding the whole document

Every type of document can be coded as a whole with a text code or emoticode. To
code a whole document, click the + CODE icon next to the name of your document.

This coding process works exactly like the coding of segments. You can use
emoticodes or text codes to code the whole document. The codes are displayed
underneath the document's name. The great advantage: All codes can also be viewed
in the document browser.
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4. Manage your codes

The code list

Open the code list to manage your codes. There are three different views. The
standard view shows all of the codes you have created in this project.

If you want to view your last used codes, click the clock icon.
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The star icon shows those codes, which you have marked as favorite.

Deleting codes

You can delete codes by clicking

in your Code list and then selecting a code, you want to delete.
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Marking a code as a favorite

You can mark codes which you want to use frequently as favorite to save time during
the coding process. To mark a code as favorite, click

within the code menu and then choose all codes, which you want to mark as favorite.
The star next to your new favorite code will change its color from grey to yellow.

5. Manage memos
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Memos for projects and documents

Important information, suggestions and ideas concerning your projects or documents
can be written down in a memo. Click the memo icon in your project or document list
to add or edit a memo.

Enter or edit the text and then save by clicking the check mark.

The memo icon changes its color into yellow to indicate an existing memo. Double-
click on it to view the content.
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Deleting memos

To delete a memo, open it and click on the trash icon.

6. Add locations

Geolinks - MAXApp connects your documents automatically with your current
location, if you haven't deactivated this function in the settings. The icon will change
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its color into red when a location is defined. Additionally the address is shown beneath
the document's title.

Click the location icon to view, edit or delete the location of a document.

If you want to edit the location, keep pressing the location icon on the map and move
it with your finger. Alternatively you can search for a location with the search box
above.
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To choose your current location use the encircled icon. Zoom in or out the map with
the help of the zoom button.

If you want to delete a location, just use the trash and submit with Delete.

7. Settings and saving options

Open the MAXApp settings by clicking the settings icon.
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Here you can edit your user name, determine the quality of your videos and audios,
choose if your pictures and videos should be saved to your library and if MAXApp is
allowed to access your location.

8. Export your MAXApp project to MAXQDA

Your data can be transferred to your computer and imported into MAXQDA in two
different ways. You can either use the Dropbox or save your data to your Android
device.

Exporting via Dropbox

You can export your projects to MAXQDA via Dropbox. Open a project, click the
Dropbox icon and allow Dropbox to export your projects. Your project will be saved to
this location: Dropbox/Apps/MAXApp for Android/(Name of the project)
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Here you will find the project on your computer:

If you haven't installed Dropbox on your computer, you can log-in online and
download the file with all of your MAXApp data from the web interface.

Step 1
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Step 2

Step 3
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Exporting to a device

You can save your MAXApp data to your Android device to transfer them to your
computer later. Open a project and click the "share"-button to Save to device.

You will find your project with all data in these folders on your device:
Local/MAXQDA.

Now you can transfer your project with an USB cable to your computer where it can
be saved and then imported into MAXQDA.

Importing from Dropbox or an Android device into MAXQDA

Now import your saved data from your computer to MAXQDA. To do so, open
MAXQDA and choose the option Import MAXApp Project. In the folder of your
MAXApp project you will find an .xml-file. This is the file you need to import so that all
the documents with their corresponding codes, memos and locations are imported
into MAXQDA.
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Your MAXApp documents and codes can now be viewed and further analysed in
MAXQDA.
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Technical Data and Information

Checking for Updates
Each time you start the program, MAXQDA will check the MAXQDA website to see if
an updated version is available. If an update is available, it is recommended that you
download it in order to benefit from interesting new features and enhancements.

Under Preferences, that you can open from the settings icon in the top right corner of
the MAXQDA window, you have the options to decide if MAXQDA should Search for
updates automatically or not.

If you have opted to skip an update, you can later request it manually by searching for
the item in the Help menu.

Tip: If you are using a MAXQDA network license, it may be possible that your network
admin has deactivated the automatic search for updates. In this case MAXQDA will
not check for an update each time you start the program and you will also not find the
option in the help menu.

Keyboard Shortcuts
The following keyboard shortcuts are available in MAXQDA.

General

Windows Mac
F1 cmd + ⇧ + ? Opens the MAXQDA help system.
Ctrl + N cmd + N Creates a new project.
ctrl + O cmd + O Opens an existing project.
ctrl + A cmd + A Highlights the entire text.

ctrl + C cmd + C
copies the selected segment to the
Windows clipboard.

ctrl + X cmd + X
cuts out the selected segment and puts it
in the Windows clipboard.

ctrl + V cmd + V
Pastes the selection from the Windows
clipboard.

Alt + 1 option ⌥ + 1
Opens/closes the window "document
system".

Alt + 2 option ⌥ + 2 Opens/closes the window "code system".
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Alt + 3 option ⌥ + 3
Opens/closes the window "document
browser".

Alt + 4 option ⌥ + 4
Opens/closes the window "retrieved
segments".

ctrl + Alt + B cmd + option ⌥ + B Opens the logbook.

ctrl + Alt + M
cmd + option ⌥ +
M

Opens the Code Matrix Browser.

ctrl + Alt + R cmd + option ⌥ + R Opens the Code Relations Browser.

ctrl + F cmd + F
Opens the search toolbar for the current
window or the table overview.

ctrl + ⇧ + F cmd + ⇧ + F Opens the lexical search.
ctrl + P cmd + P Prints the focused window or view.

Alt + Double-click
option ⌥ + double-
click

Inserts a MAXQDA object (e.g. a
document or code) into MAXMaps, if
MAXMaps is open.

ctrl + R cmd + R
Resets activations in the "Document
System" and "Code System".

"Document System“

Windows Mac
Double-click Double-click Opens a document.
⇧ + double-click ⇧ + double-click Opens a document in a new tab.
ctrl + click cmd + click Activates or deactivates a document.
F2 Enter Renames a document.
Del cmd + BackspacE Deletes a document.

Alt + UpArrow
Alt + DownArrow

option ⌥ +
UpArrow
option ⌥ +
DownArrow

Moves a document or document group up
and down in the “Document System“.

ctrl + Drag & DroP
option ⌥ + Drag &
DroP

creates a copy of the document without
coded segments (start dragging and then
hold ctrl/cmd)

ctrl + T cmd + T
creates a new document and opens it for
editing in the “Document Browser“.

ctrl + D cmd + D
Opens the dialog window for importing
documents.

Alt + ⇧ + M option ⌥ + ⇧ + M
creates a new memo or opens an existing
memo for a document.

"Code System“

Windows Mac
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ctrl + click cmd + click
Activates or deactivates a code including
the subcodes.

ctrl + ⇧ + click cmd + ⇧ + click
Activates or deactivates a code without
subcodes.

F2 Enter Renames a code.
Entf Backspace Deletes a code.

Alt + UpArrow,
Alt + DownArrow

option ⌥ +
UpArrow
option ⌥ +
DownArrow

Moves a code (possibly with subcodes) up
and down in the “Code System“.

Alt + RightArrow,
Alt +LeftArrow

option ⌥ +
RightArrow,
option ⌥ +
LeftArrow

Increases and decreases the level of
hierarchy of a code.

Alt + Drag & DroP
option ⌥ + Drag &
DroP

creates a copy of the code without coded
segments.

Alt + N cmd + option ⌥ + N Inserts a new code on the chosen level.

"Document Browser“

Windows Mac
ctrl + E cmd + option ⌥ + E starts and stops Edit Mode.
ctrl + ⇧ + P cmd + ⇧ + P starts and stops Paraphrase Mode.

Alt + L cmd + option ⌥ + L
codes the selected segment with the most
recently used code.

Alt + W
cmd + option ⌥ +
W

opens the dialog window for creating a
new code, which will be used to code the
selected segment.

Alt + C cmd + option ⌥ + C
codes the selected segment with the code
shown in the Quick List.

Alt + I cmd + option ⌥ + I

codes the selected segment with a newly-
created code named after the first 63
characters of the selected segment (in-
vivo-coding).

ctrl + l cmd + l

Inserts an internal link at the location of
the selected segment. The location it is
linked to is set by highlighting another
segment in that document or another one
in the project and hitting Ctrl + L again.

F6 F6
Inserts a new timestamp into a transcript
when in transcription mode.

PgUp, PgDN PgUp, PgDN
Moves to the next/previous page of a PDF
document.
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Pos1, End Pos1, End
Moves to the beginning or the end of a
PDF document.

ctrl + Plus,
ctrl + Minus

cmd + Plus,
cmd + Minus

Zooms in or out of the document.

ctrl + Zero cmd + Zero Zooms the view to 100 %.
Alt + Tab,
Alt + ⇧ + Tab

option ⌥ + Tab,
option ⌥ + ⇧ + Tab

Jumps to the next/previous tab.

ctrl + F4 cmd + W closes the current tab or the current view.

Multimedia Browser toolbar

Windows Mac
F3 F3 Jumps to the next memo.
⇧ + F3 ⇧ + F3 Jumps to the previous memo.
F4 or
F5 or
2 x ctrl

F4 or
F5 or
2 x ctrl

Plays or pauses the media file.

F7 F7 Sets a clip start.
F8 F8 Sets a clip end.
F9 F9 Plays a clip.
F10 F10 cancels the clip mark.
F12 F12 Jump 5 seconds forward
⇧ + F12 ⇧ + F12 Jump 5 seconds back

ctrl + L cmd + L
Insert a link start to the selected clip. Use
the same keyboard combination to insert a
link goal.

Alt + ⇧ + M option ⌥ + ⇧ + M
Insert a memo at the current position of
the media file.

Table overviews, e.g. Overview of Coded Segments

Windows Mac

ctrl + ⇧ + E cmd + ⇧ + E
Opens the table as Excel file in the
standard program.

ctrl + ⇧ + H cmd + ⇧ + H
Opens the table as HTML file in the
standard internet browser.

ctrl + E cmd + E
Opens the dialog window for exporting
the table or view.

Del cmd + Backspace Deletes the chosen row/s.



Technical Data and Information   740

MAXDictio Dictionary [only available in MAXQDA Plus and MAXQDA
Analytics Pro]

Windows Mac
ctrl + ⇧ + N cmd + ⇧ + N creates a new category.
ctrl + Alt + N cmd + option ⌥ + N creates a new search item.

ctrl + E cmd + E
Opens the dialog window for exporting a
dictionary.

Del cmd + BackspacE Deletes the chosen category.

MAXDictio Stop list [only available in MAXQDA Plus and MAXQDA
Analytics Pro]

Windows Mac
ctrl + N cmd + N creates a new word to be excluded.

ctrl + E cmd + E
Opens the dialog window for exporting
the stop list.

Del cmd + Backspace Deletes the focused items.

File Management
MAXQDA works with the following file types:

.MX20 MAXQDA 2020 project file for Windows and Mac

.MX18 MAXQDA 2018 project file for Windows and Mac

.MX12 MAXQDA 12 project file for Windows and Mac

.MX11 MAXQDA 11 project file for Mac

.MX5 MAXQDA 11 project file for Windows

.MX4 MAXQDA 10 project file

.MX3 MAXQDA 2007 project file

.MX2 MAXQDA 2 project file

.M2K MAXQDA 1 project file

.LOA Saved formula files (activation by variables)

.SEA Saved search files (SEArch file)

.TXT Exported table file

.RTF Exported texts, coded segments, and memos

.MTR Exported “Code System”

.MOD Exported MAXMAp

.MEX MAXQDA Exchange file (MAX EXchange)
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Limitations and Technical Information
MAXQDA sets very few limits. The following table informs about importable file
formats and some limits within MAXQDA.

Importable Text formats: RTF/D, DOC/X, ODT, PDF, TXT, HTML
Importable Table formats:XLS/X  
Importable Image
formats:

JPG, GIF, TIF, PNG

Supported Audio formats:
Windows: MP3, WAV, WMA, AAC, M4A
Mac: MP3, WAV, AAC, CAF, M4A

Supported Video formats:
MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP
Windows: WMV recommended Codec: H.264/AVC

Twitter Import: Max. 10,000 tweets per import
Twitter Analysis: No set limit to number of tweets
YouTube Import: Max. 10,000 most current comments per video
Number of projects: No set limit
Number of document
groups:

No set limit
Groups of more than 1,000 are not recommended

Number of documents:
No set limit. Dividing them into document with groups with
max. 1,000 is recommended

Number of codes: No set limit

Number of coded
segments:

Above 200,000 coded segments the stability of MAXQDA
cannot be guaranteed (if your computer has less than 4 GB
RAM this threshold may be lower)

Code System levels: Max. 10
Please note: If you use the direct import of web pages in HTML format, web pages are
imported as text documents (and not as web pages). The layout can change a lot
during the import, which is why the version of the import with the Web Collector from
MAXQDA is clearly preferable. The direct HTML import is particularly suitable for
simply structured and laid out data.

What data volumes can be edited with MAXQDA?

As the table overview above shows, there are very few technical limits to the data you
can work with in MAXQDA. However, it should be noted that several thousand
documents, codes and encodings in a project can affect the level of performance.

It is therefore important to note some qualitative answers to the question of how
many documents, codes, codings etc. you can process with MAXQDA. General
answers are only partially helpful, and may differ in individual cases, since the
performance of MAXQDA of course also depends on the hardware used. However, in
practise, such issues only arise in very few instances, in which very large amounts of
data need to be analyzed. They are certainly not common not for "standard" projects
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in qualitative or mixed-methods research.

The following factors may influence the performance of MAXQDA - sometimes in
combination:

Number of documents in the "Document System"

As a rule, several thousand documents will pose no problem for MAXQDA if they are
organized in several document groups. So, for example, answers to open questions
from (online) surveys with 1,000 cases (= documents) can be analyzed in MAXQDA
with ease.

Number of codes in the "Code System"

Again, there is no technical limit: Several thousand codes can be processed, but
certainly it is not easy to manage more than 2,500 codes from a research point of
view.

Number of coded segments per document

Even 1,000 coded segments and more in a document rarely pose a problem. That
being said, if the length of the text is very large or the codes are spread over a few PDF
pages or paragraphs, it is recommended to hide individual coding stripes to allow for a
greater display speed. To do this, right-click in the gray area in which the coding
stripes are displayed and select, for example, which colors should be displayed and
which should be hidden.

Length and contents of text documents

If a single text document is very long, e.g. with more than 300 pages, it may take a
few moments before the document is displayed. If such a document also contains a
large number of codes (for example, more than 500), this can cause further delays.

For text documents containing a large number of images (for example, more than 500)
or very large (for example, 30 mega pixels) images, it may be better to import the
document as a PDF document or split it into multiple documents. In this way, the
performance speed can be increased when opening and editing these documents.

Size of table documents

For table documents, the time it takes to open the document depends on the number
of rows/columns and the size of the cell contents. For 1,000 rows of 20 columns, it
may take a few seconds for the document to open. The time to open is also affected
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by how many codes there are in the table. The coding and editing of cells in an open
table document with 1,000 rows and 20 columns can then be completed without any
delays.

Number of tweets analyzed simultaneously

The start of the Twitter analysis as well as the opening and filtering of tweets is still
sufficiently fast even with 200,000 tweets. Only the compilation of word frequencies
requires one to two minutes of computation time for this amount of data.
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